Table of Contents
# Table of Contents

<table>
<thead>
<tr>
<th>Page</th>
<th>Section</th>
</tr>
</thead>
<tbody>
<tr>
<td>9</td>
<td>About this manual</td>
</tr>
<tr>
<td>10</td>
<td>Welcome!</td>
</tr>
<tr>
<td>13</td>
<td>VST Connections: Setting up input and output busses</td>
</tr>
<tr>
<td>14</td>
<td>About this chapter</td>
</tr>
<tr>
<td>14</td>
<td>Setting up busses</td>
</tr>
<tr>
<td>21</td>
<td>Using the busses</td>
</tr>
<tr>
<td>25</td>
<td>Playback and the Transport panel</td>
</tr>
<tr>
<td>26</td>
<td>Background</td>
</tr>
<tr>
<td>30</td>
<td>Operations</td>
</tr>
<tr>
<td>34</td>
<td>Options and Settings</td>
</tr>
<tr>
<td>37</td>
<td>Recording</td>
</tr>
<tr>
<td>38</td>
<td>Background</td>
</tr>
<tr>
<td>39</td>
<td>Basic recording methods</td>
</tr>
<tr>
<td>43</td>
<td>Audio recording specifics</td>
</tr>
<tr>
<td>65</td>
<td>MIDI Recording Specifics</td>
</tr>
<tr>
<td>78</td>
<td>Options and Settings</td>
</tr>
<tr>
<td>83</td>
<td>The Project window</td>
</tr>
<tr>
<td>84</td>
<td>Background</td>
</tr>
<tr>
<td>86</td>
<td>Window Overview</td>
</tr>
<tr>
<td>99</td>
<td>Operations</td>
</tr>
<tr>
<td>140</td>
<td>Options</td>
</tr>
<tr>
<td>145</td>
<td>Folder tracks</td>
</tr>
<tr>
<td>146</td>
<td>About folder tracks</td>
</tr>
<tr>
<td>147</td>
<td>Handling folder tracks</td>
</tr>
<tr>
<td>149</td>
<td>Working with folder parts</td>
</tr>
<tr>
<td>153</td>
<td>Using markers</td>
</tr>
<tr>
<td>154</td>
<td>About markers</td>
</tr>
<tr>
<td>154</td>
<td>The Marker window</td>
</tr>
<tr>
<td>158</td>
<td>Using the Marker track</td>
</tr>
<tr>
<td>163</td>
<td>Marker key commands</td>
</tr>
<tr>
<td>164</td>
<td>Editing markers in the Project Browser</td>
</tr>
<tr>
<td>165</td>
<td>Fades and crossfades</td>
</tr>
<tr>
<td>166</td>
<td>Creating fades</td>
</tr>
<tr>
<td>170</td>
<td>The Fade dialogs</td>
</tr>
<tr>
<td>173</td>
<td>Creating crossfades</td>
</tr>
<tr>
<td>176</td>
<td>The Crossfade dialog</td>
</tr>
<tr>
<td>179</td>
<td>Auto Fades and Crossfades</td>
</tr>
<tr>
<td>181</td>
<td>The mixer</td>
</tr>
<tr>
<td>182</td>
<td>About this chapter</td>
</tr>
<tr>
<td>183</td>
<td>Overview</td>
</tr>
<tr>
<td>188</td>
<td>Configuring the mixer</td>
</tr>
<tr>
<td>197</td>
<td>The audio channel strips</td>
</tr>
<tr>
<td>199</td>
<td>The MIDI channel strips</td>
</tr>
<tr>
<td>200</td>
<td>The common panel</td>
</tr>
<tr>
<td>201</td>
<td>The input &amp; output channels</td>
</tr>
<tr>
<td>202</td>
<td>Basic mixing procedures</td>
</tr>
<tr>
<td>210</td>
<td>Audio specific procedures</td>
</tr>
<tr>
<td>224</td>
<td>MIDI specific procedures</td>
</tr>
<tr>
<td>226</td>
<td>Utilities</td>
</tr>
<tr>
<td>231</td>
<td>Audio effects</td>
</tr>
<tr>
<td>232</td>
<td>About this chapter</td>
</tr>
<tr>
<td>232</td>
<td>Overview</td>
</tr>
<tr>
<td>234</td>
<td>Insert effects</td>
</tr>
<tr>
<td>244</td>
<td>Send effects</td>
</tr>
<tr>
<td>255</td>
<td>Making settings for the effects</td>
</tr>
<tr>
<td>258</td>
<td>Installing and managing effect plug-ins</td>
</tr>
<tr>
<td>Page</td>
<td>Section</td>
</tr>
<tr>
<td>------</td>
<td>---------</td>
</tr>
<tr>
<td>265</td>
<td>VST Instruments</td>
</tr>
<tr>
<td>266</td>
<td>Introduction</td>
</tr>
<tr>
<td>267</td>
<td>Activating and using VST Instruments</td>
</tr>
<tr>
<td>273</td>
<td>The Instrument Freeze function</td>
</tr>
<tr>
<td>277</td>
<td>Surround sound (Cubase SX only)</td>
</tr>
<tr>
<td>278</td>
<td>Background</td>
</tr>
<tr>
<td>281</td>
<td>Window overview</td>
</tr>
<tr>
<td>283</td>
<td>Operations</td>
</tr>
<tr>
<td>295</td>
<td>Automation</td>
</tr>
<tr>
<td>296</td>
<td>Background</td>
</tr>
<tr>
<td>299</td>
<td>Automation track operations</td>
</tr>
<tr>
<td>306</td>
<td>Using Write/Read automation</td>
</tr>
<tr>
<td>313</td>
<td>Working with automation curves</td>
</tr>
<tr>
<td>319</td>
<td>Tips and common methods</td>
</tr>
<tr>
<td>320</td>
<td>Options and Settings</td>
</tr>
<tr>
<td>321</td>
<td>Remote controlling the mixer</td>
</tr>
<tr>
<td>322</td>
<td>About this chapter</td>
</tr>
<tr>
<td>322</td>
<td>Setting Up</td>
</tr>
<tr>
<td>324</td>
<td>Operations</td>
</tr>
<tr>
<td>326</td>
<td>The Generic Remote device</td>
</tr>
<tr>
<td>331</td>
<td>Audio processing and functions</td>
</tr>
<tr>
<td>332</td>
<td>Background</td>
</tr>
<tr>
<td>333</td>
<td>Audio processing</td>
</tr>
<tr>
<td>352</td>
<td>Applying plug-ins (Cubase SX only)</td>
</tr>
<tr>
<td>355</td>
<td>The Offline Process History dialog</td>
</tr>
<tr>
<td>357</td>
<td>Freeze Edits</td>
</tr>
<tr>
<td>358</td>
<td>Detect Silence</td>
</tr>
<tr>
<td>361</td>
<td>The Spectrum Analyzer (Cubase SX only)</td>
</tr>
<tr>
<td>364</td>
<td>Statistics (Cubase SX only)</td>
</tr>
<tr>
<td>365</td>
<td>The Sample Editor</td>
</tr>
<tr>
<td>366</td>
<td>Background</td>
</tr>
<tr>
<td>366</td>
<td>Opening the Sample Editor</td>
</tr>
<tr>
<td>367</td>
<td>Window overview</td>
</tr>
<tr>
<td>371</td>
<td>Operations</td>
</tr>
<tr>
<td>383</td>
<td>Options and settings</td>
</tr>
<tr>
<td>385</td>
<td>The Audio Part Editor</td>
</tr>
<tr>
<td>386</td>
<td>Background</td>
</tr>
<tr>
<td>386</td>
<td>Opening the Audio Part Editor</td>
</tr>
<tr>
<td>387</td>
<td>Window overview</td>
</tr>
<tr>
<td>390</td>
<td>Operations</td>
</tr>
<tr>
<td>394</td>
<td>Common methods</td>
</tr>
<tr>
<td>396</td>
<td>Options and Settings</td>
</tr>
</tbody>
</table>
397 Working with hitpoints and slices

398 Background
399 Using hitpoints
405 Editing hitpoints
412 Creating slices
413 Creating groove quantize maps
414 Other Advanced submenu items

417 The Pool

418 Background
420 Window Overview
424 Operations
443 Options and Settings

445 MIDI devices and patches

446 About program change and bank select
447 Opening the MIDI Device Manager
448 Installing a MIDI Device
450 Selecting a patch for an installed device
451 Renaming patches in a device
452 Defining a new device
456 Exporting and importing device setups

457 MIDI realtime parameters and effects

458 Introduction
459 The Inspector – General handling
460 Basic track settings
463 Track parameters
468 MIDI effects
473 The included effects
499 Managing plug-ins
500 Merge MIDI in Loop

503 MIDI processing and quantizing

504 Introduction
505 Quantizing
517 Other MIDI menu functions
523 Dissolve Part

525 The MIDI editors

526 About editing MIDI
527 Opening a MIDI editor
530 The Key Editor – Overview
535 Key Editor operations
560 The Drum Editor – Overview
563 Drum Editor operations
567 Working with drum maps
576 Using drum name lists
577 The List Editor – Overview
579 List Editor operations
586 The Score Editor – Overview (Cubase SL only)
589 Score Editor operations (Cubase SL only)
605 Common MIDI editor options and settings
<table>
<thead>
<tr>
<th>Page</th>
<th>Section</th>
</tr>
</thead>
<tbody>
<tr>
<td>607</td>
<td>The Logical Editor, Transformer and Input Transformer</td>
</tr>
<tr>
<td>608</td>
<td>Introduction</td>
</tr>
<tr>
<td>610</td>
<td>Opening the Logical Editor</td>
</tr>
<tr>
<td>610</td>
<td>Window overview</td>
</tr>
<tr>
<td>611</td>
<td>Selecting a preset</td>
</tr>
<tr>
<td>612</td>
<td>Setting up filter conditions</td>
</tr>
<tr>
<td>623</td>
<td>Selecting a function</td>
</tr>
<tr>
<td>625</td>
<td>Specifying actions</td>
</tr>
<tr>
<td>629</td>
<td>Applying the defined actions</td>
</tr>
<tr>
<td>630</td>
<td>Working with presets</td>
</tr>
<tr>
<td>631</td>
<td>The Input Transformer</td>
</tr>
<tr>
<td>635</td>
<td>Working with the Tempo track</td>
</tr>
<tr>
<td>636</td>
<td>Background</td>
</tr>
<tr>
<td>637</td>
<td>The Tempo Track Editor – overview</td>
</tr>
<tr>
<td>640</td>
<td>Operations</td>
</tr>
<tr>
<td>646</td>
<td>Options and settings</td>
</tr>
<tr>
<td>647</td>
<td>The Beat Calculator</td>
</tr>
<tr>
<td>649</td>
<td>Merge Tempo From Tapping</td>
</tr>
<tr>
<td>650</td>
<td>The Time Warp tool</td>
</tr>
<tr>
<td>661</td>
<td>The Project Browser</td>
</tr>
<tr>
<td>662</td>
<td>Background</td>
</tr>
<tr>
<td>662</td>
<td>Opening the Project Browser</td>
</tr>
<tr>
<td>662</td>
<td>Window Overview</td>
</tr>
<tr>
<td>663</td>
<td>Navigating in the Browser</td>
</tr>
<tr>
<td>664</td>
<td>Customizing the View</td>
</tr>
<tr>
<td>664</td>
<td>About the Sync Selection option</td>
</tr>
<tr>
<td>665</td>
<td>Editing audio tracks</td>
</tr>
<tr>
<td>668</td>
<td>Editing MIDI tracks</td>
</tr>
<tr>
<td>671</td>
<td>Editing Automation tracks</td>
</tr>
<tr>
<td>671</td>
<td>Editing the Video track</td>
</tr>
<tr>
<td>672</td>
<td>Editing the Marker track</td>
</tr>
<tr>
<td>673</td>
<td>Editing the Tempo track</td>
</tr>
<tr>
<td>673</td>
<td>Editing Time Signatures</td>
</tr>
<tr>
<td>674</td>
<td>Deleting Events</td>
</tr>
<tr>
<td>675</td>
<td>Working with System Exclusive messages</td>
</tr>
<tr>
<td>676</td>
<td>Introduction</td>
</tr>
<tr>
<td>676</td>
<td>Bulk dumps</td>
</tr>
<tr>
<td>679</td>
<td>Recording System Exclusive parameter changes</td>
</tr>
<tr>
<td>680</td>
<td>Editing System Exclusive messages</td>
</tr>
<tr>
<td>683</td>
<td>Export Audio Mixdown</td>
</tr>
<tr>
<td>684</td>
<td>Introduction</td>
</tr>
<tr>
<td>685</td>
<td>Mixing down to an audio file</td>
</tr>
<tr>
<td>688</td>
<td>File format specifics</td>
</tr>
<tr>
<td>705</td>
<td>Synchronization</td>
</tr>
<tr>
<td>706</td>
<td>Background</td>
</tr>
<tr>
<td>713</td>
<td>Window Overview</td>
</tr>
<tr>
<td>714</td>
<td>Operations</td>
</tr>
<tr>
<td>721</td>
<td>Options</td>
</tr>
<tr>
<td>723</td>
<td>VST System Link</td>
</tr>
<tr>
<td>724</td>
<td>Introduction</td>
</tr>
<tr>
<td>725</td>
<td>Preparations</td>
</tr>
<tr>
<td>731</td>
<td>Activating VST System Link</td>
</tr>
<tr>
<td>738</td>
<td>Application examples</td>
</tr>
<tr>
<td>741</td>
<td>Video</td>
</tr>
<tr>
<td>742</td>
<td>Background</td>
</tr>
<tr>
<td>743</td>
<td>Operations</td>
</tr>
<tr>
<td>749</td>
<td>Options</td>
</tr>
</tbody>
</table>
# CUBASE SX/SL

## 751 ReWire
- Introduction
- Launching and quitting
- Activating ReWire channels
- Using the transport and tempo controls
- How the ReWire channels are handled in Cubase SX/SL
- Routing MIDI via ReWire
- Considerations and limitations

## 759 File handling
- File Operations
- Options and Settings

## 785 Customizing
- Background
- Working with window layouts
- Customizing the Transport panel
- Customizing the toolbars
- Customizing track controls
- About preference presets (Cubase SX only)

## 801 Appearance
- Where are the settings stored?

## 803 Key commands
- Background
- Setting up Key Commands
- Setting up tool modifier keys

## 815 Index
1

About this manual
Welcome!

This is the Operation Manual for Steinberg’s Cubase SX/SL 2. Here you will find detailed information about virtually all features and functions in the program.

How to use the manuals and the Help

When it comes to manuals, different users look for information in different ways, depending on their previous knowledge and personal preferences. You may be looking for a complete description of a procedure, you may just be trying to find a certain function in the program, you may have found a function in the program and want it explained – or you may simply want to learn it all!

Therefore, there are several ways to enter the documentation and get help:

• Use the Table of Contents to browse the manual or the Help and find the section you need to know more about. You can click directly on a chapter or section to go there.

• Use the Index to look up specific features and functions. Again, you can click directly on the page number for an index entry to go to there. The help also allows you to perform a free search of any term.

• In the program you will find Help buttons in most dialogs – click to get information about that specific dialog. Similarly, you can press [F1] to get information about the current window.

• If you want information about a specific menu item, use the Menu Reference section in the Help. All main menu items in Cubase SX/SL are listed and explained there.

• Finally, you could read the manuals from start to end if you like. See below for a description of all parts of the Cubase SX/SL documentation package.
Other documents

Apart from the Operation Manual and the help, the following documents are included with Cubase SX/SL:

Getting Started

In this book (also available in Adobe Acrobat pdf format) you will find:

• Requirements, installation and setting up your system.
• Basic concepts and terminology.
• Basic methods – e.g. how to set values, use tools and menus.
• A list of all default key commands.
• A number of tutorials, helping you get started with working in Cubase SX/SL.

Audio Effects and VST Instruments

In this pdf document you will find:

• Descriptions of the included VST audio effect plug-ins.
• Descriptions of the included VST instruments.

These descriptions can also be found in the help.

Remote Control Devices

This pdf document lists the supported MIDI remote control devices and describes how to set up and use them with Cubase SX/SL.

Score Layout and Printing (Cubase SX only)

This pdf document describes the advanced score editing features in Cubase SX. For information about the basic score editor included in Cubase SL, see page 586.

Using Cubase SX/SL with DSP Factory (Windows only)

In this pdf document you will find detailed information about Cubase SX/SL’s implementation for the Yamaha DSP Factory audio card.

All pdf documents can be opened from the Help menu in the program, from the Cubase SX/SL Documentation subfolder on the Windows Start menu or from the folder /Library/Documentation/Cubase SX/SL/ under Mac OS X.
About this manual
2

VST Connections: Setting up input and output buses
About this chapter

As described in the Getting Started book, Cubase SX/SL uses a system of input and output busses to transfer audio between the program and the audio hardware.

• Input busses let you route audio from the inputs on your audio hardware into the program. This means that when you record audio, you will always do this through one or several input busses.

• Output busses let you route audio from the program to the outputs on your audio hardware. When you play back audio, you will always do this through one or several output busses.

As you can see, the input and output busses are vital when you work with Cubase SX/SL. That’s the reason why you find this chapter in the beginning of the Operation Manual – once you understand the bus system and set up the busses properly, it will be easy to go on with recording, playing back, mixing and doing surround work (Cubase SX only).

Setting up busses

Strategies

You can create any number of busses in Cubase SX/SL. In Cubase SL, busses are in mono or stereo while Cubase SX also supports a number of surround formats.

• The bus configuration is saved with the projects – therefore it’s a good idea to add and set up the busses you need and save these in a template project (see page 763).

When you start working on new projects, you start from this template. That way you get your standard bus configuration without having to make new bus settings for each new project. If you need to work with different bus configurations in different projects, you could either create several different templates or store your configurations as presets (see page 20). The templates can of course also contain other settings that you regularly use – sample rate, record format, a basic track layout, etc.
So, which type of busses do you need? This depends on your audio hardware, your general audio setup (e.g. surround speaker setup) and what kind of projects you work with. Here’s an example:

Let’s say you are using audio hardware with eight analog inputs and outputs and digital stereo connections (10 inputs and outputs all in all). Furthermore, you work with a surround setup in 5.1 format (relevant for Cubase SX only). Here’s a list of busses you may wish to add:

**Input busses**

- Most likely you need at least one stereo input bus assigned to an analog input pair. This would let you record stereo material. If you want to be able to record in stereo from other analog input pairs as well, you could add stereo input busses for these too.
- Although you can record mono tracks from one side of a stereo input, it may be a good idea to add a dedicated mono input bus. This could be assigned to an analog input to which you have connected a dedicated microphone pre-amp for example. Again, you could have several different mono busses.
- You probably want a dedicated stereo input bus assigned to the digital stereo input, for digital transfers.
- If you want to transfer surround material directly to a surround track, e.g. from surround-configured location recording equipment, you need an input bus in that surround format (here, this would be a 5.1 input bus). Cubase SX only.

**Output busses**

- You probably want one or several stereo output busses for monitoring and listening to stereo mixes.
- For digital transfers, you need a stereo bus assigned to the digital stereo output as well.
- You need a surround bus in the format of your speaker configuration (here, 5.1) assigned to the correct outputs (which in turn are connected to the correct speakers). Again, this is available in Cubase SX only.
- You may want additional surround busses if you tend to work in different surround formats.

- **Different busses can use the same inputs/outputs on the audio hardware!** You may for example want a stereo output bus assigned to the same outputs as the front stereo channels in your surround bus – this makes it easy to listen to stereo mixes without having to reconnect.
Preparations

Before you set up busses, you should name the inputs and outputs on your audio hardware. For example, if you are using a 5.1 surround speaker setup, you should name the outputs according to which speaker they are connected to (Left, Right, Center and so on).

The reason for this is compatibility – it makes it easier to transfer projects between different computers and setups. For example, if you move your project to another studio, the audio hardware may be of a different model. But if both you and the other studio owner have given your inputs and outputs names according to the surround setup (rather than names based on the audio hardware model), Cubase SX/SL will automatically find the correct inputs and outputs for your busses and you will be able to play and record without changing the settings.

You name your inputs and outputs in the Device Setup dialog:

1. Open the Device Setup dialog from the Devices menu.
2. Select the VST Output Ports device in the list to the left and make sure the Setup tab is selected.
The available output ports on your audio hardware are listed.
3. To rename a port, click its name in the list and type a new name.
   • If needed, you can also disable ports by clicking in the “Visible” column (so that it says “No”).
     Disabled ports won’t show up in the VST Connections window when you are making bus settings. If you attempt to disable a port that is already used by a bus, you will be asked whether that is really what you want – note that this will remove the port from the bus!
4. Select the VST Input Ports and name them in the same way.
5. Click OK to close the Device Setup dialog.

• If you open a project created on another computer and the port names don’t match (or the port configuration isn’t the same – e.g. the project is created on a system with multi-channel i/o and you open it on a stereo in/out system), a Pending Connections dialog will appear.
  This allows you to manually re-route ports used in the project to ports available in your system.
The VST Connections window

You add and set up buses in the VST Connections window, opened from the Devices menu.

There are two tabs in the window, for viewing input buses or output buses. Depending on which tab you have selected, the window lists the current input or output buses, with the following three columns:

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bus Name</td>
<td>Lists the busses. You can select busses and rename them by clicking on them in this column.</td>
</tr>
<tr>
<td>Speakers</td>
<td>Indicates the speaker configuration (mono, stereo, surround formats) of each bus.</td>
</tr>
<tr>
<td>ASIO Device Port</td>
<td>When you have &quot;opened&quot; a bus (by clicking its + button in the Bus Name column) this column shows which physical input/output on your audio hardware is used by the bus.</td>
</tr>
</tbody>
</table>

![VST Connections - Outputs](image)
Adding a bus

1. Click the Inputs or Outputs tab depending on which type of bus you want to add.

2. Click the Add Bus button.
   A dialog appears.

   ![Add Bus dialog](image)

3. Select the desired (channel) configuration.
   The pop-up menu contains Mono and Stereo options as well as the most common surround formats (Cubase SX only). To select another surround format, use the "More..." submenu.

   • Alternatively you can right-click (Win) or [Ctrl]-click (Mac) in the VST Connections window and add a bus in the desired format directly from the context menu that appears.
   
   The new bus appears with the ports visible.

4. Click in the ASIO Device Port to select an input/output port for a channel in the bus.
   The pop-up menu that appears lists the ports with the names you have given them in the Device Setup dialog. Repeat this for all channels in the bus.
Adding a child bus (Cubase SX only)

A surround bus is essentially a set of mono channels – 6 channels in the case of 5.1 format. If you have a mono track in the project, you can route it to a separate speaker channel in the bus (or route it to the whole surround bus and use the surround panner to position it in the surround image). But what if you have a stereo track that you simply want to route to a stereo channel pair within the bus (Left and Right or Left Surround and Right Surround for example)? For this you need to create a child bus:

1. Select the surround bus in the list and right-click (Win) or [Ctrl]-click (Mac) it.
   A pop-up menu appears.

<table>
<thead>
<tr>
<th>Bus Name</th>
<th>Speakers</th>
<th>ASIO</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stereo Out</td>
<td>Mono</td>
<td>5.1</td>
</tr>
<tr>
<td>Left</td>
<td>Mono</td>
<td></td>
</tr>
<tr>
<td>Right</td>
<td>Mono</td>
<td></td>
</tr>
<tr>
<td>Add Bus</td>
<td>Mono</td>
<td>5.1</td>
</tr>
<tr>
<td>Add Child Bus</td>
<td>Stereo (L+R)</td>
<td></td>
</tr>
<tr>
<td>Remove Bus</td>
<td>Mono</td>
<td></td>
</tr>
<tr>
<td>LFE</td>
<td>Mono</td>
<td></td>
</tr>
<tr>
<td>Left Surround</td>
<td>Mono</td>
<td></td>
</tr>
<tr>
<td>Right Surround</td>
<td>Mono</td>
<td></td>
</tr>
</tbody>
</table>

2. Select a channel configuration from the “Add Child Bus” submenu.
   As you can see, you can create stereo child busses (routed to various speaker channel pairs in the surround bus) or other surround bus formats (with fewer channels than the “parent bus”).

   The child bus you created will be available for direct routing in the mixer. It’s a part of the parent surround bus, which means there will be no separate channel strip for it.

   Although child busses are probably most useful in output busses, you could also create child busses within a surround input bus – for example if you want to record a stereo channel pair (e.g. front left-right) in the surround bus to a separate stereo track.
Other bus operations

- To change the port assignment for a bus you proceed as when you added it – make sure the channels are visible (by clicking the + button next to the bus, or by clicking the "+ All" button at the top of the window) and click in the ASIO Device Port column to select ports.

- To remove a bus you don’t need, select it in the list, right-click (Win) or [Ctrl]-click (Mac) and select "Remove Bus" from the pop-up menu.

- You can store and recall bus presets with the pop-up menu at the top of the window.
  To store the current configuration as a preset, click the store (+) button and enter a name for the preset. You can then select the stored configuration directly from the Presets pop-up menu at any time. To remove a stored preset, select it and click the (-) button.
Using the busses

This section describes briefly how to use the input and output busses you have created. This is described in more detail in the chapters “Recording” and “The mixer”.

Routing

When you play back an audio track (or any other audio channel in the mixer – VST Instrument channels, ReWire channels, etc.), you route it to an output bus. In the same way, when you record on an audio track you select from which input bus the audio should be sent.

- You can select input and output busses in the Inspector, using the “In” and “Out” pop-up menus.

For channel types other than audio tracks (VST Instrument channels, FX channels, etc.), only the “Out” pop-up menu is available. To access the “Out” pop-up menu for such a channel in the Inspector, select one of its automation subtracks in the Track list.

- You can also select busses in the Input and Output Settings panel at the top of each channel strip in the mixer.

Again, for VST Instrument channels, ReWire channels, Group channels and FX channels you will only be able to select output busses.
• If the Input and Output Settings panel isn't shown, click the Show Input and Output Settings field in the common panel to the left in the mixer.

When selecting an input bus for a track you can only select busses that correspond to the track's channel configuration. Here are the details:

• Mono tracks can be routed to mono busses or individual channels within a stereo or surround bus (input or output). You can also route a mono track to the “whole” stereo or surround output bus, in which case a pan control (stereo pan or surround panner) will be used to position the sound.
• Stereo tracks can be routed to stereo busses or stereo child busses within a surround bus (input or output).
• Surround tracks can be routed to busses with the same number of speaker channels as the track (or to corresponding child busses within a “larger” surround bus).

Viewing the busses in the mixer

In the Cubase SX mixer, busses are represented by input and output channels (shown in separate panes to the left and right in the window). You can show or hide these independently by clicking the buttons Hide Input Channels and Hide Output Channels in the mixer’s common panel to the left:

• In Cubase SL, only the output busses are visible in the mixer!
The input busses you have created in the VST Connections window are available for selection on the input routing pop-up menus, but you cannot make any specific mixer settings for the input busses.
Input channels (shown in Cubase SX only)

The input channels are shown to the left in the mixer. As you can see, each input channel resembles a regular mixer channel strip. Here you can do the following:

- Check and adjust the recording level using the Input Gain knobs and/or the level fader.
  See page 47.

- Change the phase of the input signal.
  This is done by clicking the Input Phase button next to the Input Gain control.

- Add effects or EQ to the input bus.
  See page 61 for an example of how to add effects to your recording at the input bus stage.

❗ The settings you make in the input channel strip will be a permanent part of the recorded audio file!
Output channels

The output channels are shown to the right in the mixer. Here you can do the following:

- Adjust the total output level for the busses with the faders.
  For stereo output busses you can also adjust the stereo balance with the pan control.

- Add effects or EQ.
  These will affect the whole bus. Examples of effects you may want to add here include compressors, limiters and dithering. See page 241.
3

Playback and the Transport panel
Background

This chapter describes the various methods available for controlling Playback and Transport functions in Cubase SX/SL.

The Transport panel

Below you can find a brief description of each Transport panel item.

- You can customize the look of the Transport panel, hiding unneeded controls and moving controls as desired – see page 790.

The pictures below show the Transport panel with all controls visible and in their default position (note that the Jog/Shuttle control is available in Cubase SX only). The Transport panel is divided into sections, from left to right.
The main Transport functions (Cycle/Stop/Play/Record) can also be shown on the toolbar. In addition, various play options are available on the Transport menu.

**Hiding and showing**

The Transport panel is shown by default when you launch a new project. To hide or show it, select the “Transport Panel” item from the Transport menu (or use a key command – by default [F2]).

**About Preroll and Postroll**

These items are described in the chapter “Recording” – see page 79.
Customizing the Transport panel

You can customize the appearance of the Transport panel by right-clicking (Win) or [Ctrl]-clicking (Mac) anywhere on the panel and making selections on the pop-up menu that appears.

- On the upper half of the pop-up menu you can hide or show elements on the panel by activating or deactivating the corresponding menu items.
- Selecting the Show All item displays all sections of the Transport panel.
- Selecting Default shows all sections in their default positions on the panel.
- The items in the lower half of the pop-up menu are preset configurations for the Transport panel. You will also find your own stored presets here, for quick selection.
- Selecting Setup brings up a dialog where you can set show/hide status for the separate sections, configure where the sections should be placed on the panel and store different Transport panel layouts as presets for instant recall.

For more about customizing the Transport panel, see page 790.
The numeric keypad

In the default Key Command settings, the numeric keypad on the computer keyboard is assigned various Transport panel operations. The keypads are slightly different on PC and Macintosh computers:

**PC:**

- **Cycle On/Off:** Num Lock
- **Go to Marker number 3-9:** 7, 8, 9
- **Go to right locator:** 4, 5, 6, +
- **Go to left locator:** 1, 2, 3
- **Stop:** 0, , Enter
- **Record:** X
- **Rewind:** -
- **Fast Forward:** +
- **Play:** =
- **Return to Zero:** -

**Mac:**

- **Cycle On/Off:** num lock
- **Go to Marker number 3-9:** 1, 8, 9
- **Go to right locator:** 4, 5, 6, +
- **Go to left locator:** 1, 2, 3, enter
- **Stop:** 0, , enter
- **Record:** *
- **Rewind:** -
- **Fast Forward:** +
- **Play:** 
- **Return to Zero:** -
Operations

Setting the project cursor position

There are several ways to move the project cursor position:

- By using Fast Forward and Rewind.
- By using the Jog/Shuttle/Nudge control on the Transport panel (Cubase SX only – see page 33).
- By dragging the project cursor in the lower part of the ruler.
- By clicking in the ruler.
  Double clicking in the ruler moves the cursor and starts/stops playback.
- If the option “Locate when Clicked in Empty Space” is activated in the Preferences dialog (Transport page) you can click anywhere in an empty section of the Project window to move the cursor position.
- By changing the value in any of the position displays.
- By using the position slider above the transport buttons.
  The range of the slider relates to the Length setting in the Project Setup dialog. Hence, moving the slider all the way to the right will take you to the end of the project.
- By using markers (see page 154).
- By using playback options (see page 35).
- By using functions on the Transport menu.

The following functions are available:

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Locate Selection</td>
<td>Moves the project cursor to the beginning of the current selection. For this to be available, you must have selected one or more events or parts, or made a selection range.</td>
</tr>
<tr>
<td>Locate Next/Previous Marker</td>
<td>This moves the project cursor to the closest marker to the right or left (see page 154).</td>
</tr>
<tr>
<td>Locate Next/Previous Event</td>
<td>This moves the project cursor forwards or backwards respectively, to the closest beginning or end of any event on the selected track(s).</td>
</tr>
</tbody>
</table>

- If Snap is activated when dragging the project cursor, the Snap value is taken into account. This can be helpful for finding exact positions quickly.

- There are also numerous key commands available for moving the project cursor (in the Transport category in the Key Commands dialog). For example, you can assign key commands to the “Step Bar” and “Step Back Bar” functions, allowing you to move the project cursor in steps of one bar, backwards and forwards.
About the Transport panel display formats

Primary time display (left) and secondary time display (right).

The time unit shown in the ruler can be independent from the time unit shown in the main time display on the Transport panel. This means that you can display timecode in the transport position display and bars and beats in the ruler, for example. In addition, there is a secondary time display to the right of the primary time display which is also independent, giving you three different time units shown at the same time (in the Project window, you can also create additional ruler tracks – see page 97).

The following rules apply:

• If you change the time format from the primary time display on the Transport panel, this will apply to the ruler as well. This is the same as changing the display format in the Project Setup. Therefore, to have different display formats in the ruler and the main time display you should change the format in the ruler.

• The primary time display format is set on the pop-up menu to the right in the main position display.

• The setting here also determines the time format displayed for the left and right locators.

• The secondary time display is completely independent, and the display format is set on the pop-up menu to the right in the secondary position display.

• You can swap time formats between the primary and secondary time displays by clicking the double arrow symbol between them.
The left and right locators

The left and right locators are a pair of position markers used for specifying punch-in and punch-out positions during recording, and as boundaries for cycle playback and recording.

• When cycle mode is activated on the Transport panel, the area between the left and right locator will be repeated (cycled) on playback. However, if the right locator is positioned before the left, this will work as a “jump” or “skip mode” – when the project cursor reaches the right locator it will immediately jump to the left locator position and continue playback from there.

There are several ways to set locator positions:

• To set the left locator, press [Ctrl]/[Command] and click at the desired position in the ruler. Similarly, pressing [Alt]/[Option] and clicking in the ruler sets the right locator. You can also drag the locator “handles” directly in the ruler.

![Locator handles](image)

The locators are indicated by the “flags” in the ruler. The area between the locators is highlighted in the ruler and in the Project window (see page 801). Note that if the right locator is before the left locator the area will be red in the ruler to indicate this.

• Click and drag in the upper half of the ruler to “draw” a locator range. If you click on an existing locator range, you can drag to move it.

• Pressing [Ctrl]/[Command] and pressing [1] or [2] on the numeric keypad sets the left or right locator to the project cursor position. Similarly, you can press [1] or [2] on the numeric keypad (without [Ctrl]/[Command]) to set the project cursor position to the left or right locator position. Note that these are default key commands – you can change these if you like.

• By creating cycle markers you can store any number of left and right locator positions, which can be recalled by simply double clicking on the corresponding marker (see page 158).

• The “Locators to Selection” item on the Transport menu (default key command [P]) sets the locators to encompass the current selection. This is available if you have selected one or several events or made a selection range.

• You can also adjust the locators numerically in the Transport panel. Clicking the L/R buttons in the locator section on the Transport panel will move the project cursor to the respective locator. If you press [Alt]/[Option] and click the L or R button, the corresponding locator will be set to the current project cursor position.
The Shuttle Speed control (Cubase SX only)

The shuttle speed control (the outer wheel on the Transport panel) allows you to play the project at any playback speed, forwards or backwards. This provides a quick way to locate or “cue” to any position in the project.

- Turn the shuttle speed wheel to the right to start playback. The further to the right you move the wheel, the faster the playback speed. You don’t have to keep the mouse button pressed – playback will continue until you stop it.
- If you turn the wheel to the left instead, the project will play backwards. Similarly, the playback speed depends on how far to the left you turn the wheel.
- To stop playback, click Stop as usual or turn the shuttle speed wheel to the middle position.

Project scrubbing – the Jog Wheel (Cubase SX only)

The middle wheel on the Transport panel serves as a jog wheel. By clicking and dragging it to the right or left you will move the playback position manually forwards or backwards – much like scrubbing on a tape deck. This helps you pinpoint exact locations in the project.

- Note that the jog wheel is an “endless dial” – you can turn it as many times as needed to move to the desired location. The faster you turn the wheel, the faster the playback speed.
- If you click the jog wheel during playback, playback will automatically stop.
The nudge position buttons (Cubase SX only)

The + and – buttons in the middle of the Shuttle/Jog Wheel allows you to nudge the project cursor position to the right or left, respectively. Each time you click a nudge button, the project cursor is moved by one frame.

Options and Settings

The “Return to Start Position on Stop” preference

This setting is found on the Transport page in the Preferences dialog (found on the File menu under Windows, on the Cubase SX/SL menu under Mac OS X).

- If “Return to Start Position on Stop” is activated when you stop playback, the project cursor will automatically return to the position where recording or playback last started.
- If “Return to Start Position on Stop” is deactivated, the project cursor will remain at the position where you stop playback. Pressing Stop again will return the project cursor to the position where recording or playback last started.

About track disable/enable

For audio tracks, the track context menu contains an item named “Disable Track”. This shuts down all disk activity for the track, as opposed to using Mute, which merely turns down the output volume for a track. For example, if you often record “alternative takes” you can easily build up a large number of takes on different tracks. Even though these tracks are muted, they are actually still “playing back” from the hard disk during playback. This puts an unnecessary load on your disk system, so using “Disable Track” is recommended for such situations.

- Select “Disable Track” for tracks that you want to keep in the project for later use (but don’t want to play back now). Select “Enable Track” from the track context menu to re-enable disabled tracks.
Playback functions

Apart from the standard transport controls on the Transport panel, you can also find a number of functions that can be used to control playback on the Transport menu. The items have the following functionality:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Play from Selection Start</td>
<td>This activates playback from the beginning of the currently selected range.</td>
</tr>
<tr>
<td>Play from Selection End</td>
<td>This activates playback from the end of the currently selected range.</td>
</tr>
<tr>
<td>Play until Selection Start</td>
<td>This activates playback two seconds before the start of the currently selected range and stops at the selection start.</td>
</tr>
<tr>
<td>Play until Selection End</td>
<td>This activates playback two seconds before the end of the selected range and stops at the selection end.</td>
</tr>
<tr>
<td>Play until Next Marker</td>
<td>This activates playback from the project cursor and stops at the next marker.</td>
</tr>
<tr>
<td>Play Selection Range</td>
<td>This activates playback from the start of the selected range and stops at the selection end.</td>
</tr>
<tr>
<td>Loop Selection</td>
<td>This activates playback from the start of the selected range and continuously starts over again upon reaching the selection end.</td>
</tr>
</tbody>
</table>

- The functions listed above (except “Play until Next Marker”) are only available if you have selected one or more events or made a selection range.
About Chase

Chase is basically a function that makes sure your MIDI instruments sound as they should when you locate to a new position and start playback. This is accomplished by having the program transmitting a number of MIDI messages to your instruments each time you move to a new position in the project, making sure all MIDI devices are set up correctly with regard to program change, controller messages (such as MIDI Volume) etc.

For example, let’s say you have a MIDI track with a program change event inserted at the beginning. This event makes a synth switch to a piano sound.

In the beginning of the first chorus you have another program change event which makes the same synth switch to a string sound.

You now play back the song. It begins with the piano sound and then switches to the string sound. In the middle of the chorus you stop and rewind to some point between the beginning and the second program change. The synth will now still play the string sound although in this section it really should be a piano!

The Chase function takes care of that. If program change events are set to be chased, Cubase SX/SL will track the music back to the beginning, find the first program change and send this out, so that the synth is set to the right sound.

The same thing can apply to other event types as well. The Chase Events settings in the Preferences dialog—MIDI page determine which event types will be chased when you locate to a new position and start playback.

- Event types for which the checkbox is activated here will be chased.
4

Recording
Background

This chapter describes the various recording methods that you can use in Cubase SX/SL. As it is possible to record both audio and MIDI tracks in Cubase SX/SL, both these recording methods are covered in this chapter.

Before you start

This chapter assumes that you are reasonably familiar with certain basic recording concepts, and that the following initial preparations have been made:

- You have properly set up, connected and calibrated your audio hardware.
  This is described in the Getting Started book.
- You have opened a project and set the project setup parameters to your specifications.
  Project setup parameters determine the record format, sample rate, project length etc. that affect the audio recordings you make during the course of the project. See page 99.
- If you plan to record MIDI, your MIDI equipment should be set up and connected correctly.
  See the Getting Started book.
Basic recording methods

This section describes the general methods used for recording. However, there are additional preparations and procedures that are specific to audio and MIDI recording respectively. Make sure to read these sections before you start recording (see page 43 and page 65).

Record enabling a track

Cubase SX/SL can record on a single track or on several tracks (audio and/or MIDI) simultaneously. To make a track ready for recording, click the Record Enable button for the track in the Track list, in the Inspector or in the mixer. When activated, the button(s) turn red, indicating record ready mode.

- If the option "Enable Record on Selected Track" is activated in the Preferences dialog (Editing page), tracks are automatically record enabled when you select them in the Track list.
- The exact number of audio tracks you can record simultaneously depends on your computer CPU and hard disk performance.
Manually activating recording

You activate recording by clicking the Record button on the Transport panel or toolbar, or by using the corresponding key command (by default [*] on the numeric keypad).

Recording can be activated from Stop mode (from the current cursor position or from the left locator) or during playback:

- If you activate recording from Stop mode, and the option “Start Record at Left Locator” is activated on the Transport menu, recording will start from the left locator.
  The preroll setting or the metronome count-in will be applied (see page 79).
- If you activate recording from Stop mode, and “Start Record at Left Locator” is deactivated, recording will start from the current project cursor position.
- If you activate recording during playback, Cubase SX/SL will immediately enter Record mode and start recording at the current project cursor position.
  This is known as “manual punch in”.

Activating recording in Sync mode

If you are synchronizing the Cubase SX/SL transport to external equipment (Sync is activated on the Transport panel) and you activate recording, the program will go into “record ready” mode (the record button on the Transport panel will light up). Recording then starts when a valid timecode signal is received (or when you manually click the Play button). See page 706 for more information about synchronization.
Automatically activating recording

Cubase SX/SL can automatically switch from playback to recording at a given position. This is known as "automatic punch in". A typical use for this would be if you need to replace a section of a recording, and want to listen to what is already recorded, up to the recording start position.

1. Set the left locator to the position where you want recording to start.
2. Activate the Punch In button on the Transport panel.

   ![](image)
   Punch In activated.

3. Activate playback from some position before the left locator.
   When the project cursor reaches the left locator, recording is automatically activated.

Stopping recording

Again, this can be done automatically or manually:

- If you click the Stop button on the Transport panel (or use the corresponding key command, by default [0] on the numeric keypad), recording is deactivated and Cubase SX/SL goes to Stop mode.

- If you click the Record button or use the key command for recording, by default [*], recording is deactivated but playback continues. This is known as "manual punch out".

- If the Punch Out button is activated on the Transport panel, recording will be deactivated when the project cursor reaches the right locator. This is known as "automatic punch out". By combining this with automatic punch in, you can set up a specific section to record – again very useful if you want to replace a certain part of a recording. See also page 78.
Cycle recording

Cubase SX/SL can record and play back in a cycle – a loop. You specify where the cycle starts and ends by setting the left and right locators. When the cycle is active, the selected section is seamlessly repeated until you hit Stop or deactivate cycle mode.

- To activate cycle mode, click the cycle button on the Transport panel. If you now start playback, the section between the left and right locator is repeated indefinitely until you stop.

- To record in cycle mode, you can start recording from the left locator, from before the locators or from within the cycle, from Stop mode or during playback. As soon as the project cursor reaches the right locator, it will jump back to the left locator and continue recording a new lap.

- The results of cycle recording depend on the selected cycle record mode and are different for audio (see page 55) and MIDI (see page 71).
Audio recording specifics

Selecting a recording file format

The format of recorded files is set in the Project Setup dialog on the Project menu. There are three settings: sample rate, record format (bit depth) and record file type. While the sample rate is set once and for all when you start working on a new project, the bit depth and file type can be changed at any time.

Record file type

The Record File Type setting determines which type of files will be created when you record:

<table>
<thead>
<tr>
<th>File type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Wave File</td>
<td>Wave files have the extension &quot;wav&quot; and are the most common file format on the PC platform.</td>
</tr>
<tr>
<td>Wave 64 File</td>
<td>Wave64 is a proprietary format developed by Sonic Foundry Inc. Audio-wise it is identical to the Wave format, but the internal file structure makes much larger file sizes possible. This is useful e.g. for long live recordings in surround format, where the audio files could become huge.</td>
</tr>
<tr>
<td>Broadcast Wave File</td>
<td>In terms of audio content, the same as regular Wave files, but with embedded text strings for supplying additional information about the file (see below).</td>
</tr>
<tr>
<td>AIFF File</td>
<td>Audio Interchange File Format, a standard defined by Apple Computer Inc. AIFF files have the extension &quot;aiff&quot; and are used on most computer platforms. Like Broadcast Wave files, AIFF files can contain embedded text strings (see below).</td>
</tr>
</tbody>
</table>

- If you select Broadcast Wave File or AIFF format, you can specify Author, Description and Reference text strings that will be embedded in the recorded file. This is done on the Record–Broadcast Wave page in the Preferences dialog.
Record format (bit depth)

The available options are 16 bit, 24 bit and 32 bit float. Use the following guidelines:

- Normally, select the record format according to the bit depth delivered by your audio hardware.
  For example, if your audio hardware has 20 bit A/D converters (inputs), you may want to record at 24 bit resolution, to capture the full bit depth. On the other hand, if your hardware has 16 bit inputs, it’s pointless to record with a higher bit depth – this will only make the audio files larger, with no difference in audio quality. The exception is if you record with effects – see page 61 for an example of this.

- The higher the bit depth, the larger the files and the more strain is put on the disk system.
  If this is an issue, you may want to lower the record format setting.

Setting up the track

Creating a track and selecting the channel configuration

Audio tracks can be configured as mono, stereo or surround tracks (Cubase SX only). This allows you to record or import a file containing multiple channels and treat it as one entity, with no need to split it up into several mono files etc. The signal path for an audio track maintains its channel configuration all the way from the input bus, via EQ, level and other mixer settings to the output bus.

You specify the channel configuration for a track when you create it:

1. Select Add Audio Track from the Track list context menu or the Project menu (or double click in an empty area of the Track list when an audio track is selected – when a MIDI track is selected, double clicking in the Track list creates a new MIDI track).
   A dialog appears with a channel configuration pop-up menu.

2. Select the desired format from the pop-up menu.
   In Cubase SL you choose between mono and stereo; in Cubase SX the most common formats are listed directly on the pop-up menu with the remaining surround formats listed on the “More…” submenu. For a list of the available surround formats, see page 283.

3. Click OK.
   A track appears, set to the specified channel configuration. In the mixer, a corresponding channel strip appears. Note that you cannot change the channel configuration for a track.
Selecting an input bus for a track

Here we assume that you have added and set up the required input busses (see page 14). Before you record you need to specify from which input bus the track should record. You can do this in the Inspector or in the mixer:

- In the Inspector you select an input bus on the "in" pop-up menu in the top section.
  As described on page 88, the Inspector shows the settings for the selected track. You show or hide the Inspector using the Inspector icon on the Project window toolbar.

Click here to show/hide the Inspector.

- In the mixer you select an input bus on the Input Routing pop-up menu at the top of the track’s channel strip.
  If this pop-up menu isn’t shown, you need to click the Show Input and Output Settings field in the common panel to the left. See page 183 for more about the mixer.

Click here to select an input bus for the track.
Selecting a folder for the recorded audio files (Cubase SX only)

As described in the Getting Started book, each Cubase SX/SL project has a project folder containing (among other things) an “Audio” folder. By default, this is where recorded audio files are stored. However, in Cubase SX you can select record folders independently for each audio track if needed:

1. To select the same record folder for several audio tracks, you need to select them by [Shift]- or [Ctrl]/[Command]-clicking in the Track list.

2. Right-click (Win) or [Ctrl]-click (Mac) in the Track list for one of the tracks to bring up the track context menu.

3. Select “Set Record Folder”.

4. Use the file dialog that appears to navigate to the desired folder (or create a new folder with the Create button).
   Tip: if you want to have separate folders for different types of material (speech, ambient sounds, music, etc.) you can create subfolders within the Project’s “Audio” folder and assign different tracks to different subfolders. This way, all audio files will still reside within the project folder which will make managing the Project easier.

• It’s fully possible to have different tracks record to totally different locations, on different disks if you like. However, if you need to move or archive the Project, there is a risk of missing some files. The solution is to use the Prepare Archive function in the Pool to gather all external files into the project folder first — see page 440.
Setting input levels

When recording digital sound, it's important to set the input levels correctly – loud enough to ensure low noise and high audio quality, but not so loud that clipping (digital distortion) occurs.

Clipping typically occurs in the audio hardware, when a too loud analog signal is converted to digital in the hardware's A/D converters.

- If you are using Cubase SX it is also possible to get clipping when the signal from the input bus is written to a file on your hard disk. This is because in Cubase SX you can make settings for the input bus, adding EQ, effects, etc. to the signal as it's being recorded. This may raise the level of the signal, causing clipping in the recorded audio file.

The procedure for checking the signal level coming into the audio hardware is slightly different depending on whether you are using Cubase SX or Cubase SL:

**Cubase SX**

In Cubase SX you check the input level at the input channel.

To check the level of the "unprocessed" signal coming into the audio hardware you need to switch the level meters to "Input VU". In this mode the input channel level meters will show the level of the signal at the input of the bus, before any adjustments such as input gain, EQ, effects, level or pan:

1. Right-click (Win) or [Ctrl]-click (Mac) in the Mixer window. The Mixer context menu appears.
2. Select the VU-Meter Settings submenu and make sure "Input VU" is activated.
3. Play back the audio and check the level meter for the input channel. The signal should be as loud as possible without exceeding 0 dB (the Clipping indicator for the input bus should not light up).

The Clipping indicator.
4. If necessary, adjust the input level in one of the following ways:

- Adjust the output level of the sound source or external mixer.
- Use the audio hardware’s own application program to set the input levels, if this possibility is provided. See the documentation for the audio hardware.
- If your audio hardware supports the ASIO Control Panel function, it may be possible to make input level settings. To open the ASIO control panel, open the Device Setup dialog on the Devices menu and click the Control Panel button on the Setup tab for the VST Multitrack device.

The next step is to check the level of the audio being written to a file on your hard disk. This is only necessary if you have made any adjustments to the input channel (level settings, EQ, insert effects, etc.). Note also:

- If you record in 32 bit float format the bit depth will not be reduced – which means there’s no risk of clipping at this stage. Also, this preserves the signal quality perfectly. Therefore, you should consider using 32 bit float format when you are recording with effects (see page 61).
- If you record in 16 or 24 bit format the available headroom is lower which means clipping can occur if the signal is too loud. To avoid this, set the signal level in the following way:

1. Bring up the mixer context menu and select “Post-Fader VU” from the VU-Meter Settings submenu.
2. Set up the input channel, adding EQ and/or effects as desired. With some effects you may want to adjust the level of the signal going into the effect – use the Input Gain knob for this. Note that you need to press [Shift] or [Alt]/[Option] to adjust the Input Gain.
3. Play back the audio and check the level meter of the input channel. The signal should be reasonably loud but should not reach 0 dB (the Clipping indicator for the input bus should not light up).
4. If necessary, use the input channel fader to adjust the signal level.
Cubase SL

In Cubase SL, the input channels are not shown in the mixer. Instead, you need to check the level at the channel strip for the track on which you are recording:

1. Right-click (Windows) or [Ctrl]-click (Mac) somewhere in the Mixer window to bring up the Mixer context menu.
2. Select the VU-Meter Settings submenu and make sure “Input VU” is activated.
   In this mode, the level meters show the levels “pre-fader” – that is, unaffected by level fader changes, EQ, insert effects, etc.
3. Locate the channel strip for the track you’re about to record on.
4. Activate monitoring for the channel by clicking the speaker button next to the fader.
   When monitoring is activated, the meter shows the level of the incoming audio signal.
5. Play the audio source that you want to record and check the level meter for the channel.
6. Adjust the output level of your audio source so that the meters go reasonably high without reaching 0.0 dB.
   Check the numerical peak level indicator below the meter in the bus channel strip. To reset the peak level indicator, click on it.

- You must adjust the output level of the audio source – you cannot use the faders in Cubase SL to adjust the input level!
- An alternative way of checking the input levels would be to use the control panel for your audio hardware (if it’s equipped with input level meters). It may also be possible to adjust the input level in the control panel.

See the documentation of the audio hardware for details.
Monitoring

In this context, "monitoring" means listening to the input signal during recording. There are three fundamentally different ways to do this: via Cubase SX/SL, externally (by listening to the signal before it reaches Cubase SX/SL) or by using ASIO Direct Monitoring (which is a combination of both of the other methods – see page 52).

Monitoring via Cubase SX/SL

If you monitor via Cubase SX/SL, the input signal is mixed in with the audio playback. The advantage of this is that you can adjust the monitoring level and panning in the mixer, and add effects and EQ to the monitor signal just as during playback (using the track’s channel strip – not the input bus!).

The disadvantage of monitoring via Cubase SX/SL is that the monitored signal will be delayed according to the latency value (which depends on your audio hardware and drivers). Therefore, monitoring via Cubase SX/SL requires an audio hardware configuration with a low latency value (see the Getting Started book). You can check the latency of your hardware in the Device Setup dialog (VST Multitrack page).

• If you are using plug-in effects with large inherent delays, the automatic delay compensation function in Cubase SX/SL will increase the latency. If this is a problem you can use the Constrain Delay Compensation function while recording - see page 270.

When monitoring via Cubase SX/SL, you can select one of four modes in the Preferences dialog (VST page):

<table>
<thead>
<tr>
<th>VST</th>
<th>Scrub Response (Speed)</th>
<th>Scrub Volume</th>
<th>Auto Monitoring</th>
</tr>
</thead>
<tbody>
<tr>
<td>Taped Machine Style</td>
<td>Taped Machine Style</td>
<td>Taped Machine Style</td>
<td>Taped Machine Style</td>
</tr>
<tr>
<td>Stems</td>
<td>Stems</td>
<td>Stems</td>
<td>Stems</td>
</tr>
<tr>
<td>Related Effects</td>
<td>Related Effects</td>
<td>Related Effects</td>
<td>Related Effects</td>
</tr>
</tbody>
</table>
• Manual.
  This option allows you to turn input monitoring on or off by clicking the Monitor button in the Inspector, the Track list or in the mixer.

• While Record Enabled.
  With this option you will hear the audio source connected to the channel input whenever the track is record enabled.

• While Record Running.
  This option switches to input monitoring only during recording.

• Tapemachine Style.
  This option emulates standard tapemachine behavior: input monitoring in Stop mode and during recording, but not during playback.

External monitoring

External monitoring (listening to the input signal before it goes into Cubase SX/SL) requires some sort of external mixer for mixing the audio playback with the input signal. This can be a stand-alone physical mixer or a mixer application for your audio hardware, if this has a mode in which the input audio is sent back out again (usually called "Thru", "Direct Thru" or similar).

When using external monitoring, you cannot control the level of the monitor signal from within Cubase SX/SL, or add VST effects or EQ to the monitor signal. The latency value of the audio hardware configuration does not affect the monitor signal in this mode.

• If you want to use external monitoring, you need to make sure that monitoring via Cubase SX/SL isn’t activated as well.
  Select the "Manual" monitoring mode in the Preferences dialog (VST page) and simply don’t activate the Monitor buttons.
ASIO Direct Monitoring

If your audio hardware is ASIO 2.0 compatible, it may support ASIO Direct Monitoring. In this mode, the actual monitoring is done in the audio hardware, by sending the input signal back out again. However, monitoring is controlled from Cubase SX/SL. This means that the audio hardware’s direct monitoring feature can be turned on or off automatically by Cubase SX/SL, just as when using internal monitoring.

- To activate ASIO Direct Monitoring, open the Device Setup dialog on the Devices menu and use the Direct Monitoring checkbox on the Setup tab for the VST Multitrack device. If the checkbox is greyed out, your audio hardware (or its driver) doesn’t support ASIO Direct Monitoring. Consult the audio hardware manufacturer for details.

- When ASIO Direct Monitoring is activated, you can select a monitoring mode in the Preferences dialog (VST page), as when monitoring via Cubase SX/SL (see page 50).

- Depending on the audio hardware, it may also be possible to adjust monitoring level and panning from the mixer. Consult the documentation of the audio hardware if in doubt.

- VST effects and EQ cannot be applied to the monitor signal in this mode, since the monitor signal doesn’t pass through Cubase SX/SL.

- Depending on the audio hardware, there may be special restrictions as to which audio outputs can be used for direct monitoring. For details on the routing of the audio hardware, see its documentation.

- The latency value of the audio hardware configuration does not affect the monitor signal when using ASIO Direct Monitoring.
Recording

Recording is done using any of the general recording methods (see page 39). After you finish recording, an audio file has been created in the Audio folder within the project folder. In the Pool, an audio clip is created for the audio file, and an audio event that plays the whole clip appears on the recording track. Finally, a waveform image is calculated for the audio event. If the recording was very long, this may take a while.

- If the option “Create Audio Images During Record” is activated in the Preferences dialog (Record page), the waveform image will be calculated and displayed during the actual recording process.
  This real-time calculation uses some processing power – if your processor is slow or you are working on a CPU-intensive project you should consider turning this option off.

Undoing recording

If you decide that you don’t like what you just recorded, you can delete it by selecting Undo from the Edit menu. The following will happen:

- The event(s) you just created will be removed from the Project window.
- The audio clip(s) in the Pool will be moved to the Trash folder.
- The recorded audio file(s) will not be removed from the hard disk. However, since their corresponding clips are moved to the Trash folder, you can delete the files by opening the Pool and selecting “Empty Trash” from the Pool menu.
Recording overlapping events

The basic rule for audio tracks is that each track can play back a single audio event at a time. This means that if two or more events are overlapping, only one of them will be heard at any given time.

What happens when you record overlapping events (record in an area where there’s already events on the track) depends on the Linear Record Mode setting on the Transport panel:

- In “Normal” or “Merge” mode, recording where something has already been recorded creates a new audio event that overlaps the previous one(s).
  When you record audio there is no difference between “Normal” and “Merge” mode – the difference only applies to MIDI recording (see page 70).

- In “Replace” mode, existing events (or portions of events) that are overlapped by the new recording will be removed.
  This means that if you record a section in the middle of a longer existing recording, that original event will be cut into two events with a gap for the new event.

Which event will be heard?

If two or more events are overlapping, you will only hear the events (or portions of events) that are actually visible. Overlapped (hidden) events or sections are not played back.

- The functions “Move to Front” and “Move to Back” on the Edit menu (see page 121) are useful for managing overlapping events, as is the “To Front” function (see below).
Recording audio in cycle mode

If you are recording audio in cycle mode, the result depends on two factors:

• The Cycle Record Mode setting on the Transport panel.
• The “Audio Cycle Record Mode” setting in the Preferences dialog (Record page).

Cycle Record Modes on the Transport panel

There are four different modes on the Transport panel, but the differences between two of the modes only apply to MIDI recording. For audio cycle recording, the following applies:

• If “Keep Last” is selected, the last complete “take” (the last completely recorded lap) is kept as an audio event.
  In reality, all laps you recorded are saved in one audio file divided into regions – one region for each take. You can easily select a previous take for playback – this is done as when recording in “Create Regions” mode (see page 57).

• If “Stacked” is selected, each take will appear as an event on a separate “lane” on the track.
  This is useful when you want to view and edit the different takes and eventually combine them to one recording. In this mode, the Audio Cycle Record Mode preference doesn’t matter. See page 59.

• If any of the other cycle recording modes is selected, the result depends entirely on the Audio Cycle Record Mode setting in the Preferences.
  These options are described below.
Create Events mode (Preferences)

When Audio Cycle Record Mode (Preferences–Record page) is set to “Create Events”, the following will happen when you record audio in cycle mode:

- One continuous audio file is created during the entire recording process.
- For each recorded lap of the cycle, one audio event is created. The events will have the name of the audio file plus the text “Take **”, where “**” indicates the number of the take.
- The last take (the last recorded lap) will be on top (and will thus be the one you hear when you activate playback).

To select another take for playback, proceed as follows:

1. Right-click (Win) or [Ctrl]-click (Mac) the event and select “To Front” from the pop-up menu that appears. A submenu appears, listing all the other (obscured) events.

2. Select the desired take. The corresponding event is brought to front.
This method allows you to quickly combine the best parts of each take, in the following way:

1. Use the Scissors tool to split the events in several sections, one for each part of the take.
   For example, if you recorded four lines of vocals (in each take), you can split the events so that each line gets a separate event.

   ![Image of events after splitting]

   The events after splitting. Note that since the original take events overlap each other, clicking with the Scissors tool will split all takes at the same position.

2. For each section of the take, use the “To Front” function to bring the best take to the front.
   This way, you can quickly combine the best sections of each take, using the first vocal line from one take, the second line from another take and so on.

   You can also compile a “perfect” take in the Audio Part Editor, as described on page 394.

Create Regions mode (Preferences)

When Audio Cycle Record Mode (Preferences→Record page) is set to “Create Regions”, the following will happen when you record audio in cycle mode:

- One continuous audio file is created during the entire recording process.
- The audio event in the Project window shows the name of the audio file plus the text “Take *” (with “*” being the number of the last completed cycle lap).
- If you play back the recorded event, you will only hear what was recorded during the last lap of the cycle recording.
  The previous “takes” recorded in the cycle are still available, however.
- The audio clip is divided into regions (called takes), one for each lap of the cycle that was recorded.
  If you locate the audio file you just recorded in the Pool, and click on the plus sign beside it, you can see the regions that have been created, one for each lap of the cycle that was completed during recording.
“Take” regions in the Pool window.

To play back the different “takes”, proceed as follows:

1. In the Project window, right-click (Win) or [Ctrl]-click (Mac) the event that was created during cycle recording.
   The Quick menu appears.

2. Select the “Set To Region” menu item.
   A submenu appears with the takes you recorded during cycle record.

3. Now you can freely select any of the takes from the submenu and it will replace the previous take event in the Project window.

Use this method to listen through the various takes. Select the best single take, or compile a “perfect” take by cutting out the best bits from each take and putting them together (see page 394).

Create Events + Regions mode (Preferences)

In this mode, both events and regions are created. If you work with the takes as events in this mode, you can edit the events freely (e.g. splitting them as described on page 56). However, in case you want to go back to the original takes, they are still available as regions (on the “Set To Region” submenu, in the Pool or in the Sample Editor).
Recording audio in Stacked mode

When you record audio in cycle mode and the “Stacked” Cycle Record Mode is selected on the Transport panel, the following happens:

- Each complete recorded cycle lap is turned into a separate audio event.
- The track is divided into “lanes”, one for each cycle lap.
- The events are stacked above each other, each on a different lane.

This makes it easy to create a “perfect take” by combining the best parts from the different cycle laps:

1. **Zoom in so you can work comfortably with the stacked events.**
   
   If you play back the recorded section, only the lowest (last) take will be heard.

2. **To audition another take, either mute the lower take(s) with the Mute tool or move the takes between the lanes.**
   
   This can be done by dragging or by using the functions Move to Next Lane/Previous Lane on the Quick menu or Edit menu.
3. Edit the takes so that only the parts you want to keep can be heard. You can cut events with the Scissors tool, resize them, mute them or delete them.

The sections that will be heard are indicated in green.

4. When you are satisfied with the result, select all events on all lanes and select “Delete Overlaps” from the Advanced submenu on the Audio menu. This puts all events back on a single lane and resizes events so that overlapped sections are removed.

5. To turn off the lane display mode for the track, click the Lane Display Type button in the track list and select “Lanes Off”. If the button is hidden, you can bring it to view in the Track Controls Settings dialog – see page 794.
Recording with effects (Cubase SX only)

Normally you record the audio signals “dry” and add effects non-destructively during playback as described in the chapter “Audio effects”. However, Cubase SX also allows you to add effects (and/or EQ) directly while you are recording. This is done by adding insert effects and/or making EQ settings for the input channel in the mixer. Note:

- This will make the effects become part of the audio file itself – you cannot change the effect settings after recording.

About the record format

When you record with effects you should consider setting the record format (bit depth) to 32 Bit Float. This is done in the Project Setup dialog on the Project menu. Note that this isn’t required in any way – you can record with effects in 24 or 16 Bit format should you so like. However, there are two advantages to 32 Bit Float format:

- With 32 Bit Float recording you don’t risk clipping (digital distortion) in the recorded files. This can of course be avoided with 24 or 16 Bit recording as well, but requires more care with the levels.

- Cubase SX processes audio internally in 32 Bit Float format – recording in the same format means the audio quality will be kept absolutely pristine.

  The reason is that the effect processing in the input channel (as well as any level or EQ settings you make there) is done in 32 Bit Float format. If you record at 16 or 24 Bit, the audio will be converted to this lower resolution when it’s written to file – with possible signal degradation as a result.

  Note also that it doesn’t matter at which actual resolution your audio hardware works. Even if the signal from the audio hardware is in 16 Bit resolution, the signal will be 32 Bit Float after the effects are added in the input channel.
An example

This example shows how to apply the “Datube” effect while recording. Datube emulates the soft clipping distortion produced by valve amplifiers, and adds “warmth” to the recording. Note that this is only an example, you could use any effect (or any combination of effects), the principle is the same.

1. Set up an audio track for recording and select the desired input bus. Also, for best results you should activate monitoring as this allows you to hear and try out your settings before actually recording. See page 50 for a description of monitoring via Cubase SX.

2. Open the Mixer and make sure the full extended view is shown.

3. Locate the input channel (bus) from which you record. If the input channels are hidden, click on the Show/Hide Input Channels button to the left.

4. Check the input level (of the signal coming into the audio hardware) as described on page 47 and adjust the level of the source audio if necessary.
5. Pull down the View Options pop-up menu for the input channel and select “Inserts”.

The View Options pop-up menu is opened by clicking the arrow button between the fader panel and the extended panel.

Now the extended panel for the input channel shows the insert slots.

6. Click on an insert slot and select an effect from the pop-up menu that appears.

As you see, the included effects are sorted into submenus – you will find the Datube effect on the “Distortion” submenu.

The effect is loaded and activated and its control panel is automatically opened.
7. Adjust the Drive (the pre-gain of the “amplifier” – higher settings will produce more distortion) and Balance (controls the balance between the unprocessed (dry) signal and the effect output) parameters to your liking.

8. When the effect is set up as desired, you can check the level of the input channel by setting the VU Meters to post-fader (see page 48). Use the input channel fader to adjust the level if needed.


10. When you’re finished you can play back the recorded audio track. As you can hear, the effect you applied is now a part of the actual audio file.

11. If you don’t want to record more with the same plug-in, you should deactivate it by clicking in the insert slot and selecting “No Effect”.
MIDI Recording Specifics

Activating MIDI Thru

As described in the Getting Started book, the normal way to work with MIDI is to have MIDI Thru activated in Cubase SX/SL, and Local Off selected in your MIDI Instrument(s). In this mode, everything you play during recording will be “echoed” back out again on the MIDI output and channel selected for the recording track.

1. Make sure the option “MIDI Thru Active” is activated in the Preferences dialog (MIDI page).

2. Record enable the track(s) on which you want to record.
   Now, incoming MIDI is “echoed” back out again, for all record enabled MIDI tracks.

   - If you just want to use the Thru function for a MIDI track without recording, activate the monitor button for the track instead.
     This is useful e.g. if you want to try out different sounds or play a VST instrument in real time without recording your playing.
Setting MIDI channel, input and output

Setting the MIDI channel in the instrument

Most MIDI synthesizers can play several sounds at the same time, each on a different MIDI channel. This is the key to playing back several sounds (bass, piano etc.) from the same instrument. Some devices (such as General MIDI compatible sound modules) always receive on all 16 MIDI channels. If you have such an instrument, there’s no specific setting you need to make in the instrument. On other instruments you will have to use the front panel controls to set up a number of “Parts”, “Timbres” or similar so that they receive on one MIDI channel each. See the manual that came with your instrument for more information.

Naming MIDI ports in Cubase SX/SL

MIDI inputs and outputs can often be shown with unnecessarily long and complicated names. If you wish, you can rename your MIDI ports to more descriptive names:

1. Open the Device Setup dialog from the Devices menu.
2. Select the Windows MIDI or DirectMusic (Win) or MIDI System (Mac) device in the Device list. The available MIDI inputs and outputs are listed on the Setup tab. Under Windows, which device to choose depends on your system.
3. To change the name of a MIDI port, click in the Device column and type in a new name. After closing the dialog, the new names will appear on the MIDI “in:” and “out:” pop-ups.

Setting the MIDI input in the Inspector

You select MIDI inputs for tracks in the Inspector – the area to the left of the Track list in the Project window:

1. If the Inspector is hidden, click the Show Inspector button on the tool-bar.
2. Select the track(s) by clicking in the Track list. 
   To select multiple tracks, press [Shift] or [Ctrl]/[Command] and click. The Inspector shows the settings for the first selected track (for details, see page 88).

3. Click the icon in the upper right corner of the Inspector to make sure the topmost section is shown.

4. Pull down the “in” pop-up menu and select an input. 
   The available MIDI inputs are shown. The items on the menu depend on the type of MIDI interface you are using etc.

   - If you select the “All MIDI Inputs” option, the track will receive MIDI data from all available MIDI inputs.
   - If you hold down [Alt]/[Option] and select a MIDI input, this is selected for all MIDI tracks.
   - If you hold down [Shift] and select a MIDI input, this is selected for all selected MIDI tracks.
   - If you hold down [Ctrl]/[Command] and select a MIDI input, this is selected for all MIDI tracks within the same folder track (see page 91).
Setting the MIDI channel and output

The MIDI channel and output settings determine where the recorded MIDI is routed during playback, but are also relevant for MIDI Thru in Cubase SX/SL. Channel and output can be selected in the Track list or in the Inspector. The procedure below describes how to make the settings in the Inspector, but it can be done in largely the same manner in the Track list as well.

1. To select the track(s) and show the settings in the Inspector, proceed as when selecting a MIDI input (see above).

2. Pull down the “out:” pop-up menu and select an output.

   The available MIDI outputs are shown. The items on the menu depend on what type of MIDI interface you are using etc.

   - If you hold down [Alt]/[Option] and select a MIDI output, this is selected for all MIDI tracks.
   - If you hold down [Shift] and select a MIDI output, this is selected for all selected MIDI tracks.
   - If you hold down [Ctrl]/[Command] and select a MIDI output, this is selected for all MIDI tracks within the same folder track (see page 91).

3. Use the “chn” pop-up menu to select a MIDI channel for the track.
• If you set the track to MIDI channel “Any”, each MIDI event on the track will be sent out on the channel stored in the event itself. In other words, the MIDI material will be played back on the channel(s) used by the MIDI input device (the MIDI instrument you play during recording).

Selecting a sound

You can select sounds from within Cubase SX/SL, by instructing the program to send Program Change and Bank Select messages to your MIDI device. This is done using the “prg” and “bnk” value fields in the Inspector or Track list.

Program Change messages give access to 128 different program locations. If your MIDI instruments have more than 128 programs, Bank Select messages (set in the “bnk” value field) allow you to select different banks, each containing 128 programs.

• Bank Select messages are recognized differently by different MIDI instruments. Also, the structure and numbering of banks and programs may vary. Consult the documentation of your MIDI instruments for details.

• Note that it is also possible to select sounds by name. For descriptions of how to set this up, see page 446.
Recording

Recording MIDI is done according to the basic recording methods (see page 39). When you finish recording, a part containing MIDI events is created in the Project window.

About overlap and the Rec Mode setting

MIDI tracks are different from audio tracks when it comes to overlapping parts:

- **All events in overlapping parts are always played back.**
  
  If you record several parts at the same locations (or move parts so that they overlap), you will hear the events in all parts on playback, even though some of the parts are obscured in the Project window.

  When recording overlapping parts, the result depends on the Rec Mode setting on the Transport panel:

  - If Rec Mode is set to "Normal", overdub recording works as with audio tracks, i.e. if you record again where something has already been recorded, you get a new part that overlaps the previous one(s).
  - If Rec Mode is set to "Merge", the overdubbed events are added to the existing part.
  - If Rec Mode is set to "Replace", the new recording replaces any existing events in the area on that track.

About punch in and out on MIDI tracks

Performing and setting up manual and automatic punch in/out recording for MIDI tracks is done in exactly the same way as for audio tracks. There is one thing to note, however:

- Punching in and out on recordings with Pitch Bend or controller data (modulation wheel, sustain pedal, volume etc.) may lead to strange effects (apparently hanging notes, constant vibrato etc.).
  
  If this happens, you may need to use the Reset item on the MIDI menu (see page 74).

About the Auto Quantize function

If Auto Quantize is activated on the Transport panel (the "Auto Q" button), the notes you record are automatically quantized according to the current Quantize settings. For more information about quantizing, see page 505.
Recording MIDI in cycle mode

When you record MIDI in cycle mode, the result depends on which Cycle Record mode is selected on the Transport panel:

**Cycle Rec mode: Mix (MIDI)**
For each completed lap, everything you record is added to what was previously recorded, in the same part. This is useful for building up rhythm patterns, for example. Record a hi-hat part on the first lap, the bass drum part on the second lap etc.

**Cycle Rec mode: Overwrite (MIDI)**
As soon as you play a MIDI note (or send any MIDI message) all MIDI you have recorded on previous laps is overwritten – from that point on in the part. An example:

1. You start recording in an eight bar cycle.
2. The first take wasn’t good enough – you start directly with a new take on the next cycle lap and overwrite the first take.
3. After recording the second take you let the recording roll on and listen, without playing anything. You find that the take was good up until bar seven, for example.
4. On the next lap, you wait until bar seven and start playing. This way you will overwrite the last two bars only.
5. Make sure you stop playing before the next lap begins – otherwise you will overwrite the entire take.

**Cycle Rec mode: Keep Last**
Each completed lap replaces the previously recorded lap. Note:

- The cycle lap must be completed – if you deactivate recording or press Stop before the cursor reaches the right locator, the previous take will be kept.
- If you don't play or input any MIDI during a lap, nothing happens (the previous take will be kept).
**Cycle Rec mode: Stacked**

In this mode, the following happens:

- Each recorded cycle lap is turned into a separate MIDI part.
- The track is divided into “lanes”, one for each cycle lap.
- The parts are stacked above each other, each on a different lane.
- All takes but the last one are muted.

This makes it easy to create a “perfect take” by combining the best parts from the different cycle laps. You can edit the parts in the Project window (by cutting, resizing and deleting) or you can use a MIDI editor as in the following example:

1. Unmute the muted takes by clicking the parts with the Mute tool.
2. Select all takes (parts) and open them in the Key Editor for example.
3. Use the part list pop-up menu on the toolbar to select which part to edit.
   See page 528.
4. Remove or edit notes as desired.
5. When you are happy with the result, close the editor.
6. To turn it all into a single MIDI part (containing your “perfect take”), select all parts and select Merge MIDI in Loop from the MIDI menu.
7. In the dialog that appears, activate the Erase Destination option and click OK.
   The remaining events in the parts are merged together into a single part.
Recording different types of MIDI messages

- You can decide exactly which event types should be recorded by using the MIDI filters – see page 77.

Notes

With MIDI, when you press and release a key on your synth or other MIDI keyboard, a Note On (key down) and a Note Off (key up) message are sent out. The MIDI note message also contains the information which MIDI channel was used. Normally, this information is overridden by the MIDI channel setting for the track, but if you set the track to MIDI channel "Any", the notes will be played back on their original channels.

Continuous messages

Pitch bend, aftertouch and controllers (like modulation wheel, sustain pedal, volume etc.) are considered as MIDI continuous events (as opposed to the momentary key down and key up messages). If you move the Pitch bend wheel on your synthesizer while recording, this movement is recorded together with the key (Note On and Note Off messages), just as you’d expect. But the continuous messages can also be recorded after the notes have been recorded (or even before). They can also be recorded on their own tracks, separately from the notes to which they belong.

Say for instance that you record one or several bass parts on track 2. If you now set another track, like track 55, to the same output and MIDI channel as track 2 you can make a separate recording of just pitch bends for the bass parts. This means that you activate recording as usual and only move the pitch bend wheel during the take. As long as the two tracks are set to the same output and MIDI channel it will appear to the MIDI instrument as if the two recordings were made at the same time.
**Program Change messages**

Normally, when you switch from one program to another on your keyboard (or whatever you use to record), a number corresponding to that program is sent out via MIDI as a Program Change message. These can be recorded on the fly with the music, recorded afterwards on a separate track, or manually entered in the Key or List Editors.

**System Exclusive messages**

System Exclusive (SysEx) is a special type of MIDI message used to send data that only makes sense to a unit of a certain make and type. Every major MIDI manufacturer has its own SysEx identity code and these are part of practically all SysEx messages. SysEx can be used to transmit a list of the numbers that make up the settings of one or more sounds in a synth. For more about viewing and editing SysEx messages, see the chapter “Working with System Exclusive messages”.

**The Reset function**

The Reset function on the MIDI menu sends out note-off messages and resets controllers on all MIDI channels. This is sometimes necessary if you experience hanging notes, constant vibrato, etc.

- Cubase SX/SL can also automatically perform a MIDI reset during playback (after each part) and/or on stop.
  You turn these functions on or off in the Preferences dialog (MIDI page).
Retrospective Record

This feature allows you to capture any MIDI notes you play in Stop mode or during playback and turn them into a MIDI part “after the fact”. This is possible due to the fact that Cubase SX/SL can capture MIDI input in buffer memory, even when not recording.

Proceed as follows:

1. Enable the Retrospective Record function in the Preferences dialog (Record page). This activates the buffering of MIDI input, making Retrospective Record possible.

2. Make sure a MIDI track is record enabled.

3. When you have played some MIDI material you want to capture (either in Stop mode or during playback), select Retrospective Record from the Transport menu (or use the key command, by default [Shift]-[Pad*]).

The contents of the MIDI buffer (i.e. what you just played) is turned into a MIDI part on the record enabled track. The part will appear where the project cursor was when you started playing – this means that if you played along during playback, the captured notes will end up exactly where you played them in relation to the project.

- The Retrospective Record Buffer Size setting in the Preferences dialog (Record page) determines how much data can be captured.
MIDI Preferences

The following options and settings in the Preferences dialog affect MIDI recording and playback:

MIDI page

• Length Adjustment
  Adjusts the length of notes so that there always is a short time between the end of one note and the start of another (of the same pitch and on the same MIDI channel). You set the time in ticks. By default there are 120 ticks per 1/16 note, but you can adjust this with the MIDI Display Resolution setting on the same page.

Record page

• Snap MIDI Parts to Bars
  When this is activated, recorded MIDI parts will automatically be lengthened to start and end at whole bar positions. If you are working in a Bars+Beats-based context, this can make editing (moving, duplicating, repeating, etc.) easier.

• Solo Record in MIDI Editors
  If this is activated and you open a part for editing in a MIDI editor, its track is automatically record enabled. Furthermore, Record Enable is deactivated for all other MIDI tracks until you close the editor again. This makes it easier to record MIDI data when you’re editing a part – you will always be sure the recorded data ends up in the edited part and not on any other track.

• MIDI Record Catch Range in ms
  When you record starting at the left locator, this setting helps you make sure the very start of the recording is included. A very annoying scenario is when you have recorded a perfect MIDI take, only to find out that the very first note wasn’t included – because you started playing a little bit too early! If you raise the Record Catch Range, Cubase SX/SL will catch the events played just before the recording start point, eliminating this problem.
Filtering MIDI

The MIDI–MIDI Filter page in the Preferences dialog allows you to prevent certain MIDI messages from being recorded and/or “thruput” (echoed by the MIDI Thru function).

The dialog is divided into four sections:

<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Record</td>
<td>Activating any of these options prevents that type of MIDI message from being recorded. It will, however, be thruput, and if already recorded, it will play back normally.</td>
</tr>
<tr>
<td>Thru</td>
<td>Activating any of these options prevents that type of MIDI message from being thruput. It will, however, be recorded and played back normally.</td>
</tr>
<tr>
<td>Channels</td>
<td>If you activate a channel button, no MIDI messages on that MIDI channel will be recorded or thruput. Already recorded messages will, however, be played back normally.</td>
</tr>
</tbody>
</table>
| Controller | Allows you to prevent certain MIDI controller types from being recorded or thruput.  
To filter out a controller type, select it from the list at the top of the Controller section and click “Add”. It will appear on the list below.  
To remove a controller type from the list (allow it to be recorded and thruput), select it in the lower list and click “Remove”. |
Options and Settings

Recording-related Preferences

A couple of settings in the Preferences dialog (Transport page) are relevant for recording. Set these according to your preferred method of work:

Deactivate Punch In on Stop

If this is activated, punch in on the Transport panel is automatically deactivated whenever you enter Stop mode.

Stop after Automatic Punch Out

If this is activated, playback will automatically stop after automatic punch out (when the project cursor reaches the right locator and punch out is activated on the Transport panel). If the postroll value on the Transport panel is set to a value other than zero, playback will continue for the set time before stopping (see below).
About Preroll and Postroll

The preroll and postroll value fields (below the left/right locator fields) on the Transport panel have the following functionality:

• By setting a preroll value, you instruct Cubase SX/SL to “roll back” a short section whenever playback is activated. This applies whenever you start playback, but is perhaps most relevant when recording from the left locator (punch in activated on the Transport panel) as described below.

• By setting a postroll value, you instruct Cubase SX/SL to play back a short section after automatic punch out, before stopping. This is only relevant when punch out is activated on the Transport panel and “Stop after Automatic Punchout” is activated in the Preferences dialog (Transport page).

• To turn pre- or postroll on or off, click the corresponding button on the Transport panel (next to the pre/postroll value) or use the “Use Preroll” and “Use Postroll” options on the Transport menu.

An example:

1. Set the locators to where you want to start and end recording.
2. Activate punch in and punch out on the Transport panel.
3. Activate the option “Stop after Automatic Punchout” in the Preferences dialog (Transport page).
4. Set suitable preroll and postroll times by clicking in the corresponding fields on the Transport panel and typing in time values.
5. Activate pre- and postroll by clicking the buttons next to the preroll and postroll times so that they light up.
6. Activate recording.
   The project cursor “rolls back” by the time specified in the preroll field and playback starts. When the cursor reaches the left locator, recording is automatically activated. When the cursor reaches the right locator, recording is deactivated, but playback continues for the time set in the postroll field before stopping.
Using the metronome

The metronome will output a click that can be used as a timing reference. The two parameters that govern the timing of the metronome are tempo and time signature, and these are edited in the Tempo Track window (see page 640).

You can use the metronome for a click during recording and/or playback or for a precount (count-in) that will be heard when you start recording from Stop mode. Click and precount are activated separately:

- To activate the metronome, click the Click button on the Transport panel. You can also select “Metronome On” from the Transport menu or use the corresponding key command (by default [C]).
- To activate the precount, click the Precount button on the Transport panel. You can also select “Precount On” from the Transport menu or set up a key command for this.

Metronome settings

You make settings for the metronome in the Metronome Setup dialog, opened from the Transport menu.

The metronome can use either an audio click played back via the audio hardware, send MIDI data to a connected device which will play back the click or do both.
The following metronome settings can be made in the dialog:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>MIDI Click on/off</td>
<td>Selects whether or not the metronome will sound via MIDI.</td>
</tr>
<tr>
<td>MIDI Output</td>
<td>Use the pop-up to select a MIDI output for the metronome click.</td>
</tr>
<tr>
<td>Channel</td>
<td>Selects the MIDI channel for the metronome click.</td>
</tr>
<tr>
<td>High Note</td>
<td>Sets the MIDI note number for the “high note” (the first beat in a bar).</td>
</tr>
<tr>
<td>High Velocity</td>
<td>Sets the velocity value for the “high note” (the first beat in a bar).</td>
</tr>
<tr>
<td>Low Note</td>
<td>Sets the MIDI note number for the “low note” (the other beats).</td>
</tr>
<tr>
<td>Low Velocity</td>
<td>Sets the velocity value for the “low note” (the other beats).</td>
</tr>
<tr>
<td>Audio Click on/off</td>
<td>Selects whether or not the metronome will sound via the audio hardware.</td>
</tr>
<tr>
<td>Audio Click Volume slider</td>
<td>Adjusts the volume for the audio click.</td>
</tr>
<tr>
<td>Click during</td>
<td>Allows you to specify whether the metronome should be heard during playback, recording or both (when Click is activated on the Transport panel).</td>
</tr>
<tr>
<td>Use Count Base</td>
<td>If this option is activated, you use the field to the right to specify the “rhythm” of the metronome. Normally, the metronome plays one click per beat, but setting this to e.g. “1/8” gives you eighth notes – two clicks per quarter note beat. It’s also possible to create unusual metronome rhythms such as triplets etc.</td>
</tr>
<tr>
<td>Precount Bars</td>
<td>Sets the number of bars the metronome will count in before it starts recording if precount is activated on the Transport panel.</td>
</tr>
<tr>
<td>From Tempo Track</td>
<td>When this is activated, the precount will be in the time signature set in the Tempo track. Furthermore, any tempo changes in the Tempo track during the precount will be applied.</td>
</tr>
<tr>
<td>Use Signature</td>
<td>If “From Tempo Track” is deactivated, you can use these fields to set a time signature for the precount. In this mode, tempo changes in the Tempo track won’t affect the precount.</td>
</tr>
</tbody>
</table>
5

The Project window
Background

The Project window is the main window in Cubase SX/SL. This provides you with an overview of the project, allowing you to navigate and perform large scale editing. Each project has one Project window.

About tracks

The Project window is divided vertically into tracks, with a timeline running horizontally from left to right. The following track types are available:

<table>
<thead>
<tr>
<th>Track type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Audio</td>
<td>For recording and playing back audio events and audio parts. Each audio track has a corresponding audio channel in the mixer. An audio track can have any number of automation “subtracks” for automating mixer channel parameters, insert effect settings etc.</td>
</tr>
<tr>
<td>Folder</td>
<td>Folder tracks function as containers for other tracks, making it easier to organize and manage the track structure. They also allow you to edit several tracks at the same time. See page 145.</td>
</tr>
<tr>
<td>FX Channel</td>
<td>FX channel tracks are used for adding send effects. Each FX channel can contain up to eight effect processors – by routing effect sends from an audio channel to an FX channel, you send audio from the audio channel to the effect(s) on the FX channel. Each FX channel has a corresponding channel strip in the mixer – in essence an effect return channel. See page 244 for more about FX Channel tracks and send effects. An FX channel can also have any number of automation subtracks for automating mixer channel parameters, effect settings etc. All FX channel tracks are automatically placed in a special FX channel folder in the Track list, for easy management.</td>
</tr>
<tr>
<td>Group Channel</td>
<td>By routing several audio channels to a Group channel, you can submix them, apply the same effects to them, etc. (see page 222). A Group channel track contains no events as such, but displays settings and automation curves for the corresponding Group channel. Each Group channel track has a corresponding channel strip in the mixer. In the Project window, Group channels are organized as subtracks in a special Group Tracks folder.</td>
</tr>
<tr>
<td>MIDI</td>
<td>For recording and playing back MIDI parts. Each MIDI track has a corresponding MIDI channel strip in the mixer. A MIDI track can have any number of automation “subtracks” for automating mixer channel parameters, insert and send effect settings etc.</td>
</tr>
</tbody>
</table>
About parts and events

Events are the basic building blocks in Cubase SX/SL. Different event types are handled differently in the Project window:

- Video events and automation events (curve points) are always viewed and rearranged directly in the Project window.
- MIDI events are always gathered in MIDI parts, containers for one or more MIDI events. MIDI parts are rearranged and manipulated in the Project window. To edit the individual MIDI events in a part, you have to open the part in a MIDI editor (see page 526).
- Audio events can be displayed and edited directly in the Project window, but you can also work with audio parts containing several events. This is useful if you have a number of events which you want to treat as one unit in the project.

<table>
<thead>
<tr>
<th>Track type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Marker</td>
<td>The Marker track displays markers, and allows you to move and rename them directly in the Project window (see page 158). There can only be one Marker track in the project.</td>
</tr>
<tr>
<td>Ruler (SX only)</td>
<td>Ruler tracks contain additional rulers, displaying the timeline from left to right. In Cubase SX you can use any number of ruler tracks, each with a different display format if you wish. See page 96 for more information about the ruler and the display formats.</td>
</tr>
<tr>
<td>Video</td>
<td>For playing back video events. A project can only have one Video track.</td>
</tr>
</tbody>
</table>

An audio event and an audio part.
Window Overview

The info line.  Project overview  The toolbar.  The ruler.

The Inspector.  Track list with various track types.  The event display, showing audio parts and events, MIDI parts, automation, markers, etc.
The Track list

The Track list is the area to the left in the Project window. It contains name fields and various settings for the tracks. Different track types have different controls in the Track list. To see all the controls you may have to resize the track in the Track list (see page 103):

- The Track list area for an audio track:

- The Track list area for an automation subtrack (revealed by clicking the + button on a track):

- The Track list area for a MIDI track:
The Inspector

The area to the left of the Track list is called the Inspector. This shows additional controls and parameters for the track you have selected in the Track list. If several tracks are selected (see page 109), the Inspector shows the setting for the first (topmost) selected track.

To hide or show the Inspector, click the Inspector icon in the toolbar.

- For most track classes, the Inspector is divided into a number of sections, each containing different controls for the track. You can hide or show sections by clicking the tabs in their top right corner. Clicking the tab for a hidden section brings it to view and hides the other sections. [Ctrl]/[Command]-clicking the tab allows you to hide or show a section without affecting other sections. Finally, [Alt]/[Option]-clicking a tab shows or hides all sections in the Inspector.

- Folding a section does not affect the functionality but merely hides the section from view. In other words, if you have set up a track parameter or activated an effect for example, your settings will still be active even if you fold the Inspector section.

Which sections are available in the Inspector depends on the selected track’s class.
Sections

In general, the Inspector contains the same controls as the Track list, but there are also some additional buttons and parameters. Below is a list of all common, possible settings and sections, their controls and usage, followed by descriptions of which sections are actually available for each type of track:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto Fades Settings</td>
<td>Opens a dialog in which you can make separate Auto Fade settings for the track. See page 180.</td>
</tr>
<tr>
<td>Edit button</td>
<td>Opens the Channel Settings window for the track, allowing you to view and adjust effect and EQ settings, etc. See page 212.</td>
</tr>
<tr>
<td>Volume</td>
<td>Use this to adjust the level for the track. Changing this setting will move the track’s fader in the mixer window, and vice versa. See page 202 to learn more about setting levels.</td>
</tr>
<tr>
<td>Pan</td>
<td>Use this to adjust the panning of the track. As with the Volume setting, this corresponds to the Pan setting in the mixer.</td>
</tr>
<tr>
<td>Delay</td>
<td>This adjusts the playback timing of the audio track. Positive values delay the playback while negative values cause the track to play earlier. The values are set in milliseconds.</td>
</tr>
<tr>
<td>In</td>
<td>This lets you specify which Input bus or MIDI input the track should use (see page 14 for information about Input busses).</td>
</tr>
</tbody>
</table>
Audio tracks

For audio tracks, all settings and sections listed above are available.

MIDI tracks

When a MIDI track is selected, the Inspector contains a number of additional sections and parameters, affecting the MIDI events in real time (e.g. on playback). Which sections are available for MIDI tracks is described in a separate chapter, see page 459.

Marker tracks

When the marker track is selected, the Inspector shows the marker list. See page 154.

Video tracks

When a Video track is selected, the Inspector shows the Notepad section only.
Folder tracks

When a folder track is selected, the Inspector shows the folder and its underlying tracks, much like a folder structure in the Windows Explorer or Mac OS X Finder.

• You can click one of the tracks shown under the folder in the Inspector to have the Inspector show the settings for that track.
  This way, you don’t have to “open” a folder track to make settings for tracks within it.

Here, an audio track within the folder is selected.

FX channel tracks

When an FX channel track is selected, the following controls and sections are available:

• Edit button.
• Volume control.
• Pan control.
• Output routing pop-up menu.
• Inserts section.
• Equalizers section.
• Channel section.
• Notepad section.
**FX channel folder tracks**

FX channel tracks are automatically placed in a special folder, for easier management. When this folder track is selected, the Inspector shows the folder and the FX channels it contains. You can click one of the FX channels shown in the folder to have the Inspector show the settings for that FX channel – this way you don’t have to “open” a folder track to access the settings for the FX channels in it.

**Group channel tracks**

When a Group channel track is selected, the following controls and sections are available:

- Edit button.
- Volume control.
- Pan control.
- Output routing pop-up menu.
- Inserts section.
- Equalizers section.
- Sends section.
- Channel section.
- Notepad section.

**Group channel folder tracks**

Just like FX channel tracks, all Group channel tracks are placed in a separate folder – when this is selected, the Inspector shows the folder and the Group channels it contains. You can click one of the Group channels shown in the folder to have the Inspector show the settings for that Group channel – this way, you don’t have to “open” a folder track to access the settings for the Group channels in it.

**Ruler tracks (Cubase SX only)**

For ruler tracks, the Inspector isn’t used.
The toolbar

The toolbar contains tools and shortcuts for opening other windows and various project settings and functions:

- In addition, the toolbar can contain a number of other tools and shortcuts, not visible by default. How to set up the toolbar and specify which tools should be displayed or hidden is described on page 792.
The info line

The info line shows information about the currently selected event or part in the Project window. You can edit almost all values in the info line using regular value editing. Length and position values are displayed in the format currently selected for the ruler (see page 96).

- To hide or show the info line, click this icon on the toolbar:

  ![Info Line Toggle Icon]

The following elements can be selected for display and editing on the info line:

- Audio events.
- Audio parts.
- MIDI parts.
- Video events.
- Markers.
- Automation curve points.

When several elements are selected

- If you have several elements selected, the info line will show information about the first item in the selection. The values will be shown in yellow to indicate that several elements are selected.
- If you edit a value on the info line, the value change is applied to all selected elements, relatively to the current values.

  An example: You have two audio events selected. The first is one bar long and the other two bars long. The info line shows the length of the first event (one bar). If you now edit this value to 3 bars in the info line, the other event will be resized by the same amount – and will thus be 4 bars long.

- If you press [Ctrl]/[Command] and edit on the info line, the values will be absolute instead. In our example above, both events would be resized to 3 bars. Note that [Ctrl]/[Command] is the default modifier key for this – you can change this in the Preferences dialog (Editing-Tool Modifiers page, under the Info Line category).
Editing Transpose and Velocity for MIDI parts

     When one or several MIDI parts are selected, the info line contains Transpose and Velocity fields.

• Adjusting the Transpose field transposes the selected parts in semitone steps.
  Note that this transposition doesn’t change the actual notes in the part – it’s just a "play parameter", affecting the notes on playback. The transposition you specify for a part on the info line is added to the transposition set for the whole track with the Transpose track parameter in the Inspector (see page 464).

• Adjusting the Velocity field shifts the velocity for the selected parts – the value you specify is added to the velocities of the notes in the parts.
  Again, this velocity shift only affects the notes on playback, and again, the value you specify is added to the Vel.Shift. value set for the whole MIDI track in the Inspector (see page 464).
### The ruler

The ruler at the top of the event display shows the timeline. Initially, the Project window ruler uses the display format specified in the Project Setup dialog (see page 99), as do all other rulers and position displays in the project. However, you can select an independent display format for the ruler by clicking the arrow button to the right of it and selecting an option from the pop-up menu that appears (you can also bring up this pop-up menu by right-clicking (Win) or [Ctrl]-clicking (Mac) anywhere in the ruler).

<table>
<thead>
<tr>
<th>Option</th>
<th>Positions and lengths displayed as</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bars+Beats</td>
<td>Bars, beats, sixteenth notes and ticks. By default there are 120 ticks per sixteenth note but you can adjust this with the “MIDI Display Resolution” setting in the Preferences dialog (MIDI page).</td>
</tr>
<tr>
<td>Seconds</td>
<td>Hours, minutes, seconds and milliseconds.</td>
</tr>
<tr>
<td>Timecode</td>
<td>This format displays hours, minutes, seconds and frames. The number of frames per second (fps) is set in the Project Setup dialog (see page 99). You can choose from 24, 25, 29.97 and 30 fps or 29.97 and 30 dfps (“drop frame”).</td>
</tr>
<tr>
<td>Samples</td>
<td>Samples.</td>
</tr>
<tr>
<td>User</td>
<td>Hours, minutes, seconds and frames, with a user definable number of frames per second. You set the desired number of fps in the Preferences dialog (Transport page).</td>
</tr>
</tbody>
</table>

- The selection you make here affects the ruler, the info line and tool tip position values (appear when you drag an event in the Project window). You can also select independent formats for other rulers and position displays.
- To set the display format globally (for all windows), use the primary display format pop-up on the Transport panel, or hold down [Ctrl]/[Command] and select a display format in any ruler.
- If you use the “Timecode” or “User” options and the option “Show Timecode Subframes” is activated in the Preferences dialog (Transport page), the frames will also display subframes. There are 80 subframes per frame.
Using multiple rulers – ruler tracks (Cubase SX only)

As described above, the Cubase SX/SL Project window contains a main ruler at the top of the event display, displaying the timeline from left to right.

If needed, you can have several rulers in the Project window, by adding ruler tracks to the project. Each ruler track contains an additional ruler.

- To add a ruler track, select “Add Track” from the Project menu and from the submenu that appears, select “Ruler”. A ruler track showing an additional ruler is added to the Track list.

A ruler track set to the display format “Seconds”.

You can add any number of ruler tracks to a project, and position them as needed by dragging them up or down in the list. Each one can show a separate display format:

- To select a display format for a ruler track, click the leftmost part of it in the track list and select an option from the pop-up menu. See the section “The ruler” above for descriptions of the different display formats.
Note that ruler tracks are completely independent from the main event display ruler, as well as rulers and position displays in other windows. This means that:

- Ruler tracks can all have independent display formats.
- Ruler tracks are not affected by the display format setting in the Project Setup dialog (see page 99).
- Ruler tracks are not affected if you set the display format globally with the primary time display in the Transport panel.

- Ruler tracks are however affected by the option “Show Timecode Subframes” (described above) in the Preferences dialog.
Operations

Creating a new project

You create a new project in the following way:

1. Select “New Project” from the File menu.
   A dialog appears, listing a number of project templates, including any custom templates you may have created (see page 763).

2. Select a template and click OK.
   A file dialog appears, allowing you to specify a location for the project folder. This will contain all files related to the project.

3. Select an existing folder or type the name of a new one. Click OK.
   A Project window appears. The new project will be based on the selected template, and include tracks, events and settings from the template.

The Project Setup dialog

General settings for the project are made in the Project Setup dialog. This is opened by selecting “Project Setup...” from the Project menu.
The following settings are available in the Project Setup dialog:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start</td>
<td>The start time of the project. Allows you to have the project start at another time than zero. Also used for setting the sync start position when synchronizing Cubase SX/SL to external devices (see page 715).</td>
</tr>
<tr>
<td>Length</td>
<td>The length of the project.</td>
</tr>
<tr>
<td>Frame Rate</td>
<td>Used if you are synchronizing Cubase SX/SL with external equipment. If Cubase SX/SL is the slave, this value is automatically set to the frame rate of the incoming sync signal. If Cubase SX/SL is the master, this determines the frame rate of the sent sync signal. See page 721.</td>
</tr>
<tr>
<td>Display Format</td>
<td>This is the global display format used for all rulers and position displays in the program, except ruler tracks (Cubase SX only, see page 92). However, you can make independent display format selections for the individual rulers and displays if you like. For descriptions of the different display format options, see page 96.</td>
</tr>
<tr>
<td>Display Offset</td>
<td>Offsets the time positions displayed in the ruler etc., allowing you to compensate for the Start position setting. Typically, if you synchronize Cubase SX/SL to an external source starting at a frame other than zero, you set the Start position to this value. However, if you still want the display in Cubase SX/SL to start at zero, set the Display Offset to the same value too.</td>
</tr>
<tr>
<td>Bar Offset</td>
<td>This works just like “Display Offset” described above, in that it offsets the time positions in the ruler by a number of bars, allowing you to compensate for the Start position setting. The difference is that Bar Offset is only used when the “Bars+Beats” display format is selected (see page 96).</td>
</tr>
<tr>
<td>Sample Rate</td>
<td>The sample rate at which Cubase SX/SL records and plays audio.</td>
</tr>
<tr>
<td>Record Format</td>
<td>When you record audio files in Cubase SX/SL, they are recorded with this resolution. See page 43.</td>
</tr>
<tr>
<td>Record File Type</td>
<td>The file type that should be created when you record audio. See page 43.</td>
</tr>
<tr>
<td>Stereo Pan Law</td>
<td>Decides whether panning should use power compensation or not. This is explained on page 209.</td>
</tr>
</tbody>
</table>

⚠️ While most settings in the Project Setup can be changed at any time, you should select a sample rate once and for all when starting with a new project! All audio files must be of this sample rate to play back correctly.
Zoom and view options

Zooming in the Project window is done according to the standard zoom procedures (see the Getting Started book), with the following special notes:

- When you are using the Zoom tool (magnifying glass), the result depends on the option “Zoom Tool Standard Mode: Horizontal Zooming Only” in the Preferences – Editing dialog. If this is activated and you drag a selection rectangle with the Zoom tool, the window will only be zoomed horizontally (track height will not change). If the option is off, the window will be zoomed both horizontally and vertically.

- When using the vertical zoom sliders, the tracks are scaled relatively. In other words, if you have made any individual track height adjustments (see below), the relative height differences are maintained.

You find the following options are available on the Zoom submenu on the Edit menu:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Zoom In</td>
<td>Zooms in one step, centering on the project cursor.</td>
</tr>
<tr>
<td>Zoom Out</td>
<td>Zooms out one step, centering on the project cursor.</td>
</tr>
<tr>
<td>Zoom Full</td>
<td>Zooms out so that the whole project is visible. “The whole project” means the timeline from the project start to the length set in the Project Setup dialog (see above).</td>
</tr>
<tr>
<td>Zoom to Selection</td>
<td>Zooms in horizontally and vertically so that the current selection fills the screen.</td>
</tr>
<tr>
<td>Zoom to Selection (Horiz)</td>
<td>Zooms in horizontally so that the current selection fills the screen.</td>
</tr>
<tr>
<td>Zoom to Event</td>
<td>This option is available only in the Sample Editor (see page 371).</td>
</tr>
<tr>
<td>Zoom In Vertical</td>
<td>Zooms in one step vertically.</td>
</tr>
<tr>
<td>Zoom Out Vertical</td>
<td>Zooms out one step vertically.</td>
</tr>
<tr>
<td>Zoom In Tracks</td>
<td>Zooms in selected track(s) one step vertically.</td>
</tr>
<tr>
<td>Zoom Out Tracks</td>
<td>Zooms out selected track(s) one step vertically.</td>
</tr>
<tr>
<td>Zoom Selected Tracks</td>
<td>This zooms in vertically on the selected track(s) and minimizes the height of all other tracks.</td>
</tr>
</tbody>
</table>

The Project window 5 – 101
• If the option “Zoom while Locating in Time Scale” is activated in the Preferences (Transport page), you can also zoom by clicking in the main ruler and dragging up or down with the mouse button pressed. Drag up to zoom out; drag down to zoom in.

• You can zoom the contents of parts and events vertically, using the Waveform Zoom slider in the top right corner of the event display. This can be useful to better view quiet audio passages.

❐ To get an approximate reading on the level of the audio events by viewing the waveforms, make sure the slider is all the way down. Otherwise, zoomed waveforms may be mistaken for clipped audio.

• If you activate the option Quick Zoom in the Preferences (Editing page), the contents of parts and events will not be continuously redrawn when you zoom manually. Instead, the contents are redrawn once you have stopped changing the zoom – activate this if screen redraws are slow on your system.
Resizing tracks in the Track list

- You can change the height of an individual track by clicking on its lower border in the Track list and dragging up or down.
  To change the height of all tracks simultaneously, hold down [Ctrl]/[Command] and resize one of the tracks in this way. If “Snap Track Heights” is activated on the Track scale pop-up (see below), the track height will change in fixed increments when you resize it.

- You can also change the width of the Track list area, by dragging the border between the Track list and the event display.

- The controls shown for tracks in the Track list will by default adapt to the track size. This means that when resizing a track’s height or width some of the controls will be dynamically placed where they best “fit in”. If you instead always want to have the controls in fixed positions, you can deactivate the option “Wrap Controls” in the Track Controls settings dialog (see page 794).

- You can decide for each track type what controls should be shown in the Track list – see page 794.

- You can use the Track scale pop-up (opened by clicking the arrow button above the vertical zoom control) to set the number of tracks to view in the current Project window.
  The track height will be adjusted to show only the number of tracks specified on the pop-up menu. By selecting “Zoom N Tracks” from the pop-up you can manually set the number of tracks to fit in the current Project window.

- Tracks can also be divided vertically in lanes – see page 132.
Zoom presets and Cycle markers

The pop-up menu to the left of the horizontal zoom control allows you to select, create and organize zoom presets. These are useful if you want to toggle between different zoom settings (e.g. one where the whole project is displayed in the project window and another with a high zoom factor for detailed editing). With this pop-up menu, you can also zoom in on the area between cycle markers in the project.

The upper part of the menu lists the zoom presets:

- To store the current zoom setting as a preset, select Add from the pop-up menu. A dialog appears, allowing you to type in a name for the preset.
- To select and apply a preset, select it from the pop-up menu.
- The “Zoom Full” preset is always available. Selecting this option Zooms out so that the whole project is visible. “The whole project” means the timeline from the project start to the length set in the Project Setup dialog (see page 99).
- If you want to delete a preset, select “Organize...” from the pop-up menu. In the dialog that appears, select the preset in the list and click the Delete button. The preset is removed from the list.
• If you want to rename a preset, select “Organize…” from the pop-up menu.
In the dialog that appears, select the desired preset in the list and click the Rename button. A second dialog opens, allowing you to type in a new name for the preset. Click OK to close the dialogs.

Zoom presets are global for all projects, i.e. they are available in all projects you open or create.

The middle part of the pop-up lists any cycle markers you have added in the project:
• If you select a cycle marker from this menu, the event display is zoomed in to encompass the marker area (see page 161).
• You cannot edit the cycle markers in this pop-up menu. For information on editing markers, see page 154.

Only the cycle markers you create in the current project are available on the menu.

The Zoom history

Cubase SX/SL maintains a history of recent zoom stages, allowing you to undo and redo zoom operations. This way you can zoom in several steps and then easily go back to the zoom stage at which you started.

There are two ways to invoke Undo Zoom and Redo Zoom:
• Use the items on the Zoom submenu on the Edit menu.
  You can also assign key commands for these.
• Double click with the Zoom tool (magnifying glass) to Undo Zoom. Press [Alt]/[Option] and double click to Redo Zoom.
Adjusting how parts and events are shown

The Preferences dialog on the File menu (the Cubase SX/SL menu, under Mac OS X) contains several settings for customizing the display in the Project window.

The Event Display page contains common settings for all track types:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Colorize Event Background</td>
<td>Determines whether the backgrounds or &quot;contents&quot; (waveforms, etc.) of parts and events will be colorized. See page 109.</td>
</tr>
<tr>
<td>Transparent Events</td>
<td>When this is activated, events and parts will be transparent, showing the waveforms and MIDI events only.</td>
</tr>
<tr>
<td>Show Data on Small Track Heights</td>
<td>If this is activated, the contents of events and parts will be shown, even if the height of a track is very small.</td>
</tr>
<tr>
<td>Show Event Names</td>
<td>Determines whether the names of parts and events should be shown in the Project window.</td>
</tr>
</tbody>
</table>

The Event Display–Video page contains settings for video events:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show Video Thumbnails</td>
<td>When this is activated, thumbnail frames of the video contents are shown on the Video track.</td>
</tr>
<tr>
<td>Video Cache Size</td>
<td>This determines how much memory is available for video thumbnails. If you have long video clips and/or work with a large zoom factor (so that a lot of frames are shown in the thumbnails), you may have to raise this value.</td>
</tr>
</tbody>
</table>
The Event Display–Audio page contains settings for audio events:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Interpolate Audio Images</td>
<td>If the option is deactivated, single sample values are drawn as “steps”. If the option is activated they are interpolated to form “curves”.</td>
</tr>
<tr>
<td>Wave Image Style</td>
<td>Determines whether audio waveforms should be displayed as solid images, frames or “inverted” images (solid+frame). This selection affects all waveform images in the Project window, Sample Editor and Audio Part Editor. Note that the “Framed” and “Solid and Framed” styles are more demanding for the computer. If the system feels slower in these modes, please switch back to “Solid” wave image style.</td>
</tr>
<tr>
<td>Show Event Volume Curves</td>
<td>If this is activated the “volume curves” created with the volume and fade handles are always shown – if not, the curves are only shown for selected events.</td>
</tr>
</tbody>
</table>

The Event Display–MIDI page contains settings for MIDI parts:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default Edit Action</td>
<td>Determines which editor should be opened when you double click a MIDI part or select it and press [Ctrl]/[Command]-[E]; the Key, Drum, List or Score editor. Note that this setting is overridden for tracks with drum maps if the option “Edit as Drums when Drummap is assigned” (see below) is activated.</td>
</tr>
<tr>
<td>Part Data Mode</td>
<td>Determines if and how events in MIDI parts should be shown in the Project window: as lines, as score notes or as drum notes. If “No Data” is selected, events will not be shown at all. Note that this setting is overridden for tracks with drum maps if the option “Edit as Drums when Drum Map is assigned” (see below) is activated.</td>
</tr>
<tr>
<td>Show Controllers</td>
<td>Governs whether non-note events (controllers, etc.) should be shown in MIDI parts in the Project window.</td>
</tr>
<tr>
<td>Edit as Drums when Drum Map is assigned</td>
<td>If this is activated, parts on MIDI tracks with drum maps assigned will be shown with drum note symbols in the Project window. Also, the parts will automatically open in the Drum editor when double clicked (overriding the Default Edit Action setting above).</td>
</tr>
<tr>
<td>Note Name Style</td>
<td>Determines how MIDI note names (pitches) should be displayed in editors, etc.</td>
</tr>
</tbody>
</table>
Zooming and navigating in the overview line

By clicking the Show Overview button on the toolbar, an extra pane appears under the toolbar; the project overview line.

Show Overview button

In the overview line, events and parts on all tracks are displayed as boxes. You can use the overview line to zoom in or out, and for navigating to other sections of the project. This is done by moving and resizing the track view rectangle in the overview line:

• The track view rectangle indicates the section of the project currently displayed in the event display.

• You can zoom in or out horizontally by resizing the rectangle. Resizing is done by dragging the edges of the rectangle.

• You can drag the track view rectangle to view other sections of the project. This can also be done by clicking anywhere in the upper part of the overview – the track view rectangle will be moved to where you clicked. The number of tracks shown will not change.
Handling tracks

To add a track to the project, select “Add Track” from the Project menu and select a track type from the submenu that appears. The new track is added below the currently selected track in the Track list.

• The items on the “Add Track” submenu are also available on the Quick menu. This is accessed by right-clicking (Win)/[Ctrl]-clicking (Mac) in the Track list.

• There is an additional option at the bottom of the Add Track submenu, called “Multiple...”. Selecting this brings up a dialog allowing you to add more than one track in one operation.

The number of tracks to add is entered in the “Count” value field. You can set whether audio, MIDI or group tracks should be created by selecting from the Track pop-up in the dialog. For audio and group tracks, the channel configuration – mono, stereo or a surround configuration (Cubase SX only) – can be set in the Configuration pop-up.
Once you have created tracks, you can manipulate and rearrange them in various ways:

• To rename a track, double click in the name field and type in a new name.
  If you hold down any modifier key when pressing [Return] to close the name field, all events on the track will get the name you entered.

• To select a track, click on it in the Track list.
  A selected track is indicated by a light grey color in the Track list.

  ![This track is selected.]

  It is possible to select several tracks, by pressing [Ctrl]/[Command] and clicking them.
  To select a continuous range of tracks, use [Shift]-clicking.

• To move a track, click and drag it up or down in the list.

• To duplicate a track, complete with all contents and channel settings, right-click (Win)/[Ctrl]-click (Mac) in the Track list and select “Duplicate track” from the context menu.
  The duplicated track will appear above the original track.

• You can colorize the contents of selected track(s), or selected parts and events by clicking the Color button on the toolbar and selecting a color from the pop-up menu that appears.
  If one or several tracks are selected, all events and parts on the track(s) will get the selected color, as will any events and parts you add to the track later. If individual events or parts are selected, only these will be affected. Individually colorized events and/or parts will keep the applied color even if the track they belong to is later set to another color.
  The option “Colorize Event Background” in the Preferences dialog (Event Display page) determines whether the backgrounds or waveforms of events will be colorized.

• To remove a track, right-click (Win)/[Ctrl]-click (Mac) on it in the Track list and select “Remove Track” from the context menu that appears.
  You can also remove multiple selected tracks, by selecting “Remove Selected Tracks” either from the Project menu or from the context menu. Furthermore, you can remove all tracks not containing any events by selecting “Remove Empty Tracks” from the Project menu.
Disabling tracks

Tracks can be disabled by selecting “Disable Track” from the Track list context menu. Disabling a track in a way is the same as Muting it (see page 130), since a disabled track will not be played back. However, disabling a track not only “zeros” the output volume from the track, but actually shuts down all disk activity for it. See page 34 for more information.

Dividing the Track list (Cubase SX only)

It is possible to divide the Track list into two parts. Both sections will have independent zoom and scroll controls (if needed), but resizing the window vertically will affect the lower section only (if possible). This could be convenient for example if you’re working with a video track along with multi-track audio. This way, you can place the video track in the upper Track list, letting you scroll the audio tracks separately in the lower Track list, referencing them against the video track.

- To divide the Track list, click the “Divide Track List” button in the top right corner of the Track list.

- To revert to a single Track list, click the button again.

When the Track list is divided into two parts, the following applies:

- If you add tracks from the Project–Add Track submenu, Video tracks, Marker tracks and ruler tracks will automatically be placed in the upper part of the Track list.
- All other types of tracks will be placed in the lower part.
• If you add tracks from the context menu invoked by right-clicking (Windows) or [Ctrl]-clicking (Mac OS X) in the Track list, tracks will be added to the part of the Track list in which you click.

• You can move any type of track from the lower Track list to the upper and vice versa by right-clicking or [Ctrl]-clicking it in the Track list and selecting “Toggle Track List” from the context menu.

• If the Track list already contains tracks of the type Video, Marker or Ruler, these will automatically be moved to the upper part when you divide the Track list.

• You can resize the upper part by clicking and dragging the divider between the Track lists.
Switching between musical or linear time base

Tracks can be either “musical” (tempo) or “linear” (time) based.

- On a track using linear time base, the events will be positioned on specific time positions – changing the playback tempo will not affect the time position of events.
- On a track using musical time base, the positions of events are represented as meter values (bars, beats, 1/16th notes and ticks, with 120 ticks per 1/16th note). If you change the playback tempo, the events will play back at an earlier or later time.

Whether to use musical or linear time base depends on the type of project and recording situation. By default, all track types featuring a time base setting use linear time base. However, you can change this setting individually for each track. This is done by clicking the musical/linear time base button in the Inspector or Track list. Musical time base is indicated by a note symbol, while linear time base is indicated by a clock symbol.

Note that internally, events on musical time based tracks use the same high precision for positioning (64 bit floating point values) as linear time based events. However, switching between linear and musical time base results in a very small loss of precision (introduced by the mathematical operations used for scaling values in the two different formats). Therefore you should avoid switching repeatedly between the two modes.

For more information about tempo changes, see page 636.
Adding events to a track

There are a number of ways to add events to a track:

- By recording (see page 39). This is possible for audio and MIDI tracks.
- By selecting "Audio File..." or "Video File..." from the Import submenu on the File menu. This opens a file dialog, allowing you to locate the file you wish to import. When you import a file this way, a clip is created for the file and an event that plays the whole clip is added to the selected track, at the position of the project cursor. You can also import MIDI files by using the Import submenu, but this works in a slightly different way (see page 770).
- By grabbing audio CD tracks and converting them to audio files (see page 777).
- By importing only the audio portion of a video file and converting it to an audio file (see page 746).
- By using Copy and Paste on the Edit menu. This allows you to copy all kinds of events between projects. You can also copy events within the project, from the Audio Part Editor or Sample Editor.
- By drawing. Some types of events (markers and automation events) can be drawn directly into the Project window. For audio and MIDI tracks, you can draw parts (see page 116).
- By dragging files and dropping them on the track at the desired position. You can create events by dragging and dropping from the following locations:
  - The Desktop.
  - The Pool.
  - A Library (A Pool file that is not attached to a project).
  - The Project window of another open project.
  - The Audio Part Editor of any open project.
  - The Sample Editor of any open project – press [Ctrl]/[Command] and drag to create an event of the current selection, or click in the left column of the region list and drag to create an event from a region.
- The "Find media" dialog.

While you drag the clip in the Project window, its position will be indicated by a marker line and a numerical position box. See also page 425.
Audio file import options

When you are importing audio files there are a number of options concerning how the files should be treated by Cubase SX/SL:

- You can choose to copy the file into the project’s audio folder and have the project make reference to the copied file rather than the original file. This helps you keep your project “self-contained”.
- You can choose to split stereo- and multi-channel files into a number of mono files.
- Furthermore, you may want all files in the project to have the same sample rate and sample size (resolution).

The Preferences dialog (Editing – Audio page) contains a setting that lets you decide which options, if any, to use. Select the desired option on the “On Import Audio Files” pop-up:

- Open Options Dialog.

An Options dialog appears when you import, allowing you to select whether you want to copy the files to the Audio folder and/or convert them to the project settings. Note:

- When importing a single file of a format other than the project settings, you can specify which properties (sample rate and/or resolution) should be changed.
- When importing multiple files at the same time, you can select to have the imported files automatically converted if necessary, i.e. if the sample rate is different than the project’s or the resolution is lower than the project setting.
• Use Settings.

No Options dialog will appear when you import. Instead, you can choose to make any of the options below the pop-up the standard action(s). Activate any number of the following options to have them performed automatically each time you import audio files:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Copy Files to Working Directory</td>
<td>If files are not already in the project’s audio folder they are copied there before being imported.</td>
</tr>
<tr>
<td>Convert and Copy to Project If Needed</td>
<td>If files are not already in the project’s audio folder they are copied there before being imported. Furthermore, if the files have a different sample rate or a lower resolution than the project settings, they are automatically converted.</td>
</tr>
<tr>
<td>Split multi channel files</td>
<td>If you import a multi-channel audio file (including two-channel stereo files), it will be split into a number of mono files – one for each channel – which are placed on separate, automatically created mono tracks.</td>
</tr>
</tbody>
</table>

**Creating parts**

Parts are containers for MIDI or audio events. If you record MIDI, a MIDI part is automatically created, containing the recorded events. You can also create empty audio or MIDI parts and later add events to them. There are two ways to do this:

- **Draw a part on a MIDI or audio track with the Pencil tool.**
  You can also draw parts by pressing [Alt]/[Option] and using the Arrow tool.

- **Double click with the Arrow tool on a MIDI or audio track, between the left and right locator.**

To add events to a MIDI part, you use the tools and functions in a MIDI editor (see page 530). Adding events to audio parts is done in the Audio Part Editor (see page 387) by pasting or by using drag and drop.

- You can also gather existing audio events into a part, by using the “Events to Part” function on the Audio menu.
  This creates an audio part containing all selected audio events on the same track. To remove the part and make the events appear as independent objects on the track again, select the part and use the “Dissolve Part” function on the Audio menu.
Auditioning audio parts and events

Audio parts and events can be auditioned in the Project window with the Speaker tool:

- When auditioning, audio will be routed directly to the assigned Output bus, bypassing the audio channel's settings, effects and EQs.

1. Select the Play tool.
   Note that the Play tool and the Scrub tool share the same icon. If the rightmost tool icon on the toolbar isn't a Speaker symbol, first click on the icon to select it, then click again and select “Play” from the pop-up menu that appears.

2. Click where you want playback to start, and keep the mouse button pressed.
   Only the track on which you click is played back, starting at the click position.

3. Release the mouse button to stop playback.
Scrubbing

The Scrub tool allows you to locate positions in the audio by playing back, forwards or backwards, at any speed:

1. Select the Scrub tool.
   Note that the Play tool and the Scrub tool share the same icon. If the rightmost tool icon on the toolbar isn’t a “Scrub symbol”, first click on the icon to select it, then click again and select “Scrub” from the pop-up menu that appears.

   ![Scrub tool icon](image)

2. Click at the desired position and keep the mouse button pressed.
   The project cursor is moved to the position at which you click.

3. Drag to the left or right.
   The project cursor follows the mouse pointer and the audio is played back. The speed and pitch of the playback depends on how fast you move the pointer.

   You can adjust the responsiveness of the Scrub function in the Preferences dialog (VST page).

   • It is also possible to “scrub” the whole project with the Jog wheel on the Transport panel.
   See page 33.
Editing parts and events

This section describes techniques for editing in the Project window. If not explicitly stated, all descriptions apply to both events and parts, even though we use the term “event” for convenience.

- When you are using the tools for editing, you can in many cases get additional functions by pressing modifier keys (e.g. pressing [Alt]/[Option] and dragging with the Arrow tool creates a copy of the dragged event).

On the following pages, the default modifier keys are described – you can customize these in the Preferences dialog on the Editing – Tool Modifiers page (see page 813).

Selecting events

Selecting events is done using any of the following methods:

- Use the Arrow tool.
  The standard selection techniques apply.

- Use the Select submenu on the Edit menu.
  The options are:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>All</td>
<td>Selects all events in the Project window.</td>
</tr>
<tr>
<td>None</td>
<td>Deselects all events.</td>
</tr>
<tr>
<td>Invert</td>
<td>Inverts the selection – all selected events are deselected and all events that were not selected are selected instead.</td>
</tr>
<tr>
<td>In Loop</td>
<td>Selects all events that are partly or wholly between the left and right locator.</td>
</tr>
<tr>
<td>From Start to Cursor</td>
<td>Selects all events that begin to the left of the project cursor.</td>
</tr>
<tr>
<td>From Cursor to End</td>
<td>Selects all events that end to the right of the project cursor.</td>
</tr>
<tr>
<td>Equal Pitch</td>
<td>These are available in the MIDI Editors (see page 539).</td>
</tr>
<tr>
<td>All on Selected Tracks</td>
<td>Selects all events on the selected track.</td>
</tr>
<tr>
<td>Select Event</td>
<td>This is available in the Sample Editor (see page 367).</td>
</tr>
<tr>
<td>Left/Right Selection</td>
<td>These two functions are only used for range selection editing (see page 135).</td>
</tr>
</tbody>
</table>

Note that these functions work differently when the Range Selection tool is selected (see page 135).
• Select all events on a track by right-clicking in its Track list and selecting “Select All Events” from the pop-up menu that appears.

• You can also use the arrow keys on the computer keyboard, to select the closest event to the left, right, above or below. If you press [Shift] and use the arrow keys, the current selection will be kept, allowing you to select several events.

• If the option “Auto Select Events under Cursor” is activated in the Preferences dialog (Editing page), all events on the selected track(s) that are “touched” by the project cursor are automatically selected. This can be helpful when rearranging your project, since it allows you to select whole sections (on all tracks) by selecting all tracks and moving the project cursor.

• It is also possible to select ranges, regardless of the event and track boundaries. This is done using the Range Selection tool (see page 135).

Moving events

To move events in the Project window, use the following methods:

• Click and drag to a new position. All selected events will be moved, maintaining their relative positions. You can only drag events to tracks of the same type. If Snap is activated, this determines to which positions you can move the events (see page 140). Note also, that you can restrict movement to be either horizontal or vertical only, by holding down [Ctrl]/[Command] while dragging.

☐ You will note that there is a slightly delayed response when you move an event by dragging. This helps you avoid accidentally moving events when you click on them in the Project window. You can adjust this delay with the Drag Delay setting in the Preferences dialog (Editing page).

• Select the event and edit the Start position in the info line.
Use the “Move to” functions on the Edit menu. The following functions are available:

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Move to Cursor</td>
<td>Moves the selected event to the project cursor position. If there are several selected events on the same track, the first event will start at the cursor, and the following will be lined up end-to-start after the first one.</td>
</tr>
<tr>
<td>Move to Origin</td>
<td>Moves the selected events to their original positions, i.e. the positions at which they were originally recorded.</td>
</tr>
<tr>
<td>Move to Front,</td>
<td>This function doesn’t actually change the position of the events, but moves the selected events to the front or back, respectively. This is useful if you have overlapping events, and want to see one that is partially obscured. For audio events, this is an extra important feature, since only the visible sections of events will be played back. Moving an obscured audio event to front (or moving the obscuring event to back) will allow you to hear the whole event on playback. Note that it is also possible to use the &quot;To Front&quot; function on the event context menu for this (although this works in a different way, see page 56).</td>
</tr>
<tr>
<td>Move to Back</td>
<td></td>
</tr>
</tbody>
</table>

Use the Nudge buttons in the toolbar. These move the selected events to the left or right. The amount of movement depends on the selected display format (see page 99) and the value set on the Grid pop-up menu.

When the Range Selection tool is used, the Nudge buttons move the selection range (see page 137).

The Nudge buttons are not visible in the toolbar by default. You can decide which items should be visible by right-clicking (Windows) or [Ctrl]-clicking (Mac OS X) in the toolbar and checking them in the pop-up menu that appears. See page 792 for more information.
Duplicating events

Events can be duplicated in the following ways:

• Hold down [Alt]/[Option] and drag the event to a new position.
  If Snap is activated, this determines to which positions you can copy the events (see page 140).

  If you hold down [Ctrl]/[Command] as well, movement direction is restricted to either horizontal or vertical. That means if you drag an event vertically it can not be moved horizontally at the same time.

• Audio and MIDI parts can also be duplicated by pressing [Alt]/[Option] + [Shift] and dragging.
  This creates a shared copy of the part. If you edit the contents of a shared copy, all other shared copies of the same part are automatically edited in the same way.

  \[Image\]

  Shared copies are indicated by showing the name in italic text and an icon in the right corner of the part.

Note:

• When you duplicate audio events, the copies are always shared. This means that shared copies of audio events always refer to the same audio clip (see page 333).

• You can convert a shared copy to a real copy by selecting “Convert to Real Copy” from the Edit menu. This creates a new version of the clip (that can be edited independently) and adds this to the Pool. Note that no new files are created by this operation – for that you need to use the “Bounce Selection” function from the Audio menu (see page 436).

• Selecting “Duplicate” from the Edit menu creates a copy of the selected event and places it directly after the original.
  If several events are selected, all of these are copied “as one unit”, maintaining the relative distance between the events.

• Selecting “Repeat...” from the Edit menu opens a dialog, allowing you to create a number of copies (regular or shared) of the selected event(s).
  This works just like the Duplicate function, but you can specify the number of copies.
• You can also perform the Repeat function by dragging: Select the event(s) to repeat, press [Alt]/[Option], click the handle in the lower right corner of the last selected event and drag to the right. The longer to the right you drag, the more copies are created (as shown by the tooltip).

• Selecting “Fill Loop” from the Edit menu creates a number of copies starting at the left locator and ending at the right locator. The last copy is automatically shortened to end at the right locator position.

Using Cut, Copy and Paste
You can cut or copy selected events, and paste them in again, using the functions on the Edit menu.

• When you paste an event it is inserted on the selected track, positioned so that its snap point is aligned with the cursor position. If the selected track is of the wrong type, the event will be inserted on its original track. See page 140 for information about the snap point.

• If you use the “Paste at Origin” function, the event is pasted at its original position (the position from which you cut or copied it).

Renaming events
By default, audio events show the name of their clip, but you can enter a separate descriptive name for separate events if you like. This is done by selecting the event and typing in a new name in the “Description” field in the info line.

• You can also give all events on a track the same name as the track by changing the track name, holding down a modifier key and pressing [Return]. See page 109.
Splitting events

You can split events in the Project window in the following ways:

• Click with the Scissors tool on the event you want to split.
  If Snap is activated, this determines the exact split position (see page 140). You can also split events by pressing [Alt]/[Option] and clicking with the Arrow tool.

• Select “Split at Cursor” from the Edit menu.
  This splits the selected events at the position of the project cursor. If no events are selected, all events (on all tracks) that are intersected by the project cursor will be split.

• Select “Split Loop” from the Edit menu.
  This splits events on all tracks at the left and right locator positions.

• If you split a MIDI part so that the split position intersects one or several MIDI notes, the result depends on the option “Split MIDI Events” in the Preferences dialog (Editing page).
  If the option is activated, the intersected notes will be split (creating new notes at the beginning of the second part). If it is deactivated, the notes will remain in the first part, but “stick out” after the end of the part.

Gluing events together

Clicking on an event with the Glue Tube tool glues it together with the next event on the track. The result is a part containing the two events, with one exception:

• If you first split an event and then glue the two sections together again (without moving or editing them first), they become a single event again. In other words, gluing can create a single event if the two events are lined up end to start and play a continuous section of the same clip.
Resizing events

Resizing events means to move their start or end positions individually. In Cubase SX/SL, there are three types of resizing:

<table>
<thead>
<tr>
<th>Resizing type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Normal Sizing</td>
<td>The contents of the event stay fixed, and the start or end point of the event is moved to “reveal” more or less of the contents.</td>
</tr>
<tr>
<td>Sizing Moves Contents</td>
<td>The contents follow the moved start or end of the event (see the figure below).</td>
</tr>
<tr>
<td>Sizing Applies Time Stretch</td>
<td>The contents will be time stretched to fit the new event length (see separate description on page 127).</td>
</tr>
</tbody>
</table>

To select one of the resizing modes, select the Arrow tool and then click again on the Arrow tool icon on the toolbar. This opens a pop-up menu from which you can select one of the resizing mode options.

The icon on the toolbar will change, indicating the selected resizing mode.

The actual resizing is done by clicking and dragging the lower left or right corner of the event. If Snap is activated, the Snap value determines the resulting length (see page 140).

Normal sizing.
CUBASE SX/SL

5 – 126 The Project window

Sizing moves contents.

• If several events are selected, all will be resized in the same way.

• You can also resize events with the Scrub tool. This works just the same as when resizing with the Arrow tool, but the audio under the pointer is played back (scrubbed) while you drag.

• It is also possible to resize events by using the Trim buttons (located in the Nudge palette) on the toolbar. This will move the start or end position of the selected Event(s) by the amount set on the Grid pop-up menu. The sizing type currently selected applies to this method too, with the exception of “Sizing Applies Time Stretch” which is not possible with this method. You can also use key commands for this (by default, press [Ctrl] (Windows) or [Command] (Mac) and use the left and right arrow key).

• Note that the Nudge palette is not visible in the toolbar by default. See page 792 for instructions on how to show and hide items in the toolbar.
Resizing events using time stretch

If you want to resize a part and make its contents “fit” the new size, you should use this option. Proceed as follows:

1. Click the Arrow icon on the toolbar and select the “Sizing Applies Time Stretch” option from the pop-up menu.
2. Point close to the end point of the part you want to stretch.
3. Click and drag left or right.
   When you move the mouse, a tooltip information shows the current mouse position and length of the part. Note that the snap value applies, as with any part operation.

   ![Image of mouse movement example]

4. Release the mouse button.
   The part is “stretched” or “compressed” to fit the new length.

   ![Image of resized part]

- For MIDI parts, this means that the note events are stretched (moved and resized).
  Controller data will be moved.

- For audio parts, this means that the events are moved, and that the referenced audio files are time stretched to fit the new length.
  A dialog box shows the progress of the time stretch operation.

- You can adjust which algorithm should be used for the time stretch algorithm on the Preferences page (Editing–Audio–Time Stretch Tool page).
  For more information about time stretch, see page 349.
Sliding the contents of an event or part

You can move the contents of an event or part without changing its position in the Project window. By default, this is done by pressing [Ctrl]/[Command]+[Alt]/[Option], clicking in the event or part and dragging to the left or right.

When sliding the contents of an audio event, you cannot slide past the start or end of the actual audio clip. If the event plays the whole clip, you cannot slide the audio at all.

Grouping Events

Sometimes it is useful to treat several events as one unit. This can be done by grouping them: Select the events (on the same or different Tracks) and select "Group" from the Edit menu.

Grouped events are indicated by a “g” in the upper right corner.

If you edit one of the grouped events in the Project window, all other events in the same group are affected too (if applicable). Group editing operations include:

- Selecting events.
- Moving and duplicating events.
- Resizing events.
- Adjusting fade-in and fade-out (audio events only, see page 166).
- Splitting events (splitting one event will automatically split any other grouped events that are intersected by the split position).
- Locking events.
- Muting events (see below).
- Deleting events.
**Locking events**

If you want to make sure you don’t edit or move an event by accident, you can lock it. Locking can affect one (or any combination) of the following properties:

<table>
<thead>
<tr>
<th>Lock Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Position</td>
<td>If this is locked, the event cannot be moved.</td>
</tr>
<tr>
<td>Size</td>
<td>If this is locked, the event cannot be resized.</td>
</tr>
<tr>
<td>Other</td>
<td>If this is locked, all other editing of the event is disabled. This includes adjusting the fades and event volume, processing, etc.</td>
</tr>
</tbody>
</table>

- To specify which of these properties should be affected by the Lock function, use the “Lock Event Attributes” pop-up menu in the Preferences dialog (Editing page).
- To lock events, select them and select “Lock...” from the Edit menu. The events will be locked according to the options specified in the Preferences dialog.
- You can adjust the lock options for a locked event by selecting it and selecting “Lock...” from the Edit menu again. This opens a dialog in which you can activate or deactivate the desired lock options.
- To unlock an event (turn off all lock options), select it and select “Unlock” from the Edit menu.
- It is also possible to lock a whole track, by clicking the padlock symbol in the Track list or in the Inspector. This disables all editing of all events on the track.
Muting events

You can Mute individual events in the Project window in the following ways:

- To mute or unmute a single event, click on it with the Mute tool.

- To mute or unmute several events, select them – either by using the standard selection techniques, or by using one of the options on the Edit–Select submenu – and click on one of the selected events with the Mute tool. All selected events will be muted.

- You can also click in an empty area with the Mute tool and drag a selection rectangle around several events you want to mute or unmute, and then click on one of them with the Mute tool.

- You can mute events by selecting them and selecting "Mute" from the Edit menu. Similarly, you can unmute the selected events by selecting "Unmute" from the Edit menu.

- You can also change the mute status of selected events on the info line. Muted events can be edited as usual (with the exception of adjusting fades), but are not played back.

Muted events are “greyed out”.

- You can also mute whole tracks by clicking the Mute (“M”) button in the Track list, the Inspector or the mixer. Clicking the Solo (“S”) button for a track mutes all other tracks. Note that there are two modes for the track solo function:
  - If the option “Enable Solo on Selected Track” is activated in the Preferences (Editing page) and you have soloed a track, selecting another track in the track list will automatically solo that track instead – the solo state “moves” with the track selection.
  - If the option isn’t activated, the track you solo stays soloed, regardless of the selection.
Removing events

To remove an event from the Project window, use any of the following methods:

- Click on the event with the Eraser tool.
  Note that if you press [Alt]/[Option] while you click, all following events on the same track will be deleted, but not the event you clicked and all events before it.
- Select the event(s) and press [Backspace], or select “Delete” from the Edit menu.

Creating new files from events

As described in the Getting Started book, an audio event plays a section of an audio clip, which in turn refers to one or more audio files on the hard disk. However, in some situations you may want to create a new file that consists only of the section played by the event. This is done with the function “Bounce Selection” on the Audio menu:

1. Select one or several audio events.
2. Set up fade in, fade out and event volume (on the info line or using the volume handle) as desired.
   These settings will be applied to the new file. For details on fades and event volume, see page 166.
3. Select “Bounce Selection” from the Audio menu.
   You are asked whether you want to replace the selected event or not.
   - If you click “Replace”, a new file is created, containing only the audio in the original event. A clip for the new file is added to the Pool, and the original event is replaced by a new event playing the new clip.
   - If you click “No” a new file is created and a clip for the new file is added to the Pool.
     The original event is not replaced.

   You can also apply the Bounce Selection function to an audio part. In that case, the audio from all events in the part will be combined into a single audio file. If you choose “Replace” when asked, the part will be replaced with a single audio event playing a clip of the new file.
Editing in Lane Display mode

When you are recording in Stacked cycle recording mode, each take ends up on a separate lane on the track as described on page 59 and page 72. However, you can also select this lane mode manually for individual tracks, and use it when editing in the Project window. This makes it easier to view and handle overlapping events and parts.

Audio tracks

1. Make sure the Lane Display Type button is visible in the track list. If it is hidden, you need to select Track Controls Settings from the context menu for the track and add the Lane Display Type item in the dialog that appears.

2. Click the Lane Display Type button and select “Lanes Fixed” from the pop-up menu that appears. The audio track is divided vertically into two lanes. By default, all audio events end up in the first (top) lane.

3. Now you can move events or parts between lanes, either by dragging or by using the “Move to Next Lane/Previous Lane” commands on the Edit menu or Quick menu. Note that if there are overlapping audio events, the audio on the lowest lane has playback priority – moving events between lanes affects what will be heard!

If the vertical zoom factor is sufficiently high, the sections that will be heard on playback are indicated in green.
• Note that there will always be an extra, empty lane at the bottom of the track – if you move an event there, another lane will be added and so on. Depending on the number of lanes used, you may want to adjust the vertical zoom for the track – simply drag the track edges in the track list.

4. After rearranging the overlapping events so that you hear what you want, you can select all events and select "Delete Overlaps" from the Advanced submenu on the Audio menu. This puts all events in the top lane and resizes events so that overlapping sections are removed.

5. To turn off Lanes mode, select “Lanes Off” from the Lane Display Type pop-up menu. If you do this without using the "Delete Overlaps" function, all overlapping sections will be kept. However, the sections that were green will now be the sections visible (“on top”) and thus the sections that will be heard.
MIDI tracks

1. Make sure the Lane Display Type button is visible in the track list. If it is hidden, you need to select Track Controls Settings from the context menu for the track and add the Lane Display Type item in the dialog that appears.

2. Click the Lane Display Type button and select “Lanes Auto” or “Lanes Fixed”.
   - In Lanes Auto mode, extra lanes will automatically be added where necessary – if two MIDI parts overlap, they will automatically be put on separate lanes.
   - In Lanes Fixed mode, you have to move MIDI parts between lanes manually (by dragging them or by using the “Move to Next Lane/Previous Lane” commands on the Edit menu or Quick menu).
     In this mode, there will always be an extra, empty lane at the bottom of the track – if you move a part there, another lane will be added and so on.

3. You can edit the overlapping parts as usual – by cutting, deleting or muting sections in the Project window or by opening them in a MIDI editor.
   In an editor, parts on different lanes will be treated just like parts on different tracks – you can use the part list pop-up menu to select an active part for editing, etc.
   Note that there is no playback priority between lanes on a MIDI track – all unmuted parts will be heard during playback.

4. To merge all overlapping parts into one, make sure the MIDI track is selected, position the left and right locator around the parts and select “Merge MIDI in Loop” from the MIDI menu.
   In the dialog that appears, activate the Erase Destination option and click OK. This merges all unmuted MIDI between the locators to a single part.

5. To turn off Lanes mode, select “Lanes Off” from the Lane Display Type pop-up menu.
Range editing

Editing in the Project window isn’t necessarily restricted to handling whole events and parts. You can also work with selection ranges, which are independent from the event/part and track boundaries.

Creating a selection range

To make a selection range, drag with the Range Selection tool.

When the Range Selection tool is selected, the Select submenu on the Edit menu has the following items for making selection ranges:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>All</td>
<td>Makes a selection that covers all tracks, from the start of the project to the end (as defined by the Length setting in the Project Setup dialog).</td>
</tr>
<tr>
<td>None</td>
<td>Removes the current selection range.</td>
</tr>
<tr>
<td>Invert</td>
<td>Only used for event selection (see page 119).</td>
</tr>
<tr>
<td>In Loop</td>
<td>Makes a selection between the left and right locator, on all tracks.</td>
</tr>
<tr>
<td>From Start to Cursor</td>
<td>Makes a selection on all tracks, from the start of the project to the project cursor.</td>
</tr>
<tr>
<td>From Cursor to End</td>
<td>Makes a selection on all tracks, from the project cursor to the end of the project.</td>
</tr>
<tr>
<td>All on Selected Tracks</td>
<td>Only used for event selection (see page 119).</td>
</tr>
<tr>
<td>Select Event</td>
<td>This is available in the Sample Editor (see page 376).</td>
</tr>
<tr>
<td>Left Selection Side to Cursor</td>
<td>Moves the left side of the current selection range to the project cursor position.</td>
</tr>
<tr>
<td>Right Selection Side to Cursor</td>
<td>Moves the right side of the current selection range to the project cursor position.</td>
</tr>
</tbody>
</table>

- Double clicking on an event with the Range Selection tool creates a selection range encompassing the event.
  If you hold down [Shift] you can double click several events in a row, and the selection range will expand to encompass them all. Double clicking a second time on an event opens it for editing in the Sample Editor.
Adjusting the size of the selection range

You can adjust the size of a selection range in the following ways:

• By dragging its edges.
  The pointer takes the shape of a double arrow when you move it over an edge of the selection range.

• By holding down [Shift] and clicking.
  The closest selection range edge will be moved to the position at which you clicked.

• By adjusting the selection range start or end position on the info line.

• By using the Trim buttons on the toolbar.
  The left Trim buttons will move the start of the selection range and the right buttons will move the end. The edges will be moved by the amount specified on the Grid pop-up.

❐

This Trim button will move the end of the selection range to the right by 1 beat.

• By using the Nudge buttons on the toolbar.
  These will move the whole selection range to the left or the right. The amount of movement depends on the selected display format (see page 99) and the value specified on the Grid pop-up menu.

Note that the contents of the selection are not moved – using the Nudge buttons is the same as adjusting the start and end of the selection range at the same time, by the same amount.

• The Trim buttons and the Nudge buttons are located in the Nudge palette, which is not visible in the toolbar by default.
  See page 792 for instructions on how to show and hide items in the toolbar.
Making selection ranges for several non-contiguous tracks

As described above, selection ranges can cover several tracks. However, it is also possible to exclude tracks from a selection range:

1. Create a selection range from the first to the last desired track.
2. Press [Ctrl]/[Command] and click in the selection range on the tracks you want to exclude from the selection.

3. In the same manner, you can add a track to the selection range by [Ctrl]/[Command]-clicking in the selection range area on the track.

Moving and duplicating

• To move a selection range, click and drag it to a new position. This will move the contents of the selection range to the new position. If the range intersected events or parts, these will be split before moving, so that only the sections within the selection range are affected.

• To duplicate a selection range, hold down [Alt]/[Option] and drag. You can also use the Duplicate, Repeat and Fill Loop functions, just as when duplicating events (see page 122).
Using Cut, Copy and Paste

When working with selection ranges, you can either use Cut, Copy and Paste on the Edit menu, or use the functions "Cut Time" and "Paste Time" on the Range submenu on the Edit menu. These work differently to their related functions on the Edit menu:

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cut</td>
<td>Cuts out the data in the selection range and moves it to the Clipboard. The selection range is replaced by empty track space in the Project window, meaning that events to the right of the range keep their positions.</td>
</tr>
<tr>
<td>Copy</td>
<td>Copies the data in the selection range to the clipboard.</td>
</tr>
<tr>
<td>Paste</td>
<td>Pastes the clipboard data at the start position and track of the current selection. Existing events are not moved to make room for the pasted data.</td>
</tr>
<tr>
<td>Paste at Origin</td>
<td>Pastes the clipboard data back at its original position. Existing events are not moved to make room for the pasted data.</td>
</tr>
<tr>
<td>Cut Time</td>
<td>Cuts out the selection range and moves it to the Clipboard. Events to the right of the removed range are moved to the left to fill out the gap.</td>
</tr>
<tr>
<td>Paste Time</td>
<td>Pastes the clipboard data at the start position and track of the current selection. Existing events are moved to make room for the pasted data.</td>
</tr>
<tr>
<td>Paste Time at Origin</td>
<td>Pastes the clipboard data back at its original position. Existing events are moved to make room for the pasted data.</td>
</tr>
</tbody>
</table>

Deleting selection ranges

Again, you can either use "regular" Delete or "Delete Time":

- If you use the Delete function on the Edit menu (or press [Backspace]), the data within the selection range is replaced by empty track space. Events to the right of the range keep their position.
- If you use "Delete Time" on the Edit menu's Range submenu, the selection range is removed and events to the right are moved to the left to close up the gap.
Other functions

On the Range submenu on the Edit menu, you will find three more range editing functions:

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Split</td>
<td>Splits any events or parts that are intersected by the selection range, at the positions of the selection range edges.</td>
</tr>
<tr>
<td>Crop</td>
<td>All events or parts that are partially within the selection range are cropped, that is, sections outside the selection range are removed. Events that are fully inside or outside the selection range are not affected.</td>
</tr>
<tr>
<td>Insert Silence</td>
<td>Inserts empty track space from the start of the selection range. The length of the silence equals the length of the selection range. Events to the right of the selection range start are moved to the right to &quot;make room&quot;. Events that are intersected by the selection range start are split, and the right section is moved to the right.</td>
</tr>
</tbody>
</table>

Region operations

Regions are sections within a clip, with various uses. While regions are perhaps best created and edited in the Sample Editor (see page 379), the following region functions are available on the Audio menu in the Project window:

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Event or Range as Region</td>
<td>This function is available when one or several audio events or selection ranges are selected. It creates a region in the corresponding clip, with the start and end position of the region determined by the start and end position of the event or selection range within the clip.</td>
</tr>
<tr>
<td>Events from Regions</td>
<td>This function is available if you have selected an audio event whose clip contains regions within the boundaries of the event. The function will remove the original event and replace it with event(s) positioned and sized according to the Region(s).</td>
</tr>
</tbody>
</table>
Options

Snap

The Snap function helps you to find exact positions when editing in the Project window. It does this by restricting horizontal movement and positioning to certain positions. Operations affected by Snap include moving, copying, drawing, sizing, splitting, range selection, etc.

• You turn Snap on or off by clicking the Snap icon in the toolbar.

Snap activated.

• When you are moving audio events with Snap activated, it isn't necessarily the beginning of the event that is used as Snap position reference. Instead, each audio event has a snap point, which you can set to a relevant position in the audio (such as a downbeat, etc.).

The snap point is preferably set in the Sample Editor since it will allow for a higher degree of precision (see page 374). You can however also set the snap point directly in the Project window, in the following way:

1. Select an event.

2. Place the project cursor at the desired position within the selected audio event.

3. Pull down the Audio menu and select “Snap Point To Cursor”.

The snap point is set at the cursor position.

The snap point for an event is displayed as a blue line in the Project window.
Exactly how Snap works depends on which mode is selected on the Snap mode pop-up menu.

The following sections describe the different Snap modes:

Grid

In this mode, the Snap positions are set with the Grid pop-up menu to the right. The options depend on the display format selected for the ruler. For example, if the ruler is set to show bars and beats, the grid can be set to bars, beats or the quantize value set with the next pop-up menu to the right. If a time- or frame-based ruler format is selected, the grid pop-up menu will contain time- or frame-based grid options, etc.

Events

In this mode, the start and end positions of other events and parts become "magnetic". This means that if you drag an event to a position near the start or end of another event, it is automatically aligned with the start or end of the other event. For audio events, the position of the snap point is also magnetic (see page 374).

- Note that this includes marker events on the marker track. This allows you to snap events to marker positions, and vice versa.
Shuffle

Shuffle mode is useful when you want to change the order of adjacent events. If you have two adjacent events and drag the first one to the right, past the second event, the two events will change places.

The same principle works when changing the order of more than two events:

Dragging event 2 past event 4...

...changes the order of events 2, 3 and 4.

Magnetic Cursor

When this mode is selected, the project cursor becomes "magnetic". Dragging an event near the cursor causes the event to be aligned with the cursor position.

Grid + Cursor

This is a combination of the “Grid” and “Magnetic Cursor” modes.

Events + Cursor

This is a combination of the “Events” and “Magnetic Cursor” modes.

Events + Grid + Cursor

This is a combination of the “Events”, “Grid” and “Magnetic Cursor” modes.
Snap to Zero Crossing

When this option is activated in the Preferences dialog (Editing–Audio page), splitting and sizing of audio events is done at zero crossings (positions in the audio where the amplitude is zero). This helps you avoid pops and clicks which might otherwise be caused by sudden amplitude changes.

- This setting affects all windows in all open projects – with the exception of the Sample Editor (which has its own Snap to Zero Crossing button).

Autoscroll

Autoscroll activated.

When this option is activated, the waveform display will scroll during playback, keeping the project cursor visible in the window.

- If the option “Stationary Cursor” is activated in the Preferences dialog (Transport page), the project cursor will be positioned in the middle of the screen (if possible).
Folder tracks
About folder tracks

Just as the name implies, a folder track is a folder that contains other tracks. Moving tracks into a folder is a way to structure and organize tracks in the Project window. For example, grouping several tracks in a folder track makes it possible for you to “hide” tracks (thus giving you more working space on the screen). You can solo and mute several tracks in a quicker and easier way, and perform editing on several tracks as one entity. Folder tracks can contain any type of track including other folder tracks.
Handling folder tracks

Creating a folder track

Folder tracks are created just like any other track: Select “Add Track” from the Project menu and select “Folder” from the submenu that appears.

Moving tracks into a folder

You can move any type of track into a folder by using drag and drop:

1. In the Track list, click on a track that you want to move into a folder, and drag it onto a folder track.
   A green arrow pointing to a folder appears when you drag the track onto the folder track in the list.

2. Release the mouse button.
   The track is now placed in the folder track, and all parts and events on the track will be represented by a corresponding folder part (see page 149), that is a graphical representation of all parts and events in the folder.

Since you can move any type of track into a folder track, it is possible to create sub-folders by moving one folder track into another. This is called “nesting”. For example, you could have a folder containing all the vocals in a project, and each vocal part could have a nested folder containing all the takes, in a subfolder for easier handling etc.
Removing tracks from a folder

To remove a track from a folder, simply drag it out of the folder and release it in the Track list.

Hiding/showing tracks in a folder

You can hide or show the tracks located in a folder by clicking on the “Show/Hide” button (the plus sign) in the Track list for the folder track. Hidden tracks are still played back as usual.

When a folder is “closed” this way, the folder part(s) still give you a graphic representation of the parts and events within the folder.

Muting and soloing folder tracks

One of the main advantages of using folder tracks is that they provide you with a way to mute and solo several tracks as one unit. Muting and soloing a folder track affects all tracks in the folder. You can also solo or mute individual tracks in the folder.

Muting a folder track

You can mute a folder track (and thereby mute all tracks within it) the same way you mute other tracks by clicking in the Mute ("M") button in the Track list.

Soloing a folder track

You can solo a folder track (and thereby mute all tracks outside the folder) the same way you solo other tracks, by selecting it and clicking the Solo button.

Soloing or muting tracks within a folder

This can be done by showing the tracks in the folder and using the Mute and Solo buttons in the Track list as usual for any tracks inside the folder.
Working with folder parts

A folder part is a graphic representation of events and parts on the tracks in the folder. Folder parts indicate the position and length of the events and parts, as well as on which track they are (their vertical position). If part colors are used, these are also shown in the folder part.

Folder parts are created automatically when there are parts or events on the tracks within the folder. The following rules apply:

- If there is a gap between parts/events on the tracks, there will be two separate folder parts.
- Parts or events that overlap within the folder may be represented by the same folder part or by two different folder parts – depending on how much they overlap. If a part/event overlaps by half its length or less it will be placed in a new folder part.

The MIDI part overlaps the audio events by more than half its length, which means it is included in the same folder part.
If you move the MIDI part slightly to the right, the overlap is less than half its length. This means a new folder part is created.

Handling and editing folder parts

Any Project window editing you perform to a folder part affects all its contained events and parts (those elements on the track within the folder that are represented by the folder part). You can select several folder parts if you like – this allows you to handle and edit them together. The editing you can perform includes:

- Moving a folder part. This will move its contained events and parts (possibly resulting in other folder parts, depending on how the parts overlap).
- Using cut, copy and paste.
- Deleting a folder part. This will delete its contained events and parts.
- Splitting a folder part with the Scissors tool (see the example below).
- Gluing folder parts together with the Glue tube tool. This will only work if the adjacent folder parts contain events or parts on the same track.
- Resizing a folder part resizes the contained events and parts according to the selected resizing method. This is set by clicking the Arrow tool icon on the toolbar and selecting either “Normal Sizing” or “Sizing Moves Contents” from the pop-up menu – see page 125. The third option on the pop-up, “Sizing Applies Time Stretch” cannot be used to resize folder parts.
- Muting a folder part. This will mute its contained events and parts.

In short, most of the editing you can do in the Project window applies to folder parts as well.
An example

Splitting the folder part with the Scissors tool...

...will split all contained parts or events present at that position.

Editing tracks within folder parts

Tracks inside a folder can be edited as one entity, by performing the editing directly on the folder part containing the tracks as explained above. You can also edit individual tracks within the folder, by showing the contained tracks, selecting parts and opening editors as usual.

Double clicking a folder part opens the editors for the corresponding track classes present in the folder. The following applies:

- All MIDI parts located on the tracks within the folder are displayed as if they were on the same track, just like when opening the Key Editor with several MIDI parts selected.
  
  To be able to easily discern the different tracks in the editor, give each track a different color in the Project window and use the “Part Colors” option in the editor (see page 605).

- If the folder contains tracks with audio events and/or audio parts, the Sample and/or Audio Part Editors are opened, with each audio event and audio part in a separate window.
CUBASE SX/SL
6 – 152 Folder tracks
7

Using markers
About markers

Markers are used to quickly locate any position. If you often find yourself jumping to a specific position, you can set up that position as a marker. There are two types of markers:

- Cycle markers, which allow you to store the start and end positions of a range.
- Standard markers which store a specific position.

Markers can be created and edited in several ways:

- By using the Marker window (see below).
- By using the Marker track (see page 158).
- By using key commands (see page 163).
- By using the Project Browser (see page 164).

• The left and right locators are handled separately – see page 32.

The Marker window

In the Marker window you can perform most editing operations concerning markers. Markers are displayed sequentially starting from the top of the window in the order that they occur in the project. Most functions in the Marker window are also available in the Inspector when the Marker track is selected.

To open the Marker window, select “Markers” from the Project menu, click the “Show” button in the Marker section on the Transport panel or use the key command (by default [Ctrl]/[Command]-[M]).
The Marker window columns

The Marker window is divided into six columns which are used for performing the following operations:

- The leftmost column is the Locate column. Clicking in this column will move the project cursor to the corresponding Marker position. A blue arrow indicates the Marker at the project cursor position (or the closest marker before the project cursor).

- The ID column is used to edit marker ID-numbers. See page 157.

- The Position column displays the markers' time positions (or start positions for cycle markers). The marker positions can be edited directly in this column.

- The End and Length columns display the end positions and length of cycle markers – see page 158. These values can also be edited directly in the respective column.

- The Description column lets you enter names or descriptions for markers.

Adding and removing markers in the Marker window

You add position markers (in Stop mode, during playback or during recording) by clicking the Add button or by pressing [Insert] on the computer keyboard. Markers are always added at the current project cursor position.

- To add a cycle marker, select “Cycle Markers” from the Show pop-up menu and click the Add button. This adds a cycle marker between the left and right locator. You can also draw cycle markers on the Marker track (see page 159).

- To remove a marker, select it and click the Remove button.
Moving marker positions in the Marker window

The Move button in the Marker window can be used to "reprogram" marker positions. Proceed as follows:

1. Set the project cursor to the position to which you want to move (or re-program) a marker.

2. Select the marker which you want to change in the Marker window.
   Do not select the marker by clicking in the leftmost column, as this will move the project cursor you set up in the previous step.

   • If a cycle marker is selected, the Move operation affects the cycle marker start position.
     The length of the range is not affected.

3. Click the Move button.
   You can also move markers by editing their position numerically in the Position column.
About marker ID-numbers

Each time you add a marker it is automatically and sequentially assigned an ID-number, starting from ID 1 and onwards. ID numbers can be changed at any time if needed – this allows you to assign specific markers to key commands (see below).

IDs for cycle markers are shown in brackets and start from [1]. These may also be changed, for the same reason.

Assigning markers to key commands

As explained earlier, marker ID-numbers are assigned automatically and sequentially each time you add a marker. The nine first markers (1-9) can be recalled by using key commands – by default these are [Shift]-[1] to [9] on the typewriter part of the keyboard. This means that even if you have more than nine markers, you cannot use key commands to navigate to markers numbered 10 or higher.

If you want to keep all current markers, but want to specify which markers should be accessed with key commands, the solution is to reassign the marker ID-numbers. Proceed as follows:

1. First decide which of the current markers with an ID between 1 and 9 you want to reassign to a new ID-number, and thus remove its key command assignment.
   Memorize the ID-number.

2. Type in this ID-number in the ID column of the marker you want to access with a key command and press enter.
   The two marker ID-numbers are switched, and the key commands now locates to the marker selected in this step.

3. Repeat as necessary for other markers.
   - You can also simply remove a marker with an ID-number between 1 to 9 to free up a key – see page 155.
   - For more about marker key commands, see page 163.
Using the Marker track

The Marker track is used for viewing and editing markers. Markers shown on the Marker track are exactly the same as shown in the Marker window, and any changes made on the Marker track are reflected in the Marker window and vice versa. Standard position markers in the Marker track are shown as marker events, vertical lines with the marker name (if assigned) and number beside it. If you select the Marker track, all markers are shown in the Inspector, much like in the Marker window.

About cycle markers

Cycle markers are shown on the Marker track as two markers bridged by a horizontal line. Cycle markers are ideal for storing sections of a project. By setting cycle markers for sections of a song, for example “Intro”, “Verse”, “Chorus” etc., this enables you to quickly navigate to the song sections, and also to optionally repeat the section (by activating Cycle on the Transport panel).

In addition, Cycle markers appear on the horizontal Zoom pop-up menu in the Project window. If you select a Cycle marker from the pop-up menu, the screen is automatically zoomed to encompass the Cycle marker range.

Opening the Marker track

To open the Marker track, select “Marker” from the Project menu – Add Track submenu. You can only have one Marker track in a project.
Editing markers on the Marker track

The following basic editing functions can be performed directly on the Marker track:

- Adding position markers “on the fly”. Use the [Insert] key or the “Add Marker” button in the Track list for the Marker track to add position markers at the current cursor position during playback.

- Adding a cycle marker at the left and right locator positions. Clicking the “Add Cycle Marker” button in the Track list for the Marker track adds a cycle marker spanning the area between the left and right locator.

- Selecting markers. You can use standard selection techniques like dragging to make a selection rectangle or using [Shift] to select separate markers.

- Drawing position markers. By clicking with the Pencil tool (or pressing [Alt]/[Option] and clicking with the Arrow tool), you can create or “draw” position marker events at any position on the track. If snap is activated on the toolbar, this determines at which positions you can draw markers.

- Drawing cycle markers. To draw a cycle marker range, you press [Ctrl]/[Command] and use the Pencil tool or the Arrow tool. Snap settings are applied if activated.

- Cycle markers can freely overlap.

Add Marker/Add Cycle Marker buttons
• **Resizing a cycle marker.**
  Select a cycle marker by clicking on it. As you can see, two handles appear at the bottom of the start and end events. If you click and hold one of the handles you can drag the event left or right to resize the cycle marker. This can also be done numerically on the info line.

• **Moving markers.**
  Click and drag to move the selected markers, or edit marker positions on the info line. As usual, snap is taken into account if activated.

• **Removing markers.**
  This is done exactly the same way as for other events, i.e. by selecting and pressing [Delete], using the Erase tool etc.

• **Naming markers.**
  A selected marker’s name can be edited by clicking the name on the info line.
Navigating using cycle markers

Cycle markers represent ranges rather than single positions. Therefore you don’t use them for moving the project cursor, but for moving the left and right locators:

- If you double click on a cycle marker, or select it from the Cycle pop-up menu in the Track list, the left and right locators are moved to encompass the cycle marker.
  To move the project cursor position to the start or the end of the cycle marker, move it to the corresponding locator (e.g. by using the numeric pad keys [1] and [2]).

- You can also use key commands for this – see page 163.

Zooming to cycle markers

- By selecting a cycle marker on the Zoom pop-up menu, the event display is zoomed in to encompass the selected range only.
  You can also do this by pressing [Alt]/[Option] and double clicking on the cycle marker in the event display.

Editing cycle markers using tools

Cycle markers can be edited on the Marker track using the following tools. Note that the snap value applies as with regular events:

<table>
<thead>
<tr>
<th>Tool</th>
<th>Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pencil</td>
<td>Press [Ctrl]/[Command] and use the Pencil tool to create new ranges (as described above).</td>
</tr>
<tr>
<td>Eraser</td>
<td>Click with the Eraser tool to delete a cycle marker. If you hold down [Alt]/[Option] when you click, all consecutive markers will also be deleted.</td>
</tr>
<tr>
<td>Selection Range</td>
<td>This is described on page 162.</td>
</tr>
</tbody>
</table>

The other tools cannot be used with cycle markers.
Using markers to make range selections in the Project window

Besides enabling you to quickly move the project cursor and locators, markers can be used in conjunction with the Range Selection tool to make range selections in the Project window. This is useful if you quickly want to make a selection that spans all tracks in the project.

- Double click with the Range Selection tool between any two markers – this creates a selection range between the markers, spanning all tracks in the project (just as if you had used the Range Selection tool to draw a rectangle).

Any functions or processing you perform will now affect the selection only.

Moving and Copying sections

This is a quick way to move or copy complete sections of the project (on all tracks):

1. Set markers at the start and end of the section you want to move or copy.

2. Select the Range Selection tool and double click on the Marker track between the markers.

   Everything in the project within the cycle marker boundaries is selected.

3. Click on the Marker track in the selected range and drag the range to a new position.

   The selection in the Project window is moved to the same position.

- If you hold down [Alt]/[Option] while you drag the range, the selection in the Project window is copied instead.
Marker key commands

You can use key commands for the following marker operations:

<table>
<thead>
<tr>
<th>Operation</th>
<th>Description</th>
<th>Default key</th>
</tr>
</thead>
<tbody>
<tr>
<td>Insert Marker</td>
<td>Creates a new marker at the current project</td>
<td>[Insert]/[Help]</td>
</tr>
<tr>
<td></td>
<td>cursor position.</td>
<td></td>
</tr>
<tr>
<td>Locate Next Marker</td>
<td>Moves the project cursor to the right to the</td>
<td>[Shift]-[N]</td>
</tr>
<tr>
<td></td>
<td>next marker position (if any).</td>
<td></td>
</tr>
<tr>
<td>Locate Previous Marker</td>
<td>Moves the project cursor to the left to the</td>
<td>[Shift]-[B]</td>
</tr>
<tr>
<td></td>
<td>previous marker position (if any).</td>
<td></td>
</tr>
<tr>
<td>To Marker 1-9</td>
<td>Moves the project cursor to the specified</td>
<td>[Shift]-[1] to [9]</td>
</tr>
<tr>
<td></td>
<td>marker (number 1 to 9).</td>
<td></td>
</tr>
<tr>
<td>Set Marker 1-9</td>
<td>Moves the specified marker (number 1 to 9) to</td>
<td>[Ctrl]-[1] to [9]</td>
</tr>
<tr>
<td></td>
<td>the current project cursor position.</td>
<td></td>
</tr>
<tr>
<td>Recall Cycle Marker 1-9</td>
<td>Moves the left and right locators to</td>
<td>[Shift]-[Pad1] to [Pad9]</td>
</tr>
<tr>
<td></td>
<td>encompass the specified cycle marker (1 to 9).</td>
<td></td>
</tr>
</tbody>
</table>

If you need to change the key command assignments, the marker commands can be found in the Transport category in the Key Commands dialog.

- For the [Shift]-[Pad1] to [Pad9] commands to work, Num Lock must be deactivated on the computer keyboard!
Editing markers in the Project Browser

To view and edit markers in the Project Browser, the Marker track must be added to the Project window.

If you have a Marker track in the Project window, you can create and edit all marker parameters, including marker ID’s, in the Project Browser. Proceed as follows:

1. Open the Project Browser by selecting it on the Project menu.
2. Select “Marker” in the Project Structure window.
   A list of the markers is shown in the main Browser window.
3. Now you can edit marker names, positions and ID numbers, by selecting an item and typing in values as usual in the main editor window.
   For details about editing in the Project Browser see page 663.

- You can use the Add pop-up menu and Add button to insert new markers or cycle markers when the Marker track is selected in the Project Browser.
  This works just like the Add button in the Marker window (see page 155).
8

Fades and crossfades
Creating fades

There are two main types of fade-ins and fade-outs in audio events in Cubase SX/SL: fades created by using the fade handles (see below) and fades created by processing (see page 169).

Fades created by using the fade handles

Selected audio events have blue handles in the upper left and right corners. These can be dragged to create a fade-in or fade-out respectively.

Creating a fade-in. The fade is automatically reflected in the shape of the event’s waveform, giving you a visual feedback of the result when you drag the fade handle.

Fades created with the handles are not applied to the audio clip as such but calculated in real time during playback. This means that several events referring to the same audio clip can have different fade curves. It also means that having a huge number of fades may demand a lot of processor power.

- If you select multiple events and drag the fade handles on one of them, the same fade will be applied to all selected events.
- A fade can be edited in the Fade dialog, as described on the following pages. You open the dialog by double clicking in the area above the fade curve, or by selecting the event and selecting “Open Fade Editor(s)” from the Audio menu (note that this will open two dialogs if the event has both fade-in and fade-out curves).
  If you adjust the shape of the fade curve in the Fade dialog, this shape will be maintained when you later adjust the length of a fade.
- You can make the fade longer or shorter at any time, by dragging the handle. You can actually do this even without selecting the event first, i.e. without visible handles. Just move the mouse pointer along the fade curve until the cursor turns into a bi-directional arrow, then click and drag.
- If the option “Show Event Volume Curves Always” is activated in the Preferences dialog (Event Display–Audio page), the fade curves will be shown in all events, regardless of whether they are selected or not. If the option is deactivated, the fade curves are shown in selected events only.
• As an alternative to dragging the fade handles, you can use the items “Fade In to Cursor” and “Fade Out to Cursor” on the Audio menu to create fades (Cubase SX only).

Position the project cursor on an audio event where you want a fade in to end or a fade out to begin, and select the appropriate option from the Audio menu. A fade will then be created, ranging from the event’s start or end to the position of the cursor.

Creating and adjusting fades with the Range Selection tool

“Handle-type” fades can also be created and adjusted with the Range Selection tool, in the following way:

1. Select a section of the audio event with the Range Selection tool.
   The result depends on your selection, in the following way:
   • If you select a range from the beginning of the event, a fade-in will be created within the range.
   • If you select a range that reaches the end of an event, a fade-out will be created in the range.
   • If you select a range encompassing a middle section of the event, but not reaching neither the start nor the end, both a fade-in and a fade-out will be created outside of the selected range. In other words, the fade-in will cover the area from the beginning of the event to the beginning of the selected range, and the fade-out will cover the area from the end of the selected range to the end of the event.

2. Pull down the Audio menu and select “Adjust Fades to Range”.
   The fade areas are adjusted according to the selection range.

† You can select multiple audio events on separate tracks with the Range Selection tool, and apply the fade to all of them simultaneously.
About the volume handle

A selected audio event also has a blue handle in the top middle. This is the volume handle, and it provides a quick way of changing the volume of an event, directly in the Project window. It stands in direct correlation with the volume setting in the info line, that is, dragging the volume handle also changes the value in the info line.

The volume change is displayed numerically in the info line.

The event waveform reflects the volume change.

Drag the Volume handle up or down to change the volume of the event.

Removing fades

To remove a fade, select the event and select “Remove Fades” from the Audio menu.

You can also use the Range Selection tool to remove fades and crossfades:

1. Drag the Range Selection tool in the Project window, so that the selection encloses all of the fades and crossfades you wish to remove.

2. Select “Remove Fades” from the Audio menu.
Fades created by processing

If you have selected an audio event or a section of an audio event (using the Range Selection tool), you can apply a fade-in or fade-out to the selection by using the “Fade In” or “Fade Out” functions on the Process submenu on the Audio menu. These functions open the corresponding Fade dialog, allowing you to specify a fade curve.

Note that the length of the fade area is determined by your selection. In other words, you specify the length of the fade before you enter the Fade dialog.

Also note that you can select multiple events and apply the same processing to all of them simultaneously.

Fades created this way are applied to the audio clip rather than to the event. This has the following consequences:

• If you later create new events that refer to the same clip, these will have the same fades.
• At any time you can remove or modify the fades using the Offline Process History (see page 355).

If other events refer to the same audio clip, you will be asked whether you want the processing to be applied to these events or not.

• Continue will apply the processing to all events that refer to the audio clip.
• New Version will create a separate, new version of the audio clip for the selected event.
• You can also choose to put a checkmark in the “Do not ask this message again” box. Regardless of whether you then choose “Continue” or “New Version”, any and all further processing you do will conform to the option you select.

You can change this setting at any time in the Preferences dialog (Editing–Audio page), under “On Processing Shared Clips”.

The Fade dialogs

The Fade dialogs appear when you edit an existing fade or use the “Fade In”/“Fade Out” functions on the Audio menu’s Process submenu. The picture below shows the Fade In dialog; the Fade Out dialog has identical settings and features.

If you open the Fade dialog(s) with several events selected, you can adjust the fade curves for all these events at the same time. This is useful if you want to apply the same type of fade-in to more than one event, etc.

Curve Kind

These buttons determine whether the fade curve should consist of spline curve segments (left button) or linear segments (right button).

Fade display

Shows the shape of the fade curve. The resulting waveform shape is shown in dark grey, with the current waveform shape in light grey.

You can click on the curve to add points, and click and drag existing points to change the shape. To remove a point from the curve, drag it outside the display.

Restore button

The Restore button (to the right above the fade display) is only available when editing fades made by dragging the fade handles. Click this to cancel any changes you have made since opening the dialog.
**Curve shape buttons**

These buttons give you quick access to some common curve shapes.

**Default button**

Clicking the “As Default” button stores the current settings as the default fade. This shape will be used whenever you create new fades.

**Presets**

If you have set up a fade-in or fade-out curve that you may want to apply to other events or clips, you can store it as a preset by clicking the Store button.

- To apply a stored preset, select it from the pop-up menu.
- To rename the selected preset, double click on the name and type a new one.
- To remove a stored preset, select it from the pop-up menu and click Remove.

- Stored fade-in presets will only appear in the Fade In dialog, and fade-out presets will only appear in the Fade Out dialog.
**Preview, Apply and Process**

The buttons in the bottom row are different depending on whether you are editing a fade made with the fade handles or applying a fade using processing:

The Edit Fade dialog.

<table>
<thead>
<tr>
<th>Button</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>OK</td>
<td>Applies the set fade curve to the event, and closes the dialog.</td>
</tr>
<tr>
<td>Cancel</td>
<td>Closes the dialog.</td>
</tr>
<tr>
<td>Apply</td>
<td>Applies the set fade curve to the event, without closing the dialog.</td>
</tr>
</tbody>
</table>

The Process Fade dialog.

<table>
<thead>
<tr>
<th>Button</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Preview</td>
<td>Plays back the fade area. Playback will repeat until you click the button again (the button is labeled “Stop” during playback).</td>
</tr>
<tr>
<td>Process</td>
<td>Applies the set fade curve to the clip, and closes the dialog.</td>
</tr>
<tr>
<td>Cancel</td>
<td>Closes the dialog without applying any fade.</td>
</tr>
</tbody>
</table>
Creating crossfades

Overlapping audio material on the same track can be crossfaded, for smooth transitions or special effects. You create a crossfade by selecting two consecutive audio events and selecting the Crossfade command on the Audio menu (or using the corresponding key command, by default [X]). The result depends on whether the two events overlap or not:

- If the events overlap, a crossfade is created in the overlapping area. The crossfade will be of the default shape – initially a linear, symmetric crossfade, but you can change this as described below.

- If the events don’t overlap but are directly consecutive (lined up end-to-start, with no gap) it’s still possible to crossfade them – provided that their respective audio clips overlap! In this case, the two events are resized so that they overlap, and a crossfade of the default length and shape is applied. The default crossfade length and shape are set in the Crossfade dialog (see page 178).
An example:

The events in themselves do not overlap, but their clips do. Therefore, the events can be resized so that they overlap, which is required for a crossfade to be created.

When you select the Crossfade function, the two events are resized so that they overlap, and a default crossfade is created in the overlapping section.

- If the events don’t overlap, and cannot be resized enough to overlap, a crossfade cannot be created.

- Cubase SX only: You can specify the length of the crossfade using the Range Selection tool: make a selection range covering the desired crossfade area and use the Crossfade command. The crossfade is applied in the selected range (provided that the events or their clips overlap, as above). You can also make a selection range after creating the crossfade and use the function Adjust fades to Range on the Audio menu.

- Once you have created a crossfade, you can edit it by selecting one or both crossfaded events, and selecting “Crossfade” from the Audio menu again (or by double clicking in the crossfade zone). This opens the Crossfade dialog, as described below.
Removing crossfades

To remove a crossfade, select the events and select “Remove Fades” from the Audio menu, or use the Range Selection tool:

1. Drag the Range Selection tool in the Project window, so that the selection encloses all of the fades and crossfades you wish to remove.

2. Select “Remove Fades” from the Audio menu.

- You can also remove a crossfade by clicking and dragging it outside the track.
The Crossfade dialog

The Crossfade dialog contains separate settings for the fade-in and fade-out curve in the crossfade, as well as common settings.

The left part of the Crossfade dialog contains two sections with settings for the fade-in and fade-out curves in the crossfade. These two sections have identical settings.

Play buttons

- The “Play Fade Out” and “Play Fade In” buttons allow you to audition the fade-out or fade-in part only, without the crossfade.

- The “Play Crossfade” button plays back the whole crossfade.

You can also use the Transport play controls to play back the cross-faded audio events. However, that method will play back all unmuted audio events on other tracks as well.

Curve kind buttons

These buttons determine whether the corresponding fade curve should consist of spline curves (left button) or linear segments (right button).
Fade Displays

Shows the shape of the fade-out and fade-in curve, respectively. You can click on the curve to add points, and click and drag existing points to change the shape. To remove a point from the curve, drag it outside the display.

Curve shape buttons

These buttons give you quick access to some common curve shapes.

Equal Power and Gain

If you activate the “Equal Power” checkbox, the fade curves are adjusted, so that the energy (power) of the crossfade will be constant all along the crossfade region.

Equal Power curves have only one editable curve point. You cannot use the Curve kind buttons or the presets when this mode is selected.

If you activate the “Equal Gain” checkbox, the fade curves are adjusted so that the summed fade-in and fade-out amplitudes will be the same all along the crossfade region. This is often suitable for short crossfades.

Length settings

You can adjust the length of the crossfade area numerically in the “Length” field. If possible, the length change will be applied equally to “both sides” of the crossfade (i.e. Cubase SX/SL tries to “center” the crossfade).

To be able to resize a crossfade this way, it must be possible to resize the corresponding event. For example, if the left crossfaded event already plays its audio clip to the end, its endpoint cannot be moved any further to the right.
**Default buttons**

Clicking the “As Default” button stores all of the current settings as the default crossfade. These settings will then be used whenever you create new crossfades.

- The Crossfade Length setting is included in the Default settings. However, it is only applied if the events to be crossfaded don’t overlap – otherwise the crossfade will be in the overlap area (see page 173).

Clicking the “Recall Default” button copies the curves and settings in the Default crossfade to the Crossfade dialog.

**Presets**

If you have set up a crossfade shape that you may want to apply to other events, you can store it as a preset by clicking the Store button.

- To apply a stored preset, select it from the pop-up menu.
- To rename the selected preset, double click on the name and type a new one.
- To remove a stored preset, select it from the pop-up menu and click Remove.
Auto Fades and Crossfades

Cubase SX/SL features an Auto Fade function that can be set both globally, i.e. for the entire project, and separately for each audio track. The idea behind the Auto Fade function is to create smoother transitions between events by applying short (1 - 500 ms) fade-ins and fade-outs.

As mentioned earlier, fades are calculated in real time during playback. This means that the larger the number of audio tracks with Auto Fades activated in a project, the higher the demands on the processor.

Making global Auto Fade settings

1. To make Auto Fades settings globally for the project, select “Auto Fades Settings...” from the Project menu. This opens the Auto Fades dialog for the project.

2. Use the checkboxes in the upper right corner to activate or deactivate Auto Fade In, Auto Fade Out and Auto Crossfades, respectively.
3. Use the Length value field to specify the length of the Auto Fade or Crossfade (1-500 ms).

4. To adjust the shapes of Auto Fade In and Auto Fade Out, select the “Fades” tab and make settings as in the regular Fade dialogs.

5. To adjust the shape of the Auto Crossfade, select the “Crossfades” tab and make settings as in the regular Crossfade dialog.

6. If you want to use the settings you have made in forthcoming new projects, click the “As Default” button. The next time you create a new project, it will use these settings by default.

7. Click OK to close the dialog.

Making Auto Fade settings for a separate track

By default, all audio tracks will use the settings you have made in the project's Auto Fades dialog. However, since Auto Fades use computing power, a better approach may be to turn Auto Fades off globally, and activate them for individual tracks, as needed:

1. Right-click (Win) or [Ctrl]-click (Mac) the track in the Track list and select “Auto Fades Settings...” from the context menu (or select the track and click the “Auto Fades Settings” button in the Inspector). The Auto Fades dialog for the track appears. This is identical to the project’s Auto Fades dialog, with the addition of a “Use Project Settings” option.

2. Deactivate the “Use Project Settings” option.
   Now, any settings you make will be applied to the track only.

3. Set up the Auto Fades as desired and close the dialog.

Reverting to project settings

If you want a track to use the global Auto Fade settings, open the Auto Fades dialog for the track and activate the “Use Project Settings” checkbox. This makes the track use the Auto Fade settings you have made for the project.
9

The mixer
About this chapter

This chapter contains detailed information about the elements used when mixing audio and MIDI, and the various ways you can configure the mixer.

Some mixer related features are not described in this chapter. These are the following:

• Setting up and using audio effects.
  See page 232.

• Setting up and using MIDI effects.
  See page 468.

• Surround Sound (Cubase SX only).
  See page 278.

• Automation of all mixer parameters.
  See page 296.

• How to mix down several audio tracks (complete with automation and effects if you wish) to a single audio file.
  See page 685.
Overview

The picture above shows an extended mixer (Cubase SX only – see page 210).

The mixer offers a common environment for controlling levels, pan, solo/mute status etc. for both audio and MIDI channels.
Opening the mixer

The mixer can be opened in several ways:

- By selecting Mixer from the Devices menu.

- By clicking the Mixer icon on the toolbar
  This always opens the first Mixer window (see below).

- By using a key command (by default [F3]).

- By clicking the Mixer button in the Devices panel.
  You open the Devices panel by selecting Show Panel from the Devices menu.
About the multiple mixer windows

You may have noticed that there are in fact three separate mixer items selectable from the Devices menu; “Mixer”, “Mixer 2” and “Mixer 3” (in Cubase SL there are two mixer items). These are not separate mixers, but rather separate windows of the same mixer.

- Each of the mixer windows can be configured to show any combination of channels, channel types, narrow and wide channel strips etc. (how to do this is described later in this chapter).
  You can for example configure one mixer window to show MIDI channel strips, another to show input and output channels, another to show all audio channels and so on.

- You can also save channel configurations as View sets (see page 195) which are then accessible from all mixer windows.
  These features are very convenient when working with large projects. Considering the number of different channel types that can be shown in the mixer, they could even be described as necessary!
  With the three/two mixer windows combined with the ability to recall different mixer configurations, you are always able to focus on the task at hand and keep window scrolling down to a minimum.

- All the various options for configuring the mixer described in this chapter are identical for all mixer windows.
What channel types can be shown in the mixer?

The following track based channel types are shown in the mixer:

- Audio
- MIDI
- Effect return channels (FX channel tracks are referred to as effect return channels in the mixer).
- Group channels.

The order of audio, group, effect return and MIDI channel strips (from left to right) in the mixer corresponds to the Project window Track list (from the top down). If you reorder tracks of these types in the Track list, this will in turn be mirrored in the mixer.

In addition to the above, the following channel types are also shown in the mixer:

- Activated ReWire channels (see page 752).
- VST Instrument channels (see page 266).

ReWire channels cannot be reordered and always appear to the right of other channels in the main mixer pane (see below). VST instrument (VSTi) channels can be reordered in the Track list which will in turn be mirrored in the mixer.

Folder, Marker, Video and Automation tracks are not shown in the mixer.

Input and output busses in the mixer

Input and output busses are represented by input and output channels in the mixer. They appear in separate “panes” separated by movable dividers and with their own horizontal scrollbars. See page 201.

- In Cubase SL, only output channels are shown in the mixer (not input channels).
About multichannel audio (Cubase SX only)

Cubase SX has full support for surround sound. Each audio channel and bus in the mixer can carry up to 6 speaker channels. This means that if you have an audio track configured for 5.1 surround sound for example, this will have a single channel strip in the mixer, just like mono or stereo tracks (although its level meter will have six meter bars, one for each speaker channel).

Another thing to note is that the look of a channel strip differs slightly depending on how it is routed – mono or stereo tracks routed to a surround output bus will have a surround panner control instead of a regular pan control, for example.
Configuring the mixer

As mentioned earlier, the mixer windows can be configured in various ways to suit your needs and to save screen space. Here follows a run through of the various view options (the following descriptions assume that you have an active project containing some tracks):

Normal vs. Extended channel strips (Cubase SX only)

You have the option of selecting normal or extended channel strips and whether to show the input and output settings at the top of the channel strips. Proceed as follows:

1. Open any of the mixer windows.
   The leftmost strip is called the common panel and is always shown in the mixer. This contains various global settings and options relating to the mixer. For further info see page 200.

   In the lower left corner of the common panel you can see a graphic representation of a row of three "channel strips", divided into three vertical sections. The three vertical sections indicate what channel strip sections are currently visible in the mixer – if a section is lit the corresponding panel will be visible in the mixer.

   ![Diagram of channel strip sections]

   Here the middle section is dark, but the lower and upper sections are lit. This indicates that the mixer will show channel strips with the fader panel (lower section) plus the Input/Output settings panel (top section).

2. Click on the middle section so it lights up.
   Now the mixer will show the extended panel for all channel strips.

3. You can show or hide the extended and top panels of the channel strips by clicking on the corresponding section in the figure.
   The fader panel is always shown.

   • You can also show or hide the extended and top panels by clicking the + and – buttons to the left of each section in the common panel.
The fader panel shows the basic controls – faders, pan controls and an associated vertical row of buttons. The extended panel can be set to show EQ, effect sends, insert effects, etc. The input/output settings panel contains input and output routing pop-up menus (where applicable), along with input phase switches and input gain controls.
The input/output settings panel (Cubase SL)

In Cubase SL there is no extended mixer panel – all settings for EQ and effects are done in the Channel Settings windows. However, at the top of the channel strips you will find a panel with input and output routing pop-up menus. This is where you select an input bus for the channel (where applicable) and route the channel to an output bus.

- You can show or hide the input/output settings panel by clicking the +/- buttons at the top of the common panel to the left.

Selecting what to display in the extended channel strips (Cubase SX only)

You can select what to display in the extended channel strip either globally from the common panel, or individually from each channel strip.

The available options vary depending on the type of channel.

- See page 210 for a description of the various options for audio channels.
- See page 224 for a description of the various options for MIDI channels.

Selecting globally from the common panel

1. Open any of the mixer windows.
   The leftmost strip is called the common panel and is always shown in the mixer. This contains various global settings and options relating to the mixer. For further info see page 200.

2. Make sure that the extended panel of the mixer is visible.
In the extended area of the common panel you can see a vertical row of icons. These act as buttons, and determine globally what is displayed in the extended panel for all channel strips in the mixer.

If you place the pointer on an icon a tooltip appears, describing the item.

3. Click on the “Show all Inserts” button (second icon from the top).
   Now all channel strips in the mixer will show Insert effect slots in the extended panel.

   - As mentioned above, what can be set globally depends on the type of channel.
   - Channel types that do not support a selected global option will be unaffected.

   - If you press [Alt]/[Option] and click one of the global view buttons, input and output channels will be affected as well.
Selecting for individual channels

Each channel strip in the mixer features a View options pop-up, which is used for two things:

• To determine what is shown in the extended panel for individual channels in the mixer.

• To set the “Can Hide” status for individual channels in the mixer. This is described on page 195.

The View options pop-up is opened by clicking the down arrow located just above the fader panel of the channel strip.

• To select what to display in the extended panel from the View options pop-up you must first open the extended mixer. You can then use the pop-up to select what parameters to show in the extended panel for each individual channel in the mixer.
Setting the width of channel strips

- Each channel strip’s width can be sized to either “Wide” or “Narrow” mode by using the Narrow/Wide button. This is the two left/right arrows just above the fader strip (to the left of the View options pop-up).

The Narrow/Wide button

- Narrow channel strips contain a narrow fader, miniature buttons, plus the View options pop-up.
  If you have selected to show parameters in the extended section, only the channel overview is shown in narrow mode. (The parameters will be shown again when you return to wide mode.)

Wide and narrow channel strips

- When selecting wide or narrow channel strips from the common panel View options pop-up, all channel strips are affected.
Selecting what channel types to show/hide

You can specify what channel types to show or hide in the mixer. In the lower part of the common panel you find a vertical strip with different indicator buttons. Each indicator represents a channel type to show or hide in the mixer:

- Input Channels (Cubase SX only)
- Audio Channels
- Group Channels
- ReWire Channels
- MIDI Channels
- VST Instrument Channels
- Effect Return Channels
- Output Channels

For hiding individual channels – see below.

- To hide or show a channel type, click the corresponding indicator. If an indicator is dark, the corresponding channel type will be shown in the mixer. If it is orange, the corresponding channel type will be hidden.
Selecting individual channels to show/hide

You can also show/hide individual channels of any type in the mixer. This is done by first assigning channels a “Can Hide” status. After having done so you can hide all channels assigned this status at any time. Proceed as follows:

1. Pull down the View options pop-up menu for the channel you want to hide and activate the “Can Hide” option.

![Channel Hide/Show Option](image)

2. Repeat this for all channels you want to hide.

3. Click the bottom "hide button" in the common panel. This hides all channels set to “Can Hide”. To show them, click the button again.

Channel view sets

Channel view sets are saved configurations of the mixer windows, allowing you to quickly switch between different layouts for the mixer. Proceed as follows:

1. Set up the mixer the way you wish to store it as a view set.

The following settings will be stored:

- Settings for individual channel strips (e.g. narrow or wide mode and whether the channel strip is (or can be) hidden or not).
- The hide/show status for channel types.
- The mixer’s display status (fader panel, extended panel, input/output panel)
- Settings for what is shown in the extended view of the mixer.
2. Click the “Store View Set” button (the plus sign) at the top of the (non-extended) common panel.

3. A dialog appears, allowing you to type in a name for the view set. Do so and click OK to store the current mixer view set.

- You can now return to this stored configuration at any time, by clicking the “Select Channel View Set” button (the down arrow at the top of the common panel) and selecting it from the pop-up menu.

- To remove a stored channel view set, select it and click the “Remove View Set” button (the minus sign).

☐ Some remote control devices (such as Steinberg’s Houston) feature this function, which means that you can use the remote device to switch between the channel view sets.
The audio channel strips

The audio channel strips are used to control and route audio signals. They are found in the mixer in normal mode, showing from left to right: the common panel, a VST Instrument channel, a stereo audio channel, an effect return channel and a group channel strip.

All audio-related channel types (audio, input/output channels, group, effect return, VST Instrument or ReWire) basically have the same channel strip layout, with the following differences:

- Only audio track channels have an Input Routing pop-up (Cubase SX only), a Record Enable and Monitor button.
- Effect return channels and input/output channels do not have sends.
- VST Instrument channels have an additional button for opening the instrument’s control panel.
- Input channels (Cubase SX only) and output channels have clip indicators.
About the Insert/EQ/Send indicators and bypass buttons

The three indicator buttons in each audio channel strip have the following functionality:

- If an Insert or Send effect or EQ module is activated for a channel, the corresponding button is lit.
  The effect indicators will be blue, the EQ indicator will be green.

- By clicking these buttons when lit, the corresponding EQ or effects section will be bypassed.
  Bypass is indicated by yellow buttons. Clicking the button again deactivates bypass.
The MIDI channel strips

The MIDI channel strips allow you to control volume and pan in your MIDI instrument (provided that they are set up to receive the corresponding MIDI messages). The settings here are also available in the Inspector for MIDI tracks (see page 459).
The common panel

The common panel appears to the left in the mixer windows and contains settings for changing the look and behavior of the mixer, as well as global settings for all channels.

- **Shows/hides the input/output settings panel**
- **Shows/hides the extended panel (Cubase SX only).**
- **Global Solo/Mute Off**, see page 206.
- **Opens the VST Connections window** – see page 17.
- **Resets the settings to default** (for all or selected channels).
- **Show/hide buttons for the extended and input/output settings panels.**
- **The View options buttons determine what to display in the extended panels of channel strips ([Alt]/[Option]-click to affect busses as well). Only visible in extended mixer mode (Cubase SX only).**
- **Toggles “All Wide” (left arrows) or “All Narrow” channel strips in the mixer.**
- **Store/Remove View set buttons (+/-) and Select View set pop-up, see page 195.**
- **Global automation Read/Write buttons, see the “Automation” chapter.**
- **These indicator buttons select what channel types are shown/hidden in the mixer.**
- **Channel select pop-up**
- **Channel settings copy/paste, see page 219.**
The input & output channels

The busses you have set up in the VST Connections window are represented by input and output channels in the mixer. These are shown in separate “panes” (to the left and right of the regular channel strips, respectively), with their own dividers and horizontal scrollbars. The i/o channel strips are very similar to other audio channels and are identical for input and output channels (except that input channels don’t have Solo buttons).

- If you are using Cubase SL, only output channels are shown in the mixer. The input channels (busses) you have set up in the VST Connections window are available for selection on the input routing pop-up menus but you cannot view them or make settings for them in the mixer.

- How to set up input and output busses is described in the chapter “VST Connections: Setting up input and output busses”.

- How to route audio channels to busses is described on page 223.
Basic mixing procedures

Setting volume in the mixer

In the mixer, each channel strip has a fader for volume control.

- For audio channels, the faders control the volume of the channels before they are routed directly or via a group channel to an output bus. Each channel can in turn handle up to 6 speaker channels – see page 278.

- An output channel fader determines the master output level of all audio channels routed to that output bus.

- MIDI channels handle fader volume changes in the mixer by sending out MIDI volume messages to the connected instrument(s). Connected instruments must be set to respond to MIDI messages (such as MIDI volume in this case) for this to function properly.

- The fader settings are displayed numerically below the faders, in dB for audio channels and in the MIDI volume 0 to 127 value range for MIDI channels. You can click in the fader value fields and enter a volume setting by typing.

- To make fine volume adjustments, hold down [Shift] when you move the faders.

- If you hold down [Ctrl]/[Command] and click on a fader, it will automatically be set to position 0.0 dB for audio channels, or MIDI volume 100 for MIDI channels. Most mixer parameters can be reset to default values by [Ctrl]/[Command]-clicking this way.

You can use the faders to set up a volume balance between the audio and MIDI channels and perform a manual mix, by moving the faders and other controls while playing back. By using the Write function (see page 306), you can automate the levels and most mixer actions.

- It is also possible to adjust the volume of a selected audio event in the Project window or Audio Part Editor, by making volume settings on the info line, or by using the volume handle (see page 168).
About the level meters for audio channels

When playing back audio in Cubase SX/SL, the level meters in the mixer show the level of each audio channel.

- Directly below the level meter is a small level readout – this shows the highest registered peak level in the signal. Click this to reset the peak levels.

- Peak levels can also be shown as static horizontal lines in the meter (there are options for how this is displayed – see page 221).

  If the peak level of the audio goes above 0dB, the numerical level indicator will show a positive value (i.e. a value above 0dB).

Cubase SX/SL uses 32 bit floating point processing internally, so there is virtually limitless headroom – signals can go way beyond 0dB without clipping. Therefore:

- Having higher levels than 0 dB for individual audio channels is not a problem in itself. The audio quality will not be degraded by this.

  However, when many high level signals are mixed in an output bus this may require that you lower the output channel level a lot (see below). Therefore it’s good practice to keep the max levels for individual audio channels roughly around 0 dB.

About the level meters for input and output channels

For the input and output channels things are different. I/O channels have clip indicators (input channels are only shown in Cubase SX).

- When you are recording, clipping can occur when the analog signal is converted to digital in the audio hardware. With Cubase SX, it’s also possible to get clipping in the signal being recorded to disk (when 16 or 24 bit record format is used and you have adjusted the mixer settings for the input channel). Read more about checking and setting input levels on page 47.

- In the output busses, the floating point audio is converted to the resolution of the audio hardware. In the integer audio domain, the maximum level is 0dB – higher levels will cause the clip indicator for each bus to light up. If the clip indicators light up for a bus, this indicates actual clipping – digital distortion which should always be avoided.

推行 If the clip indicator lights up for an output channel, reset the clip indicator by clicking on it, and lower the level until the indicator doesn’t light up.
Adjusting Input Gain (Cubase SX only)

Each audio channel and input/output channel features an Input Gain control. This controls the gain for the incoming signal, before EQ and effects.

The Input Gain is not meant to be used as a volume control in the mixer. It can, however, be used to cut or boost the gain in various circumstances:

• To change the level of a signal before the effects section.
  The level going into certain effects can change the way the signal is affected. A compressor, for example, can be “driven” harder by raising the Input Gain.

• To boost the level of poorly recorded signals.
  To change the Input Gain, you need to press [Shift] and adjust the control (to avoid accidental gain changes). You can also press [Alt]/[Option] – this lets you adjust the Input Gain with a fader.

• You should set the Input Gain once and for all for a channel – it is not suited for continuous level adjustments during playback.
Input Phase switch (Cubase SX only)

Each audio channel and input/output channel has an Input Phase switch, to the left of the Input Gain control dial. When activated, the phase polarity is inverted for the signal. Use this to correct for balanced lines and mics that are wired backwards, or mics that are "out of phase" due to their positioning.

- Phase polarity is important when mixing together two similar signals. If the signals are "out of phase" with respect to one another, there will be some cancellation in the resulting audio, producing a hollow sound with less low frequency content.

About level meters for MIDI channels

The level meters for MIDI channels do not show actual volume levels. Instead, they indicate the velocity values of the notes played back on MIDI tracks.

About MIDI tracks set to the same MIDI channel and output

If you have several MIDI tracks set to the same MIDI channel (and routed to the same MIDI output), making volume settings for one of these MIDI tracks/mixer channels will also affect all other mixer channels set to the same MIDI channel/output combination. This also applies to pan settings.
Using Solo and Mute

The Mute (top) and Solo buttons.

You can use the Mute and Solo buttons to silence one or several channels. The following applies:

- The Mute button silences the selected channel. Clicking the Mute button again un-mutes the channel. Several channels can be muted simultaneously. A muted channel is indicated by a lit Mute button, and also by the lit Global Mute indicator on the common panel.

- Clicking the Solo button for a channel mutes all other channels. A soloed channel is indicated by a lit Solo button, and also by the lit Global Solo indicator on the common panel. Click the Solo button again to turn off Solo.

- Several channels can be soloed at the same time. However, if you press [Ctrl]/[Command] and click the Solo button for a channel, any other soloed channels will automatically be un-soloed (i.e. this Solo mode is exclusive).

- [Alt]/[Option]-clicking a Solo button activates “Solo Defeat” for that channel. In this mode (indicated by a red solo button without any other channels being muted) the channel will not be muted if you solo another channel (see page 254 for a practical use of this). To turn off Solo Defeat, [Alt]/[Option]-click the Solo button again.

- You can un-mute or un-solo all channels by clicking the Mute or Solo indicator on the common panel.
Setting pan in the mixer

The mixer 9 – 207

The pan controls.

The pan controls in the mixer are used to position a channel between the left and right side of the stereo spectrum. For stereo audio channels, pan (by default) controls the balance between the left and right channels. By selecting one of the other pan modes (see below) you can set pan independently for the left and right channel.

- To make fine pan adjustments, hold down [Shift] when you move the pan control.
- To select center pan position, hold down [Ctrl]/[Command] and click on the pan control.
- For MIDI channels, the pan control sends out MIDI pan messages. The result depends on how your MIDI instrument is set to respond to pan – check your documentation for details.
- The Surround Panner is described on page 287.
About the three pan modes (Cubase SX only)

If you right-click (Win) or [Ctrl]-click (Mac) in the pan control field for a (stereo) audio channel you can select one of three pan modes:

- **Stereo Balance Panner** controls the balance between the left and right channels. This is the default mode.

- **If Stereo Dual Panner is selected**, there will be two pan controls with the upper controlling pan for the left channel, and the lower controlling pan for the right channel. This allows you set pan independently for the left and right channels. Note that it is possible to reverse the left and right channels, i.e. the left channel can be panned to the right and vice versa. You can also “sum” two channels by setting them to the same pan position (i.e. mono) – note that this will increase the volume of the signal.

- **If Stereo Combined Panner is selected**, the left and right pan positions are shown as two lines with a blue/gray area between them. If you reverse the left and right channels, the area between the pan controls will be red instead of blue/gray.
Stereo Combined mode also allows you set pan independently for the left and right channels. This is done by holding down [Alt]/[Option] and dragging the corresponding pan control. When you release the [Alt]/[Option] key, the left and right pan controls are linked, and can be moved left and right like a single pan control (with their relative positions intact).

When moving combined pan controls so that the left or right pan control reaches its maximum pan value, it naturally cannot go any further. If you do continue to move further in the same direction, only the other pan control will move, thus altering the set relative pan range until both channels are panned fully to one side. If you move the pan controls in the opposite direction without releasing the mouse, the previously set pan range will be restored.

- The pan settings made with the Dual Panner are reflected in the Combined Panner and vice versa.

About the “Stereo Pan Law” Preference (audio channels only)

In the Project Setup dialog there is a pop-up menu named “Stereo Pan Law”, on which you can select one of three pan modes. This is all related to the fact that without power compensation, the power of the sum of the left and right side will be higher (louder) if a channel is panned center than if it’s panned left or right.

To remedy this, the Stereo Pan Law setting allows you to attenuate signals panned center, by -6, -4.5 or -3dB (default). Selecting the 0dB option effectively turns off “constant-power panning”. Experiment with the modes to see which fits best in a given situation.
Audio specific procedures

This section describes the options and basic procedures regarding audio channels in the mixer.

Options for the extended audio channel strip (Cubase SX only)

When using the extended channel strip view options, the upper panel can be set to show different views for each audio channel strip. You can select what to display in the extended panel individually for each channel or globally for all channels (see page 190).

The following views are possible:

• The 8 insert effect slots.
  The inserts can also be found in the Inspector and the Channel Settings window, see page 212.

• The 8 effect sends, with pop-ups and send level value sliders.
  The sends can also be found in the Inspector and the Channel Settings window, see page 212.

• You also have the option of displaying four sends at a time (the Sends 1-4 and 5-8 menu items).
  These modes offer the additional benefit of displaying send levels as dB values.

• There are no sends for Effect Return channels and Input/Output channels.
• The EQ section, either with parameter dials (“EQ +” menu item), value sliders (“EQs” item) or as numerical settings with a curve display (“EQs curve” item). These three views have exactly the same controls but different graphic layouts. The EQ section is also available in the Channel Settings window. For EQ parameter descriptions, see page 214.

• The Surround Panner section (where applicable).
  If the channel is routed to a surround bus you can view a compact version of the Surround Panner in the extended panel – double click to open the full Surround Panner panel.

• The “VU Meter” option shows large level meters in the extended panel. These operate exactly like the regular meters.

• Selecting the “Empty” option will display a blank panel in the extended strip.

• You can also select the “Overview” option – this shows a graphic overview of which insert effect slots, EQ modules and effects sends are activated for the channel.
  You can click the indicators to turn the corresponding slot/EQ module/send on or off.

• If you have selected a parameter for the extended channel strip and then switch to “narrow” mode, only the channel overview is shown in the extended channel strip. When you switch back to “wide” mode, the parameter settings are displayed again.
Using Channel Settings

For each audio channel strip in the mixer (and in the Inspector and Track list for each audio track) there is an Edit button ("e").

Clicking this opens the VST Audio Channel Settings window. This window contains a simplified common panel, a duplicate of the mixer channel strip (without the extended panel but with the input and output settings panel), a section with eight (five in Cubase SL) insert effect slots (see page 234), four EQ modules and an associated EQ curve display (see page 214) and a section with eight effect sends (see page 248). Every channel has its own channel settings (although you can view each in the same window if you like – see below).

The Channel Settings window is used for the following operations:

- Apply equalization, see page 214.
- Apply send effects, see page 244.
- Apply insert effects, see page 234.
- Copy channel settings and apply them to another channel, see page 219.

All channel settings are applied to both sides of a stereo channel.
Changing channels in the Channel Settings window

You can view any channel’s settings from a single window. If the option “Mixer Selection Follows Project” is activated in the Preferences (Editing page), this can be done “automatically”:

- Open the Channel Settings window for a track and position it so that you can see both the Project window and the Channel Settings window.

Selecting a track in the Project window automatically selects the corresponding channel in the mixer (and vice versa). If a Channel Settings window is open, this will immediately switch to show the settings for the selected channel. This allows you to have a single Channel Settings window open in a convenient position on the screen, and use this for all your EQ and channel effect settings.

You can also select a channel manually (thereby changing what is shown in the open Channel Settings window). Proceed as follows:

1. Open the Channel Settings window for any channel.

2. Open the Channel Select pop-up on the common panel.

3. Select a channel from the pop-up to show the settings for that channel in the open Channel Settings window.

- Alternatively, you can select a channel in the mixer by clicking the strip at the bottom of the channel strip (above the channel name). This selects the channel, and the Channel Settings window will be updated.

- To open several Channel Settings windows at the same time, press [Alt]/[Option] and click the Edit buttons for the respective channels.
Making EQ settings

Each audio channel in Cubase SX/SL has a built-in parametric equalizer with up to four bands. There are several ways to view and adjust the EQs:

- By selecting one of the three EQ display modes ("EQs", "EQs +" or "EQs Curve") for the extended channel strip in the mixer (Cubase SX only).
  These three modes contain the same settings but present them in different ways:

  - The top value slider controls the gain, the middle controls frequency and the lower sets the Q parameter for each EQ band.
  - The outer ring of the dial controls the frequency, while the inner controls gain.
  - The small dial sets the Q parameter.

  From left to right, “EQs” mode (sliders), “EQs +” mode (dials) and “EQs Curve” mode (numeric values with a curve display).

- By selecting the “Equalizers” or “Equalizer Curve” tab in the Inspector.
  The “Equalizers” section is similar to the “EQs” mode in the extended mixer, while the “Equalizer Curve” section shows a display in which you can “draw” an EQ curve. Setting EQ in the Inspector is only possible for track-based audio channels (not for ReWire channels).

- By using the Channel Settings window.
  This offers both parameter dials and a clickable curve display and also lets you store and recall EQ presets.

Below we describe how to set up EQ in the Channel Settings window, but the parameters are the same in the mixer and Inspector (apart from the presets and reset function).

In the Channel Settings window you find the EQ section in the middle (or to the right, if you are making settings for an FX channel track). The section consists of four EQ modules with parameter dials, an EQ curve display and some additional functions at the top.
Using the parameter dials

1. Activate an EQ module by clicking its power button.
   Although the modules are labeled “lo”, “lo mid” and so on, they all have the same frequency range (20Hz to 20kHz). The only difference between the modules is that the “lo” and “hi” bands can act as shelving or high/low-pass filters (described below).

2. Set the desired frequency with the outer ring of the parameter dial.
   This is the center frequency of the frequency range to be cut or boosted.

3. Set the amount of cut or boost with the gain control – the inner parameter dial.
   The range is ± 24 dB.

4. Set the Q value with the lower dial.
   This determines the width of the affected frequency range. Higher values give narrower frequency ranges.
   - If you set the Q value for the “lo” EQ module to minimum, it will act as a low shelving filter.
     If you set it to its maximum value, it will act as a high-pass filter.
   - If you set the Q value for the “hi” EQ module to minimum, it will act as a high shelving filter.
     If you set it to its maximum value, it will act as a low-pass filter.

5. If needed, you can activate and make settings for up to four modules.
   Note that you can edit the values numerically as well, by clicking in a value field and entering the desired gain, frequency or Q value.
Using the curve display

When you activate EQ modules and make settings with the parameter dials you will see that your settings are automatically reflected in the curve display above. You can also make settings directly in the curve (or combine the two methods any way you like):

1. To activate an EQ module, click in the curve display.
   This adds a curve point and one of the modules below are activated.

2. Make EQ settings by dragging the curve point in the display.
   This allows you to adjust gain (drag up or down) and frequency (drag left or right).

3. To set the Q parameter, press [Shift] and drag the curve point up or down.
   You will see the EQ curve become wider or narrower as you drag.

   - You can also restrict the editing by pressing [Ctrl]/[Command] (sets gain only) or [Alt]/[Option] (sets frequency only) while you drag the curve point.

4. To activate another EQ module, click somewhere else in the display and proceed as above.

5. To turn off an EQ module, double click its curve point or drag it outside the display.

EQreset (Channel Settings window only)

To the right above the EQ curve display in the Channel Settings window you will find a reset button. Clicking this will turn off all EQ modules and reset all EQ parameters to their default values.
EQ bypass

Whenever one or several EQ modules are activated for a channel, the EQ button will light up in green in the mixer channel strip, Inspector (Equalizer and Channel sections), Track list and Channel Settings window (top right corner of the EQ section).

Clicking the EQ button will bypass all EQ modules for the channel, allowing you to compare the sound with and without EQ. When the EQ is in Bypass mode, the EQ button is yellow.

Using EQ presets (Channel Settings window only)

Some useful basic presets are included with the program. You can use them as they are, or as a starting point for further “tweaking”.

- To call up a preset, pull down the presets pop-up menu above the EQ curve display and select one of the available presets.

- To store the current EQ settings as a preset, click the store button (plus sign) to the left of the presets field.
  The settings are stored with the default name “Preset” and a number. To rename a preset, double click in the preset pop-up field and enter a new name.

- To remove a preset, select it and click the remove (minus sign) button.
**EQ in the channel overview**

If the “Channel” section is selected in the Inspector or the “Channel Overview” view mode is selected in the extended mixer (Cubase SX only), you will get an overview of which EQ modules, insert effects and effect sends are activated for the channel.

By clicking the “hi”, “hi mid”, “lo mid” or “lo” indicator, you can turn the corresponding EQ module on or off.

![The channel overview in the Inspector.](image)

---

CUBASE SX/SL  
9 – 218  The mixer
Copying settings between audio channels

It is possible to copy all channel settings for an audio channel and paste them onto another channel. This applies to all audio channel types. For example, you can copy EQ settings from an audio track and apply these to a group or VST Instrument channel, if you want them to have the same sound. Proceed as follows:

1. Select the channel you want to copy settings from by clicking the narrow horizontal strip just above the channel name field (or just above the pan control). A selected channel is indicated by these two fields being highlighted.

   You can also select channels with the Channel Select pop-up menu – see page 213.

   Selecting a channel in the channel strip (left), and in the common panel (right).

2. Click the “Copy” button in the common panel.

3. Select the channel you want to copy the settings to and click the Paste button.

   The settings are applied to the selected channel.

4. To copy the same settings to several channels, repeat step 3.

   The copied settings are retained in memory until you copy new channel settings, or close the project.

- Channel settings can be copied from stereo channels and pasted to mono channels and vice versa.
Cubase SX note: Copying channel settings from a channel using a surround format to a mono or stereo channel can lead to conflicts. For example, any Insert effects routed to surround speaker channels will be muted. Or, in other words: you can copy channel settings to any type of channel, but of course only those settings are used for which corresponding speakers are available in the target channel.

Input/output channels and effect return channels do not have sends, but channel settings can still be copied to/from other audio channel types. When copying from a i/o or effect channel, any send settings in the channel you paste into are unaffected.

Initialize Channel and Reset Mixer

The Initialize Channel button can be found at the bottom of the Channel Settings common panel. It resets the selected channel to the default settings. Similarly, the mixer common panel holds a Reset Mixer button – when you click this you will be asked whether to reset all channels or just the selected channel.

Default settings are:

• All EQ, Insert and Send effect settings are deactivated and reset.
• Solo/Mute is deactivated.
• The fader is set to 0dB.
• Pan is set to center position.
Changing the meter characteristics

On the Mixer context menu, opened by right-clicking (Win) or [Ctrl]-clicking (Mac) anywhere on the mixer panel, there is a submenu named “VU-Meter Settings”. Here you can make settings for the preferred meter characteristics, with the following options:

- If “Hold Peaks” is activated, the highest registered peak levels are "held" and are shown as static horizontal lines in the meter. Note that you can turn this on or off by clicking in any audio level meter in the mixer.

- If “Hold Forever” is activated, the peak levels will remain until meters are reset (by clicking the numerical peak display below the meter). If "Hold Forever" is off, you can specify for how long the peak levels will be held with the parameter "VU-Meter Peak’s Hold Time" in the Preferences dialog (VST page). The peak hold time can be between 500 and 30000ms.

- If “Input VU” is activated, meters will show input levels for all audio channels and input/output channels. Note that the input VU meters are post input gain (Cubase SX only).

- If “Post-Fader VU” is activated, meters will show post-fader levels. This is the default setting for channels in the mixer.

- If “Fast Release” is activated, the meters respond very quickly to level peaks. If "Fast Release" is deactivated, the meters respond more like standard VU meters.
Using group channels

You can route the outputs from multiple audio channels to a group. This enables you to control the channel levels using one fader, apply the same effects and equalization to all of them etc. To create a group channel, proceed as follows:

1. Select Add Track from the Project menu and select “Group Channel” from the submenu that appears.
2. Select the desired channel configuration and click OK.
   A group channel track is added to the Track list and a corresponding group channel strip is added to the mixer. By default the first group channel strip is labeled “Group 1”, but you can rename it just like any channel in the mixer.
3. Pull down the Output routing pop-up for a channel you want to route to the group channel, and select the group channel.
   The output of the audio channel is now redirected to the selected group.
4. Do the same for the other channels you wish to route to the group.

Settings for group channels

The group channel strips are (almost) identical to audio channel strips in the mixer. The descriptions of the mixer features earlier in this chapter apply to group channels as well. Some things to note:

- You can route the output of a group to an output bus or to another group with a higher number.
  You cannot route a group to itself. Routing is done with the Output Routing pop-up menu in the Inspector (select an automation track for the Group in the Track list) or in the input/output settings area at the top of each channel strip.
- There are no input routing pop-ups, monitor buttons or record enable buttons for group channels.
  This is because inputs are never connected directly to a group.
- Solo functionality is automatically linked for a channel routed to a group and the group channel itself.
  This means that if you solo a group channel, all channels routed to the group are automatically soloed as well. Similarly, soloing a channel routed to a group will automatically solo the group channel.

One application of group channels is to use them as “effect racks” – see page 243.
About output busses

As described in the Getting Started book Cubase SX/SL uses a system of input and output busses which are set up using the VST Connections dialog. This is described in the chapter “VST Connections: Setting up input and output busses”.

Output busses let you route audio from the program to the outputs on your audio hardware.

Routing audio channels to busses

To route the output of an audio channel to one of the active busses, proceed as follows:

1. Open the Mixer.

2. Make sure the input/output settings panel is visible – see page 188.

3. Pull down the output routing pop-up menu at the top of the channel strip and select one of the busses.
   This pop-up menu contains the output busses configured in the VST Connections window, as well as available group channels (provided that the busses and groups are compatible with the speaker configuration for the channel – see page 21).

   You can also make routing settings in the Inspector.

   For details on routing surround channels (Cubase SX), see page 282.

Viewing the output busses in the mixer

Output busses are shown as output channels in a separate pane to the right in the mixer. You show or hide this pane by clicking the Hide Output Channels button in the mixer’s common panel to the left:

Each output channel resembles a regular audio channel strip. Here you can do the following:

- Adjust master levels for all configured output busses using the level faders.
- Adjust input gain and input phase of the output busses (Cubase SX only).
- Add effects or EQ to the output channels (see page 241).
MIDI specific procedures

This section describes basic procedures for MIDI channels in the mixer.

Selecting what to show in the extended MIDI channel strip
(Cubase SX only)

When using the extended channel strip view options (see page 188), the upper panel can be set to show different views for each MIDI channel strip. You select what to display for each channel by using the View options pop-up menu at the top of each channel strip. The following views are possible:

• The MIDI insert effects.
  The MIDI inserts can also be found in the Inspector and the Channel Settings window for MIDI channels. How to use MIDI insert effects is described in the chapter “MIDI realtime parameters and effects” – see page 468.

• The MIDI send effects.
  The sends can also be found in the Inspector and the Channel Settings window for MIDI channels. How to use MIDI send effects is described in the chapter “MIDI realtime parameters and effects” – see page 468.

• The “VU Meter” option shows large level (velocity) meters in the extended panel.

• Selecting “Empty” will display a blank panel in the extended strip.

• You can also select the “Overview” option – this shows a graphic overview of which insert effect slots and effect sends are activated for the channel. You can click the indicators to turn the corresponding slot/send on or off.

• By selecting from the View options pop-up in the common panel, you can set the view for all channels in the mixer. Selecting EQ or Surround Panners (which apply to audio channels only) will not change the view for MIDI channels. Selecting inserts or send effects from the common panel will change the view for all channel types.

• If you have selected a parameter for the extended channel strip and then switch to “narrow” mode, only the channel overview is shown in the extended channel strip. When you switch back to “wide” mode, the parameter settings are displayed again.
Using Channel Settings

For each MIDI channel strip in the mixer (and MIDI track in the Track list or the Inspector) there is an Edit ("E") button.

Clicking this opens the MIDI Channel Settings window. This window contains a duplicate of the mixer channel strip, a section with four MIDI inserts and a section with four MIDI send effects. Every MIDI channel has its own channel settings.

The MIDI Channel Settings window.
Utilities

Link/Unlink channels

This function is used to “link” selected channels in the mixer so that any change applied to one channel will be mirrored by all channels in that group. You can link as many channels as you like, and you can also create as many groups of linked channels as you like. To link channels in the mixer, proceed as follows:

1. Press [Ctrl]/[Command] and click on the strip just above the name field for all the channels that you want to link.
   There is an identical select channel field just above the pan control. Selected channels are indicated by highlighted select fields. [Shift]-clicking allows you to select a continuous range of channels.

2. Right-click (Win) or [Ctrl]-click (Mac) somewhere on the grey mixer panel.
   The Mixer context menu appears.

3. Select “Link Channels” from the context menu.

   • To unlink channels, select one of the linked channels and select “Unlink Channels” from the Mixer context menu.
     The channels are unlinked. Note that you do not need to select all the channels that are linked, only one of them.

   • **It is not possible to remove individual channels from Link status.**
     To make individual settings to a linked channel, press [Alt]/[Option] when changing the setting.
What will be linked?

The following rules apply for linked channels:

- Fader levels will be "ganged".

  The relative level offset between channels will be kept if you move a linked channel fader.

  The three channels shown are linked. Pulling down one fader changes the levels for all three channels, but keeps the relative level mix.

- Any individual channel settings you have made before linking will remain until you alter the same setting for any of the linked channels. For example, if you link three channels, and one of them was muted at the time you applied the Link Channel function, this channel will remain muted after linking. However, if you mute another channel then all linked channels will be muted. Thus, the individual setting for one channel is lost as soon as you change the same parameter setting for any of the linked channels.

- Only level, mute, solo, select, monitor and record enable will be linked between channels. Effect/EO/pan/input and output routing settings are not linked.

- By pressing [Alt]/[Option], you can make individual settings and changes for channels that are linked.

  Linked channels can also have individual automation subtracks. These are completely independent, and are not affected by the Link function.
Saving mixer settings

- Saving/Loading mixer settings does not apply to MIDI channels in the mixer – only audio related channels (group, audio, effect return, VSTi and ReWire) are saved with this function!

It is possible to save complete mixer settings for selected or all audio channels in the mixer. These can later be loaded into any project. Channel settings are saved as mixer settings files. These have the Windows file extension "*.vmx".

Right-clicking (Win) or [Ctrl]-clicking (Mac) somewhere on the mixer panel or in the Channel Settings window brings up the Mixer context menu where four Save/Load items can be found. The following options are available:

- “Save Selected Channels” will save all channel settings for the selected channels. Input/output routings are not saved.
- “Save All Mixer Settings” saves all channel settings for all channels. When you select any of the above options, a standard file dialog opens where you can select a name and storage location on your disk for the file.
Loading mixer settings

Load Selected Channels

To load mixer settings saved for selected channels, proceed as follows:

1. Select the same number of channels in the new project to match the number of channels you saved settings for in the previous project.
   For example, if you saved settings for six channels, then select six channels in the mixer.
   - Mixer settings will be applied in the same order as they appear in the mixer, when saved.
   Thus, if you save settings from channels 4, 6 and 8 and apply these settings to channels 1, 2 and 3, the settings saved for channel 4 would be applied to channel 1, the settings saved for channel 6 to channel 2 and so on.

2. Right-click (Win) or [Ctrl]-click (Mac) the mixer panel to open the context menu, and select “Load Selected Channels”.
   A standard file dialog appears, where you can locate the saved file.

3. Select the file and click “Open”.
   The channel settings are applied to the selected channels.

サー If you choose to apply mixer settings to fewer channels than you saved, the order of the saved channels in the mixer applies – i.e. the saved channels that are “left over” and not applied will be the channels with the highest channel numbers (or furthest to the right in the mixer).

Load All Mixer Settings

Selecting “Load All Mixer Settings” from the context menu allows you to open a saved mixer settings file, and have the stored settings applied to all channels for which there is information included in the file.
All channels, master settings, VST Instruments, sends and master effects will be affected.

• Please note that if the saved mixer settings were 24 channels, and the mixer you apply it to currently contains 16 channels, only the settings for channels 1 to 16 will be applied – this function will not automatically add channels.
About the VST Performance window

The VST Performance window is opened by selecting it from the Devices menu. It indicates the current load on the CPU and the hard disk transfer rate. It is recommended that you check this from time to time, or keep it open always. Even though you have been able to activate a number of audio channels in the project without getting any warning, you may possibly run into performance problems when adding EQ or effects.

- The upper bar graph shows the CPU (processor) load.
  If the red Overload indicator lights up, you need to decrease the number of EQ modules, active effects and/or audio channels playing back simultaneously.

- The lower bar graph shows the hard disk transfer load.
  If the red overload indicator lights up, the hard disk is not supplying data fast enough to the computer. You may need to reduce the number of tracks playing back by using the Disable Track function (see page 34). If this doesn’t help, you need a faster hard disk. Note that the overload indicator may occasionally blink, typically when you locate during playback. This does not indicate a problem, but happens because the program need an instant for all channels to load data for the new playback position.

- The CPU and Disk load meters can also be shown on the Transport panel and on the Project window toolbar.
  There they are shown as two miniature vertical meters (by default at the left side of the panel/toolbar).
10

Audio effects
About this chapter

Cubase SX/SL comes with a number of effect plug-ins included. This chapter contains general details about how to assign, use and organize effect plug-ins. The effects and their parameters are described in the separate pdf document “Audio Effects and VST Instruments”.

This chapter describes audio effects, i.e. effects that are used to process audio, group, VST Instrument and ReWire channels. For info on how to use MIDI effects, see the chapter “MIDI realtime parameters and effects”.

Overview

There are three ways to use audio effects in Cubase SX/SL:

• As insert effects.
   An insert effect is inserted into the signal chain of an audio channel, which means that the whole channel signal passes through the effect. This makes inserts suitable for effects for which you don’t need to mix dry and wet sound, e.g. distortion, filters or other effects that change the tonal or dynamic characteristics of the sound. You can have up to eight (five in Cubase SL) different insert effects per channel (and the same is true for input and output busses – for recording with effects and “master effects”, respectively).

• As send effects.
   Each audio channel has eight effect sends, each of which can be freely routed to an effect (or to a chain of effects). Send effects are practical for two reasons: you can control the balance between the dry (direct) and wet (processed) sound individually for each channel using the sends, and several different audio channels can use the same send effect. In Cubase SX/SL, send effects are handled by means of FX channel tracks.

• By using offline processing (Cubase SX only).
   You can apply effects directly to individual audio events – this is described on page 352.
About VST plug-ins and tempo sync

Version 2.0 of the VST plug-in standard (and later) allows plug-ins to receive MIDI from the host application (in this case, Cubase SX/SL). A typical use for this feature is tempo-based effects (such as delays, auto-panning, etc.), but it is also used in other ways for certain plug-ins.

- MIDI timing information is automatically provided to any VST 2.0 plug-in that “requests it”. You don’t need to make any special settings for this.
- In many cases you set up tempo sync by specifying a base note value and a multiplier. The resulting timing interval is the base note value multiplied with the multiplier value. For example, if you set the base note value to 1/16 (a sixteenth note) and the multiplier to 3, the resulting timing is 3/16. In the case of a delay effect, this means the interval between each delay repeat will be three sixteenth notes.
- When MIDI receive is available (or necessary) for other purposes than timing, the setting up and operation is described in the documentation for the corresponding effect. Please refer to the pdf document “Audio Effects and VST Instruments” for details about the included effects.

About plug-in delay compensation

A plug-in effect may have some inherent delay or latency. This means that it takes a brief time for the plug-in to process the audio fed into it – as a result, the output audio will be slightly delayed. This may happen with dynamics processors featuring “look-ahead” functions, etc.

However, Cubase SX/SL provides full plug-in delay compensation through-out the entire audio path. All plug-in delays are compensated for, maintaining the sync and timing of all audio channels.

Normally, you don’t have to make any settings for this. However, in the “Plug-In Information” dialog, you can switch off plug-in delay compensation for individual plug-ins by unchecking the corresponding option in the “Use Delay Compensation” column (see page 261). Note that you have to re-load the plug-in for the change to take effect.

You can also constrain the delay compensation, which is useful to avoid latency when recording audio or playing a VST Instrument in real time. See page 270.
**Insert effects**

**Background**

As the name implies, insert effects are inserted into the audio signal path – this means that the audio will be routed through the effect. You can add up to eight different insert effects (five in Cubase SL) independently for each audio channel (audio track, group channel track, FX channel track, VST Instrument channel or ReWire channel) or bus. The signal passes through the effects in series from the top downwards, with the signal paths shown in this figures (for Cubase SX and Cubase SL, respectively):

As you can see, in Cubase SX the last two insert slots (for any channel) are post-EQ and post-fader. In Cubase SL, the last insert slot for an output channel is post-EQ and post-fader. Post-fader slots are best suited for insert effects where you don’t want the level to be changed after the effect, such as dithering (see page 241) and maximizers – both typically used as insert effects for output busses.
• Applying insert effects on many channels uses up a lot of CPU power!
It might often be more efficient to use send effects, especially if you want to use the
same type of effect on several channels. Remember that you can use the VST Perform-
ance window to keep an eye on the CPU load.

Which effect plug-ins can I use as insert effects?

Most effect plug-ins will work fine as insert effects. In general, the only
restrictions are with the number of inputs and outputs in the effects:

• For a plug-in to be usable as an insert effect, it has to have at least 1
  or 2 inputs and 1 or 2 outputs.
Different effects feature different amounts of inputs and outputs, but the number of in-
puts and outputs actually used is determined by whether you use the insert effects on
a single (mono) audio channel, a stereo channel pair or a surround audio channel (mul-
tiple channels – Cubase SX only).

• For stereo audio channels, you need to use an effect with at least two
  inputs (stereo).
It is possible to use a mono-input effect with a stereo channel pair, but then only the
one channel in the pair will be processed, which is probably not what you want. It is
also possible to use an effect with more than two inputs of course, since both chan-
nels in the stereo pair will be processed even though the effect actually accommo-
dates more.

• For mono audio channels, you can use mono- or stereo-input effects.
However, since the audio channel is in mono, the output of the effect will also be in
mono. For stereo output effects, the left channel will then be used.

• For multi-channel audio tracks (Cubase SX only), you can use effects
  with any number of inputs.
If you use an effect with only one or two inputs however, this will have the effect that
only one or two channels (most often L and/or R) in a surround configuration will be af-
fected, leaving the other channels unprocessed by the effect. See page 236.
Routing an audio channel or bus through insert effects

Insert effect settings are available in the mixer (in extended mode), the Channel Settings window and the Inspector (audio tracks, group tracks and FX tracks only). The examples below show the Channel Settings window, but the procedures are similar for all three send sections:

1. Bring up the Channel Settings window, the Inserts pane in the extended mixer or the Inserts section in the Inspector.
   In the Channel Settings window, the inserts are located immediately to the right of the channel strip.

2. Pull down the effect type pop-up for one of the insert slots, and select an effect.

   The effect is loaded and automatically activated and its control panel appears. You can hide or show the control panel for the effect by clicking the “e” button for the insert slot.

   • If the effect has a Dry/Wet Mix parameter you can use this to adjust the balance between the dry signal and the effect signal. See page 255 for details about editing effects.

   • When one or several insert effects are activated for a channel, the insert effects buttons light up in blue in the mixer and Track list. Click the button for a channel to bypass (disable) all its inserts. When the inserts are bypassed, the buttons are yellow. Click the button again to enable the inserts. Note that the bypass button is also available in the Inspector and the Channel settings window for the audio track.

   • To remove an effect, pull down the effect type pop-up menu and select “No Effect”. You should do this for all effects that you don’t intend to use, to minimize unnecessary CPU load.
When you have several insert effects for a channel, you can bypass separate effects by clicking the bypass button of the respective slot. When an effect is bypassed, the button is yellow.

The “Reverb A” insert effect slot is bypassed.

Insert effects in the channel overview

If the “Channel” section is selected in the Inspector or the “Channel Overview” view mode is selected in the extended mixer, you will get an overview of which EQ modules, insert effects and effect sends are activated for the channel.

You can activate or deactivate individual insert effect slots by clicking the corresponding number (in the upper half of the overview).

The channel overview in the Inspector.
Using mono or stereo effects with a surround channel (Cubase SX only)

Normally, when you apply a mono or stereo insert effect to a surround (multi channel) track, the first speaker channel(s) of the track (often L and/or R) are routed through the effect’s available channels, and the other channels of the track are left unprocessed.

However, you may want to apply the effect to other speaker channels. This is done in the Channel Settings window:

1. Click in the small window to the left above the inserts section to open up the Display Modes pop-up menu.

2. Select “Routing” from the menu.

The inserts section changes appearance, to display a row of small signal diagrams.
3. Double click on the small signal diagram for the effect to open up an editor window.

The columns in the diagram represent the channels in the current surround configuration, with signals passing from top to bottom. The grey field in the middle represents the actual effect plug-in.

- The squares above the effect represent inputs to the effect plug-in.
- The squares below the effect represent outputs from the effect plug-in.
- A line that passes through the effect (with no square input/output indicators) represent a bypass connection – the audio on that speaker channel passes the effect without being processed.
- A “broken” line indicates a broken connection – the audio on that speaker channel will not pass on to the output at all.

Here, the effect will process the Ls and Rs channels. The L, R and C channels will pass through unaffected, while the Lfe connection is broken.
Operations

You can move connections to the effect inputs and outputs sideways to route the audio to/from other inputs/outputs than the standard configuration. To do this, you click the arrow buttons to the right.

- The upper two arrows move the input connections, and the lower two arrows move the output connections. If the “Link” checkbox is activated the input and output connections will be moved at the same time. This is the mode to use when you simply want to process other channels than the default, without any cross-connections.

- If you move inputs or outputs independently of each other, this means you create a “cross-connection”.

![Diagram of audio connections](image)

The audio on the Ls-Rs channels is processed in the plug-in and output on the L-R channels. Since the L-R channels are bypassed, this means the final L-R output will contain both the original L-R signals and the processed Ls-Rs signals.

- If a channel is bypassed (a straight line is shown through the plug-in) you can [Ctrl]/[Command]-click the line to break the connection. [Ctrl]/[Command]-click again to replace the broken connection with a bypass.

- Clicking Reset gets you back to the original standard connection.

- Changes you make in this window are audible immediately.
About adding insert effects to busses

As already stated, all input and output busses have eight insert slots, just like regular audio channels. The procedures for adding insert effects are the same (except you cannot use the Inspector here).

- Adding insert effects to an input bus (Cubase SX only) allows you to record with effects. The effects will become a permanent part of the recorded audio file (see page 61).

- Insert effects added to an output bus will affect all audio routed to that bus, like a “master insert effect”. Typically you would add compressors, limiters, EQ or other plug-ins to tailor the dynamics and sound of the final mix. A special case is dithering, as described below.

Dithering

Dithering is a method for controlling the noise produced by quantization errors in digital recordings. The theory behind this is that during low level passages, only a few bits are used to represent the signal, which leads to quantization errors and hence distortion.

For example, when “truncating bits”, as a result of moving from 24- to 16-bit resolution, quantization errors are added to an otherwise immaculate recording. By adding a special kind of noise at an extremely low level, the effect of these errors is minimized. The added noise could be perceived as a very low-level hiss under exacting listening conditions. However, this is hardly noticeable and much preferred to the distortion that otherwise occurs.

When should I use dithering?

- Consider dithering when you mix down to a lower resolution, either in real-time (playback) or with the Export Audio Mixdown function. A typical example is when you mix down a project to a 16-bit stereo audio file for audio CD burning.

What is a “lower resolution” then? Well, Cubase SX/SL uses 32-bit float resolution internally, which means that all integer resolutions (16-bit, 24-bit, etc.) are lower. The negative effects of truncation (no dithering) are probably most noticeable in 8-bit, 16-bit and 20-bit format; whether to dither when mixing down to 24 bits is perhaps a matter of taste.
Applying dithering

1. Click the “e” button to bring up the Output Settings window for the output bus, or display its Inserts section in the extended mixer pane, as described above.

2. Cubase SX: Pull down the Inserts pop-up menu in slot 7 or 8.
   In Cubase SX, the two last Insert effect slots (for all channels) are post-fader, which is crucial for a dithering plug-in. The reason is that any master gain change applied after dithering would bring the signal back to the internal 32 bit float domain, rendering the dithering settings useless.

3. Cubase SL: Pull down the Inserts pop-up menu in the last slot (5).
   In Cubase SL, the last insert effect slot for all output channels are post-fader, useful for dithering as explained above.
   If you need to apply dithering to a channel other than the output channels, you must make sure that no other plug-ins are inserted after the dithering plug-in and that the level fader of the channel is set to 0.0 dB (no change).

4. Select a dithering plug-in from the pop-up menu.
   Cubase SL only has one; the UV22 dithering plug-in. Additional dithering plug-ins included with Cubase SX are:

<table>
<thead>
<tr>
<th>Plug-in</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>UV22HR</td>
<td>UV22HR offers very high-quality dithering with support for multiple resolutions (8, 16, 20 or 24 bits).</td>
</tr>
<tr>
<td>SurroundDither</td>
<td>SurroundDither is a surround-compatible plug-in capable of dithering six channels at the same time. If you are applying dithering to a surround bus, this is the recommended dithering plug-in to use.</td>
</tr>
</tbody>
</table>

For a description of the included dithering plug-ins and their parameters, please see the separate PDF document “Audio Effects and VST Instruments”. If you have installed another dithering plug-in that you prefer, you can of course select this instead.

5. Make sure the dithering plug-in is set to dither to the correct resolution.
   This would be the resolution of your audio hardware (on playback) or the desired resolution for the mixdown file you want to create (as set in the Export Audio Mixdown dialog, see page 685).

6. Use the other parameters in the control panel to set up the dithering to your liking.
Using group channels for insert effects

Like all other channels, group channels can have up to eight insert effects (five in Cubase SL). This is useful if you have several audio tracks that you want to process through the same effect (e.g. different vocal tracks that all should be processed by the same compressor). Another special use for group channels and effects is the following:

If you have a mono audio track and want to process this through a stereo insert effect (e.g. a stereo chorus or an auto panner device), you cannot just insert the effect as usual. This is because the audio track is in mono – the output of the insert effect will then be in mono as well, and the stereo information from the effect will be lost.

One solution would be to route a send from the mono track to a stereo fx channel track, set the send to pre fader mode and lower the fader completely for the mono audio track. However, this makes mixing the track cumbersome, since you cannot use the fader. Here's another solution:

1. Create a group channel track in stereo and route it to the desired output bus.
2. Add the desired effect to the group channel as an insert effect.
3. Route the mono audio track to the group channel.

Now the signal from the mono audio track is sent directly to the group, where it passes through the insert effect, in stereo.
Send effects

Background

Send effects are handled through FX channel tracks. These are special tracks that each can contain up to eight insert effects (five in Cubase SL). The signal path is as follows:

- By routing an effect send from an audio track to an FX channel track, the audio is sent to the FX channel and through its insert effect(s). Each audio channel has eight sends, which can be routed to different FX channels. You control the amount of signal sent to the FX channel by adjusting the effect send level.

- If you have added several effects to the FX channel, the signal passes through the effects in series, from the top (the first slot) downward. This allows for “custom” send effect configurations – you could e.g. have a chorus followed by a reverb followed by an EQ and so on.

- The FX channel track has its own channel strip in the mixer, the effect return channel. Here you can adjust the effect return level and balance, add EQ and route the effect return to any output bus.

- Each FX channel track has an automation subtrack, for automating various effect parameters. See page 311 for information.
Setting up send effects

Adding an FX channel track

1. Pull down the Project menu and select “FX Channel” from the “Add Track” submenu.
   A dialog appears.

   ![Add FX Channel Track]

   2. Select a channel configuration for the FX channel track.
      Normally, stereo is a good choice since most effect plug-ins have stereo outputs.

   3. Select an effect for the FX channel track.
      This is not strictly necessary at this point – you can leave the Plug-in pop-up menu set to “No Effect” and add effects to the FX channel later if you like.

   4. Click OK.
      An FX channel track is added to the Track list, and the selected effect, if any, is loaded into the first insert effect slot for the FX channel (in that case, the lit Inserts tab for the FX channel track in the Inspector indicates that an effect has been assigned and automatically activated).

- All FX channel tracks you create will appear in a kind of “folder” in the Track list.
  This makes it easy to manage and keep track of all your FX channel tracks, and also allows you to save screen space by folding the FX Channel folder.

![FX Channels]

FX channel tracks are automatically named “FX 1”, “FX 2” etc., but you can rename them if you wish. Just double click the name of an FX channel track in either the Track list or the Inspector and type in a new name.
Adding and setting up effects

As mentioned above, you can add a single insert effect when you create the FX channel track if you like. To add and set up effects after the FX channel track is created, you can either use the Inspector for the track (click the Inserts tab) or the FX Settings window:

1. Click the Edit ("e") button for the FX channel track (in the Track list, mixer or Inspector).
   The FX Settings window appears – this is like a regular Channel Settings window but without the send panel.

![FX Channel Settings](image)

In the middle of the window is the Inserts section with eight effect slots (five in Cubase SL).

2. Make sure the FX channel is routed to the correct output bus.
   This is done with the output routing pop-up menu at the top of the fader section (also available in the mixer and Inspector).

3. To add an insert effect in an empty slot (or replace the current effect in a slot), click on the slot and select an effect from the pop-up menu.
   This works just like when selecting insert effects for a regular audio channel.
4. When you add an effect, its control panel will automatically appear. Typically you should set the Wet/Dry Mix control to all “wet”. This is because you control the balance between wet and dry signal with the effect sends. For more about making settings in the effect control panels, see page 255.

- If you like, you can add up to eight effects for the FX channel (five in Cubase SL). Note that the signal will pass through all the effects in series. It is not possible to adjust the effect send- and return levels separately for each effect – this is done for the FX channel as a whole. If what you want is several separate send effects (where you can control their send and return levels independently) you should instead add more FX channel tracks – one for each effect.

- To remove an insert effect from a slot, click the slot and select “No Effect” from the pop-up menu. You should do this for all effects that you don’t intend to use, to minimize unnecessary CPU load.

- You can also bypass individual effects (or all effects) by clicking the corresponding Bypass Inserts button(s) for the FX channel track. See page 236.

- You can also adjust level, pan and EQ for the effect return in this window. As always, this can also be done in the mixer or in the Inspector.

- **Remember that effects rely heavily on the CPU power in your computer.** The more activated effect units, the more computer power will be used for effects.
Setting up the sends

The next step is to set up and route a send for an audio channel to the FX channel. This can be done in the mixer (in the extended panel), in the Channel Settings window or in the Inspector for the audio track. The example below shows the Channel Settings window, but the procedure is similar for all three sections:

1. Click the “e” button for an audio channel to bring up its Channel Settings window.

In the mixer you would select one of the Sends modes for the extended mixer panel; in the Inspector you would click the Sends tab.

In the channel settings window, the send section is located to the far right. Each of the eight sends has the following controls and options:

- A send on/off switch
- A send level slider
- A pre/post fader switch
- An Edit button

2. Pull down the routing pop-up menu for a send by clicking in the empty slot, and select the desired routing destination.

- If the first item on this menu, “No Bus” is selected, the send isn’t routed anywhere.
- Items called “FX 1”, “FX 2” etc. correspond to existing FX tracks. If you have renamed an FX track (see page 245) that name will appear on this menu instead of the default.
- The menu also allows for routing a send directly to output busses, separate output bus channels or Group channels.

Routing a send to an output bus allows you to use external effect devices for example.
3. In this case, select an FX channel track from the pop-up menu. Now the send is routed to the FX channel.

4. Click the power button for the effect send so that it lights up in blue. This activates the send.

5. Click and drag the send level slider to a moderate value. The send level determines how much of the signal from the audio channel is routed to the FX channel via the send.

6. If you want the signal to be sent to the FX channel before the audio channel’s volume fader in the mixer, click on the Pre Fader button for the send so that it lights up. Normally you want the effect send to be proportional to the channel volume (post fader send). The pictures below show where the sends are “tapped” from the signal in pre and post fader mode, in Cubase SX and Cubase SL, respectively:

Cubase SX:

- Input gain
- Insert effects 1-6
- EQ
- Pre-fader sends
- Volume (fader)
- Insert effects 7-8
- Post-fader sends

Cubase SL:

- Insert effects 1-5
- EQ
- Pre-fader sends
- Volume (fader)
- Post-fader sends
A send set to pre fader mode.

- **You can choose whether a send in pre fader mode should be affected by the channel’s Mute button or not.**
  This is done with the option “Mute Pre-Send when Mute” in the Preferences (VST page).

- **When one or several sends are activated for a channel, the Send Effects buttons light up in blue in the mixer and the Track list. Click the button for a channel to bypass (disable) all its effect sends.**
  When the sends are bypassed, the button is yellow. Click the button again to enable the sends. Note that this button is also available in the Inspector and the Channel settings window.

Click this button to bypass the sends.

- **You can also bypass individual sends in the channel overview.**
  See page 237.

- **Alternatively, in the same manner you can bypass the send effects by clicking the “Bypass Inserts” button for the FX channel.**
  The difference is that this bypasses the actual send effects which may be used by several different channels. Bypassing a send affects that send and that channel only.
Setting pan for the sends

Each send in the Channel Settings window for an audio channel features a pan control that lets you position the effect sound from an FX channel in the sound field – stereo or surround (Cubase SX only).

There are several uses for this:

• If you route a send from a mono channel to a stereo FX channel track, you can position the send signal at center pan in the stereo FX channel (or anywhere you like).
• If you route a send from a stereo channel to a mono FX channel track, the pan control works as a crossfader, determining the balance between the stereo sides when the stereo send signal is mixed to mono.
• In Cubase SX, if you route a send from a mono or stereo channel to a FX channel track in surround format, you can use the surround panner to position the send signal in the surround image.

You set up send panning the following way:

1. Open the Channel settings window for the audio channel.
2. Pull down the Display Modes pop-up menu, located above the sends to the right.
3. On the menu, select “Routing”

Where applicable, small pan controls appear above effect sends routed to FX channels.
4. Click and drag the handle to pan the send.
   As usual, you can reset the pan control to the center position by pressing [Ctrl]/[Command] and clicking on the pan control slider.

- If the FX channel is configured in a surround format (Cubase SX only), the pan control will be a miniature surround panner, similar to the one found in the mixer.
  You can click and drag the “ball” in this figure to position the send in the surround field, or double click the figure to bring up the surround panner. See page 287.

- If both the send (the audio channel) and the FX channel is in mono, the pan control is not available.
Setting effect levels

After you have set up the sends as described in the previous sections, the following is now possible:

- You can use the send level slider in the Channel Settings, Inspector, or the extended part of the mixer to set the send level. By adjusting the send level you control the amount of signal sent from the audio channel to the FX channel.

![Setting the effect send level.](image1)

- In the mixer, you can use the level fader for the FX channel to set the effect return level. By adjusting the return level you control the amount of the signal sent from the FX channel to the output bus.

![Setting the effect return level.](image2)
FX channels and the Solo Defeat function

When mixing, you might sometimes want to solo specific audio channels, and listen only to these while other channels are muted. However, this will mute all FX channels as well. If the soloed audio channels have sends routed to FX channels, this means you won’t hear the send effects for the channels.

To remedy this, you can use the Solo Defeat function for the FX channel:

1. First press [Alt]/[Option] and click on the Solo button for the FX channel.
   This activates the Solo Defeat function for the FX channel. In this mode, the FX channel will not be muted if you solo another channel in the mixer.

2. You can now solo any of the audio channels without having the effect return (the FX channel) muted.

3. To turn off the Solo Defeat function for the FX channel, [Alt]/[Option]-click the Solo button for the FX channel again.
Making settings for the effects

Selecting effect presets

Most VST effect plug-ins come with a number of useful presets for instant selection. You can select presets in the control panel for the effect, but they are also available for selection from the Channel Settings window:

1. Open the Channel Settings for the channel with the insert effects. This means that to select presets for send effects, you should open the FX Settings window for the FX channel track.

2. Pull down the Display Modes pop-up menu above the insert slots and select “Preset”. Now the insert slots show the currently selected presets.

3. Use the pop-up menu (the arrow to the right of the preset name) to select another preset.
Editing effects

All inserts and sends have an Edit ("e") button. Clicking this opens the selected effect’s control panel in which you can make parameter settings.

The contents, design and layout of the control panel depends on the selected effect. However, all effect control panels have a power button, a Bypass button, Read/Write automation buttons (for automating effect parameter changes — see page 311), a preset selection pop-up menu and a file pop-up menu for saving or loading programs. In Cubase SX/SL for Mac OS X these are located at the bottom of the control panel, whereas they are at the top of the control panel in Cubase SX/SL under Windows.

The Rotary effect control panel.

- Please note that all effects can be edited using a simplified control panel (horizontal sliders only, no graphics) if you prefer this. To edit effects using this “basic” control panel instead, press [Ctrl]/[Command]+[Shift] and click on the Edit button for the effect send or slot.

Making settings

Effect control panels may have any combination of knobs, sliders, buttons and graphic curves.

- For specifics about the included effects and their parameters, please refer to the separate pdf document “Audio Effects and VST Instruments”.
Naming effects

If you edit the parameters for an effect, these settings are saved automatically in the project. If you want to name the current settings, the following points apply:

• The basis for the current settings may have been a preset effect program, in which case there is a name in the preset field.
• The basis for the current settings may have been a default setting program location in which case “Default” is displayed in the preset field.

In both cases, if you have changed any effect parameter settings, these are already saved! To name the current settings, click the Name field, type in a new name and press [Return]. The new name replaces the previous name on the program pop-up menu.

Saving effects

You can save your edited effects for further use (e.g. in other projects) by using the file pop-up menu to the right of the name field.

1. Pull down the file pop-up menu.

• If you want to save the current program only, select “Save Effect”. Effect programs have the Windows file extension “.fxp”.

• If you want to save all programs for the effect, select “Save Bank”. Effect banks have the Windows file extension “.fxb”.

2. In the file dialog that appears, select a name and location for the file and click Save.
   It might be a good idea to prepare a special folder for your effects.

Loading effects

1. Pull down the file pop-up menu.

2. Select “Load Effect” or “Load Bank”.

3. In the file dialog that opens, locate the file and click Open.
   If you loaded a Bank, it will replace the current set of all effect programs. If you loaded a single effect, it will replace the currently selected effect program only.

Automating effect parameters

Effects parameters can be automated – see the chapter “Automation”.

Audio effects  
CUBASE SX/SL  
10 – 257
Installing and managing effect plug-ins

There is a wide range of additional effect plug-ins available in the two formats supported by Cubase SX/SL (VST and DirectX). The two formats are handled differently when it comes to installation and organizing:

VST plug-ins

Mac OS X

- If you acquire additional VST plug-ins, make sure they are created specifically for Mac OS X! Plug-ins in Mac OS 9.X format cannot be used.

There is a large number of VST plug-ins available for purchase or download. To install a VST plug-in under Mac OS X, quit Cubase SX/SL and drag the plug-in file to one of the following folders:

- /Library/Audio/Plug-Ins/VST/
  This is only possible if you are the system administrator. Plug-ins installed in this folder will be available to all users, for all programs that support them.

- Users/Username/Library/Audio/Plug-Ins/VST/
  “Username” above is the name you use to log on to the computer (the easiest way to open this folder is to go to your “Home” folder and use the path /Library/Audio/Plug-Ins/VST/ from there). Plug-ins installed in this folder are only available to you.

When you launch Cubase SX/SL again, the new effects will appear on the effect pop-up menus.

- An effect plug-in may also come with its own installation application, in which case you should use this.
  Generally, always read the documentation or readme files before installing new plug-ins.

Windows

Under Windows, VST plug-ins are usually installed simply by dragging the files (with the extension ".dll") into the Vstplugins folder in the Cubase SX/SL application folder, or into the Shared VST Plug-in folder – see below. When you launch Cubase SX/SL again, the new effects will appear on the Effect pop-up menus.

- If the effect plug-in comes with its own installation application, you should use this.
  Generally, always read the documentation or readme files before installing new plug-ins.
Organizing VST plug-ins

If you have a large number of VST plug-ins, having them all on a single pop-up menu in the program may become unmanageable. For this reason, the plug-ins installed with Cubase SX/SL are placed in appropriate subfolders according to the effect type.

- Under Windows, you can rearrange this by moving, adding or renaming subfolders within the Vstplugins folder if you like.
  When you launch the program and pull down an Effects pop-up menu, the subfolders will be represented by hierarchical submenus, each listing the plug-ins in the corresponding subfolder.

- Under Mac OS X, you cannot change the hierarchic arrangement of the "built-in" VST plug-ins.
  You can however arrange any additional plug-ins you have installed (in the /Library/Audio/Plug-Ins/VST/ folders, see above) by placing them in subfolders. In the program, the subfolders will be represented by hierarchical submenus, each listing the plug-ins in the corresponding subfolder.

About shared VST plug-ins (Windows only)

While Cubase SX/SL's own plug-ins reside in the Vstplugins folder within the Cubase SX/SL program folder, the program can also access plug-ins in an additional location, called the shared VST plug-ins folder. This lets you use plug-ins installed by other VST compatible applications, etc. You can change what folder is considered the "shared" Vstplugins folder at any time in the Plug-in Information window, see page 261.

About the “Earlier VST Plug-ins” and “Cubase 5 Plug-ins” subfolders

When installing Cubase SX/SL, you were asked whether you wanted to install the effects from previous versions of Cubase. If you chose to do so, the Cubase 5 effects will appear on a submenu to the effect pop-up menus. If you chose to install the earlier (pre-Cubase 5) plug-ins as well, these will appear on a submenu to the "Cubase 5 Plug-ins" submenu.

The foremost reason for installing these earlier plug-ins is backwards compatibility, allowing you to import old Cubase songs and get the correct effect settings.
**DirectX plug-ins (Windows only)**

To be able to use DirectX plug-ins, you must have Microsoft DirectX installed on your computer (Version 8.1 – or later – recommended and included on the Cubase SX/SL CD).

DirectX plug-ins should *not* be placed in the Vstplugins folder, as these are installed under the operating system rather than for Cubase SX/SL exclusively. Rather, you should follow the installation instructions included with the plug-ins. See also page 264.

- **On the effect menus, all DirectX plug-ins are listed on the DirectX submenu.**
  Selecting, activating and editing them is done as with VST effects.
The Plug-in Information window

On the Devices menu, you will find an item called “Plug-in Information”. Selecting this opens a dialog listing all the available VST and DirectX compatible plug-ins in your system (including VST Instruments), along with all MIDI plug-ins (see page 499).

Managing and selecting VST plug-ins

To see which VST plug-ins are available in your system, click the "VST Plug-ins" tab at the top of the window. The window now displays all plug-ins in the Cubase SX/SL and the shared Vstplugins folder.

- To enable a plug-in (make it available for selection), click in the left column. Only the currently enabled plug-ins (shown with a check sign in the left column) will appear on the effect menus.

- The second column indicates how many instances of the plug-in are currently used in Cubase SX/SL. Clicking in this column for a plug-in which is already in use produces a pop-up showing exactly where each use occurs.

- A plug-in may be in use even if it isn't enabled in the left column. You might for example have opened a project containing effects that currently are disabled on the menu. The left column purely determines whether or not the plug-in will be visible on the effect menus.

- All columns can be resized by using the divider in the column header.
The other columns show the following information about each plug-in:

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the plug-in.</td>
</tr>
<tr>
<td>Nb I/O</td>
<td>This column shows the number of inputs and outputs for each plug-in.</td>
</tr>
<tr>
<td>Category</td>
<td>This indicates the category of each plug-in (such as VST Instruments,</td>
</tr>
<tr>
<td></td>
<td>Surround Effects, etc.).</td>
</tr>
<tr>
<td>Vendor</td>
<td>The manufacturer of the plug-in.</td>
</tr>
<tr>
<td>VST Version</td>
<td>Shows with which version of the VST protocol a plug-in is compatible.</td>
</tr>
<tr>
<td>Delay (sample)</td>
<td>This shows the delay (in samples) that will be introduced if the effect is</td>
</tr>
<tr>
<td></td>
<td>used as an Insert. This is automatically compensated for by Cubase</td>
</tr>
<tr>
<td></td>
<td>SX/SL.</td>
</tr>
<tr>
<td>Use Delay Compensation</td>
<td>This option (checked by default) means that plug-in delay compensation</td>
</tr>
<tr>
<td></td>
<td>is used for this plug-in (see page 233). Note that you can temporarily</td>
</tr>
<tr>
<td></td>
<td>constrain delay compensation - see page 270.</td>
</tr>
<tr>
<td>Nb Params</td>
<td>The number of parameters for the plug-in.</td>
</tr>
<tr>
<td>Nb Programs</td>
<td>The number of programs for the plug-in.</td>
</tr>
<tr>
<td>Old Host Behaviour</td>
<td>Check this column for a specific plug-in if you want it to be processed</td>
</tr>
<tr>
<td></td>
<td>like it was by previous versions of Cubase SX/SL, to avoid problems</td>
</tr>
<tr>
<td></td>
<td>such as feedback-like sounds. Note that you have to reload the plug-in</td>
</tr>
<tr>
<td></td>
<td>for the change to take effect.</td>
</tr>
<tr>
<td>Modified</td>
<td>The last modification date of the plug-in file.</td>
</tr>
<tr>
<td>Path</td>
<td>The path and name of the folder in which the plug-in file is located.</td>
</tr>
</tbody>
</table>

**Update Button**

Pressing this button will make Cubase SX/SL re-scan the designated Vstplugins folders for updated information about the plug-ins.

- If you press [Ctrl]/[Command] and click this button, a text file with the plug-in information is generated.
  The file will be saved in the folder `Documents and Settings\Administrator\Local Settings\Temp` under Windows. Under MacOS X, you will be asked to specify a folder where the file should be saved.
  This document could be useful if you need to contact Steinberg Technical Support – or you might want to use it just as a handy reference of the installed effects.
Changing the Shared Plug-ins Folder (Windows only)

If you like, you can change what folder is to be the “shared” Vstplugins folder. For example, if you have Steinberg’s Cubase VST 5.1 installed on your computer, you can get access to the Cubase VST 5.1-specific plug-ins in Cubase SX/SL by switching to the Vstplugins folder within the Cubase VST 5.1 folder.

The currently selected Shared Folder is displayed in the text field at the top of the window. Clicking the “Change...” button opens a file dialog where you can browse to another Vstplugins folder on your hard drive. Clicking OK selects the new folder as the shared VST plug-ins folder.

After selecting a new shared plug-ins folder, you will first be prompted to confirm your choice, and you will then need to restart Cubase SX/SL for the effects in the new folder to become available.

- Similarly, you can also add additional Shared Plug-ins folders by clicking the “Add” button and browsing to another Vstplugins folder on your hard drive.

If you have several folders assigned as Shared Plug-ins Folders, you can at any time use the text field pop-up menu to decide which of the assigned folders should be the designated active one.

- To remove a Shared Plug-ins Folder, select it and click the “Remove” button.
Managing and selecting DirectX plug-ins (Windows only)

To see which DirectX plug-ins are available in your system, click the "DirectX Plug-ins" tab at the top of the window.

- To enable a plug-in (make it available for selection), click in the leftmost column. Only the currently enabled plug-ins (shown with a check sign in the left column) will appear on the Effect menus.

  The idea here is that there could be a variety of DirectX plug-ins in your system, many of which are not intended for musical audio processing. Disabling these helps you keep the effect menus in Cubase SX/SL more manageable.

- The second column indicates how many instances of the plug-in are currently used in Cubase SX/SL. Clicking in this column for a plug-in which is already in use produces a pop-up showing exactly where each use occurs.

  Please note that a plug-in may be in use even if it isn’t enabled in the left column. You might for example have opened a project containing effects that currently are disabled on the menu. The left column purely determines whether or not the plug-in will be visible on the effect menus.
11

VST Instruments
Introduction

VST Instruments are software synthesizers (or other sound sources) that are contained within Cubase SX/SL. They are played internally via MIDI, and their audio outputs appear on separate channels in the mixer, allowing you to add effects or EQ, just as with audio tracks.

Some VST Instruments are included with Cubase SX/SL, others can be purchased separately from Steinberg and other manufacturers. The following VST Instruments are included and installed with Cubase SX/SL:

• A1 – a software synthesizer powered by Waldorf.
• VB-1 – a virtual bass instrument built on real-time physical modelling principles.
• LM-7 – a 24 bit drum machine.
• This chapter describes the general procedures for setting up and using VST Instruments.

For descriptions of the included VST Instruments and their parameters, see the separate pdf document “Audio Effects and VST Instruments”.

Activating and using VST Instruments

1. Pull down the Devices menu and select VST Instruments. The VST Instruments panel appears with 64 slots (32 in Cubase SL).

2. Pull down the pop-up menu for an empty slot in the panel and select the desired instrument. The instrument is loaded and activated, and its control panel is automatically opened.

   • If you look in the Project window, you will find that a special “folder” for the chosen instrument has been added, within a “VST Instruments” folder (where all your VST Instruments will appear). The separate folder for the added instrument contains two or more automation tracks: one for automating the plug-in parameters and one for each mixer channel used by the VST Instrument. For example, if you add a VST Instrument with four separate outputs (four separate mixer channels), the folder will contain five automation tracks. To keep the screen less cluttered, you may want to close the folder for the VST Instrument until you need to view or edit any of the automation tracks. For more about automation, see page 297.

3. Select the mixer channel automation track(s) for the VST Instrument and use the “Out” pop-up menu in the Inspector to route them to the desired output channels or groups. If you are using Cubase SX, you can also do this from the mixer.

4. Select an unused MIDI track in the Project window.

5. Pull down the output pop-up menu for the MIDI track in the Track list or in the Inspector. The pop-up menu will now contain an additional item, with the name of the activated VST Instrument.
6. Select the VST Instrument on the MIDI output pop-up menu.
   The MIDI output from the track is now routed to the selected instrument.

7. Depending on the selected instrument, you may also need to select a MIDI channel for the track.
   For example, a multi-timbral VST Instrument can play back different sounds on different MIDI channels – check the instrument’s documentation for MIDI implementation details.

8. Make sure the option “MIDI Thru Active” is activated in the Preferences dialog (MIDI page).

9. Click the Monitor button for the MIDI track (in the Track list, Inspector or mixer).
   When this is activated (or when the track is record enabled, see page 65) incoming MIDI is passed on to the selected MIDI output (in this case the VST Instrument).

10. Open the mixer.
    You will find one or more additional channel strips for the instrument’s audio outputs. VST Instrument channel strips have the same features and functionality as group channel strips, with the addition of an Edit button at the bottom of the strip for opening the VST Instrument control panel. In Cubase SX you will also find output routing pop-up menus at the top of the channel strips, for routing the VST Instrument channel(s) to output channels or groups (in Cubase SL this is done from the Inspector).

11. Play the instrument from your MIDI keyboard.
    You can use the mixer settings to adjust the sound, add EQ or effects, etc. – just as with regular audio channels. Of course, you can also record or manually create MIDI parts that play back sounds from the VST Instrument.

   - You can have up to 64 (32 in Cubase SL) VST Instruments activated at the same time, different models or several instances of the same instrument. However, software synthesizers can consume quite a lot of CPU power – keep an eye on the VST Performance window to avoid running out of processor power. See also page 273.
About latency

Depending on your audio hardware and its ASIO driver, the latency (the time it takes for the Instrument to produce a sound when you press a key on your MIDI controller) may simply be too high to allow comfortable real-time VST Instrument playback from a keyboard.

If this is the case, a workaround is to play and record your parts with another MIDI Sound Source selected, and then switch to the VST Instrument for playback.

• You can check the latency for your audio hardware in the Device Setup dialog (VST Multitrack page).
  The input and output latency values are shown under the ASIO Driver pop-up menu. For live VST Instruments playing, these values should ideally be a few milliseconds (although the limit for “comfortable” live playing is a matter of personal taste).
Constrain Delay Compensation

Cubase SX/SL features full delay compensation throughout the entire audio path. This means that any delay inherent in the VST plug-ins you use will automatically be compensated for during playback, so that all channels are kept in perfect sync (see page 233).

However, when you play a VST Instrument in real time or record live audio (with monitoring through Cubase SX/SL activated), this delay compensation may sometimes result in added latency. To avoid this, you can click the Constrain Delay Compensation button on the Project window toolbar. This function tries to minimize the latency effects of the delay compensation, while maintaining the sound of the mix as far as possible.

- In the Preferences dialog (VST page) you will find a setting called Delay Compensation Threshold. Only plug-ins with a delay higher than this setting will be affected by the Constrain Delay Compensation function.

- VST plug-ins (with higher delay than the threshold value) which are activated for VST Instrument channels, audio track channels that are record enabled, group channels and output channels will be turned off when you activate Constrain Delay Compensation.

- VST plug-ins activated for FX channels are not turned off but their delay is disregarded by the program (delay compensation is turned off).

After recording or using a VST Instrument with Constrain Delay Compensation, you should turn off the function to restore full delay compensation.
Selecting patches and making settings

- To select a patch for a VST Instrument, use its patch pop-up menu in the VST Instruments window. The available patches depends on the VST Instrument. Not all VST Instruments come with pre-made patches.

- To access the parameters for the VST Instrument, click the Edit button in the VST Instruments window or in its channel strip (at the bottom of the fader strip) in the mixer. This opens a "control panel" for the VST Instrument.

- For descriptions of the included VST Instruments and their parameters, see the separate pdf document "Audio Effects and VST Instruments".

Selecting patches from the Project window

When a VST Instrument is selected as MIDI output for a track, you can also select patches by name, using the program pop-up menu in the Track list or Inspector. Although this is set up automatically and transparently, there are a couple of things to note:

- If the VST Instrument supports the VST 2.1 standard (or later), selecting a patch will cause Cubase SX/SL to send MIDI Program Change and Bank Select messages to the VST Instrument, just as with "real" physical MIDI instruments. A consequence of this is that you can enter Program Change events in MIDI parts anywhere on the track, having the VST Instrument change patch at the desired locations ("automating" the patch selection).

- If the VST Instrument supports the original VST 2.0 standard only, only limited support of patch selection is offered. In this case, selecting a patch will actually ask the VST Instrument to change "Plug-in Program", which is not the same as selecting a "Patch" by sending MIDI Program Change and Bank Select messages.
Automating a VST Instrument

- Automation of the VST Instrument channel settings is done in the same way as automating regular channels.
- Automation of the specific parameters for a VST Instrument is done in the same way as automating VST effect parameters.

See page 296.
The Instrument Freeze function

Like all plug-ins, VST Instruments can sometimes require a lot of processor power. If you are using a moderately powerful computer or if you are using a large number of VST Instruments, you may come to a point where your computer cannot handle all VST Instruments playing back in real time (the CPU overload indicator in the VST Performance window lights up, you get crackling sounds, etc.).

Enter the Instrument Freeze function! This is how it works:

- When you freeze a VST Instrument, the program renders an audio file of its output (taking into account all unmuted MIDI parts routed to that VST Instrument). This file is placed in the “Freeze” folder within the Project folder.
- All MIDI tracks routed to the VST Instrument are muted and locked (the controls for these tracks will appear “greyed-out” in the Track list and Inspector).
- When you play back, the rendered audio file is played back from an “invisible” audio track, routed to the VST Instrument’s mixer channel. Thus, any effects, EQ or mixing automation will still be applied.

The result of all this is that you get exactly the same sound as before, but the computer processor doesn’t have to calculate the sound of the VST Instrument in real time.

- If you need to edit the MIDI parts routed to the VST Instrument or adjust the settings on the instrument itself, you need to unfreeze the instrument first. This removes the rendered file and restores the MIDI tracks and VST Instrument. Once you have made the necessary adjustments you can freeze the instrument again.
Performing the Freeze

1. Set up the Project so that the VST Instrument plays back the way you want it.
   This includes editing the MIDI parts routed to the VST Instrument and making parameter settings for the VST Instrument itself. If you have automated parameter changes for the VST instrument, make sure the Read (R) button is activated.

2. Open the Project Setup dialog and make sure the Length setting matches the actual project length.
   The rendered freeze file will span the whole project length. Although empty (silent) sections will not affect the size of the freeze file, the Instrument Freeze operation will take longer if you have an unnecessarily high Length setting.

3. Open the VST Instruments window from the Devices menu.

4. Click the Freeze button for the VST Instrument (the button to the left of the VST Instrument slot).
   A progress dialog is shown while the program renders the VST Instrument audio to a file on your hard disk.
   The Freeze button lights up and the power, bypass and edit buttons for the VST Instrument are greyed out (and the control panel closes if it was open). If you check the Project window at this point you will find that the relevant MIDI tracks have greyed out controls in the Track list and Inspector. Furthermore, the MIDI parts are locked and cannot be moved.

5. Try playing back the project.
   You will hear exactly the same sound as before Freezing the VST Instrument – but the CPU load will be considerably less! You can make settings for the VST Instrument channel in the Mixer as usual – add EQ, effects, make level adjustments, etc.
Unfreezing

If you need to make adjustments (either to the MIDI tracks or to the VST instrument parameters) you need to unfreeze the VST Instrument:

1. Click the Freeze button for the VST Instrument slot again.
   You will be asked whether you really want to unfreeze the instrument.

2. Click "Unfreeze".
   The MIDI tracks and VST Instrument are restored and the rendered “freeze file” is deleted.
12
Surround sound
(Cubase SX only)
Background

What is Surround sound?

Surround is a common name for various techniques for positioning audio in reference to the listener. Whereas regular stereo is limited to left/right positioning, within a relatively narrow field, surround sound opens possibilities of positioning an audio source anywhere around the listener.

Surround sound comes in many flavors, from the ill-fated Quadraphonic format for vinyl discs launched in the 70s, to today’s more successful incarnations.

The differences between the formats are in two areas:

• The number and configuration of speakers. This varies from two speakers up to 6.
• The intended final coding format. This depends on the media the audio will be “stored” on: film, broadcast video or DVD, for example.

Surround sound is a large topic, there are entire books and regular publications devoted to the subject. This chapter will not provide an in-depth introduction to surround sound as such. Instead it will concentrate on the specific implementation in Cubase SX.

Surround sound in Cubase SX

Cubase SX has integrated surround sound features with support for several formats. This support goes all the way through the audio path – all audio channels and busses can handle multiple speaker channel configurations (up to 6 channels). An individual channel in the mixer can either carry complete surround mixes, or an individual speaker channel which is part of a surround setup.

• Audio channels can be routed freely to surround channels.
• The Surround Panner function in the mixer allows you to graphically position channels in the surround field.
• Cubase SX is ready for surround specific plug-ins, that is plug-ins with multi-channel support specifically designed for surround sound mixing tasks (the included “Mix6to2” plug-in is an example of this). There are also surround aware plug-ins, which are not designed specifically for Surround but which due to their multi-channel support work well in a Surround configuration. An example is the Surrounddither plug-in.
• You configure Cubase SX for surround by defining input and output busses in the desired surround format, and specifying which audio inputs and outputs should be used for the different channels in the busses. This is done in the VST Connections window.

Requirements for using Surround

The following additional equipment is required for taking advantage of Cubase SX’s surround sound implementation:

• An audio card with more than two outputs.
  The card must have as many outputs as the surround format you plan to select.
• A matching amplifier/speaker configuration.

Encoding

The result of a surround mix in Cubase SX is either the multi-channel audio sent from the surround output bus to your surround speaker setup, or (if you use the Export audio feature) audio file(s) on your hard disk. Exported surround mixes can either be split (one mono file per speaker channel) or interleaved (a single file containing all the surround channels).

Getting from this step to the final product (surround sound on DVD disc etc.) requires special software and possibly hardware. This equipment will encode the signal into the desired format, possibly compress the audio and store it on the final media.

Exactly what type of software and/or hardware you need depends on what kind of format you are mixing for and is not dependent on Cubase SX in any way.
About surround plug-ins

Included with the program are some specific surround-plug-ins. These are:

- **Mix6to2**
  The Mix6to2 effect allows you to control the levels of up to six surround channels, and to mix these down to a stereo output.

- **SurroundDither**
  This is a dithering plug-in capable of handling six channels at the same time – use this for applying dithering to a surround output bus.

- **SurroundPanner**
  This is described on page 287.

- **Surround plug-ins (apart from the SurroundPanner) are described in the separate pdf document “Audio Effects and VST instruments”**.
Window overview

VST Connections

In this window you can add input and output busses. There is a complete selection of common surround configurations available, as well as standard mono or stereo busses.

The Bus Name column contains the currently configured busses as they will appear in the input and output routing pop-ups in the mixer.

Selects the Input or Output bus page. Click here to add a bus. The outputs selected for the channels in the busses.

VST Connections showing the Outputs page.
**Surround in the mixer**

Surround sound is supported throughout every stage of the signal path in the Cubase SX mixer, from input to output bus. Each bus or audio channel can carry up to 6 surround speaker channels.

Here, the SurroundPanner is used for positioning the sound “dynamically” in the surround field.

Using the Output Routing pop-up, audio channels can be routed directly to surround channels.

In the output channel section of the mixer you can control the master levels for configured busses. The level meter for a bus (or channel in the mixer) that carries multiple surround channels will show multiple level bars, one for each speaker channel in the surround configuration.
Operations

Setting up the surround configuration

Output bus configuration

Before you can start working with surround sound, you have to configure a surround output bus, through which all the speaker channels of the chosen surround format are routed. How to add and set up buses is described in detail on page 14. Here is a brief run through:

1. Open the VST Connections window from the Devices menu.
2. Click the “Outputs” tab.
3. Click the “Add Bus” button and select one of the preset formats from the Configuration pop-up (see below). The new bus appears with the ports visible.
4. By clicking in the ASIO Device Port column you can now route the speaker channels to the desired outputs of your audio hardware.
5. If you like, rename the output bus by clicking its name and typing in a new one. This name will appear in the mixer and on routing pop-ups.

The following surround configurations are included:

<table>
<thead>
<tr>
<th>Format</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>LRCS</td>
<td>LRCS refers to Left Right Center Surround, where the surround speaker is center-rear positioned. This is the original surround format that first appeared as Dolby Stereo in cinema and later as the home cinema format Dolby ProLogic.</td>
</tr>
<tr>
<td>5.0</td>
<td>This is the same as 5.1 (see below) but without the LFE channel. The LFE channel is optional in 5.1 and if you don’t plan to use it, you might find this option more convenient.</td>
</tr>
<tr>
<td>5.1</td>
<td>This format is one of the most popular in cinema and DVD. In its various cinema and DVD encoding implementations (established by different manufacturers) it is referred to as Dolby Digital, AC-3, DTS and MPEG 2 Multichannel. 5.1 has one center speaker (mainly used for speech) and four surround speakers (for music and sound effects). Additionally a sub-channel (LFE – Low Frequency Effects) with lower bandwidth is used for special low frequency effects.</td>
</tr>
</tbody>
</table>
Child busses

Essentially a child bus is a bus within a (“bigger”) bus. Typically you may want stereo child busses within your surround bus – this allows you to route stereo tracks directly to a stereo speaker pair within the surround bus. You may also want to add child busses in other surround formats (with fewer channels than the “parent bus”).

Once you have created a surround bus, you can add one or several child busses to it by right-clicking (Windows) or [Ctrl]-clicking (Mac) the bus and selecting “Add Child Bus”. This is described in detail on page 19.

<table>
<thead>
<tr>
<th>Format</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>LRC</td>
<td>Same as LRCS, but without the surround speaker channel.</td>
</tr>
<tr>
<td>LRS+Lfe</td>
<td>Same as LRS but with an Lfe sub-channel added.</td>
</tr>
<tr>
<td>Quadro</td>
<td>The original Quadraphonic format for music, with one speaker in each corner.</td>
</tr>
<tr>
<td>LRCS+Lfe</td>
<td>Same as LRCS but with an Lfe sub-channel added.</td>
</tr>
<tr>
<td>Quadro+Lfe</td>
<td>Same as Quadro but with an Lfe sub-channel added.</td>
</tr>
<tr>
<td>6.0 Cine</td>
<td>A Left-Right-Center front speaker arrangement with 3 (Left-Right-Center)</td>
</tr>
<tr>
<td></td>
<td>surround channels.</td>
</tr>
<tr>
<td>6.0 Music</td>
<td>This uses 2 (Left/Right) front channels with Left and Right surround chan-</td>
</tr>
<tr>
<td></td>
<td>nels and Left and Right Side channels.</td>
</tr>
</tbody>
</table>
**Input bus configuration**

To work with surround sound in Cubase SX, it is often not necessary to configure a surround format input bus. You can record audio files via standard inputs, and easily route the resulting audio channels to surround outputs at any stage. You can also directly import multichannel files of specific surround format onto audio tracks of the same format.

You should add a surround input bus in the following circumstances:

- You have existing audio material in a specific surround format, and you wish to transfer this material into Cubase SX as a single, multi-channel file.

- You wish to record a surround setup “live”.

In both cases, you can add and configure an input bus of the format you wish to use in the VST Connections dialog so that each input on your audio hardware is routed to the corresponding speaker channel.

To add an input bus, use the same general method as described on page 283, but select the “Inputs” tab instead.
Routing channels directly to surround channels

If you want to place an audio source in one separate speaker channel only, you can route it directly to that speaker channel. This is useful for pre-mixed material or multi-channel recordings that don’t require panning.

1. Open the mixer and locate the channel you wish to route.
2. From the output routing pop-up menu, select the corresponding surround speaker channel.

• If a stereo audio channel is routed directly to speaker channel, the left/right channels will be mixed to mono.
  The pan control for the audio channel governs the balance between the left and right channel in the resulting mono mix. Center pan will produce a mix of equal proportion.

Routing channels using Child busses

Child busses provide a way to route stereo (or multichannel) audio channels to specific speaker channels in a surround configuration.

The most obvious application of a child bus is when you wish to add a stereo channel to two specific left/right surround speaker channels.

If you have added a child bus within a surround bus (see page 284), it appears as a submenu item within the surround bus on the output routing pop-up menu. Select this to route a stereo audio channel directly to that stereo speaker pair in the surround bus.
Using the Surround Panner

Cubase SX has a special feature for graphically positioning a sound source in a surround field. This is actually a special plug-in which distributes the audio from the channel in various proportions to the surround channels.

1. Open the mixer and locate the channel you wish to position.
   This could be a mono or stereo channel.

2. From the output routing pop-up menu, select the “whole surround bus” (not a surround speaker channel).
   A miniature graph of the surround plug-in interface appears above the fader in the channel strip.

   ![Surround Panner Interface](image)

   When the “whole surround bus” is selected, the channel strip shows a miniature surround control.

3. Click and drag directly in the miniature image to move the sound in the surround field.
   The horizontal red strip to the right controls the subbass (LFE) level (if available in the selected surround format).

   - You can also view a slightly larger version of this control by selecting “Surround Pan” on the view options pop-up for the extended mixer panel.
     This mode offers click and drag-panning as well as numerical values for left/right balance, front/rear balance and LFE amount – type or use a mouse wheel to adjust them.

   - For total control over surround panning, you can double click on the miniature image to open the full Surround Panner interface in a separate window.
The **SurroundPan controls**

The SurroundPan plug-in interface in Standard, Position and Angle mode, respectively.

The SurroundPan plug-in allows you to position your audio in the surround field. It consists of an image of the speaker arrangement, as defined by the output bus selected on the output routing pop-up menu, with the sound source indicated as a grey ball.

The following options and methods are available:

**Mode – Standard/Position/Angle**

The Standard Mode/Position Mode/Angle Mode switch allows you to work in three modes:

- In both Standard and Position mode, the speakers in the front are aligned, as they would normally be in a cinema-type situation. This means that the front speakers are at a varying distance from the center. Standard mode (default) is the best mode for moving sources between speakers without level attenuation.
- Angle Mode is the traditional surround sound mixing definition. Note that here the speakers are defined as being at equal distance from the center. This is not really a true representation of for example a cinema, but has still proven to work well in many situations.
Speakers

The speakers in the panel represent the chosen surround configuration.

- The speakers in the front are aligned, as they would normally be in a cinema-type situation. This means that the front speakers are at a varying distance from the center, allowing you to move sources between speakers without level attenuation.

- You can turn speakers on and off by clicking them with [Alt]/[Option] pressed. When a speaker is turned off, no audio will be routed to that surround channel.

Positioning and levels

- The text below assumes mono/stereo pop-up is set to “Mono Mix”. For more information on the other modes, see below.

A sound source is positioned either by clicking or dragging the grey “ball” around in the panel (or by using key commands, see below). By dragging during playback you can record automation, see page 306.

- In Standard Mode, the signal levels from the individual speakers are indicated by colored lines from the speakers to the center of display.

- In Position Mode, the concentric circles will help you determine the level of the signal at a certain position. The yellow circle represents -3dB below nominal level, the red circle is at -6dB and the blue is located at -12dB. These are affected by attenuation, see below.

- In Angle Mode, a red arc helps you determine the perceived “range” of a source. The sound will be at its loudest in the middle of the arc and will have dropped in level towards the ends.

Exactly how levels are handled may require some explanation:

- When you move a source around, a number will indicate the loudness in each speaker. This is a value in dB (decibel) and is relative to the nominal level of the source. In other words, 0.0 (dB) represents full level.

- If you position the source far enough away from a speaker, its level will drop to zero (indicated by an infinity symbol).
• The signal levels from the individual speakers are indicated by colored lines from the speakers to the center of display.

• You can use modifier keys to restrict movement in various ways:

In Standard and Position Mode:

<table>
<thead>
<tr>
<th>Key</th>
<th>Movement restriction</th>
</tr>
</thead>
<tbody>
<tr>
<td>[Shift]</td>
<td>Horizontally only</td>
</tr>
<tr>
<td>[Ctrl]/[Command]</td>
<td>Vertically only</td>
</tr>
<tr>
<td>[Alt]/[Option]</td>
<td>Diagonally (up left, down right)</td>
</tr>
<tr>
<td>[Ctrl]/[Command]+[Alt]/[Option]</td>
<td>Diagonally (up right, down left)</td>
</tr>
</tbody>
</table>

In Angle Mode:

<table>
<thead>
<tr>
<th>Key</th>
<th>Movement restriction</th>
</tr>
</thead>
<tbody>
<tr>
<td>[Shift]</td>
<td>From center to perimeter only</td>
</tr>
<tr>
<td>[Ctrl]/[Command]</td>
<td>Along the perimeter only (at current distance from center)</td>
</tr>
</tbody>
</table>

There is also a special set of key commands for working in the SurroundPan window.

☐ For a complete list of the available key commands, click on the “Surround-Panner” logo and then click again!
The LFE dial (All Modes)

If the selected surround setup includes an LFE (Low Frequency Effects) channel, a separate LFE level dial will be available in the SurroundPan window. Use this to set the signal amount sent to the LFE channel. You can also set this using the small red strip to the right of the Surround Panner in the mixer channel strip, or by typing in a numerical value in the larger Surround Panner that can be shown in the extended channel strip.

The Surround Panner in the channel strip (bottom) and in the extended panel of the mixer channel strip (“SurroundPan” activated).

Mono/stereo pop-up (All Modes)

If you have a mono channel this is by default set to Mono Mix. The panner will then behave as described above.

If you have a stereo channel, you have the option of using one of the three Mirror modes. Two grey balls will then appear, one for each channel (L/R). This will allow you to move the two channels symmetrically, by just dragging one of them. The three modes allow you to select which axis should be used for mirroring.

- The default mode for stereo channels is the Y-Mirror mode.
- If you run a stereo signal through the panner in Mono Mix mode, the two channels will be mixed together before entering the plug-in.
- If you run a mono signal through the plug-in in one of the stereo modes, the signal will be split before entering the plug-in.
Additional Parameters (Standard Mode)

- **Center Level.**
  This determines how center source signals should be reproduced by the front speakers. With a value of 100%, the center speaker will provide the center source. With a value of 0%, the center source will be provided by the ghost image created by the left and right speakers. Other values will produce a mix between these two methods.

- **Divergence Controls.**
  The three divergence controls determine the attenuation curves used when positioning sound sources, for X-axis front, X-axis back and Y-axis (front/rear), respectively. If all three Divergence values are 0% (default), positioning a sound source on a speaker will set all other speakers to zero level (\(-\infty\)) (except for the center speaker which depends on the center level). With higher values, the other speakers will receive a percentage of the sound source.
Additional Parameters (Position and Angle Mode)

• Attenuate.
  Attenuate can be used to amplify or weaken the source. Exactly what effect this has on the level in each speaker can be determined by the level readouts, the concentric circle (Position mode) and the arc (Angle mode).

• Normalize.
  Normalize is a function for controlling the overall loudness from all speakers. When this is set to 1.0 (full normalization), the level from all speakers together is always exactly 0dB. The individual levels will then be boosted or attenuated accordingly.

- Please note that this is not a dynamic feature, like compression or limiting. It is instead just a tool for scaling the nominal output levels from the surround channels.

Automation

All parameters in the SurroundPan plug-in can be automated, just as with any other plug-in. See page 306.

Exporting a Surround mix

When you have set up a surround mix you can choose to export it with the Export Audio Mixdown function. This function exports a single selected output bus – this means that all channels that you want to be part of the mix must be routed to the surround output bus.

You have the following export options when doing surround work:

• Export to “split” format, resulting in one mono audio file for each surround channel.
• Export to interleaved format, resulting in a single multi-channel audio file (e.g. a 5.1 file, containing all six surround channels).
• Under Windows you can also export a 5.1 surround mix to a file in Windows Media Audio Pro format.
  This is an encoding format tailored for 5.1 surround – see page 701.

For more about exporting to files, see the chapter “Export Audio Mixdown”.

Surround sound (Cubase SX only)
Using effects in surround configurations

Cubase SX introduces a special surround format for VST plug-ins, that is plug-ins that can process more than two channels. Mix6to2 is an example of such a plug-in.

Applying a Surround-aware plug-in

This is not different from applying a regular plug-in. The only difference is that the plug-in panel may have controls for more than two channels.

Using a stereo plug-in in a surround configuration

Normally, when you apply a stereo insert effect to a surround configuration, the first two speaker channels (often L and R) are routed through the plug-in and other channels are left unprocessed.

However, you may want to use the plug-in on other speaker channels. This is described on page 238.
Automation
Background

Cubase SX/SL provides very comprehensive automation features. Virtually every mixer and effect parameter can be automated.

There are two main methods you can use to automate parameter settings:

- By manually drawing curves on automation subtracks in the Project window. See page 314.

- By using the Write/Read buttons and adjusting parameters in the mixer. See page 306.

The methods are not different in terms of how the automation data is applied – they only differ in the way the automation events are created; manually drawing them or recording them. Any applied automation data will be reflected in both the mixer (a fader will move for example) and in a corresponding automation track curve (although this may be hidden).
About automation subtracks

Audio tracks, group tracks and FX channel tracks all have automation subtracks. These allow you to view and edit the automation of all mixer settings for the track, including settings for the track’s insert effects. There is one automation subtrack for each parameter, and subtracks can be shown or hidden in any combination.

Similarly, MIDI tracks have automation subtracks for mixer settings, track parameters as well as send and insert effect settings (if used).

VST Instruments have special automation tracks that appear in the Project window when you add a VST Instrument. There is one automation track for the plug-in parameters and one track for each mixer channel used by the instrument. These tracks all have automation subtracks, giving you access to all parameters and mixer settings.

Finally, for ReWire channels and input/output channels, automation tracks are automatically added as soon as you activate automation (with the Write button) in the corresponding mixer channel strip or Channel Settings window. These automation tracks have subtracks for all parameters as well.

What can be automated?

Mixing in Cubase SX/SL can be completely automated. The following parameter settings can be recorded automatically – or manually drawn in – on automation subtracks:

For each audio or group track and ReWire channel:

- Volume
- Mute
- Pan left/right
- 8 x insert effect program selection and effect parameters (if inserts are used)
- 8 x effect send on/off switches
- 8 x effect send levels
- Surround panner parameters
- EQ master bypass
- Settings for 4 EQ modules (enable/freq/quality/gain)
For each FX channel track and input/output bus:

- Volume
- Mute
- Pan left/right
- 8 x insert effect program selection and effect parameters (if inserts are used)
- Surround panner parameters
- EQ master bypass
- Settings for 4 EQ modules (enable/freq/quality/gain)

For each VST Instrument

- VST Instrument plug-in parameters and program selection plus (for each mixer channel/separate output used by the instrument):
  - Volume
  - Mute
  - Pan left/right
  - 8 x insert effect program selection and effect parameters (if inserts are used)
  - 8 x effect send on/off switches
  - 8 x effect send levels
  - Surround panner parameters
  - EQ master bypass
  - Settings for 4 EQ modules (enable/freq/quality/gain)

Note that Cubase SL only has 5 insert slots for each audio/group/ReWire/FX and output bus channel.

For each MIDI track

- Volume
- Pan
- Mute
- Track parameters on/off switch
- Transpose
- Vel. shift
- Random 1-2 min/max/target
- Range 1-2 min/max/target
- 4 x insert effect on/off switches
- 4 x send effect on/off switches
- 4 x MIDI insert effect parameters (if used)
- 4 x MIDI send effect parameters (if used)
Automation track operations

Opening automation subtracks

Every track/channel has a number of automation subtracks, each showing one automation parameter.

For audio, group, MIDI and FX channel tracks, there are two ways you can open an automation subtrack for the channel:

• By right-clicking (Win) or [Ctrl]-clicking (Mac) the track in the Track list and selecting “Show Automation” from the pop-up that appears.

• By clicking on the “Show/Hide Automation” button (the plus sign) in the Track list for the channel.

An automation subtrack opens in the Track list, and a straight black horizontal line is shown as well as a greyed out mirror image of the audio events’ waveform (or MIDI events for MIDI tracks) in the event display. By default, the volume parameter is assigned to the first subtrack.

Click the “+” button to open an automation subtrack.

For VST Instruments, automation tracks appear automatically when you add VST Instruments.

For ReWire channels and input/output busses, automation tracks are automatically created when the Write automation button (see page 306) is activated in either:

• The corresponding channel strip in the mixer.
• The corresponding Channel Settings window.
• The mixer common panel (“Write All”).
• The area above the Track list (“Write All”)
Opening additional automation subtracks

- If you click on the “Append Automation Track” button (the “+” sign) for an automation subtrack, another subtrack opens, by default showing the next parameter in the Add Parameter list (see below).
Assigning a parameter to an automation subtrack

Default parameters are already assigned to automation subtracks when you open them, according to their order in the Add Parameter list (see below). To select what parameter an open subtrack should display, proceed as follows:

1. If none exists, open an automation subtrack using one of the methods described above.

2. Click in the parameter display for the automation subtrack. A pop-up list is shown containing some of the automation parameters plus the item “More...” at the bottom of the list.

   • If the parameter you wish to automate is on the pop-up you can select it directly. The parameter will then replace the current parameter in the automation subtrack.

   • If you wish to add a parameter not available on the pop-up and want to view all parameters that can be automated, go on to the next step.
3. Select “More...”.
   The Add Parameter dialog appears. This dialog shows a list with all parameters, sorted
   into different categories, that can be automated for the selected channel, including the
   parameters for any assigned insert effects. See page 297 for a list of the available pa-
   rameters according to channel type.

   ![Add Parameter dialog for an audio track.](image)

   The Add Parameter dialog for an audio track.

4. Select a parameter from the list and click OK.
   The parameter will then replace the current parameter in the automation subtrack.

   • To view the parameters in each category click the “+” sign for the cate-
     gory folder.
• Note that the “replacing” of the parameter displayed in the subtrack is completely non-destructive.

For example, if the subtrack contained any automation data for the parameter you just replaced, this data would still be there, although it would not be visible after you replaced the parameter. If you click in the parameter display you can switch back to the replaced parameter. All automated parameters are indicated by an asterisk (*) after the parameter name on the pop-up menu.

![Image of subtracks]

The Volume parameter is automated.

You can click the “Show/Hide Automation” button (the plus sign) for the automation subtrack to open additional subtracks and repeat the above procedure to assign a parameter to each subtrack.

**Removing automation subtracks**

To remove automation subtracks from the Track list, proceed as follows:

- To remove a single subtrack, click the parameter name and select “Remove Parameter” from the pop-up menu.
  Note that this will also delete any automation events on the subtrack, and the subtrack will be closed.

- To remove all currently unused subtracks from a track in the Track list, select “Remove Unused Parameters” from any of its subtrack parameter name pop-ups.
  All subtracks that do not contain automation events will be closed for the selected track.
Hiding automation subtracks

- To hide a single automation subtrack, click the “Hide Automation” button (the minus sign) in the Track list.

- To hide all automation subtracks for a track, right-click (Win) or [Ctrl]-click (Mac) the track for which you wish to hide the automation subtracks, and select “Hide Automation” from the pop-up menu that appears.

- To hide all automation subtracks for all tracks in the Track list, right-click (Win) or [Ctrl]-click (Mac) any track and select “Hide All Automation” from the pop-up menu that appears. This option is also available on the Project menu.

Showing only used automation subtracks

If a lot of automation subtracks are used, it may be impractical to have them all open in the Track list. If you want to view only the subtracks that are used (i.e. those that actually contain automation events) and hide all empty automation subtracks, do one of the following:

- Right-click (Win) or [Ctrl]-click (Mac) any track in the Track list and select the option “Show Used Automation for All Tracks” from the pop-up menu. This will close all automation subtracks not containing any automation events, while leaving used subtracks open for all tracks. This option is also available on the Project menu.

- Right-click (Win) or [Ctrl]-click (Mac) a specific track and select the option “Show Used Automation” from the pop-up menu. This will close all automation subtracks not containing any automation events, while leaving used subtracks open for the selected track.
Muting automation subtracks

You can mute individual automation subtracks by clicking their Mute buttons in the Track list. While clicking the Read (R) button (see page 306) for an automation subtrack will activate or deactivate Read mode for all automated parameters of the track, using the Mute button allows you to turn off automation for a single parameter.

The “Automation follows Events” setting

If you activate “Automation follows Events” on the Edit menu (or in the Preferences–Editing dialog), automation events will automatically follow when you move an event or part on the track.

This makes it easy to set up automation related to a specific event or part, rather than to a specific position in the project. For example, you can automate the panning of a sound effect event (having the sound pan from left to right, etc.) – if you need to move the event, the automation will automatically follow! The rules are:

- All automation events for the track between the start and end of the event or part will be moved.
  - If there are automation events in the new position (to which you move the part or event), these will be overwritten.
- If you duplicate an event or part (by [Alt]/[Option]-dragging or by using the Duplicate or Repeat functions) the automation events will be duplicated as well.
- This function affects copying and pasting as well.
Using Write/Read automation

All track types except folder, marker, video and ruler tracks feature Write (W) and Read (R) buttons in the mixer, in the Track list and in the Channel Settings window. Furthermore, the control panels for all plug-in effects and VST Instruments also feature Write and Read buttons.

The Write and Read buttons for a channel in the mixer, and for an automation subtrack in the Track list.

• If you activate Write for a channel, all mixer parameters you adjust during playback for that specific channel will be recorded as automation events.

• If you activate Read for a channel, all your recorded mixer actions for that channel will be performed during playback, just like you performed them in Write mode.

• The W and R buttons for a track in the Track list are mirrors of the W and R buttons in the corresponding channel strip in the mixer.

• Some track types require that you activate the Write button (either for the track or globally – see below) to create an automation track for it. These are: VST Instrument, ReWire and Input/Output tracks. The first time the Write button is activated for these track types, automation subtracks will be created for them. You can then proceed with automating the parameters of the tracks (by editing the automation subtracks or by writing, as described below). To play back the automation, make sure the Read button for the tracks is activated.
There are also global Read All and Write All Automation buttons in the mixer’s common panel and at the top of the Track list:

- When Read All is activated, all your recorded mixer actions for all channels will be performed during playback.
- When Write All is activated, all mixer actions you perform during playback (for all channels) will be recorded as automation events.
About the five automation modes (Cubase SX only)

- In Cubase SL the automation mode is always “Touch Fader”.

When recording automation, you can choose one of five automation modes (available on the Project window toolbar):

- When Touch Fader mode is selected, the program starts writing the automation as soon as you click the control and stops writing when you release the mouse button.

- For most plug-in parameters (audio effects and VST Instruments), there is no way for the program to “know” whether a control is “pressed” or not (this information is not passed back by the plug-in interface). For this reason, automation of most plug-in parameters will work as in Autolatch mode (see below), even if Touch Fader is selected.

- When Autolatch mode is selected, the program starts writing the automation as soon as you click the control and stops writing when you stop playback or turn off the Write function. The last automation value will be continuously written until you stop or turn off Write. This is useful if you want to overwrite a long section of previous automation, and also when you are recording automation from a remote device (because then there is no way for the program to know when you “release” the control). However, make sure you only touch the desired control(s) when recording automation in Autolatch mode – and remember to stop playback when you’re done!

- X-Over mode works like Autolatch mode, but with one difference: As soon as you “cross” any existing (previous) automation curve, the writing is automatically turned off.
• Overwrite mode affects volume automation only. It works like Autolatch mode, with one significant difference: the program starts writing the automation as soon as you start playback, and stops writing when you turn off Write. This means that automation will be written continuously from the moment you start playback until you turn off Write – even if you don’t touch any controls. This is useful if you want to have a “clean slate” and redo previous volume automation.

• Trim mode is useful for volume automation only. It offsets the volume automation curve without overwriting any previous volume automation, letting you adjust the volume for already existing automation. In Trim mode, the channel’s volume fader in the mixer is initially positioned in the exact middle position, regardless of any existing volume automation. By raising the fader relative to the middle position, you offset the volume curve upwards. By lowering the fader, you offset the volume curve downwards. In Trim mode, the program starts writing the automation as soon as you click the control and stops writing when you release the mouse button.

• Trim mode has a special feature: if you enable Write automation when playback is stopped and select Trim mode, you can use the fader to trim (offset) the volume curve between the left and right locator. This makes it easy to e.g. raise the relative volume in a specific area: set the locators accordingly, enable Write, select Trim mode and raise the level fader.
Recording your actions - an example

If the settings in your current project are crucial, you may not want to “experiment” with automation until you know more about how it all fits together. If so, you can create a new project for the following example. It doesn’t even have to contain any audio events, just a few audio tracks. Proceed as follows:

1. Open the Mixer window.

2. Click the “Write All” button in the mixer common panel.
   Cubase SX/SL is now in global Write mode.

3. Start playback, and adjust some volume faders and/or other parameter settings in the mixer or perhaps in a Channel Settings window.
   Stop playback when you are done, and return to the position where you started playback.

4. Deactivate Write mode, and click the Read All button in the mixer common panel.
   Cubase SX/SL is now in global Read mode.

5. Start playback, and watch the Mixer window.
   All your actions performed during the previous playback will be reproduced exactly.

6. If you wish to redo anything that was recorded, activate Write mode again, and start playback from the same position.

   • You can have Write and Read activated simultaneously, if you want to watch and listen to your recorded mixer actions while you’re recording fader movements for another mixer channel, etc.
Recording plug-in automation

Every parameter for every assigned effect or VST Instrument can be automated in much the same manner as described above.

The following example assumes that you have assigned an insert effect to an FX channel track (see page 248), and describes how to record automation for the effect:

1. Activate Write All in the mixer common panel or in the Track list to put Cubase SX/SL in global Write mode.

2. Select the FX channel track in the Track list and open its Inserts section in the Inspector.
   If the Inspector is hidden, click the “Show Inspector” button in the Project window toolbar.

3. Open the control panel for the effect by clicking the Edit button (“e”) above the insert effect slot in the Inspector.

4. Click the Write button in the control panel to activate Write mode.
   All effects and VST Instruments have Write/Read buttons on their control panels. These work exactly like the corresponding buttons in the mixer or in the Track list. In the previous example, we used global Write mode, in which mixer and parameter changes are recorded on all tracks, but in this example we’ll use Write mode for one track only.

5. Start playback and adjust some effect parameters in the control panel.
   When you are finished, stop playback and return to the position where you started playback.

6. Deactivate Write and instead click the Read button on the control panel.

7. Start playback, and watch the control panel.
   All actions you performed during the previous playback will be reproduced exactly.
Assigning an automated parameter to an automation subtrack

To select which parameter is currently shown in the automation track for the FX channel, proceed as follows:

1. Click in the parameter display for the FX channel automation subtrack. The parameter display pop-up list is shown containing the automation parameters for the plug-in. The parameter(s) you previously automated are indicated by an asterisk after the parameter name in the list.

   Automated parameters for the DoubleDelay effect.

2. Select the parameter you wish to view from the parameter display pop-up. The automation curve for the parameter you selected is displayed on the automation subtrack.

   • To view VST Instrument parameters you use the same method, but for the first automation track for the instrument.

   As described earlier, each VST Instrument have two or more automation tracks – one for the plug-in settings and one for each VST Instrument mixer channel.

Where did the automation data I recorded end up?

When using Write All automation, you can write automation data on all channels’ automation tracks. In the previous write operations, you probably added automation events for many different channels and parameters.

   • To view all the automation events you recorded during the operations, select “Show Used Automation” from the Project menu.

   Now the automation data for every channel parameter that you adjusted in the mixer during Write mode is shown on corresponding subtracks in the Project window. The automation events recorded are shown as points in the automation curves.
Working with automation curves

About automation curves

There are two kinds of automation curves, “ramp” and “jump”:

- Jump curves are created for any parameter that only has on/off values, like a Mute button, for example.

- Ramp curves are created for any parameter that generates continuous multiple values, such as fader or dial movements etc.

![Examples of jump (top subtrack) and ramp automation curves shown in the event display.](image)

About the static value line

When you first open an automation subtrack for a parameter, it doesn’t contain any automation events (unless you have previously adjusted that parameter with write automation activated), and this is reflected in the event display as a straight horizontal black line, the “static value” line. This line represents the current parameter setting.

- If you have manually added any automation events or used write automation for the corresponding parameter, and then deactivate Read mode, the automation curve will be greyed-out in the automation subtrack event display and the static value will be used instead. As soon as Read mode is activated the automation curve will become available.
Editing automation events

Drawing automation events

By using write automation in the mixer, you generate automation events by moving parameter dials and fader settings in the mixer. You can also add them manually, by drawing automation curves on an automation subtrack. Proceed as follows:

1. Open a volume automation subtrack for an audio track by clicking the “+” sign. The static value line is shown in the event display.

2. Select the Pencil tool. You can also use the various modes of the Line tool for drawing curves, see below.

3. If you click on the static value line, an automation event is added, read automation mode is automatically activated, and the static value line changes to a blue automation curve.

4. If you click and hold, you can draw a curve, by adding a multitude of single automation events.
5. When you release the mouse button, the number of automation events is reduced to a few events, but the basic shape of the curve still remains the same. This "thinning" of events is governed by the Automation Reduction Level setting in the Preferences dialog, see page 320.

6. If you now activate playback, the volume will change with the automation curve. In the mixer the corresponding fader moves accordingly.

7. Simply redo the operation if you are not happy with the result. If you draw over existing events, a new curve is created.
   • If the automation subtrack is in Read mode already, you can also add automation events by clicking with the Arrow tool. If you are trying to add a point between two existing points and the new point doesn’t deviate from the existing curve, it will be removed by reduction (see page 320) as soon as you release the mouse button.

Using the various modes of the Line tool to draw automation curves

The Line tool can be very useful for drawing automation events. The various modes are accessed by clicking on the Line tool on the toolbar and selecting from the pop-up that appears.

• Clicking and dragging with the Line tool in Line mode shows a line in the automation subtrack, and creates automation events aligned with this line. This is a quick way to create linear fades, etc.
• The Line tool in Parabola mode works in the same way, but aligns the automation events with a parabolic curve instead, giving more “natural” curves and fades. Note that the result depends on the direction from which you draw the parabolic curve.

• The Sine, Triangle and Square Line tool modes create automation events aligned with continuous curves. If snap is activated and set to Grid, the period of the curve (the length of one curve “cycle”) is determined by the grid setting. If you press [Shift] and drag, you can set the period length manually, in multiples of the grid value.

Selecting automation event points

• To select a single automation event point, click on it with the Arrow tool. The point turns red, and you can drag it in any horizontal or vertical direction between two points.

• To select multiple curve points, you can either [Shift]-click or drag a selection rectangle with the Arrow tool. All events inside the selection rectangle will become selected.

When selected, several points can be moved in all directions as “one”, i.e. the curve shape formed by the selected event points remains intact.

• To select all automation events on a subtrack, right-click (Win) or [Ctrl]-click (Mac) the automation subtrack in the Track list and choose “Select All Events” from the context menu.
Removing automation events

There are several ways to remove event points:

• By selecting points and pressing [Backspace] or [Delete] or selecting Delete from the Edit menu.

• By clicking on a point with the Eraser tool.

• By selecting a range (with the Range Selection tool), and pressing [Backspace] or [Delete] or selecting Delete from the Edit menu.

• By clicking in the parameter display on a subtrack and selecting “Remove Parameter” from the pop-up.
  This will remove all automation events from the subtrack, and the subtrack will be closed.

Editing automation events

Automation events can be edited much like other events. You can use cut, copy and paste, you can group and nudge events etc. There are however four items on the Edit menu that are not applicable to automation events. These are:

• Split at Cursor
• Split Loop
• Move to Front
• Move to Back
Editing automation events in the Project Browser

You can also edit automation events in the Project Browser. Proceed as follows:

1. Open the Project Browser by selecting it from the Project menu. The Browser window opens. The window is divided into two sections, the Structure list to the left, and the event display to the right.

2. Click on the “+” sign for a track in the structure list. Automated tracks have two subitems: Track Data and Automation. The Automation item corresponds to the automation subtrack in the Project window, and contains the track’s automation events.

3. Click on the plus sign for the Automation item. All automated parameters for the track are shown in the structure list.

4. Clicking on a parameter in the structure list brings up the automation events in the event display.

The following parameters are available for all automation subtracks:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Position</td>
<td>The position of the automation event.</td>
</tr>
<tr>
<td>Value</td>
<td>The value (0.000 to 1.000) of the automation event.</td>
</tr>
</tbody>
</table>
**Tips and common methods**

There are no hard and fast rules when it comes to describing which automation method you should use. You can for example never even open an automation subtrack, and stick with write automation throughout a project. Or you can stick to drawing automation curves to automate settings in a project. Both methods have their advantages, but it is of course up to you to decide what to use and when.

- Editing curves on automation subtracks offers a graphical overview in relation to the track contents and the time position. This makes it easy to quickly change parameter values at specific points, without having to activate playback. For example, this method gives you a good overview if you have a voice-over or a dialog on one track and a music bed on another track, the level of which needs to be lowered with a specific amount every time the dialog occurs.

- By using write automation in the mixer you don’t have to manually select parameter subtracks from the Add Parameter list. You can work much like you would using a “real” physical mixer. Every action you perform is automatically recorded on subtracks which you can later open for viewing and editing of the parameters you changed.

These are just two examples of advantages for each method. Generally, editing curves and using write automation are two methods that complement each other, and depending on the nature of your projects you will probably work out what method works best for a given situation.
Options and Settings

About the Automation Reduction Level preference

This item can be found on the Editing page in the Preferences dialog. Automation reduction reduces the number of automation events after you have used write automation or added automation events manually. When you write (or draw with the Pencil tool) automation events, these are added as a continuous stream of densely packed events. This is necessary because the program cannot "guess" what you will be doing next! However, when you are done, the reduction function will remove all superfluous event points and the automation curve now contains only the event points necessary to reproduce your actions.

For example, all event points that might exist between two other points, but do not deviate from the curve, will be automatically removed by reduction.

If you try to add an event that doesn't deviate from the existing curve between two existing points...

...it will be removed when the mouse is released. If you moved the selected event by any amount so that the resulting curve isn't a straight line, the event would of course be added.

- If you feel you need a lower (or higher) reduction level of events than the default setting of roughly 75% reduction, you can change it, but normally the default setting works well.

- A minimum reduction level setting is not recommended as this will simply retain a lot of unnecessary events.
Remote controlling the mixer
About this chapter

It is possible to control the Cubase SX/SL mixer via MIDI. A large number of MIDI control devices are supported. This chapter describes how to set up Cubase SX/SL for remote control.

• For specific information about the supported remote control devices, see the separate “Remote Control Devices” pdf document.

• There is also a Generic Remote Device, allowing you to use any MIDI controller to remote control Cubase SX/SL. How to set this up is described on page 326.

Setting Up

Connecting the remote device

Connect the MIDI Out on the remote unit to a MIDI In on your MIDI interface. Depending on the remote unit model, you may also need to connect a MIDI Out on the interface to a MIDI In on the remote unit (this is necessary if the remote unit features “feedback devices” such as indicators, motorized faders, etc.).

If you will be recording MIDI tracks, you don’t want any MIDI data from the remote unit to accidentally be recorded as well. To avoid this, you should also make the following setting:

1. Open the Device Setup dialog from the Devices menu.
2. Select “All MIDI Inputs” in the list to the left.
3. Check the list to the right and locate the MIDI input to which you have connected the MIDI remote unit.
4. Click in the “Active” column for that input to set it to “No”.
5. Click OK to close the Device Setup dialog.

Now you have removed the remote unit input from the “All MIDI Inputs” group. This means that you can record MIDI tracks with the “All MIDI Inputs” port selected without risking to record the data from the remote unit at the same time.
Selecting a remote device

1. Pull down the Devices menu and select Device Setup. A dialog window opens with a list of devices shown in the left part of the window.

2. If you can't find the remote device you are looking for, click on the Add/Remove tab and select it from the Device Classes list. Click “Add” to add it to the Devices list.

• Note that it is possible to select more than one remote device of the same type. If you have more than one remote device of the same type, these will be numbered in the Devices list.

3. Now click the Setup tab and select your MIDI control device model from the Devices list. Depending on the selected device, either a list of programmable function commands or a blank panel is shown in the right half of the dialog window.

4. Select the correct MIDI input from the pop-up menu.

5. If necessary, select the correct MIDI output from the pop-up menu.

6. Click OK to close the dialog.

You can now use the MIDI control device to move faders and knobs, activate Mute and Solo, etc. The exact parameter configuration depends on which external MIDI control device you are using.
Operations

Writing automation using remote controls

Automating the mixer using a remote control device is basically done in the same way as when you operate on-screen controls in Write mode. However, when it comes to replacing existing automation data, there is one important difference:

- If you activate Write mode and move a control on the remote control device, all data for the corresponding parameter is replaced from the position where you moved the control, up until the position where playback is stopped!
  In other words, as soon as you have moved a control in Write mode, it remains "active" until you stop playback. The reason for this is explained below.

  As a consequence, an additional precaution must be taken:

- Make sure you move only the controller you want to replace!

  In order to replace existing automation data for a control, the computer needs to know how long the user actually "grabbed" or used the control. When doing this "on screen", the program simply detects when the mouse button is pressed and released. When you are using an external remote control device, however, there is no mouse button involved, and Cubase SX/SL cannot tell whether you "grab and hold" a fader, or simply move it and release it. Instead, you have to indicate that you have "released" the control by stopping playback.

- The above does not apply to the JLCooper MCS 3000 device. This device has touch sensitive faders, which means that it stops writing as soon as you release the fader.

- This is only relevant when you are using a remote control device and Write mode is activated in the mixer.
Assigning remote key commands

For some of the supported remote devices, you can assign any Cubase SX/SL function (that can be assigned a key command) to generic buttons, wheels or other controls. As of this writing, these devices are:

- JL Cooper MCS 3000
- JL Cooper CS-10
- CM Automation Motor Mix

Proceed as follows:

1. Open the Device Setup dialog and select one of the remote devices that support this feature.
   On the right side of the window there are three columns. This is where you assign commands.

2. Use the “Button” column to locate a Remote device control or button to which you wish to assign a Cubase SX/SL function.

3. Click in the “Category” column for the control, and select one of the Cubase SX/SL function categories from the pop-up menu that appears.

4. Click in the “Command” column, and select the desired Cubase SX/SL function from the pop-up menu that appears.
   The available items on the pop-up menu depend on the selected category.

5. Click “Apply” when you are done.
   The selected function is now assigned to the button or control on the remote device.

A note about remote controlling MIDI tracks

While most remote control devices will be able to control both MIDI and audio channels in Cubase SX/SL, the parameter setup may be different. For example, audio-specific controls (such as EQ) will be disregarded when controlling MIDI channels.
The Generic Remote device

If you have a generic MIDI controller, you can use this for remote control of Cubase SX/SL by setting up the Generic Remote device:

1. Open the Device Setup dialog on the Devices menu.
   If the Generic Remote device isn’t on the Devices list, you need to add it:

2. Click the “Add/Remove” tab and select the "Generic Remote" device in the list to the right.

3. Click the Add button.

   • When the Generic Remote device is added in the Device Setup dialog, you can open the Remote Status window by selecting “Generic Remote” from the Devices menu.

The Remote Status window
4. Click the Setup tab and select the Generic Remote device in the Devices list to the left. The settings for the Generic Remote device are displayed, allowing you to specify which control on your device should control which parameter in Cubase SX/SL.

5. Use the MIDI Input and Output pop-up menus to select the MIDI Port(s) to which your remote device is connected.

6. Use the pop-up menu to the right to select a bank. The concept of banks is based on the simple fact that most MIDI devices can control a limited number of channels at a time (often 8 or 16). For example, if your MIDI control device has 16 volume faders, and you are using 32 mixer channels in Cubase SX/SL, you would need two banks of 16 channels each. When the first bank is selected you control channel 1 to 16; when the second Bank is selected you control channel 17 to 32. Since you can control Transport functions as well, you may need several banks.

7. Set up the upper table according to the controls on your MIDI control device.
The columns have the following functionality:

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Control Name</td>
<td>Double clicking this field allows you to enter a descriptive name for the control (typically a name written on the console). This name is automatically reflected in the Control Name column in the lower table.</td>
</tr>
<tr>
<td>MIDI Status</td>
<td>Clicking in this column pulls down a pop-up menu, allowing you to specify the type of MIDI message sent by the control. The options are Controller, Program Change, Note On, Note Off, Aftertouch and Polyphonic Pressure. Also available are Continuous Control NRPN and RPN, a way to extend the available control messages. The “Ctrl JLCooper” option is a special version of a Continuous Controller where the 3rd byte of a MIDI message is used as address instead of the 2nd byte (a method supported by various JL-Cooper remote devices).</td>
</tr>
<tr>
<td>MIDI Channel</td>
<td>Clicking in this column pulls down a pop-up menu, allowing you to select the MIDI channel on which the controller is transmitted.</td>
</tr>
<tr>
<td>Address</td>
<td>The Continuous Controller number, the pitch of a note or the address of a NRPN/RPN Continuous Controller.</td>
</tr>
<tr>
<td>Max. Value</td>
<td>The maximum value the control will transmit. This value is used by the program to “scale” the value range of the MIDI controller to the value range of the program parameter.</td>
</tr>
</tbody>
</table>
| Flags        | Clicking in this column pulls down a pop-up menu, allowing you to activate or deactivate three flags:  
• Receive – activate this if the MIDI message should be processed on reception.  
• Transmit – activate this if a MIDI message should be transmitted when the corresponding value in the program changes.  
• Relative – activate this if the control is an “endless” dial, which reports the number of turns instead of an absolute value. |

• If you find that the upper table holds too many or too few controls, you can add or remove controls with the Add and Delete buttons to the right of the upper table.

• If you are uncertain of which MIDI message a certain controller sends, you can use the Learn function:  
Select the control in the upper table (by clicking in the Control Name column), move the corresponding control on your MIDI device and click the Learn button to the right of the table. The MIDI Status, MIDI Channel and Address values are automatically set to those of the moved control.
8. Use the lower table to specify which Cubase SX/SL parameters you want to control.
Each row in the table is associated to the controller in the corresponding row in the upper table (as indicated by the Control Name column). The other columns have the following functionality:

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Device</td>
<td>Clicking in this column pulls down a pop-up menu, used for determining which device in Cubase SX/SL should be controlled. The special option “Command” allows you to perform certain command actions by remote control. One example of this is the selection of remote banks. If you have a Yamaha DSP Factory card installed (Windows version only), this will also appear as an option on the Device pop-up menu.</td>
</tr>
<tr>
<td>Channel/Category</td>
<td>This is where you select the channel to be controlled or, if the “Command” Device option is selected, the Command category.</td>
</tr>
<tr>
<td>Value/Action</td>
<td>Clicking in this column pulls down a pop-up menu, allowing you to select the parameter of the channel to be controlled (typically, if the “VST Mixer” Device option is selected you can choose between volume, pan, send levels, EQ, etc.). If the “Command” Device option is selected, this is where you specify the “Action” of the category.</td>
</tr>
<tr>
<td>Flags</td>
<td>Clicking in this column pulls down a pop-up menu, allowing you to activate or deactivate three flags:</td>
</tr>
<tr>
<td></td>
<td>• Push Button – When activated, the parameter is only changed if the received MIDI message shows a value unequal to 0.</td>
</tr>
<tr>
<td></td>
<td>• Toggle – When activated, the parameter value is switched between minimum and maximum value each time a MIDI message is received. The combination of Push Button and Toggle is useful for remote controls which do not latch the state of a button. One example is controlling mute status with a device on which pressing the Mute button turns it on, and releasing the Mute button turns it off. If Push Button and Toggle are activated, the Mute status will change between on and off whenever the button is pressed on the console.</td>
</tr>
<tr>
<td></td>
<td>• Not Automated – When activated, the parameter will not be automated.</td>
</tr>
</tbody>
</table>

9. If needed, select another bank and make settings for this.
Note that you only need to make settings in the lower table for this – the upper table is already set up according to the MIDI remote device.
• If you need, you can add banks by clicking the Add button below the Bank pop-up.
  Clicking the Rename button allows you to assign a new name to the currently selected bank, and you can remove an unneeded bank by selecting it and clicking the Delete button.

10. When you are finished, close the Generic Remote Setup window.
  Now, you can control the specified Cubase SX/SL parameters from the MIDI remote device. To select another bank, use the pop-up menu in the Remote Status window (or use a control on the MIDI remote device, if you have assigned one for this).

Importing and Exporting Remote Setups

The Export button in the upper right corner of the Generic Remote Setup window allows you to export the current setup, including the Control configuration (the upper table) and all banks. The setup is saved as a file (with the Windows file extension “.xml”). Clicking the Import button allows you to import saved Remote Setup files.

• The last imported or exported Remote Setup will automatically be loaded when the program starts or the Generic Remote control is added in the Device Setup dialog.
Audio processing and functions
Background

Audio processing in Cubase SX/SL can be called “non-destructive”, in the sense that you can always undo changes or revert to the original versions. This is possible because processing affects audio clips rather than the actual audio files, and because audio clips can refer to more than one audio file. This is how it works:

1. If you process an event or a selection range, a new audio file is created in the Edits folder, within your project folder. This new file contains the processed audio, while the original file is unaffected.

2. The processed section of the audio clip (the section corresponding to the event or selection range) is then made to refer to the new, processed audio file. The other sections of the clip will still refer to the original file.

   • Since all edits are available as separate files, it is possible to undo any processing, at any point and in any order! This is done in the Offline Process History dialog, as described on page 355.

   • Furthermore, the original, unprocessed audio file can still be used by other clips in the project, by other projects or by other applications.
Audio processing

Basically, you apply processing by making a selection and selecting a function from the Process submenu on the Audio menu. Processing is applied according to the following rules:

- Selecting events in the Project window or the Audio Part Editor will apply processing to the selected events only. Processing will only affect the clip sections that are referenced by the events.
- Selecting an audio clip in the Pool will apply processing to the whole clip.
- Making a selection range will apply processing to the selected range only. Other sections of the clip are not affected.

If you attempt to process an event that is a shared copy (i.e. the event refers to a clip that is used by other events in the project), you are asked whether you want to create a new version of the clip or not.

Select “New Version” if you want the processing to affect the selected event only. Select “Continue” if you want the processing to affect all shared copies.

- If you activate the “Do not show this message again” option, any and all further processing you do will conform to the selected method (“Continue” or “New Version”).

You can change this setting at any time by using the “On Processing Shared Clips” pop-up menu in the Preferences dialog (Audio page).
Common settings and features

If there are any settings for the selected Audio processing function, these will appear when you select the function from the Process submenu. While most settings are specific for the function, some features and settings work in the same way for several functions:

The “More...” button

If the dialog has a lot of settings, some options may be hidden when the dialog appears. To reveal these, click the “More...” button.

To hide the settings, click the button again (now labeled “Less...”).

The Preview, Process and Cancel buttons

These buttons have the following functionality:

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Preview</td>
<td>Allows you to listen to the result of the processing with the current settings. Playback will continue repeatedly until you click the button again (the button is labeled “Stop” during Preview playback). You can make adjustments during Preview playback, but the changes are not applied until the start of the next “lap”. Some changes may automatically restart the Preview playback from the beginning.</td>
</tr>
<tr>
<td>Process</td>
<td>Performs the processing and closes the dialog.</td>
</tr>
<tr>
<td>Cancel</td>
<td>Closes the dialog without processing.</td>
</tr>
</tbody>
</table>

Pre/post crossfade

Some processing functions allow you to gradually mix the effect in or out. This is done with the pre and post crossfade parameters. If you activate Pre-crossfade and specify a value of e.g. 1000 ms, the processing will be applied gradually from the start of selection, reaching full effect 1000 ms after the start. Similarly, if you activate post-crossfade, the processing will gradually be removed, starting at the specified interval before the end of the selection.

☐ The sum of the pre- and post-crossfade times cannot be larger than the length of the selection.
Envelope

The Envelope function allows you to apply a volume envelope to the selected audio. The dialog contains the following settings:

Curve Kind buttons

These determine whether the envelope curve should consist of spline curve segments (left button) or linear segments (right button).

Fade display

Shows the shape of the envelope curve. The resulting waveform shape is shown in dark grey, with the current waveform shape in light grey. You can click on the curve to add points, and click and drag existing points to change the shape. To remove a point from the curve, drag it outside the display.

Presets

If you have set up an envelope curve that you may want to apply to other events or clips, you can store it as a preset by clicking the Store button.

- To apply a stored preset, select it from the pop-up menu.
- To rename the selected preset, double click on the name and type a new one in the dialog that appears.
- To remove a stored preset, select it from the pop-up menu and click Remove.
**Fade In and Fade Out**

These functions are described in the chapter "Fades and crossfades" (see page 166).

**Gain**

Allows you to change the gain (level) of the selected audio. The dialog contains the following settings:

- **Gain**
  
  This is where you set the desired gain, between -50 and +20dB. The setting is also indicated below the Gain display as a percentage.

**Clip detection text**

If you use the Preview function before applying the processing, the text below the slider indicates whether the current settings result in clipping (audio levels above 0 dB). If that is the case, lower the Gain value and use the Preview function again.

- If you want to increase the level of the audio as much as possible without causing clipping, you should use the Normalize function instead (see page 339).

**Pre- and Post-Crossfade**

See page 334.
Merge Clipboard

This function mixes the audio from the clipboard into the audio selected for processing, starting at the beginning of the selection.

- For this function to be available, you need to have Cut or Copied a range of audio in the Sample Editor first.

The dialog contains the following settings:

**Sources mix**

Allows you to specify a mix ratio between the Original (the audio selected for processing) and the Copy (the audio on the clipboard).

**Pre- and Post-Crossfade**

See page 334.
Noise Gate

Scans the audio for sections weaker than a specified threshold level, and replaces them with silence. The dialog contains the following settings:

**Threshold**

The level below which you want audio to be silenced. Levels below this value will close the gate.

**Attack Time**

The time it takes for the gate to open fully after the audio level has exceeded the threshold level.

**Min. Opening Time**

This is the shortest time the gate will remain open. If you find that the gate opens and closes too often when processing material that varies rapidly in level, you should try raising this value.

**Release Time**

The time it takes for the gate to close fully after the audio level has dropped below the threshold level.

**Linked Channels**

This is available for stereo audio only. When it is activated, the Noise Gate is opened for both channels as soon as one or both channels exceed the Threshold level. When Linked Channels is deactivated, the Noise Gate works independently for the left and right channel.
Dry/Wet mix
Allows you to specify a mix ratio between “dry” and processed sound.

Pre- and Post-Crossfade
See page 334.

Normalize

The Normalize function allows you to specify the desired maximum level of the audio. It then analyzes the selected audio and finds the current maximum level. Finally it subtracts the current maximum level from the specified level, and raises the gain of the audio by the resulting amount (if the specified maximum level is lower than the current maximum, the gain will be lowered instead). A common use for Normalizing is to raise the level of audio that was recorded at too low an input level. The dialog contains the following settings:

Maximum
The desired maximum level for the audio, between -50 and 0dB. The setting is also indicated below the Gain display as a percentage.

Pre- and Post-Crossfade
See page 334.
Phase Reverse

Reverses the phase of the selected audio, turning the waveform “up-side down”. The dialog contains the following settings:

Phase Reverse on

When processing stereo audio, this pop-up menu allows you to specify which channel(s) should be phase reversed.

Pre- and Post-Crossfade

See page 334.

Pitch Shift

This function allows you to change the pitch of the audio with or without affecting its length. You can also create “harmonies” by specifying several pitches, or apply pitch shift based on a user specified envelope curve.
When the “Transpose” tab is selected, the dialog contains the following parameters:

**Keyboard display**

This offers a way to specify the transpose interval in semitones, and gives a graphic overview of the transposition setting.

- The “root note” is indicated in red. This has nothing to do with the actual key or pitch of the original audio, it just provides a way to display transpose intervals. If you like, you can change the root note by using the settings to the right below the keyboard display, or by pressing [Alt]/[Option] and clicking in the keyboard display.

- To specify a transpose interval, click on one of the keys. The key is indicated in blue, and the program plays test tones in the base pitch and transpose pitch, to give you an audible confirmation.

- If “Multi Shift” is activated (see below), you can click on several keys to create “chords”. Clicking on a blue (activated) key removes it.

**Transpose settings**

The “Semitones” and “Fine tune” settings allow you to specify the amount of pitch shift. You can transpose the audio ±16 semitones, and fine tune it by ±200 cents (hundredths of semitones).

**Volume**

Allows you to lower the volume of the pitch shifted sound.

**Multi Shift**

When this is activated, you can add more than one transpose value, creating multi-part harmonies. This is done by adding intervals in the keyboard display, as described above.

- If the intervals you add make up a standard chord, this chord is displayed to the right. Note however, that to include the base pitch (the original, untransposed sound) in the processed result, you need to click the base key in the keyboard display as well, so that it is displayed in blue.

---

Audio processing and functions | CUBASE SX/SL
15 – 341
**Listen Key/Chord button**

Clicking this button plays a test tone, pitched according to the activated interval key on the keyboard display. If “Multi Shift” is activated, this button is called “Listen Chord”, and plays all activated intervals, as a chord.

**Pitch Shift Base**

This allows you to set the root note (the red key in the keyboard display). This has no actual relation to the pitch of the audio material, but should be viewed as an aid for easily setting up intervals and chords.

**Accuracy**

Set this parameter according to whether the rhythmic feel of the audio material has a high priority or not. If you set this to a high value (drag the slider to the right), the timing and rhythmic feel will be preserved as accurately as possible. If you set it to a low value, the tonal quality gets priority, allowing slight changes in timing. This parameter is not available if the MPEX algorithm is used (Cubase SX only).

**Algorithm**

Allows you to select one of four pitch shift algorithms: Mode 1, Mode 2, Advanced and MPEX (Cubase SX only, see below). The resulting audio quality is progressively higher, and the processing time longer from Mode 1 through to MPEX. Mode 1 and 2 are quicker and give lower audio quality while Advanced and MPEX are slower and give higher audio quality.

- **About the MPEX mode (Cubase SX only):**
  This mode is based on Prosoniq’s proprietary MPEX (Minimum Perceived Loss Time Compression/Expansion) algorithm. This algorithm (which is also used in Prosoniq’s TimeFactory™ application) uses an artificial neural network for time series prediction in the scale space domain to achieve high end time and pitch scaling. This gives the best possible audio quality result.
  Note that the Accuracy parameter isn’t available in MPEX mode. Furthermore, you should not use the Preview function in MPEX mode, since the MPEX algorithm isn’t designed for real time processing.
Formant Mode

If you are processing vocal material, you should activate this option in order to preserve the vocal characteristics of the pitch shifted audio.

Time Correction

When this is activated, the pitch shift process will not affect the length of the audio. When this is deactivated, raising the pitch will shorten the audio section and vice versa, much like changing the playback speed on a tape recorder.

Using envelope based Pitch Shift

When the “Envelope” tab is selected, you can specify an envelope curve on which the pitch shift should be based. This allows you to create pitch bend effects, pitch shift different sections of the audio by different amounts, etc.
Envelope display

Shows the shape of the envelope curve, over the waveform image of the audio selected for processing. Envelope curve points above the center line indicate positive pitch shift, while curve points below the center line indicate negative pitch shift. Initially, the envelope curve will be a horizontal, centered line, indicating zero pitch shift.

- You can click on the curve to add points, and click and drag existing points to change the shape. To remove a point from the curve, drag it outside the display.

Curve Kind

These buttons determine whether the envelope curve should consist of spline curve segments (left button) or linear segments (right button).

![Spline curve segment envelope.](image1)

![The same envelope with linear segments selected.](image2)
Range

This parameter determines the vertical pitch range of the envelope. If set to “4”, moving a curve point to the top of the display corresponds to pitch shifting by +4 semitones. The maximum range is +/- 16 Semitones.

Transpose and Fine Tune

Allows you to adjust the value of a curve point numerically:

1. Click on a curve point to select it.
   The selected point is shown in red.
2. Adjust the Transpose and Fine Tune parameters to change the pitch of the curve point in semitones and cents, respectively.

Pitch Shift Mode

These are the same parameters as on the Transpose tab, see page 342.

Example

Let’s say that you wish to create a pitch bend effect, so that the pitch is raised linearly by exactly 2 semitones in a specific part of the selected audio.

1. Remove all curve points by clicking the Reset button.
2. Select a linear curve by clicking the right Curve Kind button.
3. Create a point where you want the pitch bend to start by clicking on the envelope line.
   Since this is the starting point for the pitch bend, you want its pitch to be zero (the envelope line should still be straight). If necessary, use the Fine Tune parameter to set the curve point to 0 cents, because this point governs the start point, where you want the pitch transition to begin.
4. Create a new curve point at the horizontal position where you want the pitch bend to reach the full value.
   This curve point determines the rise time of the pitch bend effect, i.e. the further away from the starting point the new point is positioned, the longer it will take for the pitch bend to reach the full value, and vice versa.
5. Make sure the Range parameter is set to 2 semitones or higher.
6. With the second point still selected, use the Transpose and Fine Tune parameters to set the pitch to exactly 2 semitones.

7. Create a new curve point to set the duration of the pitch bend, i.e. the time the pitch should remain transposed by 2 semitones.

8. Finally, create a point where you want the pitch bend to end. You don't need to create a new point if this should be the end of the audio file being processed. There is always an end point at the right side of the waveform display.

9. If necessary, make additional settings in the Pitch Shift Mode section.

10. Click Process. The pitch bend is applied according to the specified settings.

**Remove DC Offset**

This function will remove any DC offset in the audio selection. A DC offset is when there is too large a DC (direct current) component in the signal, sometimes visible as the signal not being visually centered around the “zero level axis”. DC offsets do not affect what you actually hear, but they affect zero crossing detection and certain processing, and it is recommended that you remove them.

- It is recommended that this function is applied to complete audio clips, since the DC offset (if any) is normally present throughout the entire recording.

There are no parameters for this function. Note that you can check for DC Offset in an audio clip using the Statistics function (see page 364).
Resample

The Resample function can be used for changing the length, tempo and pitch of an event.

The original sample rate of the event is listed in the dialog. Resample the event to a higher or lower sample rate by either specifying a sample rate or by specifying the difference (in percentages) between the original sample rate and the desired new one.

- Resampling to a higher sample rate will make the event longer and cause the audio to play back at a slower speed with a lower pitch.
- Resampling to a lower sample rate will make the event shorter and cause the audio to play back at a faster speed with a higher pitch.

- You can audition the result of the resampling by entering the desired value and clicking “Preview”. The event will then be played back as it will sound after the resampling.
- When you are satisfied with the preview result, click “Process” to close the dialog and apply the processing.

Reverse

Reverses the audio selection, as when playing a tape backwards. There are no parameters for this function.

Silence

Replaces the selection with silence. There are no parameters for this function.
Stereo Flip

This function works with stereo audio selections only. It allows you to manipulate the left and right channel in various ways. The dialog contains the following parameters:

Mode

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Flip Left-Right</td>
<td>Swaps the left and right channel.</td>
</tr>
<tr>
<td>Left to Stereo</td>
<td>Copies the left channel sound to the right channel.</td>
</tr>
<tr>
<td>Right to Stereo</td>
<td>Copies the right channel sound to the left channel.</td>
</tr>
<tr>
<td>Merge</td>
<td>Merges both channels on each side, for mono sound.</td>
</tr>
<tr>
<td>Subtract</td>
<td>Subtracts the left channel information from the right and vice versa.</td>
</tr>
<tr>
<td></td>
<td>This is typically used as a “Karaoke effect”, for removing centered mono</td>
</tr>
<tr>
<td></td>
<td>material from a stereo signal.</td>
</tr>
</tbody>
</table>

This pop-up menu determines what the function does:
Time Stretch

This function allows you to change the length and “tempo” of the selected audio, without affecting the pitch. The dialog contains the following parameters:

**Input section**

This section contains information and settings regarding the “input”, the audio selected for processing:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Length in Samples</td>
<td>The length of the selected audio, in samples.</td>
</tr>
<tr>
<td>Length in Seconds</td>
<td>The length of the selected audio, in seconds.</td>
</tr>
<tr>
<td>Tempo in BPM</td>
<td>If you are processing music, and know the actual tempo of the audio, you can enter it here as beats per minute. This makes it possible to time stretch the audio to another tempo, without having to compute the actual time stretch amount.</td>
</tr>
<tr>
<td>Bars</td>
<td>If you use the tempo setting, you need to specify the length of the selected audio here, as bars, beats, 1/16-notes and ticks (with 120 ticks per 1/16-note).</td>
</tr>
<tr>
<td>Time Signature</td>
<td>If you use the tempo setting, you specify the time signature here.</td>
</tr>
</tbody>
</table>
Output section

These settings are used if you want to stretch the audio to fit within a specific time span or tempo. The values will change automatically if you adjust the Timestretch amount (see below).

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Samples</td>
<td>The desired length in samples.</td>
</tr>
<tr>
<td>Seconds</td>
<td>The desired length in seconds.</td>
</tr>
<tr>
<td>BPM</td>
<td>The desired tempo (beats per minute). For this to work, you have to know the actual tempo of the audio, and specify this (along with time signature and length in bars) in the Input section to the left.</td>
</tr>
<tr>
<td>Range</td>
<td>Allows you to specify the desired length as a range between two time positions.</td>
</tr>
<tr>
<td>Set to Locators Range</td>
<td>Clicking this button sets the Range values to the length of the Cycle.</td>
</tr>
</tbody>
</table>

Timestretch

The Timestretch parameter determines the amount of timestretch, as a percentage of the original length. If you use the settings in the Output section to specify the amount of timestretch, this value will change automatically. The possible timestretch range depends on the “Effect” option:

- If the “Effect” checkbox is deactivated, the range is 75-125%.
  This is the preferred mode if you want to preserve the character of the sound.
- If the “Effect” checkbox is activated, you can specify values between 10 and 1000%.
  This mode is mainly useful for special effects, etc.
Accuracy

Set this parameter according to whether the rhythmic feel of the audio material has a high priority or not. If you set this to a high value (drag the slider to the right), the timing and rhythmic feel will be preserved as accurately as possible. If you set it to a low value, the tonal quality gets priority, allowing slight changes in timing. This parameter is not available if the MPEX algorithm is used (Cubase SX only).

Algorithm

Allows you to select one of five time stretch algorithms: Mode 1, Mode 2, Advanced, MPEX (Cubase SX only, see below) and Drum mode. The resulting audio quality is progressively higher, and the processing time longer from Mode 1 through to MPEX. Mode 1 and 2 are quicker and give lower audio quality while Advanced and MPEX are slower and give higher audio quality.

- About the MPEX algorithm (Cubase SX only):
  This mode is based on Prosoniq’s proprietary MPEX (Minimum Perceived Loss Time Compression/Expansion) algorithm. This algorithm (which is also used in Prosoniq’s TimeFactory™ application) uses an artificial neural network for time series prediction in the scale space domain to achieve high end time and pitch scaling. This gives the best possible audio quality result.
  Note that the Accuracy parameter isn’t available in MPEX mode. Furthermore, you should not use the Preview function in MPEX mode, since the MPEX algorithm isn’t designed for real time processing.

- Drum mode:
  This is a special algorithm, optimized for processing rhythmic material. The Accuracy parameter and Preview function are not available in Drum mode.
Applying plug-ins (Cubase SX only)

As described in the chapter “Audio effects”, you can add plug-in effects in real-time during playback. However, sometimes it’s useful to “permanently” apply effects processing to one or several selected events. In Cubase SX, this is done in the following way:

1. Make a selection in the Project window, the Pool or an editor. Effects are applied according to the same rules as Processing (see page 334).

2. Select “Plug-ins” from the Audio menu.

3. Select the desired effect from the submenu that appears. The Process Plug-in dialog appears.

About stereo and mono

If you are applying an effect to mono audio material, only the left side of the effect’s stereo output will be applied.

The process plug-in dialog

The process plug-in dialog for the Chorus effect.

The upper section of the process plug-in dialog contains the actual effect parameters of the selected plug-in. For details on the included plug-ins’ parameters, see the separate “Audio Effects and VST Instruments” pdf document.
The lower section of the dialog contains settings for the actual processing. These are common to all plug-ins.

• If the lower section is hidden, click the “More...” button to display it. Clicking the button again (now labeled “Less...”) will hide the lower section.

The following settings and functions are available in the common, lower section of the dialog:

**Wet mix/Dry mix**

These two sliders allow you to specify the balance between wet (processed) and dry (original) signal in the resulting clip.

Normally the two sliders are "reverse-ganged", so that raising the Wet mix slider lowers the Dry mix slider by the same amount. However, if you press [Alt]/[Option] and drag a slider, you can move it independently. This allows you to set e.g. 80% dry and 80% wet signal. Be careful to avoid distortion.

**Tail**

This parameter is useful if you are applying an effect that adds material after the end of original audio (such as reverb and delay effects). When the checkbox is activated, you can specify a tail length using the slider. The tail time is included when playing back with the Preview function, allowing you to find the appropriate tail length.

**Pre/Post Crossfade**

These settings allow you to gradually mix the effect in or out. If you activate Pre-Crossfade and specify a value of e.g. 1000 ms, the effect will be applied gradually from the start of selection, reaching full effect 1000 ms after the start. Similarly, if you activate Post-Crossfade, the processing will gradually be removed starting at the specified interval before the end of the selection.

* The sum of the Pre- and Post-Crossfade times cannot be larger than the length of the selection.
Preview button
Allows you to listen to the result of the processing with the current settings. Playback will continue repeatedly until you click the button again (the button is labeled “Stop” during Preview playback). You can change the effect settings during Preview playback if needed.

Process button
Applies the effect and closes the dialog.

Cancel button
Closes the dialog without applying the effect.
The Offline Process History dialog

Procedures

If you find you want to remove some or all processing from a clip, this can be done in the Offline Process History dialog. Processing that can be modified in the Offline Process History dialog includes the functions on the Process menu, any applied plug-in effects, and Sample Editor operations such as Cut, Paste, Delete and drawing with the Pencil tool.

Due to the clip-file relationship (see page 332), it is even possible to modify or remove some processing “in the middle” of the Process History, while keeping later processing! This feature depends on the type of processing performed (see page 356).

Proceed as follows:

1. Select the clip in the Pool or one of its events in the Project window.
   You can see which clips have been processed by checking the Status column in the Pool – the waveform symbol indicates that processing or effects have been applied to the clip (see page 356).

2. Select “Offline Process History...” from the Audio menu.
   The Offline Process History dialog appears.

The left part of the dialog contains a list of all processing you have added to the clip, with the most recent operations at the bottom of the list. The “Start” and “Length” columns indicate which section of the clip was affected by each operation. The “Status” column indicates if the operation can be modified or removed.
3. Locate the operation you want to edit and select it by clicking on it in the list.

- To modify the settings of the selected processing, click the “Modify” button.
  This opens the dialog for the processing function or applied effect, allowing you to change the settings. This works just as when you applied the processing or effect the first time.

- To replace the selected operation with another processing function or effect, select the desired function from the pop-up menu and click the “Replace By” button.
  If the selected function has settings, a dialog will appear as usual. The original operation will then be removed and the new processing will be inserted in the Offline Process History.

- To remove the selected operation, click the “Remove” button.
  The processing is removed from the clip.

- To undo the selected operation and remove the processing from the clip click the “Deactivate” button.
  The processing is removed from the clip, but the operation remains in the list. To redo the operation and apply the processing again, click the button, now renamed to “Activate”, again.

4. Click “Close” to close the dialog.

Restrictions

- If there are no settings for the processing function, you can’t modify it.

- If you have applied processing that changes the length of the clip (such as Cut, Insert or Time Stretch), you can only remove this if it is the most recent processing in the Offline Process History (at the bottom of the list in the dialog). If an operation can not be removed or modified, this is indicated by an icon in the “Status” column. Also, the corresponding buttons will be greyed out.
Freeze Edits

The Freeze Edits function on the Audio menu allows you to make all processing and applied effects permanent for a clip:

1. Select the clip in the Pool or one of its events in the Project window.
2. Select “Freeze Edits...” from the Audio menu.

- If there is only one edit version of the clip (no other clips refer to the same audio file), the following dialog will appear:

![Cubase SX]

If you select “Replace”, all edits will be applied to the original audio file (the one listed in the clip’s Path column in the Pool). If you select “New File”, the Freeze Edits operation will create a new file in the Audio folder within the project folder (leaving the original audio file unaffected).

- If the selected clip (or the clip played by the selected event) has several edit versions (i.e. there are other clips referring to the same audio file), the following alert will appear:

![Cubase SX]

As you can see, you don’t have the option to Replace the original audio file in this case. This is because that audio file is used by other clips. Select “New File” to have a new file created in the Audio folder within the project folder.

- Now, the clip refers to a new, single audio file. If you open the Offline Process History dialog for the clip, the list will be empty.
Detect Silence

The Detect Silence function on the Audio menu isn’t really a processing function, since it doesn’t actually affect the audio clip. Instead, it searches for silent sections in an event, and either splits the event, removing the silent parts from the project, or creates regions corresponding to the non-silent sections. Proceed as follows:

1. Select the event in the Project window or the Audio Part Editor. You can select several events if you like, in which case you will be allowed to make separate settings for each selected event.

2. Select “Detect Silence” from the Audio menu. The Detect Silence dialog appears.

![Detect Silence dialog](image-url)
3. Adjust the settings in the area below the waveform display. They have the following functionality:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open Threshold</td>
<td>When the audio level exceeds this value, the function will &quot;open&quot;, i.e. let the sound through. Set this low enough to open when a sound starts, but high enough to remove unwanted noise during &quot;silent&quot; sections.</td>
</tr>
<tr>
<td>Close Threshold</td>
<td>When the audio level drops below this value, the function will &quot;close&quot;. This value cannot be higher than the Open Threshold value. Set this high enough to remove unwanted noise during &quot;silent&quot; sections.</td>
</tr>
<tr>
<td>Linked</td>
<td>If this checkbox is ticked, Open and Close Threshold will have the same value.</td>
</tr>
<tr>
<td>Min. Opening Time</td>
<td>Determines the minimum time that the function will remain &quot;open&quot; after the audio level has exceeded the Open Threshold value. If the audio contains repeated short sounds, and you find that this results in too many short &quot;open&quot; sections, try raising this value.</td>
</tr>
<tr>
<td>Min. Closing Time</td>
<td>Determines the minimum time that the function will remain &quot;closed&quot; after the audio level has dropped below the Close Threshold value. Usually you would want to set this to a low value, to avoid removing sounds.</td>
</tr>
<tr>
<td>Pre-Roll</td>
<td>Allows you to have the function &quot;open&quot; slightly before the audio level exceeds the Open Threshold value. In other words, the start of each &quot;open&quot; section is moved to the left according to the time you set here. This is useful to avoid removing the attack of sounds.</td>
</tr>
<tr>
<td>Post-Roll</td>
<td>Allows you to have the function &quot;close&quot; slightly after the audio level drops below the Close Threshold value. This is useful to avoid removing the natural decay of sounds.</td>
</tr>
</tbody>
</table>
4. Click the “Compute” button.
   The audio event is analyzed, and the waveform display is redrawn to indicate which sections will be considered “silent”, according to your settings.

- If you like, you can use the Preview function to listen to the result.
  The event is played back repeatedly in its entire length, but with the “closed” sections silenced.

5. Repeat steps 3 and 4 until you are satisfied with the result.

6. Select what you want the function to do, by activating either the “Add as Regions” checkbox, the “Strip Silence” checkbox, or both.
   “Add as Regions” will create regions according to the non-silent sections. “Strip Silence” will split the event at the start and end of each non-silent section, and remove the silent sections in between.

7. If you activated “Add as Regions”, you can specify a name for the Regions in the Regions Name field.
   In addition to the name, the regions will be numbered, starting with the number specified in the Auto Number Start field.

8. Click “Process”.
   The event is split and/or regions are added.

- If you selected more than one event in step 1 above, the dialog will appear again, allowing you to make separate settings for each selected event.
The Spectrum Analyzer (Cubase SX only)

This function analyzes the selected audio, computes the average “spectrum” (level distribution over the frequency range) and displays this as a two-dimensional graph, with frequency on the x-axis and level on the y-axis.

1. Make an audio selection (a clip, an event or a range selection).
2. Select “Spectrum Analyzer” from the Audio menu.

A dialog with settings for the analysis appears.

The default values are chosen to give good results in most situations, but you can adjust the settings if you like:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Size in Samples</td>
<td>The function divides the audio into “analysis blocks”, the size of which is set here. The larger this value, the higher the frequency resolution of the resulting spectrum.</td>
</tr>
<tr>
<td>Size of Overlap</td>
<td>The overlap between each analysis block.</td>
</tr>
<tr>
<td>Window used</td>
<td>Allows you to select which window type should be used for the FFT (Fast Fourier Transform, the mathematical method used for computing the spectrum).</td>
</tr>
<tr>
<td>Normalized values</td>
<td>When this is activated, the resulting level values are scaled, so that the highest level is displayed as “1” (0 dB).</td>
</tr>
<tr>
<td>From Stereo</td>
<td>When analyzing stereo material, there is a pop-up menu with the following options: Mono mix – the stereo signal is mixed to mono before analyzing. Mono left/right – the left or right channel signal is used for analysis. Stereo – both channels are analyzed (two separate spectrums will be displayed).</td>
</tr>
</tbody>
</table>
3. Click the “Process” button. The spectrum is computed and displayed as a graph.

4. You can adjust the display with the settings in the display window:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>dB</td>
<td>When this is activated, the vertical axis shows dB values. When it is</td>
</tr>
<tr>
<td></td>
<td>deactivated, values between 0 and 1 are shown.</td>
</tr>
<tr>
<td>Freq. log</td>
<td>When this is activated, frequencies (on the horizontal axis) are displayed</td>
</tr>
<tr>
<td></td>
<td>on a logarithmic scale. When it is deactivated, the frequency axis is</td>
</tr>
<tr>
<td></td>
<td>linear.</td>
</tr>
<tr>
<td>Precision</td>
<td>Indicates the frequency resolution of the graph. This value cannot</td>
</tr>
<tr>
<td></td>
<td>be changed here, but is governed by the Size in Samples setting in the</td>
</tr>
<tr>
<td></td>
<td>previous dialog.</td>
</tr>
<tr>
<td>Frequency/Note</td>
<td>Allows you to select whether you want the frequencies to be displayed in</td>
</tr>
<tr>
<td></td>
<td>Hertz or with note names.</td>
</tr>
<tr>
<td>Min.</td>
<td>Sets the lowest frequency shown in the graph.</td>
</tr>
<tr>
<td>Max.</td>
<td>Sets the highest frequency shown in the graph. By adjusting the Min and</td>
</tr>
<tr>
<td></td>
<td>Max values, you can take a closer look at a smaller frequency range.</td>
</tr>
<tr>
<td>Active</td>
<td>When this is activated, the next Spectrum Analysis will appear in the same</td>
</tr>
<tr>
<td></td>
<td>window. When deactivated, new Spectrum Analysis results will appear in</td>
</tr>
<tr>
<td></td>
<td>separate windows.</td>
</tr>
</tbody>
</table>
5. If you move the mouse pointer over the graph, a crosshair cursor follows the graph curve and the display in the upper right corner shows the frequency/note and level at the current position.

To compare the level between two frequencies, move the pointer to one of the frequencies, right-click (Win) or [Ctrl]-click (Mac) once and move the pointer to the second frequency. The delta value (the difference in level between the current position and the right/[Ctrl]-click position) is displayed in the upper right corner (labeled “D”).

- If you analyzed stereo audio and selected the “Stereo” option in the first dialog, the graphs for the left and right channel are superimposed in the display, with the left channel graph in white and the right channel graph in yellow.

The display in the upper right corner shows the values for the left channel – to see the right channel values, hold down [Shift]. An “L” or “R” is displayed to indicate which channel values are shown.

6. You can leave the window open or close it by clicking the “Close” button.

If you leave it open and the “Active” checkbox is ticked, the result of the next Spectrum Analysis will be displayed in the same window.
## Statistics (Cubase SX only)

The Statistics function on the Audio menu analyzes the selected audio (events, clips or range selections) and displays a window with the following information:

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Min. Sample Value</td>
<td>The lowest sample value in the selection, as a value between -1 and 1 and in dB.</td>
</tr>
<tr>
<td>Max. Sample Value</td>
<td>The highest sample value in the selection, as a value between -1 and 1 and in dB.</td>
</tr>
<tr>
<td>Peak Amplitude</td>
<td>The largest sample value (in absolute numbers) in the selection, in dB.</td>
</tr>
<tr>
<td>DC Offset</td>
<td>The amount of DC Offset (see page 346) in the selection, as a percentage and in dB.</td>
</tr>
<tr>
<td>Estimated Resolution</td>
<td>Even though an audio file is in 16 or 24 bits, it may have been converted from a lower resolution. The Estimated Resolution value makes an educated guess about the actual audio resolution, by computing the smallest level difference between two samples.</td>
</tr>
<tr>
<td>Estimated Pitch</td>
<td>The estimated pitch of the audio selection.</td>
</tr>
<tr>
<td>Sample Rate</td>
<td>The sample rate of the audio selection.</td>
</tr>
<tr>
<td>Min. RMS Power</td>
<td>The lowest loudness (RMS) measured in the selection.</td>
</tr>
<tr>
<td>Max. RMS Power</td>
<td>The highest loudness (RMS) measured in the selection.</td>
</tr>
<tr>
<td>Average</td>
<td>The average loudness over the whole selection.</td>
</tr>
</tbody>
</table>
The Sample Editor
Background

The Sample Editor allows you to view and manipulate audio at the audio clip level, by cutting and pasting, removing or drawing audio data or applying effects. This editing can be called “non-destructive”, in the sense that you can undo changes or revert to the original versions at any point, using the Offline Process History.

For details, see the section about non-destructive processing on page 332 and the description of the Offline Process History on page 355.

Opening the Sample Editor

You open the Sample Editor by double clicking an audio event in the Project window or the Audio Part Editor, or by double clicking an audio clip in the Pool. You can have more than one Sample Editor open at the same time.

• Note that double clicking on an audio part in the Project window will open the Audio Part Editor, even if the part only contains a single audio event.
  See page 386.
Window overview

The Elements menu

If you right-click (Win) or [Ctrl]-click (Mac) in the Sample Editor to bring up the Quick menu, you will find a sub menu called “Elements”. By activating or deactivating options on this submenu, you can decide what you want shown in the editor window. Some of these options are also available as icons on the toolbar.
The toolbar

The toolbar contains tools and various settings:

- You can customize the toolbar by right-clicking it (Win) or [Ctrl]-clicking it (Mac) and using the pop-up menu to hide or show items. Selecting Setup from the pop-up menu allows you to reorder sections on the toolbar, store presets, etc. See page 792.

The thumbnail display

The thumbnail display provides an overview of the whole clip. The section currently shown in the Sample Editor’s main waveform display is indicated by a blue rectangle in the thumbnail, while the current selection range is shown in blue.

- You can move the blue rectangle in the thumbnail to view other sections of the clip. Click in the lower half of the rectangle and drag it to the left or right to move it.
- You can resize the blue rectangle (by dragging its left or right edge) to zoom in or out, horizontally.
- You can define a new viewing area by clicking in the upper half of the overview and dragging a rectangle with the pointer.
The Sample Editor ruler is located between the thumbnail and the waveform display. It shows the timeline in the display format specified in the Project Setup dialog (see page 99). If you like, you can select an independent display format for the ruler by clicking on the arrow button to the right of it and selecting an option from the pop-up menu that appears (this affects the values in the info line too). For a list of the display format options, see page 96.

The waveform display and the level scale

The waveform display shows the waveform image of the edited audio clip – in the style selected in the Preferences dialog (Event Display–Audio page), see page 106. To the left of it, a level scale can be shown, indicating the amplitude of the audio.

- When the level scale is shown, you can select whether the level should be shown as a percentage or in dB. This is done by right-clicking the level scale and selecting an option from the pop-up menu that appears. This also allows you to hide the level scale.
• To display the level scale after hiding it, right-click (Win) or [Ctrl]-click (Mac) to bring up the Quick menu and activate “Level Scale” on the Elements submenu.
This submenu also allows you to select whether you want the zero axis and/or the half level axis indicated in the waveform display.

The info line

The info line at the bottom of the window shows information about the edited audio clip. You cannot edit the values on the info line.

• To hide or show the info line, click the Show Info button on the toolbar.

• Initially, length and position values are displayed in the format specified in the Project Setup dialog (see page 99), but you can change this by clicking in the middle field of the info line and selecting another display format from a pop-up menu.
This selection affects the Sample Editor ruler as well.
Operations

Zooming

Zooming in the Sample Editor is done according to the standard zoom procedures, with the following special notes:

- The vertical zoom slider changes the vertical scale relative to the height of the editor window, in a way similar to the waveform zooming in the Project window (see page 101).
  The vertical zoom will also be affected if you drag a rectangle with the Zoom tool and the option “Zoom Tool Standard Mode” (Preferences – Editing dialog) is deactivated.

- The following options relevant to the Sample Editor are available on the Zoom submenu on the Edit menu:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Zoom In</td>
<td>Zooms in one step, centering on the position cursor.</td>
</tr>
<tr>
<td>Zoom Out</td>
<td>Zooms out one step, centering on the position cursor.</td>
</tr>
<tr>
<td>Zoom Full</td>
<td>Zooms out so that the whole clip is visible in the editor.</td>
</tr>
<tr>
<td>Zoom to Selection</td>
<td>Zooms in so that the current selection fills the screen.</td>
</tr>
<tr>
<td>Zoom to Event</td>
<td>Zooms in so that the editor shows the section of the clip correspon-</td>
</tr>
</tbody>
</table>
<pre><code>                 | ding to the edited audio event. This is not available if you opened the |
                 | Sample Editor from the Pool (in which case the whole clip is opened for |
                 | editing, not an event).                                                  |
</code></pre>
<p>| Zoom In/Out Vertical | This is the same as using the vertical zoom slider (see above).         |</p>

- You can also zoom by resizing the rectangle in the thumbnail display. See page 368.

- The current zoom setting is shown in the info line, as a "samples per screen pixel" value.

- Note that you can zoom in horizontally to a scale with less than one sample per pixel!
  This is required for drawing with the Pencil tool (see page 382).

- If you have zoomed in to one sample per pixel or less, the appearance of the samples depend on the option “Interpolate Audio Images” in the Preferences dialog (Event Display–Audio page).
  If the option is deactivated, single sample values are drawn as "steps". If the option is activated they are interpolated to “curves” form.
Auditioning

While you can use the regular play commands to play back audio when the Sample Editor is open, it is often useful to listen to the edited material only. Below are two ways to do this.

- When auditioning, audio will be routed directly to the first output bus, bypassing the audio channel’s settings, effects and EQs.
- You can adjust the auditioning level with the miniature level fader on the toolbar. This does not affect the regular playback level.

By using the Speaker tool

If you click somewhere in the waveform display with the Speaker tool and keep the mouse button pressed, the clip will be played back from the position at which you clicked. Playback will continue until you release the mouse button.

By using the Play icon

Clicking the Play icon on the toolbar plays back the edited audio, according to the following rules:

- If you have made a selection, this selection will be played back.
- If there is no selection, but the option “Show Event” is activated (see page 383), the section of the clip corresponding to the event will be played back.
- If there is no selection, and “Show Event” is deactivated, the playback will start at the cursor position (if the cursor is outside the display, the whole clip is played back).
- If the Loop icon is activated, playback will continue repeatedly until you deactivate the Play icon. Otherwise, the section will be played back once.
- Note that there is a separate Play button for auditioning Regions. See page 380.
Scrubbing

The Scrub tool allows you to locate positions in the audio by playing back, forwards or backwards, at any speed:

1. Select the Scrub tool.

2. Click in the waveform display and keep the mouse button pressed. The project cursor is moved to the position at which you click.

3. Drag to the left or right. The project cursor follows the mouse pointer and the audio is played back. The speed and pitch of the playback depends on how fast you move the pointer.

- You can adjust the response of the Scrub tool with the Scrub Response (Speed) setting in the Preferences dialog (VST page). There you will also find a separate Scrub Volume setting.
Adjusting the snap point

The snap point is a marker within an audio event (or clip – see below). This is used as a reference position when you are moving events with snap activated, so that the snap point is “magnetic” to whatever snap positions you have selected.

By default, the snap point is set at the beginning of the audio event, but often it is useful to move the snap point to a “relevant” position in the event, such as a downbeat, etc.:

1. Activate the “Audio Event” option so that the event is displayed in the editor.

2. Scroll so that the event is visible, and locate the “S” flag in the event. If you haven’t adjusted this previously, it will be located at the beginning of the event.

3. Click on the “S” flag and drag it to the desired position.

   • Cubase SX only: If the Scrub tool is selected when you move the snap point, you will hear the audio while dragging (just like when scrubbing). This makes it easier to find the correct position.

   You can also adjust the snap point by setting the project cursor:

   1. Place the cursor at the desired position (intersecting the event). You may want to do this by scrubbing, to spot the right position exactly.
2. Pull down the Audio menu and select “Snap Point To Cursor”. The snap point will be set to the position of the cursor. This method can also be used in the Project window and the Audio Part Editor.

• It is also possible to define a snap point for a clip (for which there is no event yet).
  
  To open a clip in the Sample Editor, double click it in the Pool (or drag it from the Pool to the Sample Editor). After having set the snap point using the procedure described above, you can insert the clip into the project from the Pool or the Sample Editor, taking the snap point position into account.

Making selections

To select an audio section in the Sample Editor, you click and drag with the Range Selection tool.

- If Snap to Zero Crossing is activated on the toolbar, the start and end of the selection will always be at zero crossings (see page 384).

- You can resize the selection by dragging its left and right edge or by [Shift]-clicking.

- The current selection is indicated to the right on the toolbar. You can fine-tune the selection by changing these values numerically. Note that the values are relative to the start of the clip, rather than to the project timeline.
Using the Select submenu

The Select submenu on the Edit menu contains the following selection functions:

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>All</td>
<td>Selects the whole clip.</td>
</tr>
<tr>
<td>None</td>
<td>Selects no audio (the selection length is set to &quot;0&quot;).</td>
</tr>
<tr>
<td>In Loop</td>
<td>Selects all audio between the left and right locator.</td>
</tr>
<tr>
<td>From Start to Cursor</td>
<td>Selects all audio between the clip start and the project cursor.</td>
</tr>
<tr>
<td>From Cursor to End</td>
<td>Selects all audio between the project cursor and the end of the clip.</td>
</tr>
<tr>
<td>Select Event</td>
<td>Selects the audio that is included in the edited event only. This is not available if you opened the Sample Editor from the Pool (in which case the whole clip is opened for editing, not an event).</td>
</tr>
<tr>
<td>Left Selection Side to Cursor</td>
<td>Moves the left side of the current selection range to the project cursor position. For this to work, the cursor must be within the clip boundaries.</td>
</tr>
<tr>
<td>Right Selection Side to Cursor</td>
<td>Moves the right side of the current selection range to the project cursor position (or the end of the clip, if the cursor is to the right of the clip).</td>
</tr>
</tbody>
</table>

Editing selection ranges

Selections in the Sample Editor can be manipulated in several ways. Please note:

- If you attempt to edit an event that is a shared copy (i.e. the event refers to a clip that is used by other events in the project), you are asked whether you want to create a new version of the clip or not (if you haven’t made a "permanent" choice already – see below). Select “New Version” if you want the editing to affect the selected event only. Select “Continue” if you want the editing to affect all shared copies.
  
  Note: If you activate the option “Do not show this message again” in the dialog, any and all further editing you do will conform to the selected method (“Continue” or "New Version"). You can change this setting at any time with the “On Processing Shared Clips” pop-up menu in the Preferences dialog (Editing – Audio page).

- Any changes to the clip will appear in the Offline Process History, making it possible to undo them at a later point (see page 355).
**Cut, Copy and Paste**

The Cut, Copy and Paste commands on the Edit menu work according to the following rules:

- Selecting Copy copies the selection to the clipboard.
- Selecting Cut removes the selection from the clip and moves it to the clipboard. The section to the right of the selection is moved to the left to fill out the gap.
- Selecting Paste copies the data on the clipboard into the clip. If there is a selection in the editor, this will be replaced by the pasted data. If there is no selection (if the selection length is "0"), the pasted data will be inserted starting at the selection line. The section to the right of the line will be moved to make room for the pasted material.

**Insert Silence**

Selecting "Insert Silence" from the Range submenu on the Edit menu will insert a silent section with the same length as the current selection, at the selection start.

- The selection will not be replaced, but moved to the right to make room. If you want to replace the selection, use the "Silence" function instead (see page 347).
Delete

Selecting Delete from the Edit menu (or pressing [Backspace]) removes the selection from the clip. The section to the right of the selection is moved to the left to fill out the gap.

Processing

The functions on the Process submenu on the Audio menu can be applied to selections in the Sample Editor, as can the effects on the Plug-ins submenu. See the chapter “Audio processing and functions”.

Creating a new event from the selection

You can create a new event that plays only the selected range, using the following method:

1. Make a selection range.
2. Press [Ctrl]/[Command] and drag the selection range to the desired audio track in the Project window.

Creating a new clip or audio file from the selection

You can extract a selection from an event and either create a new clip or a new audio file, in the following way:

1. Make a selection range.
2. Select “Bounce Selection” from the Audio menu.

A new clip is created and added to the Pool, and another Sample Editor window will open with the new clip. The new clip will refer to the same audio file as the original clip, but will only contain the audio corresponding to the selection range.

You can also use the Bounce Selection function to create new audio files on disk from regions in the Pool – see page 436.
Working with regions

Regions are sections within a clip. One of the main uses for regions is Cycle recording, in which the different “takes” are stored as regions (see page 55). You can also use this feature for marking important sections in the audio clip. Regions can be dragged into the Project window from the Editor or the Pool, to create new audio events. You can also export a region to disk as a new audio file, from the Pool.

Regions are best created, edited and managed in the Sample Editor:

Creating a region

1. Select the range you want to convert to a region.

2. Click the “Show Regions” icon on the toolbar, or activate the “Regions” option on the Elements submenu on the Quick menu.
   The regions list is displayed to the right in the Sample Editor window.

3. Click the Add region button above the Regions list (or select “Create Region(s)” from the Audio menu).
   A region is created, corresponding to the selected range.

4. To name the region, click on it in the list and type in a new name.
   Regions can be renamed at any time, using this procedure.
   • When a region is selected in the Regions list, it is instantly displayed and selected in the Sample Editor.
Editing regions

The region selected in the list is displayed in grey in the waveform display and thumbnail.

There are two ways to edit the start and end position of a region:

• Click and drag its start and end handles in the waveform display (with any tool).
  When you move the pointer over the handles, it will automatically change to an arrow
  pointer, to indicate that you can drag the handles.

• Edit the Start and End positions numerically in the Regions list.
  The positions are shown in the display format selected for the ruler and info line, but
  are relative to the start of the audio clip, rather than the project timeline.

Auditioning regions

You can listen to a region by selecting it in the list and clicking the
Play Region button (above the list). The region will play back once or
repeatedly, depending on whether the Loop icon on the toolbar is ac-
tivated or not.
Making selections from regions

If you select a region in the list and click the Select Region button above, the corresponding section of the audio clip is selected (as if you had selected it with the Range Selection tool). This is useful if you want to apply processing to the region only, etc.

• Note that you can also double click a region in the Pool, to have its audio clip open in the Sample Editor with the area of the region automatically selected.

Creating new events from regions

You can create new audio events from regions, using the following method:

1. Click in the Region’s leftmost column in the list and keep the mouse button pressed.

2. Move the pointer to the desired audio track and position in the Project window.

3. Release the mouse button.
   A new event is created.

• You can also use the function “Events from Regions” for this (see page 139).

Removing regions

To remove a region from a clip, select it in the list and click the Remove Region button above the list.

Exporting regions as audio files

If you create a region in the Sample Editor, the region can be exported to disk as a new audio file. This is done from the Pool, and is described on page 436.
Drawing in the Sample Editor

It is possible to edit the audio clip at sample level, by drawing with the Pencil tool. This can be useful if you need to manually edit out a spike or click, etc.

1. **Zoom in to a zoom value lower than 1.**
   This means that there is more than one screen pixel per sample.

2. **Select the Pencil tool.**

3. **Click and draw at the desired position in the waveform display.**
   When you release the mouse button, the edited section is automatically selected.

☐ **Any changes created by drawing will appear in the Offline Process History, making it possible to undo them at a later stage (see page 355).**
Options and settings

Show audio event

This is only available if you opened the Sample Editor by double clicking on an audio event in the Project window or the Audio Part Editor.

When the option “Audio Event” is activated on the Elements submenu on the Quick menu (or the Show Audio Event button is activated on the toolbar), the section corresponding to the edited event is shown with a white background in the waveform display and Thumbnail. The sections of the audio clip that are “outside” the event are shown with a grey background.

• In this mode, you can adjust the start and end of the event in the clip, by dragging the event handles in the waveform display.

When you move the pointer over the event handles (no matter what tool may be selected), it takes on the shape of an arrow, to indicate that you can click and drag.
Snap to Zero Crossing

Snap to Zero Crossing activated.

When this option is activated, all audio edits are done at zero crossings (positions in the audio where the amplitude is zero). This helps you avoid pops and clicks which might otherwise be caused by sudden amplitude changes.

- This setting affects the Sample Editor only. In the Project window and other editors, the Snap to Zero Crossing setting in the Preferences dialog (Editing–Audio page) is used.

Autoscroll

Autoscroll activated.

When this option is activated, the waveform display will scroll during playback, keeping the project cursor visible in the editor.
17

The Audio Part Editor
Background

The Audio Part Editor allows you to view and edit the events inside audio parts. Essentially, this is the same type of editing that you do in the Project window, which means that this chapter contains a lot of references to the chapter “The Project window”.

Audio parts are created in the Project window, in one of the following ways:

- By selecting one or several audio events on the same track, and selecting “Events to Part” from the Audio menu.
- By gluing together two or more audio events on the same track with the Glue Tube tool.
- By drawing an empty part with the Pencil tool.
- By double clicking between the left and right locator on an audio track. With the last two methods, an empty part is created. You can then add events to the part by pasting, or by using drag and drop from the Pool.

Opening the Audio Part Editor

You open the Audio Part Editor by selecting one or more audio part(s) in the Project window and double clicking on any one of them (or using the Edit-Open key command, by default [Ctrl]/[Command]-[E]). The Audio Part Editor can display several parts at once, and you can also have more than one Audio Part Editor open at the same time.

- Note that double clicking on an audio event in the Project window will open the Sample Editor (see page 366).
Window overview

The toolbar

The tools, settings and icons on the toolbar have the same functionality as in the Project window, with the following differences:

• A Solo button (see page 390).
• Separate tools for audition (Speaker) and scrubbing (see page 392).
• No Pencil, Glue Tube or Mute tool.
• Play and Loop icons and an Audition Volume control (see page 390).
• Independent Track Loop settings (see page 391).
• Part List controls for handling several parts: Activating parts for editing, restricting editing to active parts only and showing part borders (see page 392).

• You can customize the toolbar, hiding or reordering its items.
  This is described on page 792.

The ruler and info line

These have the same functionality and appearance as their counterparts in the Project window.

• Note that you can select a separate display format for the Audio Part Editor ruler by clicking on the arrow button on the right and selecting an option from the pop-up menu that appears.
  For a list of the available formats, see page 96.
About lanes

If you make the editor window larger, this will reveal additional space below the edited events. This is because an audio part is divided vertically in lanes.

Lanes can make it easier to work with several audio events in a part:

- To move an event to another lane without accidentally moving it horizontally, press [Ctrl]/[Command] and drag it up or down. This is the default modifier key for this – you can adjust this in the Preferences if you like.
**Overlapping events**

Only one event per track can be played back at the same time! This means that if you have overlapping events, on the same lane or different lanes, these will cut each other off, according to the following rules:

- For events on the same lane, the ones that are on top (visible) will be played.
  To move overlapping events to the front or back, use the Move to Front and Move to Back functions on the Edit menu.

- For events on different lanes, the event on the lowest lane gets playback priority.

The "greyed-out" sections of the upper event will not be played since the event on the lower lane has playback priority! Note that in the actual program, playback priority between lanes is not indicated by event sections being greyed out.
Operations

- Zooming, selecting and editing in the Audio Part Editor is done just as in the Project window (see page 99).

- Note that if a part is a shared copy (i.e. you have previously copied the part by [Alt]+[Shift]/[Option]+[Shift]-dragging), any editing you perform will affect all shared copies of this part. To indicate that it is a shared copy, its name is displayed in italics and a symbol is displayed in the lower right corner of the part in the Project window (see page 122).

Auditioning

There are three ways to listen to the events in the Audio Part Editor:

- By using the Speaker tool
  If you click somewhere in the editor’s event display with the Speaker tool and keep the mouse button pressed, the part will be played back from the position at which you clicked. Playback will continue until you release the mouse button.

- By using the Audition icon
  The Audition and Audition Loop icons.
  Clicking the Audition icon on the toolbar plays back the edited audio, according to the following rules:
  
  - If you have selected events in the part, only the section between the first and last selected event will be played back.
  - If you have made a range selection, only this section will be played back.
  - If there is no selection, the whole part will be played back. Note that if the project cursor is within the part, playback starts from the current cursor position. If the project cursor is outside the part, playback starts from the beginning of the part.
  - If the Audition Loop icon is activated, playback will continue until you deactivate the Audition icon. Otherwise, the section will be played back once.
• When auditioning with the Speaker tool or Audition icon, audio will be routed directly to the first output bus, bypassing the audio channel's settings, effects and EQs.
  You can adjust the auditioning level with the miniature level fader on the toolbar. This does not affect the regular playback level.

By using regular playback

You can of course use the regular playback controls while in the Audio Part Editor. Furthermore, if you activate the Solo Editor button on the toolbar, only the events in the edited part will be played back.

The independent track loop function

The independent track loop is a sort of “mini-cycle”, affecting only the edited part. When the loop is activated, the events in the parts that are within the loop will be repeated continuously and completely independent – other events (on other tracks) are played back as usual. The only “interaction” between the loop and the “regular playback” is that every time the cycle starts over again, so does the loop.

To set up the independent track loop, proceed as follows:

1. Turn on the loop by clicking on the Loop button on the toolbar.
   If it isn't visible, you need to right-click (Windows) or [Ctrl]-click (Mac) the toolbar and add the Independent Track Loop Settings section – see page 792.

When the loop is activated, the cycle isn’t shown in the editor’s ruler. Now you need to specify the length of the loop:

2. Either [Ctrl]/[Command]-click and [Alt]/[Option]-click in the ruler to set the start and end of the loop, respectively…

3. …or edit the loop start and end positions numerically in the fields next to the Loop button.
   The loop is indicated in purple in the ruler.

• The events will be looped as long as the Loop button is activated and the Audio Part Editor window is open.
Scrubbing

In the Audio Part Editor, the Scrub tool has a separate icon on the toolbar. Apart from that, scrubbing works exactly as in the Project window (see page 118).

Handling several parts

When you open the Audio Part Editor with several parts selected – all on the same track or on different tracks – they might not all “fit” in the editor window, which can make it hard to get an overview of the different parts when editing.

Because of this, the toolbar features a few functions to make working with multiple parts easier and more comprehensive:

• The Part List menu lists all parts that were selected when you opened the editor, and lets you select which part should be active for editing. When you select a part from the list, it is automatically made active and centered in the display.

• Note that it is also possible to activate a part by clicking on it with the Arrow tool.

• The button “Edit Active Part Only”, lets you restrict editing operations to the active part only.

   If you for example select “All” from the Select submenu on the Edit menu with this option activated, all events in the active part will be selected but not the events in other parts.

“Edit Active Part Only” activated on the toolbar.
• You can zoom in on an active part so that it fills the screen by selecting “Zoom to Event” from the Zoom submenu on the Edit menu.

• The button “Show Part Borders” can be used if you want to see clearly defined borders for the active part. When this is activated, all parts except the active one are grayed out, making the borders easily discernible. There are also two “markers” in the ruler with the name of the active part, marking its beginning and end. These can be moved freely to change the part borders.

“Show Part Borders” activated on the toolbar.

• It is possible to cycle between parts, making them active, with key commands.
  In the Key Commands dialog – Edit category, there are two functions: “Activate Next Part” and “Activate Previous Part”. If you assign key commands to these, you can use them to cycle between parts. Please refer to page 805 for instructions on how to set up key commands.
Common methods

Assembling a “perfect take”

When you record audio in Cycle mode, either an event or a region (or both) is created for each recorded lap (see page 55). These events and regions are named “Take X”, where “X” is the number of the take. You can create a perfect take by putting together sections of the different takes in the Audio Part Editor.

• The procedure below will not work if you recorded with “Keep Last” mode selected on the Transport panel.
In that case, only the last take will be kept on the track (although the previous takes will be available as regions in the Pool)

First, you have to create an audio part from the takes. This procedure is slightly different depending on whether you choose to create events or regions.

Creating an audio part from events

1. In the Project window, use the Object Selection tool to draw a rectangle around the recorded events.
   This is necessary, since clicking on the event may just select the event on top (the last take). If in doubt, check the info line – the info text should be yellow.

2. Pull down the Audio menu and select “Events to Part”.
The events are converted to an audio part.

• Note that the events cycle record mode also makes it easy to combine different takes in the Project window – see page 56.

Creating an audio part from regions

1. In the Project window, select the event you recorded in Cycle mode.
   After recording, this will play the last take.

2. Pull down the Audio menu and select “Events to Part”.
   You are asked whether you want to “Create Part using Regions”.

3. Click “Regions”.
The regions are converted to an audio part.
Assembling a take

1. Double click the part to open the Audio Part Editor. Now, the different takes will be placed on different lanes, with the last take at the bottom.

2. Use the tools to cut out pieces of the takes and assemble the final result. This can include splitting with the Scissors tool, resizing events with the Arrow tool or deleting with the Eraser tool.

   • Remember that the events on the lowest lane have playback priority. Use the Audition icon to audition the result.

3. Close the Audio Part Editor. You have now assembled a "perfect take"!
Options and Settings

The following options and settings are available in the Audio Part Editor:

- **Snap**
  You can specify an independent Snap mode (and snap value for the Grid mode) in the editor. The functionality is exactly the same as in the Project window.

- **Autoscroll**
  When Autoscroll is activated on the toolbar, the window will scroll during playback, keeping the project cursor visible in the editor. This setting can be activated or deactivated individually for each window.
18

Working with hitpoints and slices
Background

Hitpoint detection is a special feature of the Sample Editor. It automatically detects attack transients in an audio file, and then adds a type of marker, a “hitpoint”, at each transient. These hitpoints allow you to create “slices”, where each slice ideally represents each individual sound or “beat” in a loop (drum or other rhythmic loops work best with this feature). When you have successfully sliced the audio file, you can do a number of useful things with it:

• Change the tempo without affecting pitch.
• Extract the timing (a groove map) from a drum loop. This can then be applied to quantize other events.
• Replace individual sounds in a drum loop.
• Edit the actual playing in the drum loop without affecting the basic feel.
• Extract sounds from loops.

• **The term “loop” is used throughout this chapter. Loop in this context usually means an audio file with a musical timebase, i.e. the length of the loop represents a certain number of bars and/or beats at a certain tempo. Playing the loop back at the right tempo in a cycle set to the correct length will produce a continuous loop, without gaps.**
Using hitpoints

The basic functionality of using hitpoints to slice up a loop is to make a loop fit the tempo of a song, or alternatively to create a situation that allows the song tempo to be changed whilst retaining the timing of a rhythmic audio loop, just like when using MIDI files.

What audio files can be used?

Here are some guidelines to what type of audio files will render the best results when slicing files using hitpoints:

- Each individual sound in the loop should have some noticeable attack. Slow attacks, legato playing etc. may not produce the desired result.
- Poorly recorded audio might be difficult to slice correctly. However, the hitpoint detection function can automatically normalize the audio to improve the detection results – see below.
- There may be problems with sounds drowned in smearing effects, like short delays.

Calculating hitpoints and slicing a loop – a quick tutorial

Before proceeding, find a suitable loop using the criteria above. At this point it doesn’t matter whether you know the original tempo of the loop, as this will be automatically detected. Proceed as follows:

1. Open the event or clip for editing in the Sample Editor. You could do this by double clicking an event on an audio track in the Project window or a clip in the Pool. In this example, we assume you work with an event on a track.

2. If needed, make a selection range spanning a section of the loop.

   - For example, if you have extracted the audio clip from a track on an audio sample CD, it may contain more than one actual loop (many loop CDs have several loops for each CD track). In that case you would want to make a selection around the loop you’re interested in. The selection can include some silence before and after the loop, it doesn’t matter.
Another possibility is that you want to extract a particular section within a long loop.

In that case, make a selection range that starts at the correct position in the loop and ends slightly after the end of the section you’re interested in. You can use the audition and loop buttons on the toolbar to check your selection range.

Finally, if the audio clip contains one loop only or you want to use the very first loop in the clip, you don’t need to make any selection at all.

3. Click the Hitpoint Mode button on the Sample Editor toolbar.

Now a dialog appears with settings for the hitpoint detection:

4. Leave the “Use level scan” checkbox activated.
   When this is on (recommended), the hitpoints detection function will analyze a normalized version of the audio, which most often gives more accurate detection results.
   Note that this doesn’t affect the actual audio loop in any way.

5. Activate the “Adjust Loop” checkbox.
   This tries to detect the loop’s tempo automatically, based on the following settings:

   - **Maximum bars**
     This will affect the length of the loop in the following way: the program will look at the selection range you’ve made (if any) and the Maximum bars setting and try to set the loop length to an even number of bars, less than or equal to the Maximum bars value.
     This means that if you want to use the first bar in the selection (or clip) only, you should set Maximum bars to 1 (note that this is required for extracting grooves – these must be 1 bar long!). Similarly, if you are working with a long audio clip and want to use the first x bars in the clip, set Maximum bars to this number.
     If you want to use the whole selection (or clip), you should set Maximum bars to the number of bars in the selection/clip, or to a higher value.
• **Beats**
  This doesn’t affect the actual detection but rather which hitpoints will be shown afterwards. If you e.g. know that your loop is based on 1/16th notes, select “1/16”. If you’re uncertain, set this to “All” – you can change this setting afterwards if needed.

• **Minimum – Maximum BPM**
  These values help the program detect the tempo of the loop – set them so that the original loop tempo is somewhere in between.

  **The smaller the min-max bpm range, the higher the precision of the hitpoint detection** – if you have a good idea about the original loop tempo, set a narrow min-max range for best results.
  If you have no idea about the original loop tempo, listen to the loop and try to determine whether it’s slow (70-100 bpm, common in hip-hop, soul, r’n’b, etc.), medium (100-140 bpm, typical for house, some rock, etc.) or fast (trance, d’n’b, etc.).
  You can use a pretty wide min-max range, but if the max value is twice the min value or more you will probably get the wrong result.

6. **Click Process.**
   The hitpoints are detected.

   As you now can see, hitpoints have been set at the beginning of each sound in the loop (or at least at most sounds), a grid has appeared, a blue area is shown in the ruler (indicating the length of the loop as set with the “Maximum bars” setting in the dialog) and the right half of the toolbar now shows the Sensitivity slider and additional pop-ups.
7. Check that the loop range is correct by activating the loop and audition buttons in the toolbar.
The loop should be played back repeatedly until you click the audition button again.
Note: if you made a selection range before calculating the hitpoints, you need to remove this by clicking anywhere in the clip – otherwise the selection range will be played back instead of the loop range!

8. If you now move the Hitpoint Sensitivity slider to the left, this gradually hides the hitpoints. Moving the slider to the right increases the sensitivity to reveal additional hitpoints detected during the calculate process.
The basic aim is to add, remove or in various other ways edit the hitpoints so that one individual sound is played between each hitpoint. This is described in detail starting on page 405.

As you can see, the calculated original tempo is shown to the right on the toolbar (see page 404). In the next step, the loop will adapt to the project tempo set in Cubase SX/SL.

9. Pull down the Audio menu, and select “Create Audio Slices” from the Advanced submenu.
Now the following happens:

• The Sample Editor closes.
• The audio event is “sliced” so that there is a separate event for each hitpoint. Only the section within the loop range (blue ruler area) is kept.
• The audio event is replaced by an audio part, containing the slices (double click the part to view the slices in the Audio Part Editor).
• The loop is automatically adapted to the project tempo.

The slices in the Audio Part Editor. Here, the project tempo was higher than the loop’s original tempo – this means the slice events will overlap slightly.
• If you opened the Sample Editor for a clip in the Pool, you will find that the icon for the clip changes in the Pool (to indicate that it is sliced). Dragging the sliced clip from the Pool to an audio track will create an audio part with the slices adapted to the project tempo, just as above.

10. If you activate cycle playback on the Transport panel, the loop should now play back seamlessly at the tempo set in the program!

11. To make the loop follow any further tempo changes, make sure it’s set to “Musical time base” by using the toggle button in the Track list or Inspector (the button should show a note symbol – see page 113).

• Note that if the project tempo is lower than the loop’s original tempo, there may be audible gaps between each slice event in the part. This can be remedied by using the Close Gaps function on the Advanced submenu – see page 416. You should also consider activating auto fades for the part’s audio track – fade-outs set to about 10 ms will help eliminate any clicks between the slices when you play back the part. See page 179.

• If the project tempo is higher than the loop’s original tempo, you may want to activate auto crossfades for the track. You can use the Close Gaps functions in this case as well if needed.
A note about the calculated tempo

The “original tempo” setting shown in the toolbar depends on the following settings:

- The loop range (indicated by the bright blue area in the ruler). This determines which area of the loop event should be used for the tempo detection.

- The bars, beats and time signature settings on the toolbar. These inform the program about the length (in musical terms) of the loop range.

If you adjust the loop range (by dragging its edges in the ruler) or the bars/beats/signature settings on the toolbar, the original tempo display will change as well. For the original tempo to be correctly calculated, the bars/beats/signature setting should match the loop range. In other words, if the loop range contains exactly one bar of music (in 4/4 time), the toolbar should be set to 1 bar, 0 beats, 4/4 signature.

This is what the program attempts to do when automatically calculating the tempo. If you turn off “Adjust loop” when detecting hitpoints, you need to set this up manually, by adjusting the loop range and specifying the correct bars, beats and time signature.

- A quick way to adjust the loop range is to make a selection range and select “Locators to Selection” from the Transport menu (or use the key command for this, by default [P]).

In Hitpoint mode in the Sample Editor, this will adjust the loop range rather than the actual locator (cycle) range. Note that the selection range is magnetic to hitpoints, making it easy to adjust the loop range correctly this way!
Editing hitpoints

In this section, we go back a bit and look at what can be done with hitpoints in the Sample Editor. There are three ways to invoke the hitpoint calculation:

- Select Calculate Hitpoints from the Advanced submenu on the Audio menu.
- Click the Hitpoint Mode button in the Sample Editor toolbar.
- Select the Hitpoint Edit tool from the toolbar or Quick menu.

The last two methods will calculate hitpoints if they haven’t already been calculated.

As outlined in the previous section, this makes the program calculate (or detect) hitpoints in the audio event, and you can use the Sensitivity slider to change how many hitpoints are shown.

For some loops, this may be all that is needed to set the hitpoints so that each slice to be created will contain a single “hit” or sound. However, there will almost certainly be cases when the automatic calculation may add a hitpoint where there shouldn’t be one, and fail to add a hitpoint where one is needed, even if the Sensitivity slider is set to maximum. If there are too many or too few hitpoints in a loop, it will most probably not play back properly.

When this occurs, you have to edit the hitpoints manually in the Sample Editor.
Auditioning slices

A slice is a section of the waveform, from one hitpoint to the next.

The first thing you should do before editing hitpoints is to listen to each slice in the Sample Editor, to determine what they contain. The aim is basically to avoid “double hits”, like a snare hit being followed by a hi-hat hit within the same slice. You also want to determine whether any hitpoints have been added that should be removed:

1. Open a loop in the Sample Editor.
   If you have already created slices you can open them in the Sample Editor by double clicking any event in the Audio Part Editor. If it is a new loop, follow the instructions in the tutorial.

2. Select the Speaker tool.

3. Now you can simply point and click on any slice and it will be played back.
   Listen for “double hits” and slices that contain parts of a single sound.

   If you find hitpoints that need to be removed or instances where a hitpoint needs to be added, the first thing to try is to change the sensitivity setting – see the following section.
Setting the sensitivity

The loop is first analyzed to determine where hitpoints should appear (where the individual “beats” in the loop are), then you manually set the sensitivity with the Sensitivity slider to determine how many hitpoints there should be.

- Try raising the sensitivity to add “missing” hitpoints, and lowering it to remove unwanted hitpoints. This may or may not work, depending on the situation, but as a general rule you should try this first.

- Audition the slices again to determine if changing the sensitivity has improved matters.

The “Use” pop-up menu

The “Use” pop-up menu on the toolbar affects which hitpoints are shown and is a useful tool for removing unwanted hitpoints. The options on the pop-up menu are:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>All</td>
<td>All hitpoints are shown (taking the Sensitivity slider into account).</td>
</tr>
<tr>
<td>1/4, 1/8, 1/16, 1/32</td>
<td>Only hitpoints that are close to the selected note value positions within the loop (e.g. close to exact sixteenth note positions, if you have selected the 1/16 option) will be shown. Again, the Sensitivity slider is taken into account.</td>
</tr>
<tr>
<td>Metric Bias</td>
<td>This is like the “All” mode, but all hitpoints that are close to even meter divisions (1/4 notes, 1/8 notes, 1/16 notes, etc.) get a “sensitivity boost” – they are visible at lower Sensitivity slider settings. This is useful if you are working with dense or cluttered material with a lot of hitpoints, but you know that the material is based on a strict meter. By selecting Metric Bias it will be easier to find the hitpoints close to the meter position (although most other hitpoints are also available, at higher sensitivity settings).</td>
</tr>
</tbody>
</table>
How many slices do I need?

If your main reason for slicing the loop is to change the tempo, you generally need as many slices as you can get, but never more than one per individual “hit” in the loop.

If you want to create a groove (see page 413), you should try to get approximately one slice per eighth note, sixteenth note or whatever the loop requires.

Disabling slices

You might run into situations where there are too many slices – a single sound may have been split into two slices for example. You could of course reduce the sensitivity to get rid of the hitpoints you don’t want, but then other hitpoints could disappear too, which may be undesirable. What you need to do in a situation like this is to disable an individual slice, using the Hitpoint Edit tool in Disable mode:

1. Select the Hitpoint Edit tool and click the tool icon on the toolbar again. A pop-up menu appears, listing the three modes of the Hitpoint Edit tool.
2. Select the Disable mode. The pointer turns into a cross in the Sample Editor window.
3. Click on the handle (the triangle) of the hitpoint you wish to disable. The hitpoint handle is diminished and its line disappears to indicate that it is disabled.
4. Now, the hitpoint won’t be taken into account when you create slices.
5. To reactivate a disabled hitpoint, click on the hitpoint handle with the Disable tool.
Locking slices

If you lock a hitpoint, by clicking on its handle with the Hitpoint Edit tool in Lock mode, it will stay even if you drag the Sensitivity slider all the way to zero. This can be used in situations where one or several slices contain double hits, but raising the sensitivity adds a lot of unwanted slices.

1. Find the place where you hear double hits when auditioning.
2. Remember the current slider setting.
3. Raise the Sensitivity slider to a higher value so that a hitpoint appears, separating the two sounds. Most likely this will add a lot of other unwanted hitpoints as well.
4. Audition to make sure you got what you wanted.
5. Select the Hitpoint Edit tool and click the tool icon again to select Lock mode. A lock icon is shown beside the pointer in the Sample Editor window.
6. Lock the new slice by clicking on its handle.
7. Drag the Sensitivity slider to the original setting. The locked hitpoint will remain shown.

- You can unlock a locked hitpoint by clicking it again with the Hitpoint Edit tool in Lock mode.
Setting hitpoints manually

If you cannot get the desired result by adjusting sensitivity, disabling or locking, you can add, move and delete hitpoints manually.

Adding hitpoints

Manually adding hitpoints can be done in situations where a hitpoint is missing at a specific point, but doesn’t appear even if the sensitivity is set to full.

1. Zoom in on the waveform at the point where you wish to add a hitpoint.
2. Audition the area with the Speaker tool to make sure that the start of the sound is in view.
3. Activate Snap to Zero Crossing on the Sample Editor toolbar.
   By finding zero crossings in the waveform (positions where the amplitude is close to zero), manually added slices won’t introduce any clicks or pops. All hitpoints found by the Calculate function are automatically placed at zero crossings.
4. Select the Pencil tool from the Sample Editor toolbar and click just before the start of the sound.
   A new hitpoint appears. Manually added hitpoints are locked by default.

   ![Waveform with hitpoints added](image)

   • If you click and keep the mouse button pressed, you can adjust the position of the new hitpoint by dragging.
     Releasing the mouse button adds the hitpoint.

5. Audition the new slice with the Play tool to make sure you got what you wanted.
Moving hitpoints

If you manually added a hitpoint, and it was either placed too far away from the start of the sound, or too far into the sound, you can manually move the hitpoint. It is also possible to move calculated hitpoints this way.

1. Make sure Snap to Zero Crossing is activated on the Sample Editor toolbar.

2. Select the Hitpoint Edit tool and click the tool icon again to select the Move mode.
   You can also use the regular Range Selection tool for this.

3. Click on the hitpoint handle and drag it to the new position.

Deleting hitpoints

To delete a hitpoint, select the Move tool and drag it out of the Sample Editor window. Hitpoints that you have created manually can also be deleted with the Hitpoint Edit tool in Disable mode.
Creating slices

After you have specified the correct loop length and time signature and worked on the hitpoints in the Sample Editor so that one sound per slice is heard, it is time to actually slice the file (if that is what you want to do – there are other uses for hitpoints as well, as described on the following pages). This is done by selecting “Create Audio Slices” from the Advanced submenu on the Audio menu.

• This function (and many of the others on the Advanced submenu) are only available if a valid loop tempo is detected.
  In other words, if the bars/beats and loop range settings “make sense”.

Now the following happens:

• If you edited an event on an audio track, the Sample Editor closes.

• The audio event is “sliced” so that there is a separate event for each hitpoint.
  In other words, the sections between the hitpoints become separate events, all referring to the same original file.

• On the audio track, the audio event is replaced by an audio part, containing the slices.
  If you edited a clip from the Pool, you need to drag it to an audio track to get a part with the slices.

• The loop is automatically adapted to the tempo set in Cubase SX/SL.
  This takes the loop length settings you made into account: if the loop was e.g. one bar long, the part is resized to fit exactly one bar in the Cubase SX/SL tempo, and the slices are moved accordingly – keeping their relative positions intact within the part.

  Now, you can change the tempo and have the loop automatically follow (provided that the track is set to musical time base – see page 113). Furthermore, you can double click the part to edit the slices in the Audio Part Editor. You can:

  • Remove or mute slices.
  • Change the loop by reordering, replacing or quantizing slices.
  • Apply processing or effects to individual slices.
  • Create new files from individual slices using the “Bounce Selection” function on the Audio menu.
Creating groove quantize maps

You can generate groove quantize maps based on the hitpoints you have created in the Sample Editor. Groove quantizing is not meant for correcting errors, but for creating rhythmic feels. This is done by comparing your recorded music with a “groove” (a timing grid generated from the file) and moving the appropriate notes so that their timing matches the one of the groove. In other words, you can extract the timing from an audio loop and use it for quantizing MIDI parts (or other audio loops, after slicing them).

Proceed as follows:

1. Create and edit hitpoints as described earlier in this chapter. You don’t have to create slices – just set up the hitpoints.

   • You should try to get approximately one slice per eighth note, sixteenth note or whatever the loop requires when setting hitpoints for extracting a groove.

   It can be helpful to use one of the note value-based options on the “Use” pop-up menu when you’re setting up the hitpoints (see page 407).

2. When you have finished setting the hitpoints, select “Create Groove Quantize” from the Advanced submenu on the Audio menu. The groove is extracted.

3. If you now pull down the Quantize pop-up in the Project window you will find an additional item at the bottom of the list, with the same name as the file from which you extracted the groove. This groove can now be selected as a base for quantizing, just like any other quantize value. See page 505.

   • You can also create grooves from a MIDI part, by selecting the part and selecting “Part to Groove” from the Advanced Quantize submenu on the MIDI menu.
Other Advanced submenu items

On the Advanced submenu on the Audio menu you will also find the following functions:

Create Markers

If an audio event contains calculated hitpoints, this function can be used to add markers – one for each hitpoint – to an automatically created marker track (see page 158). This can be useful for locating to hitpoints, and for using the Timewarp tool (see page 650) to snap to hitpoints.

Divide Audio Events

This Advanced submenu item can be used when you simply wish to create separate events according to the hitpoints for a file. This means that you do not have to make the same considerations as when slicing for tempo changes. You can use any method you like to set hitpoints, use sensitivity, note values, manually or any combination.

• The slices created will appear in the Project window as separate events.
Set Audio Event from Loop

When you calculate hitpoints, a special loop range is defined in the Sample Editor – indicated by the bright blue area in the ruler. If you used the “Adjust Loop” option in the dialog (see page 400), the loop will have the length specified with the “Maximum bars” setting (or the length of the whole event, if you set a higher “Maximum bars” value).

The Set Audio Event from Loop function will resize the event according to the loop range. For example, if you have a long loop event and want to “extract” the first bar only, simply calculate hitpoints with “Maximum bars” set to 1, and then use Set Audio Event from Loop.

Set Tempo from Event

This function sets the project tempo according to the original tempo of the loop (as calculated by the hitpoints detection, or set up manually – see page 404). The result depends on whether the Tempo track is activated or you are using fixed tempo.

- If you are using fixed tempo, you will be asked to confirm that you want to change this – click Yes to set the fixed tempo to the event’s original tempo.
- If you are using the Tempo track, but there are no tempo changes, you will be asked whether to change the global tempo or not:
  Click Yes to change the global tempo (the first tempo event on the Tempo track) or No to insert tempo events at the beginning and end of the audio event (i.e. the project tempo will be adapted to the loop tempo but only during the course of the event).

- If you are using the Tempo track with tempo changes, new tempo events will be inserted at the beginning and end of the audio event. The project tempo will be adapted to the loop tempo during the course of the event.
Stretch to Project Tempo

The Stretch to Project Tempo function on the Advanced submenu (Audio menu) makes use of the “original tempo” calculated by the hitpoint detection and applies time stretch to the selected event, so that it fits the current project tempo (the tempo at the start position of the event).

This can be used for stretching a whole loop (not sliced) to the project tempo. Note: for this function to be available, you must have calculated hitpoints for the event (since the function relies on the “original tempo” information).

Using the Close Gaps function

If you have sliced a loop for tempo changes, lowering the tempo below the loop’s original tempo will create gaps between the slices. The lower the tempo is in relation to the original tempo, the wider the gaps will be. This can be fixed using the “Close Gaps” function on the Advanced submenu on the Audio menu:

1. Set the desired tempo.
2. Select the part in the Project window.
   Now time stretch is applied on each slice to close the gaps. Depending on the length of the part, this can take a little while.
4. The waveform is redrawn and the gaps are now closed!

• Note that this feature creates new clips in the Pool, one for each slice.
• Close Gaps can also be used when the project tempo is higher than the original loop tempo.
  This will use the time stretch function to shrink the slices to fit.
• If you decide to change the tempo again after using the Close Gaps function, you should undo the Close Gaps operation or start over again, using the original unstretched file.
• You can also use this function on individual events (in the Audio Part Editor or Project window).
  The events don’t have to be slices – you can use Close Gaps simply to stretch an audio event to the start position of the next event.
The Pool
Background

What is the Pool?

Every time you record on an audio track, a file is created on your hard disk. A reference to this file – a clip – is also added to the Pool. Two general rules apply to the Pool:

• All clips, audio or video, that belong to a project are listed in the Pool.
• There is a separate Pool for every project.

The way the Pool displays folders and their contents is similar to the way the Mac OS X Finder and the Windows Explorer display folders and lists of files.

What can you do in the Pool?

In the Pool you can, amongst other things, perform the following operations:

Operations that affect files on disk

• Import clips (audio files can automatically be copied and/or converted).
• Convert file formats.
• Rename clips (this will also rename the referred files on disk).
• Delete clips (if you select the "Move to Trash" option and empty the Trash folder – see page 426).
• Prepare File Archives for backup.
• Minimize Files.

Operations that only affect clips

• Copy clips.
• Audition clips.
• Organize clips.
• Apply audio processing to clips.
• Save or import complete Pool files.
Opening the Pool

You open the Pool in any of the following ways:

• By clicking the Pool icon in the Project window.

• By selecting “Pool” on the Project menu or “Open Pool Window” on the Pool menu.

• By using a key command (by default [Ctrl]/[Command]-[P]).

The content of the Pool is divided into three main folders:

• The Audio folder
  This contains all audio clips and regions currently in the project.

• The Video folder
  This contains all video clips currently in the project.

• The Trash folder
  Unused clips can be moved to the Trash folder for later permanent removal from the hard disk.

These folders cannot be renamed or deleted from the Pool, but any number of subfolders can be added (see page 438).
Window Overview

Audio folder  Audio clip name  Region name  Toolbar  Column Headings

Trash folder  Video folder  Waveform image

Toolbar overview

Hide/show info line  View Pop-up  Open/Close all Folders  Import Button  Project Folder Path

Play and Loop buttons, audition volume control  Search Button  Pool Record Folder Path
The info line

Click the “Show Info” button on the toolbar to show or hide the info line at the bottom of the Pool window. It shows the following information:

- Number of audio files in the Pool
- Total size of all audio files in the Pool
- Number of audio files in use
- Number of files in the Pool that are not in the project folder (e.g. video files)

How clips and regions are displayed in the Pool

- Audio clips are represented by a waveform icon followed by the clip name.

  ![Guitars2](image)

- Audio regions are represented by a region icon followed by the region name.

  ![Region 1](image)

- Video clips are represented by a camera icon followed by the clip name.

  ![Video](image)
### The Pool window columns

Various information about the clips and regions can be viewed in the Pool window columns. The columns contain the following information:

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Media</td>
<td>This column contains the Audio, Video and Trash folders. If the folders are opened, the clip or region names are shown and can be edited. This column is always shown.</td>
</tr>
<tr>
<td>Used</td>
<td>This column displays the number of times a clip is used in the project. If a column row is empty, the corresponding clip is not used.</td>
</tr>
<tr>
<td>Status</td>
<td>This column displays various icons that relate to the current Pool and clip status. See page 423 for a description of the icons.</td>
</tr>
<tr>
<td>Info</td>
<td>This column shows the following information for audio clips: The sample rate, bit resolution, number of channels and the length in seconds. For regions, it displays start and end times in frames, and for video clips the frame rate, number of frames, and length in seconds.</td>
</tr>
<tr>
<td>Type</td>
<td>This column shows the file format of the clip.</td>
</tr>
<tr>
<td>Date</td>
<td>This column shows the date when the clip was created.</td>
</tr>
<tr>
<td>Origin Time</td>
<td>This column shows the original start position where a clip was recorded in the project. As this value can be used as a basis for the &quot;Insert into Project&quot; Pool menu item (and other functions), you can change it if the Origin Time value is redundant. This can either be done by editing the value in the column, or by selecting the corresponding clip in the Pool, moving the project cursor to the new desired position and selecting &quot;Update Origin&quot; from the Pool menu.</td>
</tr>
<tr>
<td>Image</td>
<td>This column displays waveform images of audio clips or regions.</td>
</tr>
<tr>
<td>Path</td>
<td>This column shows the path to the location of a clip on the hard disk.</td>
</tr>
<tr>
<td>Reel Name</td>
<td>If you have imported an OMF file (see page 788), they may include this attribute, in which case it is shown in this column. The Reel Name describes the 'physical' reel or tape from which the media was originally captured.</td>
</tr>
</tbody>
</table>
About the Status column symbols

The Status column can display various symbols that relate to the clips status. The following symbols can be shown:

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Record symbol" /></td>
<td>This indicates the current Pool Record folder (see page 437). This symbol is shown if a clip has been processed.</td>
</tr>
<tr>
<td><img src="image" alt="Question mark symbol" /></td>
<td>The question mark indicates that a clip is referenced to the project but is missing from the Pool (see page 430).</td>
</tr>
<tr>
<td><img src="image" alt="External file symbol" /></td>
<td>This indicates that the clip file is external, i.e. located outside the current Audio folder for the project.</td>
</tr>
<tr>
<td><img src="image" alt="Recorded symbol" /></td>
<td>This indicates that the clip has been recorded in the currently open version of the project. This is useful for finding recently recorded clips quickly.</td>
</tr>
</tbody>
</table>

Sorting the Pool contents

You can sort the clips in the Pool by name, date etc. This is done by clicking on the corresponding column heading. Clicking again on the same heading switches between ascending and descending sort order.

The arrow indicates the sort column and sort order.
Operations

Renaming clips in the Pool

To rename a clip in the Pool, select it and click on the existing name, type in a new name and press [Return].

Renaming a clip in the Pool is much preferred to renaming it outside Cubase SX/SL (for example on the computer desktop). This way Cubase SX/SL already “knows” about the change, and won’t lose track of the clip the next time you open the project. See page 430 for details about lost files.

Copying clips in the Pool

To make a duplicate clip, proceed as follows:

1. Select the clip you wish to copy.
2. Select “New Version” on the Pool menu. A new version of the clip appears in the same Pool folder, with the same name but with a “version number” after it, to indicate that the new clip is a duplicate. The first copy made of a clip will logically get the version number “2” and so on.

Copying a clip does not create a new file on disk, but just a new edit version of the clip (referring to the same original file).

Inserting clips into a project

Using menus

1. Select the clip(s) you want to insert into the project.
2. Pull down the Pool menu and select an “Insert into Project” option. The “At Cursor” option will insert the clip(s) at the current project cursor position. The “At Origin” option will insert the clip(s) at their Origin Time position(s).
   • Note that the clip will be positioned so that its snap point is aligned with the selected insert position. You can also open the Sample Editor for a clip by double clicking it, and perform the insert operation from there. This way you can set the snap point before inserting a clip.
3. The clip is inserted on a new audio track, created automatically, or on a selected track.
   If several tracks are selected, the clip will be inserted on the first selected track.
By using drag and drop

You can use drag and drop to insert clips into the Project window. You can also use drag and drop from the Sample Editor for a clip by making a selection range and pressing [Ctrl]/[Command] while dragging. Note:

• Snap is taken into account if activated.

• While you drag the clip in the Project window, its position will be indicated by a marker line and a numerical position box. Note that these indicate the position of the snap point in the clip. For example, if you drop the clip at the position 22.00, this will be where the snap point ends up. See page 374 for info about how to set the snap point.

• If you position the clip in an empty area in the event display (i.e. below existing tracks), a new track is created for the inserted event.
Deleting clips

Removing clips from the Pool
To remove a clip from the Pool without deleting it from the hard disk, proceed as follows:

1. Select the file(s) and select “Delete” from the Edit menu (or press [Backspace] or [Delete]).
   • If you try to delete a clip that is used by one or more events, the program will ask you if you want to remove these events from the project.

2. Click Remove.
   A new prompt asks whether you want to move the clip to the Trash or remove it from the Pool.

3. Select “Remove from Pool”.
   The clip is no longer associated with the project, but still exists on the hard disk, and can be used in other projects etc. This operation can be undone.

Deleting from the hard disk
To delete a file permanently from the hard disk, it must first be moved to the Trash folder:

• Follow the instructions for deleting clips above and select “Trash”.
  When clips are in the Trash folder they can be removed permanently.

• Select “Empty Trash” on the Pool menu.
  A dialog box asks you if you are sure you want to follow through. Remember that this operation cannot be undone!

☐ Before you permanently delete audio files from the hard disk, you should make sure that these aren't used by another project!
Removing unused clips from the Pool

This function finds all clips in the Pool that are not used in the project, and either moves them to the Pool Trash folder where they can be permanently deleted, or removes them from the Pool:

1. Select “Remove Unused Media” on the Pool menu.
   A prompt appears with the text “Move to Trash or Remove From Pool?”
2. Make your selection.

Locating events referring to a clip in the Pool

If you want to find out which events in the project refer to a particular clip in the Pool, proceed as follows:

1. Select the clip in the Pool.
2. Select “Select in Project” on the Pool menu.
   All events that refer to the selected clip are now selected in the Project window.

Locating clips or regions in the Pool

You can perform a search of the Pool to locate particular clips or regions, in the following way:

1. Select “Find in Pool” from the Pool menu.
   This opens the Find Media window, in which you can specify various criteria to match. You can search by any one (or a combination) of the following properties:
   • Name.
   • Size (in seconds, minutes, frames or bytes).
   • Bitsize (resolution).
   • Channels (stereo or mono).
2. Tick the box beside the property you would like to search by, and enter the desired name or value.
   For the “Size” property, you can search for sizes smaller or greater than a value, or between two values. This is determined by the second pop-up menu.
3. Press Start.
   The search result appears in the lower half of the window.
To select the found clips or regions in the Pool, click the "Select in Pool" button.

To insert a found clip or region directly into the project, select it in the list in the dialog and select one of the "Insert into Project" options from the Pool menu.

The options are described on page 424.

The "Find in Pool" command is also accessible from the Project window – the Pool window does not have to be open.

Locating selected events

If you quickly want to find the clip for an event in the Project window, you can also use the following method:

1. Select one or several events in the Project window.

2. Pull down the Audio menu and select "Find Selected in Pool".

The corresponding clip(s) will be located and highlighted in the Pool. If the Pool window isn’t already open it will be opened.
Searching for audio files on disk

The Pool can help you locate audio files on your hard disk or other media. This works much like the regular file search, but with a couple of extra features:

1. Click the Search button in the toolbar.
   A lower pane appears in the window, displaying the search functions.

2. Use the Folder pop-up menu to specify where to search.

3. Specify the name of the file(s) to search for in the Name field.
   You can use partial names or wildcards (*), if you like. Note however, that the function only searches for audio files of the supported formats.

4. Click the Search button in the search pane.
   The search is started and the Search button is labeled Stop – click this to cancel the search if needed.

   When the search is finished, the found files are listed to the right.

   - To audition a file, select it in the list and use the playback controls to the left (Play, Stop, Pause and Loop).
     If Auto Play is activated, selected files will automatically be played back.
   - To import a found file into the Pool, select it in the list and click the Import button in the search pane.

5. To close the search pane, click the Search button in the toolbar again.
About missing files

When you open a project, you may get a warning that one or more files are "missing". If you click Close in the warning dialog, the project will open anyway, without the missing files. In the Pool you can check which files are considered missing. This is indicated by a question mark in the Status column.

A file is considered missing under one of the following conditions:

- The file has been moved or renamed outside the program since the last time you worked with the project, and you ignored the Resolve Missing files dialog when you opened the project for the current session.
- You have moved or renamed the file outside the program during the current session.
- You have moved or renamed the folder in which the missing files are located.

Locate missing files

1. Select “Find Missing Files” from the Pool menu.
   The Resolve Missing Files dialog opens.

2. In the dialog that appears, decide if you want the program to try to find the file for you (Search), if you want to do it yourself (Locate) or if you want to specify in which directory the program should search for the file (Folder).
   - If you select Locate, a file dialog opens, allowing you to locate the file manually.
     Click “Open” when you have located the file.
   - If you select Folder, a dialog opens to let you specify the directory in which the missing file can be found.
     This might be the preferred method if you have renamed or moved the folder containing the missing file, but the file still has the same name. Once you select the correct folder, the program finds the file and you can close the dialog.
If you select Search, the program will scan your hard disks for a file with the proper name and display them in a list. The dialog allows you to specify which folder or disk should be scanned. Click the Search Folder button, select a directory or a disk and then click the Start button. If found, select the file from the list and click “Accept”. Afterwards Cubase SX/SL tries to map all other missing files automatically.

Reconstructing missing edit files

If a missing file cannot be found (e.g. if you have accidentally deleted it from the hard disk) it will normally be indicated with a question mark in the Status column in the Pool. However, if the missing file is an edit file (a file created when you process audio, stored in the Edits folder within the project folder), it may be possible for the program to reconstruct it by recreating the editing to the original audio file:

1. Open the Pool and locate the clip(s) for which files are missing.
2. Check the Status column – if this says “Reconstructible”, the file can be reconstructed by Cubase SX/SL.
3. Select the reconstructible clips and select “Reconstruct” from the Pool menu.
The editing is performed and the edit files are recreated.

Removing missing files from the Pool

If the Pool contains audio files that cannot be found or reconstructed, you may want to remove these:

- Select “Remove Missing Files” from the Pool menu to remove all missing files from the Pool (and remove their corresponding events from the Project window).
Auditioning clips in the Pool

There are two methods you can use to audition clips in the Pool:

• By selecting a clip and activating the Play button.
  The whole clip will play back, unless you stop playback by clicking the Play button again.

  ![Play button](Image)

• By clicking somewhere in the waveform image for a clip.
  The clip will play from the position in the waveform you click until the end of the clip,
  unless you stop playback by clicking the Play button, or by clicking anywhere else in
  the pool window.

  ![Clicking waveform](Image)

  In both cases, the audio will be routed directly to the first output bus.
  You can adjust the auditioning level with the miniature level fader on the toolbar. This
  does not affect the regular playback level.

  If you have activated the Loop button before you audition, the following will happen:

  ![Loop button](Image)

  • If you click the Play button to audition a clip, it will repeat indefinitely
    until you stop playback by clicking the Play or Loop button again.

  • If you click in the waveform image to audition, the section from the
    point you clicked to the end of the clip will repeat indefinitely until you
    stop playback.
Opening clips in the Sample Editor

The Sample Editor allows you to perform detailed editing on the clip (see the Sample Editor chapter for details). You can open clips in the Sample Editor directly from the Pool in the following ways:

• If you double click on a clip waveform icon, the clip will open in the Sample Editor.

• If you double click on a region in the Pool, its clip will open in the Sample Editor with the region selected.

One practical use for this is to set a snap point for a clip (see page 374). When you later insert the clip from the Pool into the project, you can have it properly aligned according to the set snap point.
Import Medium...

The Import Medium dialog lets you import files directly into the Pool. It is opened from the Pool menu or with the Import button in the Pool window.

This is a standard file dialog, where you can navigate to other folders, audition files etc. The following audio file formats can be imported:

- Wave (Normal or Broadcast, see page 695)
- AIFF and AIFC (Compressed AIFF)
- REX or REX 2 (see page 780)
- Sound Designer II
- MPEG Layer 2 and Layer 3 (mp2 and mp3 files – see page 781)
- Ogg Vorbis (ogg files – see page 781)
- Windows Media Audio (Windows – see page 781)
- Wave64 (.w64 files – Cubase SX only)
- Stereo or mono
- Any sample rate (although files with another sample rate than the one used in the project will play back at the wrong speed and pitch – see below).
- 8, 16, 24 bit or 32 bit float resolution

In addition, AVI, QuickTime, WMV (Windows only), DV (Mac OS X only) and MPEG 1 and 2 video files can be imported into the Pool.

- It is also possible to use the commands on the Import submenu on the File menu to import audio or video files into the Pool.
- For video files to be played back correctly, the right codecs have to be installed.
When you select a file in the Import Medium dialog and click Open, the Import Options dialog will appear.

It contains the following options:

- **Copy File to Working Directory.**
  Activate this if you want a copy of the file to be made in the Project’s Audio folder, and have the clip refer to this copy. If the option is off, the clip will refer to the original file in the original location (and will thus be marked as “external” in the Pool – see page 423).

- **Convert to Project.**
  Here you can choose to convert the sample rate and/or the sample size (resolution) to the current format used in the project. The options will only be available if necessary (if the sample rate is different than the one set for the project and/or if the sample size is lower than the record format used in the project).
  Note that if you are importing several audio files in one go, the Import Options dialog will instead contain a “Convert if needed” checkbox. When this is activated, the imported files will be converted only if the sample rate is different or the sample size is lower than the project’s.

- **Split Channels**
  If this is activated, stereo and multi-channel files will be split into a corresponding number of mono files – one for each channel – and these will be imported into the Pool.
  Note that if you use this option, the imported files will always be copied to the Project’s Audio folder, as described above.

- **Do not Ask again.**
  If this is ticked, you will always import files according to the settings you have made, without this dialog appearing. This can be reset in the Preferences–Audio Editing dialog.

You can always convert later should you so wish, by using the Convert Files (see page 441) or Conform Files (see page 442) options.
Importing audio CD tracks

You can import tracks (or sections of tracks) from an audio CD directly into the Pool by using the “Import Audio CD” function on the Pool menu. This opens a dialog in which you can specify which tracks should be grabbed from the CD, converted to audio files and added to the Pool.

For details about the Import Audio CD dialog, see page 777.

Exporting regions as audio files

If you have created regions within an audio clip (see page 379) these can be exported as separate audio files. To create a new audio file from a region, proceed as follows:

1. In the Pool, select the region you wish to export.
2. Pull down the Audio menu and select “Bounce Selection”. A browser dialog opens.
3. Select the folder in which you want the new file to be created. A new audio file is created in the specified folder. The file will have the name of the region and will automatically be added to the Pool.

• If you have two clips that refer to the same audio file (different “versions” of clips, e.g. created with the “Convert to Real Copy” function), you can use the Bounce Selection function to create a new, separate file for the copied clip. Select the clip and select Bounce Selection – you will be asked for a location and name for the new file.
Changing the Pool Record folder

The Pool Record folder is where all audio clips that you record in the project will end up in the Pool. The Pool Record folder is indicated by the text "Record" in the Status column, and by a red dot on the folder itself, as shown in the picture above. By default, this is the main Audio folder. You can, however, at any time create a new Audio subfolder and designate this as your Pool Record folder. Proceed as follows:

1. Select the Audio folder or any audio clip. You cannot designate the Video folder (or a subfolder in it) as the Pool Record folder.


3. Select the new folder.

4. Select “Set Pool Record Folder” on the Pool menu, or click in the new folders Status column. The new folder now becomes the Pool Record folder, and any audio recorded in the project will from this point on end up in this folder.
Organizing clips and folders

If you accumulate a large number of clips in the Pool, it may sometimes be difficult to quickly find specific items. In such cases, organizing clips in new subfolders with suitable names that reflect the content can be a solution. For example, you could put all sound effects in one folder, all lead vocals in another etc. Proceed as follows:

1. Select the type of folder, audio or video, in which you want to create a subfolder.
   You cannot put audio clips in a video folder and vice versa.

2. Select “Create Folder” on the Pool menu.
   A new empty subfolder named “New Folder” appears in the Pool.

3. Click on the name and type in a new appropriate name for the folder.

4. Select and drag the clips you wish to move to the new folder.

5. Repeat steps 1-4 as necessary.

Applying processing to clips in the Pool

You can apply audio processing to clips from within the Pool, just like you can to events in the Project window. Simply select the clip(s) and select a processing method from the Audio menu. To find out more about audio processing, see page 333.

Freeze Edits

If you have applied processing to a clip, either in the Project window or in the Pool, this is indicated by the red and grey waveform symbol in the Status column. This processing can always be undone using the Offline Process History (see page 355). You can also use the Freeze Edits function to create a new file with processing applied or replace the original with a processed version – see page 357.
Minimize File

This item on the Pool menu allows you to change the size of audio files according to the audio clips referenced in a project. The files produced using this option will only contain the audio file portions actually used in the project, which can significantly reduce the size of the project (given that large portions of the audio files are unused).

- This operation will permanently alter the selected audio files in the Pool (the process cannot be undone), so be careful with this command! If this is not what you want, you can use the “Save Project to New Folder” File menu item instead. This function also has the option of minimizing files, but copies all files into a new folder, leaving the original project untouched. See page 764.

It is useful for archiving purposes. If you have completed a project and wish to minimize the project size as much as possible, use this function.

Proceed as follows:

1. Select the file(s) you wish to minimize in the Pool.

2. Select “Minimize File” from the Pool menu.
   An alert appears informing you that the entire Edit History will be cleared. You will at this point have the option of cancelling or continuing the operation.

3. After the operation is finished, another alert asks you to save the project, to update the new file references.
   Do so.

   The audio file(s) in the Pool Record folder will now be cropped so that only the audio actually used in the project remains in the corresponding audio file.
Prepare Archive

This Pool menu command should be used when you want to archive a project. It checks that every clip referenced in the project is located in the same folder. To be more precise, it does the following:

• Any files that are located outside the current project folder will be copied to it.
  Please note that audio files that reside within the project folder will not be copied to the audio folder. You will therefore have to copy them there manually before backing up the audio folder or save them separately during backup, see below.

• If any processing has been applied, you will be asked whether you want to Freeze Edits.
  If you do this, you don't have to archive the Edit folder. Everything belonging to the project will be contained in the project file and the Audio folder.

• Once you have performed a Prepare Archive, you can copy the project file, the Audio folder and any other audio material you saved in the project folder to backup disks, etc.
  It is not necessary to archive the Images folder, since these can be recreated by Cubase SX/SL. You may also find a file with the extension ".csh" in the project folder. This contains image information for edited clips and other data that can be recreated, and can safely be deleted.

Video clips are always referenced, and are not stored in the project folder.

Importing and exporting Pool files (Cubase SX only)

You can export a Pool as a separate file (file extension ".npl"), by using the Export Pool command on the Pool menu. If you import a Pool file with the Import Pool command, the file references in it are "added" to the current Pool.

• The audio and video files themselves are not saved in the Pool file, only a reference to them.
  For there to be any point in importing a Pool file, you need access to all reference files (which preferably should have the same file paths as when the Pool was saved).

• You can also save and open libraries – stand-alone Pool files that are not associated with a project (Cubase SX only).
  See page 765.
Convert Files

Selecting Convert Files on the Pool menu opens the Convert Options dialog which operates on selected files. Use the pop-up menus to specify which audio file attributes you want to keep and which you want to convert. The options are:

- **Sample Rate**
  Keep as is, or convert to a sample rate between 8.000 and 96.000 kHz.

- **Sample Width**
  Keep the sample width (resolution) as is, or convert to 16 bit, 24 bit or 32 Bit float.

- **Channels**
  Keep as is, or convert the file to Mono or Stereo Interleaved.

- **File Format**
  Keep as is, or convert to Wave, AIFF, Wave 64 or Broadcast Wave format.

**Options**

When you convert a file, you can use the Options pop-up to set one of the following options regarding what to do with the new file:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>New Files</td>
<td>Creates a copy of the file in the audio folder and converts this new file according to the chosen attributes. The new file is added to the Pool, but all clip references will still point to the original, unconverted file.</td>
</tr>
<tr>
<td>Replace Files</td>
<td>Converts the original file without changing clip references. The references are however saved with the next save action.</td>
</tr>
<tr>
<td>New + Replace in Pool</td>
<td>Creates a new copy with the chosen attributes, replaces the original file with the new one in the Pool and redirects the current clip references from the original file to the new file. This is the option to select if you want your audio clips to refer to the converted file, but still want to keep the original file on disk (e.g. if the file is used in other projects).</td>
</tr>
</tbody>
</table>
Conform Files

By using this Pool menu command, you will change all selected files that have different file attributes than what is specified for the project, to conform to this standard. Proceed as follows:

1. Select all clips in the Pool.

2. Select “Conform Files” on the Pool menu.
   A dialog opens allowing you to choose between keeping or replacing the original unconverted files in the Pool. The following applies:
   • Clip/event references in the pool are always redirected to the conformed files.
   • If any 'keep' option is selected, original files remain in the Project’s Audio folder and new files are created.
   • If you select the “Replace” option, files in the Pool and in the Project’s Audio folder are replaced.

Extract Audio from Video

This Pool menu item allows you to extract the audio from a video file on disk and automatically generate a new audio clip that will appear in the Pool Record folder. The resulting clip will have the following properties:

• It will get the same file format and sample rate/width as is used in the current project.

• It will get the same name as the video file.

• This function is not available for mpeg video files.
Options and Settings

Customizing the view

- You can specify which of the columns should be shown or hidden by selecting the View pop-up on the toolbar and ticking items on or off.

- You can rearrange the order of the columns by clicking on a column heading and dragging the column to the left or to the right. The mouse pointer changes to a hand when you place it on the column heading.

- The width of a column can also be adjusted by placing the pointer between two column headers and dragging left or right. The pointer changes to a divider when you place it between two column headers.
20

MIDI devices and patches
About program change and bank select

To instruct a MIDI instrument to select a certain patch (sound), you send a MIDI Program Change message to the instrument. Program Change messages can be recorded or entered in a MIDI part like other events, but you can also enter a value in the Program (prg) field in the Inspector for a MIDI track (see page 460). This way, you can quickly set each MIDI track to play a different sound.

With Program Change messages, you are able to select between 128 different patches in your MIDI device. However, many MIDI instruments contain a larger number of patch locations. To make these available from within Cubase SX/SL, you need to use Bank Select messages, a system in which the programs in a MIDI instrument are divided into banks, each bank containing 128 programs. If your instruments support MIDI Bank Select, you can use the Bank (bnk) field in the Inspector to select a bank, and then the Program field to select a program in this bank.

Unfortunately, different instrument manufacturers use different schemes for how Bank Select messages should be constructed, which can lead to some confusion and make it hard to select the correct sound. Also, selecting patches by numbers this way seems unnecessarily cumbersome, when most instruments use names for their patches nowadays.

To help with this, Cubase SX/SL features the MIDI Device Manager. This allows you to specify which MIDI instruments you have connected, by selecting from a vast list of existing devices or by specifying the details yourself. Once you have specified which MIDI devices you’re using, you can select to which particular device each MIDI track should be routed. It is then possible to select patches by name in the track list or Inspector.
Opening the MIDI Device Manager

Select MIDI Device Manager from the Devices menu to bring up the following window:

This is the list of MIDI devices you have connected. The first time you open the MIDI Device Manager, this list will be empty.

These buttons let you manage the list of installed devices.

Here you specify to which MIDI output the selected device is connected.

This pop-up menu lets you edit the selected device (provided that "Enable Edit" is ticked).

Here, the patch structure is shown for the device selected above.

This area shows exactly which MIDI messages should be sent out to select the patch highlighted in the list to the left.

When you open the MIDI Device Manager for the first time, it will be empty (because you haven’t installed any devices yet). On the following pages we describe how to add a pre-configured MIDI device to the list, how to edit the settings and how to define a device from scratch (only necessary if a MIDI device isn’t included among the pre-configured devices).
Installing a MIDI Device

In this case “install” means “add to the Installed Devices” list, i.e. specify that a certain device is part of your MIDI system. Proceed as follows:

1. Click the Install Device button.
   A dialog appears listing all pre-configured MIDI devices. For now we assume that your MIDI device is included in this list.

2. Locate and select the device in the list and click OK.
   - If your MIDI device isn’t included in the list but is compatible with the GM (General MIDI) or XG standards, you can select the generic GM or XG Device options at the top of the list.
     When you select any of these options, a name dialog will appear. Enter a name for the instrument and click OK.
     Now the device appears in the Installed Devices list to the left.

3. Make sure that the new device is selected in the list and pull down the Output pop-up menu.

4. Select the MIDI output that is connected to the device.
   When the device is selected in the Installed Devices list, the Patch Banks list below shows the patch structure of the device. This could simply be a list of patches, but it’s usually one or several layers of banks or groups containing the patches (much like a folder structure on a hard disk for example).

   ![Patch Banks Diagram]

   - You can rename a device in the Installed Devices list by double clicking and typing — this is useful if you have several devices of the same model, and want to separate them by name instead of by number.

   - To remove a device from the Installed Devices list, select it and click Remove Device.
About Patch Banks

Depending on the selected device, you may find that the Patch Banks list is divided in two or more main banks. Typically, these are called Patches, Performances, Drums etc. The reason for having several patch banks is that different “types” of patches are handled differently in the instruments. For example, while “patches” typically are “regular” programs that you play one at the time, “performances” may be combinations of patches, which could e.g. be split across the keyboard, layered or used for multitimbral playback.

For devices with several banks, you will find an additional button to the right, labeled Bank Assignment. Clicking this opens a dialog in which you can specify for each MIDI channel which bank it should use.

The selection here will affect which bank is displayed when you select programs by name for the device in the track list or Inspector (see below). For example, many instruments use MIDI channel 10 as an exclusive drum channel, in which case you would want to select the "Drums" (or "Rhythm Set", "Percussion", etc.) bank for channel 10 in this list. This would then let you select between different drum kits in the track list or Inspector.
Selecting a patch for an installed device

If you return to the Project window at this point, you will find that the installed device has been added to the MIDI Output menus (in the track list and the Inspector). Now you can select patches by name, in the following way:

1. Pull down the Output menu (in the track list or Inspector) for a track that you want to play the installed device, and select the device. This directs the track to the MIDI output specified for the device in the MIDI Device Manager. The bank and program fields in the track list and Inspector are replaced by a single “prg” field.

2. Click the “prg” field to display a pop-up menu, hierarchically listing all the patches in the device. The list is similar to the one displayed in the MIDI Device Manager. You can scroll the list up and down (if required), click the plus/minus signs to show or hide subgroups, etc.

3. Click a patch in the list to select it. This sends the appropriate MIDI message to the device. You can also scroll the program selection up or down, as with any value.
Renaming patches in a device

The pre-configured devices list is based on the factory-preset patches, i.e. the patches included in the device when you first bought it. If you have replaced some of the factory presets with your own patches, you need to modify the device so that the patch name list matches the actual device:

1. In the MIDI Device Manager, select the device in the Installed Devices list.
2. Activate the Enable Edit checkbox. When this is turned off (default) you cannot edit the pre-configured devices.
3. Use the Patch Banks display to locate and select the patch you want to rename. In many instruments, the user-editable patches are located in a separate group or bank.
4. Click on the selected patch in the Patch Banks list to edit its name.
5. Type in the new name and click OK.
6. Rename the desired patches in this way, and finish by deactivating Enable Edit again (to avoid modifying the device by accident).

• It’s fully possible to make more radical changes to the patch structure in a device as well (adding or deleting patches, groups or banks). For example, this would be useful if you expanded your MIDI device by adding extra storage media such as RAM cards, etc. The available editing functions are described below.
Defining a new device

If your MIDI device is not included in the list of pre-configured devices (and not a “plain” GM or XG device), you need to define it manually to make it possible to select patches by name:

1. In the MIDI Device Manager, click the Install Device button. The Add MIDI Device dialog appears.

2. Select “Define New...” and click OK. A name dialog appears.

3. Enter the name of the device and click OK. The device appears in the Installed Devices list.

4. Select the device in the list. As you can see, it currently contains only an Empty Bank item.

5. Make sure the Enable Edit checkbox is activated. Now you can use the functions on the Commands pop-up menu to the left to organize the patch structure of the new device.

A patch structure is made out of the following components:

- Banks are the main categories of sounds – typically patches, performances and drums, as described above.
- Each bank can contain any number of groups, represented by folders in the list.
- The individual patches, performances or drum kits are represented by presets in the list.

The Commands pop-up menu contains the following items:

Create Bank

Creates a new bank at the highest hierarchical level of the Patch Banks list. You can rename this by clicking on it and typing a new name.

New Folder

Creates a new subfolder in the selected bank or folder. This could correspond to a group of patches in the MIDI device, or just be a way for you to categorize sounds, etc. When you select this item, a name dialog will appear, allowing you to name the folder. You can also rename the folder afterwards by clicking it and typing in the list.
**New Preset**

This adds a new preset in the selected bank or folder.

You can rename the preset by clicking it and typing a new name. When the preset is selected, its corresponding MIDI events (Program Change, Bank Select, etc.) are shown in the event display to the right. The default setting for a new preset is Program Change 0 – to change this, use the following procedures:

- For details on which MIDI events are used for selecting patches in the MIDI device, consult its documentation.
- To change which Program Change value should be sent out to select the patch, adjust the number in the Value column for the Program Change event.
- To add another MIDI event (e.g. Bank Select) click immediately below the last event in the list and select a new event from the pop-up menu that appears. After adding a new event, you need to set its value in the Value column, as with Program Change.
- To replace an event, click on it and select another event from the pop-up menu. For example, a MIDI device may require that a Bank Select message is sent first, followed by a Program Change message, in which case you would need to replace the default Program Change message with a Bank Select message and add a new Program Change after that.
- To remove an event, select it and press [Delete] or [Backspace].
- Different devices use different schemes for Bank Select. When you insert a Bank Select event, you should check the device’s documentation to find whether to choose “CC: BankSelect MSB”, “Bank Select 14 Bit”, “Bank Select 14 Bit MSB-LSB Swapped” or possibly some other option.
Add Multiple Presets

This opens a dialog, allowing you to set up a range of presets to be added in the selected bank or folder.

Proceed as follows:

1. Add the event types required for selecting a patch in the MIDI device. This is done just as when editing the settings for a single event: clicking in the event display brings up a pop-up menu from which you can select an event type.

2. Use the Range column to set up either a fixed value or a range of values for each event type in the list. This requires some explanation:
   - If you specify a single value in the Range column (e.g. 3, 15 or 127), all added presets will have an event of this type set to the same value.
   - If you instead specify a value range (a start value and an end value, separated by a dash, e.g. 0-63), the first added preset will have an event set to the start value, the next value will be incrementally raised by one and so on, up to and including the end value.

- The number of added presets depends on the Range setting.

This example will generate eight presets, each with a Bank Select event set to 2, but with different Program Change events (ranging from 0 to 7).
3. Specify a Default Name below the event display.
   The added events will get this name, followed by a number. You can rename presets manually in the Patch Banks list later.

4. Click OK.
   A number of new presets are now added in the selected bank or folder, according to your settings.

Other editing functions

- You can move presets between banks and folders by dragging them in the Patch Banks list.
- You can remove a bank, folder or preset by selecting it in the Patch Banks list and pressing [Backspace].
- If you specify more than one bank, a Bank Assignment button will appear to the right above the event display. Use this to assign banks to the different MIDI channels (see page 449).
Exporting and importing device setups

Clicking the Export Setup button allows you to export your complete MIDI device setup as a separate file. The file can then be imported using the Import Setup button. This is useful if you move your instruments to another studio, install the program on a new computer, etc.

- **When you import a stored setup with the Import Setup function, a dialog will appear, listing all devices included in the stored setup.**
  Select the device(s) you wish to import and click OK.

- **Importing will not overwrite any currently installed devices.**
  If the current list contains a device with the same name as a device to be imported, a number will be added to the name of the imported device.
MIDI realtime parameters and effects
**Introduction**

For each MIDI track, you can set up a number of track parameters and MIDI effects. These affect how the MIDI data is played back, “transforming” MIDI events in real time before they are sent to the MIDI outputs.

On the following pages, the available parameters and effects are described. Keep in mind:

- The actual MIDI events will not be affected – the changes happen “on the fly”.
- Since the track parameter settings don’t actually change the MIDI data on the track, they will not be reflected in the MIDI editors. To convert the settings to “real” MIDI events, you need to use the Merge MIDI in Loop function (see page 500).
The Inspector – General handling

The track parameters and effects are set up in the Inspector (although some settings are available in the mixer as well, see page 199). Here’s a brief rundown on how to handle the Inspector:

• To show or hide the Inspector, click the Inspector icon on the Project window’s toolbar.

• The Inspector for a MIDI track is divided into seven sections. You can fold or unfold the sections individually by clicking the tabs in their upper right corners. Clicking the tab for a hidden section brings it to view and hides the other sections. [Ctrl]/[Command]-clicking the tab allows you to hide or show a section without affecting other sections. Finally, [Alt]/[Option]-clicking a tab shows or hides all sections in the Inspector.

• Folding a section does not affect the functionality but merely hides the section from view.

In other words, your settings will still be active even if you fold the Inspector settings.
Basic track settings

The topmost Inspector section contains the basic settings for the selected MIDI track. These are settings that either affect the basic functionality for the track (mute, solo, enable record, etc.) or send out additional MIDI data to the connected devices (program change, volume, etc.). The section contains all settings in the Track list (see page 87), with a few additional parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Track name field</td>
<td>Click to rename the track.</td>
</tr>
<tr>
<td>Mute/Solo buttons</td>
<td>Mutes or solos the MIDI track.</td>
</tr>
<tr>
<td>Read/Write buttons</td>
<td>Used for automating the track settings – see page 296.</td>
</tr>
<tr>
<td>Input transformer button</td>
<td>Opens the Input Transformer dialog, allowing you to transform incoming MIDI events in real time. See page 631.</td>
</tr>
<tr>
<td>Record enable button</td>
<td>Activate this to make the track ready for recording.</td>
</tr>
<tr>
<td>Monitor button</td>
<td>When this is activated (and MIDI Thru Active is on in the Preferences–MIDI dialog), incoming MIDI will be routed to the selected MIDI output.</td>
</tr>
<tr>
<td>Toggle Timebase button</td>
<td>Switches between musical (tempo related) and linear (time related) time base for the track. See page 113.</td>
</tr>
<tr>
<td>Lock button</td>
<td>Activating this disables all editing of all events on the track.</td>
</tr>
<tr>
<td>Edit button</td>
<td>This opens the channel settings window for the track (a window showing a channel strip with volume fader and other controls, along with effect settings – see page 225).</td>
</tr>
</tbody>
</table>
• Note that the functionality of the “Programs” settings (used for selecting sounds in the connected MIDI instrument) depends on to which instrument the MIDI output is routed, and how you have set up this in the MIDI Device Manager.

As described on page 446, the MIDI Device Manager allows you to specify which MIDI instruments and other devices are connected to the various MIDI outputs, thus making it possible to select patches by name.

• Many of the basic track settings are duplicated in “mixer channel strip form”, in the Channel section at the bottom of the Inspector. See page 462.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Volume</td>
<td>Use this to adjust the level for the track. Changing this setting will move the track’s fader in the Mixer window, and vice versa. See page 202 for more about setting levels.</td>
</tr>
<tr>
<td>Pan</td>
<td>Use this to adjust the panning of the track.</td>
</tr>
<tr>
<td>Delay</td>
<td>This adjusts the playback timing of the MIDI track. Positive values delay the playback while negative values cause the track to play earlier. The values are set in milliseconds.</td>
</tr>
<tr>
<td>In/Out/Chn pop-ups</td>
<td>This is where you select MIDI input, MIDI output and MIDI channel for the track.</td>
</tr>
<tr>
<td>Edit VST Instrument button</td>
<td>If the MIDI track is routed to a VST instrument, clicking this button opens the control panel for the VST instrument.</td>
</tr>
<tr>
<td>Bnk/Prg/Programs</td>
<td>Allows you to select sounds by sending MIDI Bank Select and Program Change messages (see below)</td>
</tr>
<tr>
<td>Map pop-up</td>
<td>Allows you to select a drum map for the track – see page 573.</td>
</tr>
</tbody>
</table>
**Other Inspector sections**

Apart from the basic track settings (above), the Track Parameters and the effect sections (both described on the following pages), the Inspector for a MIDI track also contains the following:

**The Channel section**

This contains a single channel strip, allowing you to set volume, pan, mute/solo and other parameters for the track.

- This is a "mirror" of the track's channel strip in the Cubase SX/SL mixer – for details see page 199.

**The Notepad section**

This is a standard notepad, allowing you to enter notes and comments about the track. Each track has its own notepad in the Inspector.
Track parameters

The following settings will affect the MIDI events on the track in real time during playback. They will also be in effect if you play “live” with the track selected and record enabled (provided that “MIDI Thru Active” is activated on the Preferences–MIDI page). This makes it possible to e.g. transpose or adjust the velocity of your live playing.

- If you want to compare the result of your track parameters with the “unprocessed” MIDI, you can use the Bypass button in the Track Parameters section.

When this is activated, the Track Parameter settings will be temporarily disabled. A bypassed section is indicated by its Inspector tab turning yellow.
Transpose

This allows you to transpose all notes on the track in semitones. The available range is -127 to +127 semitones, but remember that the total range of MIDI note numbers is 0 to 127. Furthermore, not all instruments can play back notes over the whole range. Therefore, extreme transpositions can give rather strange and unwanted results.

- You can also transpose individual MIDI parts using the Transpose field in the info line.
  The transposition in the info line (for the individual part) is added to the transpose value you have set up for the whole track in the Inspector.

Velocity Shift

This setting lets you change the dynamics of all notes on the track. The value in this field is added to the velocity of each note message that is sent out (use negative values to lower the velocities). The range is -127 to +127 with 0 representing no change in velocity.

Note that the effects of changing the velocity depends on the sound and instrument.

- You can also adjust the velocity of events in individual MIDI parts using the Velocity field in the info line.
  The velocity shift in the info line (for the individual part) is added to the velocity shift you have set up for the whole track in the Inspector.
**Velocity Compression**

This function multiplies the velocity values with the factor you specify. This factor is set using a numerator (left value) and a denominator (right value), resulting in a fractional number (1/2, 3/4, 3/2 etc.). For example, if you set the factor to 3/4, the velocities will be three quarters of their original values. The point is, that this will also affect the difference in velocity between the notes, thereby compressing or expanding the velocity scale. Typically, you would combine this setting with the Velocity Shift parameter. An example:

Let’s say you have three notes with the velocity values 60, 90 and 120, and wish to “even out” the velocity differences somewhat. If you set the Velocity Compression value to 1/2, the notes will play back with the velocities 30, 45 and 60. By adding 60 in the Velocity Shift field, you will have the notes playing back with the velocities 90, 105 and 120, meaning you have in effect compressed the velocity range.

In a similar way, you can use Velocity Compression values greater than 1/1 together with negative values in the Velocity Shift field, to expand the velocity range.

- **Remember that the maximum velocity is always 127 no matter how much you try to expand.**

**Length Compression**

This value adjusts the lengths of all notes on the track. As with Velocity Compression, the value is set with a numerator and denominator. For example, the value 2/1 means that all note lengths will be doubled, while 1/4 means all note lengths will be quarter of the actual lengths.
Random

The Random settings let you introduce random variations to various properties of MIDI notes. Anything from very subtle variations to dramatic changes can be applied. There are two separate “Random generators”, each of which are set up in the following way:

1. Pull down the Random pop-up menu and select which note property should be randomized.
   The options are position, pitch, velocity and length.
   • Keep in mind that depending on the content of the track, certain parameter changes might not be immediately noticeable, or have any effect at all (as would be the case if applying random length to a percussion track playing “one-shot” samples for example).
   To best audition the random changes choose a track with clearly defined rhythm and note content, if possible (as opposed to a string pad).

2. Set the desired range of random deviation by entering values in the two number fields.
   The two values govern the limits of the randomization, so that the values will vary between the left value and the right value (you cannot set the left value higher than the right value). The maximum random range for each property is listed in the table below:

<table>
<thead>
<tr>
<th>Property</th>
<th>Range</th>
</tr>
</thead>
<tbody>
<tr>
<td>Position</td>
<td>-500 to +500 ticks</td>
</tr>
<tr>
<td>Pitch</td>
<td>-120 to +120 semitones</td>
</tr>
<tr>
<td>Velocity</td>
<td>-120 to +120</td>
</tr>
<tr>
<td>Length</td>
<td>-500 to +500 ticks</td>
</tr>
</tbody>
</table>

   • Note again that you can make independent settings for the two random generators.
   • To deactivate the Random function, pull down the Random pop-up menu(s) and select “OFF”.

CUBASE SX/SL
21 – 466 MIDI realtime parameters and effects
Range

The Range function lets you specify a note (pitch) or velocity range and either force all notes to fit within this range, or exclude all notes outside this range from playback. As with the Random function, there are two separate Range settings. Set them up as follows:

1. Pull down the Range pop-up menu and select one of the following four modes:

<table>
<thead>
<tr>
<th>Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vel. Limit</td>
<td>This function affects all velocity values outside the specified range. Velocity values below the Min setting (the lower limit of the range) are set to the Min value, and velocity values above the Max setting are set to the Max value. Notes with velocity values within the set range are not affected. Use this if you want to force all velocity values to fit within a certain range.</td>
</tr>
<tr>
<td>Vel. Filter</td>
<td>Velocity Filter works by excluding all notes with velocity values outside the specified range. Notes with velocity values below the Min setting or above the Max setting will not be played back. Use this to &quot;isolate&quot; notes with certain velocity values.</td>
</tr>
<tr>
<td>Note Limit</td>
<td>This function allows you to specify a pitch range, and forces all notes to fit within this range. Notes outside the specified range are transposed up or down in octave steps until they fit within the range. Note: If the range is too &quot;narrow&quot;, so that some notes cannot be fit within the range by octave-transposing, these notes will get a pitch in the middle of the range. For example, if you have a note with a pitch of F3, and the range is C4-E4, that note will be transposed to D4.</td>
</tr>
<tr>
<td>Note Filter</td>
<td>Note Filter works by excluding all notes with pitches outside the specified range. Notes lower than the Min setting or higher than the Max setting will not be played back. Use this to &quot;isolate&quot; notes with certain pitches.</td>
</tr>
</tbody>
</table>

2. Use the two fields to the right to set the min and max values. These values will be shown as numbers (0-127) for the velocity modes and as note numbers (C-2 to G8) for the pitch modes.

Note again that you can make independent settings for the two Range functions.

• To deactivate the Range function, pull down the Range pop-up menu(s) and select "OFF".
MIDI effects

Cubase SX/SL comes with a number of MIDI effect plug-ins, capable of transforming the MIDI output from a track in various ways.

Just like the MIDI track parameters, MIDI effects are applied in real time to the MIDI data played back from the track (or to MIDI you play live “thru” the track).

What are MIDI effects?

Although a MIDI effect can be similar to an audio effect, it’s important to remember that you’re not processing the sound resulting from MIDI playback, but the MIDI data (the “instructions” for how the music should be played back).

A MIDI effect will change properties of the MIDI events (e.g. change the pitch of notes) and/or generate new MIDI events (for example, a MIDI delay may add new MIDI notes, “echoing” the original notes).

- The included MIDI effect plug-ins are described in the separate “MIDI devices and features” document.

Insert and send effects

As with audio effects, there are two ways to route the MIDI events on a track to an effect:

- If you add an insert effect, the MIDI events will be sent to the effect, which will process the data and pass it on to the track’s MIDI output (or to another insert effect).
  In other words, the MIDI events will be routed “through” the insert effect.

- If you use a send effect, the MIDI events will be sent both to the track’s MIDI output and to the effect.
  That is, you will get both the unprocessed MIDI events and the output of the MIDI effect. Note that the effect can send its processed MIDI data to any MIDI output – not necessarily to the one used by the track.

There are separate sections in the Inspector for Inserts and Sends:
Inserts section

This allows you to add up to four MIDI insert effects. The section contains the following items:

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Edit button</td>
<td>Opens the Channel Settings window for the MIDI track.</td>
</tr>
<tr>
<td>Bypass button</td>
<td>Click this to temporarily disable all insert effects for the track (useful for comparing with the unprocessed MIDI, etc.).</td>
</tr>
<tr>
<td>Inserts section tab</td>
<td>This lights blue if any insert effect is activated.</td>
</tr>
<tr>
<td>Effect selection pop-up menu (x 4)</td>
<td>Selecting an effect from this pop-up menu automatically activates it and brings up its control panel (which can be a separate window or a number of settings below the insert slot in the Inspector). To remove an insert effect completely, select &quot;No Effect&quot;.</td>
</tr>
<tr>
<td>On button (x 4)</td>
<td>Allows you to turn the selected effect on or off.</td>
</tr>
<tr>
<td>Edit button (x4)</td>
<td>Click this to bring up the control panel for the selected effect. Depending on the effect, this may appear in a separate window or below the insert slot in the Inspector. Clicking the button again hides the control panel.</td>
</tr>
</tbody>
</table>

- Effects that display their controls in the Inspector can be forced to appear in a separate control panel window by pressing [Alt]/[Option] and clicking the Edit button.
Sends section

This allows you to add up to four MIDI send effects. Unlike audio send effects, you can select and activate send effects individually for each track. The section contains the following items:

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Edit button</td>
<td>Opens the Channel Settings window for the MIDI track.</td>
</tr>
<tr>
<td>Bypass button</td>
<td>Click this to temporarily disable all send effects for the track (useful for comparing with the unprocessed MIDI, etc.).</td>
</tr>
<tr>
<td>Sends section tab</td>
<td>This lights blue if any send effect is activated.</td>
</tr>
<tr>
<td>Effect selection pop-up menu (x 4)</td>
<td>Selecting an effect from this pop-up menu automatically activates it and brings up its control panel (which can be a separate window or a number of settings below the send slot in the Inspector). To remove a send effect completely, select “No Effect”.</td>
</tr>
<tr>
<td>On button (x 4)</td>
<td>Allows you to turn the selected effect on or off.</td>
</tr>
<tr>
<td>Edit button (x4)</td>
<td>Click this to bring up the control panel for the selected effect. Depending on the effect, this may appear in a separate window or below the sends slot in the Inspector. Clicking the button again hides the control panel.</td>
</tr>
<tr>
<td>Output pop-up menu (x4)</td>
<td>This determines to which MIDI output the effect should send the processed MIDI events.</td>
</tr>
</tbody>
</table>
Effects that display their controls in the Inspector can be forced to appear in a separate control panel window by pressing [Alt]/[Option] and clicking the Edit button.

About presets

Several of the MIDI plug-ins come with a number of presets for instant use. The controls for handling presets consist of a Presets pop-up menu along with Store (+) and Remove (-) buttons.

- To load a preset, select it from the Presets pop-up menu.
- To store your current settings as a preset, click the (+) button to the right.
A dialog appears, asking you to specify a name for the preset. The stored preset will then be available for selection from the pop-up menu for all instances of that MIDI plug-in, in all projects.
- To remove a stored preset, select it and click the (-) button to the right.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Channel setting (x4)</td>
<td>This determines on which MIDI channel the effect should send the processed MIDI events.</td>
</tr>
<tr>
<td>Pre button (x4)</td>
<td>If this is activated, the MIDI signals will be sent to the send effects before the track parameters and insert effects.</td>
</tr>
</tbody>
</table>

Item Description

- Channel setting (x4): This determines on which MIDI channel the effect should send the processed MIDI events.
- Pre button (x4): If this is activated, the MIDI signals will be sent to the send effects before the track parameters and insert effects.

- To load a preset, select it from the Presets pop-up menu.
- To store your current settings as a preset, click the (+) button to the right.
A dialog appears, asking you to specify a name for the preset. The stored preset will then be available for selection from the pop-up menu for all instances of that MIDI plug-in, in all projects.
- To remove a stored preset, select it and click the (-) button to the right.
Applying a MIDI insert effect – an example

Here is a step-by-step example of how to add a MIDI insert effect to a MIDI track:

1. Select the MIDI track and open the Inspector.
2. Click the Inserts tab in the Inspector.
   • Alternatively you could use the mixer: bring up the extended mixer panel and select “Inserts” on the view options pop-up menu for the track’s channel strip.
3. Click in one of the insert slots to show the MIDI effect pop-up menu.
4. Select the desired MIDI effect from the pop-up menu.
   The effect is automatically activated (the power button for the insert slot lights up) and its control panel appears, either in a separate window or in the Inserts section below the slot (depending on the effect).
   Now all MIDI from the track will be routed through the effect.
5. Use the control panel to make settings for the effect.
   All included MIDI effects are described below.
   • You can bypass the insert effect by clicking its power button (above the insert slot).
   • To bypass all insert effects for the MIDI track, use the bypass button in the Inserts section in the Inspector, in the mixer channel strip or in the Track list.
   • To remove an insert effect, click in its slot and select “No Effect”.

All included MIDI effects are described below.
The included effects

Arpache 5

A typical arpeggiator accepts a chord (a group of MIDI notes) as input, and plays back each note in the chord separately, with the playback order and speed set by the user. The Arpache 5 arpeggiator does just that, and more. Before describing the parameters, let’s look at how to create a simple, typical arpeggio:

1. Select a MIDI track and activate monitoring (or record enable it) so that you can play “thru” the track.
   Check that the track is properly set up for playback to a suitable MIDI instrument.

2. Select and activate the arpeggiator.
   For now, use it as an insert effect for the selected track.

3. In the arpeggiator panel, use the Quantize setting to set the arpeggio speed.
   The speed is set as a note value, relative to the project tempo. For example, setting Quantize to “16” means the arpeggio will be a pattern of sixteenth notes.

4. Use the Length setting to set the length of the arpeggio notes.
   This allows you to create staccato arpeggios (Length smaller than the Quantize setting) or arpeggio notes that overlap each other (Length greater than Quantize).

5. Set the Semi-Range parameter to 12.
   This will make the notes arpeggiate within an octave.

6. Play a chord on your MIDI instrument.
   Now, instead of hearing the chord, you will hear the notes of the chord played one by one, in an arpeggio.

7. Try the different arpeggio modes by clicking the Playmode buttons.
   The symbols on the buttons indicate the playback order for the notes (up, down, up+down, etc.). The Play Order settings are described below.
Parameters

The Arpache 5 has the following settings:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Playmode buttons</td>
<td>Allows you to select the playback order for the arpeggiated notes. The options are down+up, up+down, up, down, random (&quot;?&quot; button) and &quot;Order off&quot;, in which case you can set the playback order manually with the Play Order fields below.</td>
</tr>
<tr>
<td>Quantize</td>
<td>Determines the speed of the arpeggio, as a note value related to the project tempo. The range is 32T (1/32 note triplets) to 1. (one and a half bar).</td>
</tr>
<tr>
<td>Length</td>
<td>Sets the length of the arpeggio notes, as a note value related to the project tempo. The range is the same as for the Quantize setting.</td>
</tr>
<tr>
<td>Semi-Range</td>
<td>Determines the arpeggiated note range, in semitones counted from the lowest key you play. This works as follows:</td>
</tr>
<tr>
<td></td>
<td>- Any notes you play that are outside this range will be transposed in octave steps to fit within the range.</td>
</tr>
<tr>
<td></td>
<td>- If the range is more than one octave, octave-transposed copies of the notes you play will be added to the arpeggio (as many octaves as fits within the range).</td>
</tr>
<tr>
<td>Thru</td>
<td>If this is activated, the notes sent to the arpeggiator (i.e. the chord you play) will be passed through the plug-in (sent out together with the arpeggiated notes).</td>
</tr>
<tr>
<td>Play Order</td>
<td>If the &quot;Order on&quot; playmode is selected, you can use these &quot;slots&quot; to specify a custom playback order for the arpeggio notes:</td>
</tr>
<tr>
<td></td>
<td>Each slot corresponds to a position in the arpeggio pattern. For each slot, you specify which note should be played on that position by selecting a number. The numbers correspond to the keys you play, counted from the lowest pressed key.</td>
</tr>
<tr>
<td></td>
<td>So, if you play the notes C9-E3-G3 (a C major chord), &quot;1&quot; would mean C3, &quot;2&quot; would mean E3, and &quot;3&quot; would mean G3. Note that you can use the same number in several slots, creating arpeggio patterns that are not possible using the standard play modes.</td>
</tr>
</tbody>
</table>
AutoPan

This plug-in works a bit like an LFO in a synthesizer, allowing you to send out continuously changing MIDI controller messages. One typical use for this is automatic MIDI panning (hence the name), but you can select any MIDI Continuous Controller event type. The AutoPanner has the following parameters:

**Waveform selectors**

These determine the shape of the controller curves sent out. The results of most of these waveforms are obvious from looking at the buttons, but a few of them require some extra explanations:

- This generates a “random” controller curve.

These generate curves with a “periodical envelope”. The amplitude will gradually increase or decrease over a time, set with the Period parameter (see below).

**Period**

This is where you set the speed of the Autopanner, or rather the length of a single controller curve cycle. The value can be set ticks (1/480ths of quarter notes), or as rhythmically exact note values (by clicking the arrow buttons next to the value). The lower the note value, the slower the speed. For example, if you set this to 240 (“8th”) the waveform will be repeated every eighth note.
Density

This determines the density of the controller curves sent out. The value can be set ticks (1/480ths of quarter notes), or as rhythmically exact note values (by clicking the arrow buttons next to the value). The higher the note value, the smoother the controller curve. For example, if you set this to 60 (shown as “32th”) a new controller event will be sent out every 60th tick (at every 1/32 note position).

You should probably avoid extremely low Density values, as these will generate a very large number of events (which may cause the MIDI instrument to “choke”, delaying notes etc.).

AmpMod

This is only used for the two waveforms with “periodical envelopes” (see above). The period value (set in beats) determines the length of the envelope. In the following figure, Period is set to 4th and the AmpMod is 4 beats. This results in a quarter note-based curve in which the top amplitude decreases gradually, repeated each bar:

Controller

Determines which Continuous Controller type is sent out. Typical choices would include pan, volume and brightness but your MIDI instrument may have controllers mapped to various settings, allowing you to modulate the synth parameter of your choice – check the MIDI implementation chart for your instrument for details!

Min and Max

These determine the minimum and maximum controller values sent out, i.e. the “bottom” and “top” of the controller curves.
Chorder

The Chorder is a MIDI chord processor, allowing you to assign complete chords to single keys in a multitude of variations. There are three main modes of operation: Normal, Octave and Global. You switch between these modes by clicking the respective button to the left below the keyboard.

Normal mode

In this mode, you can assign a different chord to each single key on the keyboard. Proceed as follows:

1. Select the key to which you want to assign a chord, by clicking in the lower "Trigger Note" keyboard display.

2. Set up the desired chord for that key by clicking in the upper "Chord Setup" keyboard display.
   Clicking a key adds it to the chord; clicking it again removes it.

3. Repeat the above with any other keys you wish to use.
   If you now play the keys you have set up, you will instead hear the assigned chords.
Octave mode

The Octave mode is similar to the Normal mode, but you can only set up one chord for each key in an octave (that is, twelve different chords). When you play a C note (regardless of whether it’s a C3, C4 or any other octave) you will hear the chord set up for the C key.

Global mode

In the Global mode, you only set up a single chord, using the Chord Setup keyboard display (the lower keyboard display is hidden). This chord is then played by all keys on the keyboard, but transposed according to the note you play.
Using switches

The Switch Setup section at the bottom of the panel allows you to set up variations to the defined chords. This works with all three modes and provides a total of eight variations for each assignable key (that is, a maximum of 8 different chords in Global mode, 12x8 chords in 1Oct mode and 128x8 chords in Normal mode).

The variations can be controlled by velocity or note range. Here’s how you set it up:

1. Select one of the two switch modes: velocity or note. How to use these is explained below.

![Velocity switch mode](image)

The velocity switch mode selected.

2. Specify how many variations you want to use with the Use value box.

3. Click the first Switch Select button and set up the chord(s) you want for the first variation.

4. Click the next Switch Select button and set up the chord(s) you want for that variation.

5. Repeat this for the number of variations you specified with the Use setting. Each Switch Select button corresponds to a variation.
6. Now you can play the keyboard and control the variations according to the selected switch modes. These work as follows:

<table>
<thead>
<tr>
<th>Switch mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Velocity</td>
<td>The full velocity range (1-127) is divided into “zones”, according to the number of variations you specified. For example, if you’re using two variations (Max is set to 2) there will be two velocity “zones”: 1-63 and 64-127. Playing a note with velocity at 64 or higher will trigger the second variation, while playing a softer note will trigger the first variation.</td>
</tr>
<tr>
<td>Note</td>
<td>In this mode, the chorder will play one chord at a time – you cannot play several different chords simultaneously. When the Note switch mode is selected, you play a key to determine the base note for the chord, then press a higher key to select a variation. The variation number will be the difference between the two keys. To select variation 1, press a key one semitone higher than the base note, for variation 2, press a key two semitones higher, and so on.</td>
</tr>
</tbody>
</table>

- To turn the variation switch feature off, select the “No Switch” mode.
This MIDI Compressor is used for evening out or expanding differences in velocity. Though the result is similar to what you get with the Velocity Compression track parameter, the Compress plug-in presents the controls in a manner more like regular audio compressors. The parameters are:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threshold</td>
<td>Only notes with velocities over this value will be affected by the compression/expansion.</td>
</tr>
<tr>
<td>Ratio</td>
<td>This determines the rate of compression applied to the velocity values above the threshold level. Ratios greater than 1:1 result in compression (i.e. less difference in velocity) while ratios lower than 1:1 result in expansion (i.e. greater difference in velocity). What actually happens is that the part of the velocity value that is above the threshold value is divided by the ratio value.</td>
</tr>
<tr>
<td>Gain</td>
<td>This adds or subtracts a fixed value from the velocities. Since the maximum range for velocity values is 0-127, you may need to use the Gain setting to compensate, keeping the resulting velocities within the range. Typically, you would use negative Gain settings when expanding and positive Gain settings when compressing.</td>
</tr>
</tbody>
</table>
Density

This generic control panel affects the "density" of the notes being played from (or thru) the track. When this is set to 100%, the notes are not affected. Lowering the Density setting below 100% will randomly filter out or "mute" notes. Raising the setting above 100% will instead randomly add new notes.

Micro Tuner

The Micro Tuner lets you set up a different microtuning scheme for the instrument, by detuning each key.

- Each Detune field corresponds to a key in an octave (as indicated by the keyboard display). Adjust a Detune field to raise or lower the tuning of that key, in cents (hundreds of a semitone).
- Set the Convert setting according to whether the track is routed to a VST instrument or a "real" standard MIDI instrument (capable of receiving microtuning information).

The Micro Tuner comes with a number of presets, including both classical microtuning scales and experimental ones.
MIDIControl

This generic control panel allows you to select up to eight different MIDI controller types, and use the value fields/sliders to set values for these. A typical use for this would be if you're using a MIDI instrument with parameters that can be controlled by MIDI controller data (e.g. filter cutoff, resonance, levels, etc.). By selecting the correct MIDI controller types, you can use the plug-in as a control panel for adjusting the sound of the instrument from within Cubase SX/SL, at any time.

- To select a controller type, use the pop-up menus to the right.
- To deactivate a controller slider, set it to "Off" (drag the slider all the way to the left).
**MIDI Echo**

This is an advanced MIDI Echo, which will generate additional echo-ing notes based on the MIDI notes it receives. It creates effects similar to a digital delay, but also features MIDI pitch shifting and much more. As always it is important to remember that the effect doesn’t “echo” the actual audio, but the MIDI notes which will eventually produce the sound in the synthesizer.

The following parameters are available:

**Quantize**

The echoed notes will be moved in position to a quantizing grid, as set up with this parameter. You can either use the slider or type to set the value in ticks (1/480 ticks of quarter notes) or click the arrow buttons to step between the “rhythmically exact” values (displayed as note values – see the table below). This makes it easy to find rhythmically relevant quantize values, but still allows experimental settings in between.

An example: setting this to “16th” will force all echo notes to be played on exact 16th note positions, regardless of the timing of the original notes and the Echo-Quant. setting.

- To disable quantizing, set this parameter to its lowest value (1).

**Length**

This sets the length of the echoed notes. This can either be the same as their original notes (parameter set to its lowest value, “Source”) or the length you specify manually. You can either set the length in ticks or click the arrow buttons to step between the “rhythmically exact” lengths (displayed as note values – see the table below).

- The length can also be affected by the Length Decay parameter.
Repeat

This is the number of echoes (1 to 12) you get from each incoming note.

Echo-Quant.

The Echo-Quant. parameter sets the delay time, i.e. the time between a played note and its first echo note. You can either use the slider or type to set the value in ticks (1/480 ticks of quarter notes) or click the arrow buttons to step between the “rhythmically exact” delay times (displayed as note values – see the table below).

For example, setting this to “8th” will cause the echo notes to sound an eighth note after their original notes.

- The echo time can also be affected by the Echo Decay parameter.

Velocity Decay

This parameter allows you to add or subtract to the velocity values for each repeat so that the echo fades away or increases in volume (provided that the sound you use is velocity sensitive). For no change of velocity, set this to 0 (middle position).

Echo Decay

This parameter lets you adjust how the echo time should be changed with each successive repeat. The value is set as a percentage.

- When set to 100% (middle position) the echo time will be the same for all repeats (as set with the Echo-Quant. parameter).
- If you raise the value above 100, the echoing notes will play with gradually longer intervals (i.e. the echo will become slower).
- If you lower the value below 100, the echoing notes will come gradually faster, like the sound of a bouncing ball.
Pitch Decay

If you set this to a value other than 0, the repeating (echoing) notes will be raised or lowered in pitch, so that each successive note has a higher or lower pitch than the previous. The value is set in semitones.

For example, setting this to -2 will cause the first echo note to have a pitch two semitones lower than the original note, the second echo note two semitones lower than the first echo note, and so on.

Length Decay

This parameter lets you adjust how the length of the echoed notes should change with each successive repeat. The higher the setting (25 – 100), the longer the echoed notes will be compared to their original notes.

About ticks and note values

The timing- and position-related parameters (Echo-Quant., Length and Quantize) can all be set in ticks. There are 480 ticks to each quarter note. While the parameters allow you to step between the rhythmically relevant values (displayed as note values), the following table can also be of help, showing you the most common note values and their corresponding number of ticks:

<table>
<thead>
<tr>
<th>Note Value</th>
<th>Ticks</th>
</tr>
</thead>
<tbody>
<tr>
<td>1/32 note</td>
<td>60</td>
</tr>
<tr>
<td>1/16 note triplet</td>
<td>90</td>
</tr>
<tr>
<td>1/16 note</td>
<td>120</td>
</tr>
<tr>
<td>1/8 note triplet</td>
<td>160</td>
</tr>
<tr>
<td>1/8 note</td>
<td>240</td>
</tr>
<tr>
<td>Quarter note triplet</td>
<td>320</td>
</tr>
<tr>
<td>Quarter note</td>
<td>480</td>
</tr>
<tr>
<td>Half note</td>
<td>960</td>
</tr>
</tbody>
</table>
Note to CC

This effect will generate a MIDI continuous controller event for each incoming MIDI note. The value of the controller event corresponds to the note number (pitch) and the single parameter allows you to select which MIDI controller should be sent out (by default controller 7, MIDI volume). The incoming MIDI notes pass through the effect unaffected.

For example, if MIDI volume (controller 7) is selected, notes with low note numbers (pitches) will lower the volume in the MIDI instrument, while higher note numbers will raise the volume. This way you can create “keyboard tracking” of volume or other parameters.

Note that a controller event is sent out each time a new note is played. If high and low notes are played simultaneously, this could lead to somewhat confusing results. Therefore, the Note to CC effect is probably best applied to monophonic tracks (playing one note at the time).
Quantizer

Quantizing is a function that changes the timing of notes by moving them towards a “quantize grid”. This grid may consist of e.g. straight sixteenth notes (in which case the notes would all get perfect sixteenth note timing), but could also be more loosely related to straight note value positions (applying a “swing feel” to the timing, etc.).

- **The main Quantize function in Cubase SX/SL is described on page 505.**

While the Quantize function on the MIDI menu applies the timing change to the actual notes on a track, the Quantizer effect allows you to apply quantizing “on the fly”, changing the timing of the notes in real time. This makes it easier to try out different settings when creating grooves and rhythms. Note however, that the main Quantize function contains settings and features that are not available in the Quantizer.

The Quantizer has the following parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Quantize Note</td>
<td>This sets the note value on which the quantize grid is based. Straight notes, triplets and dotted notes are available. For example, “16” means straight sixteenth notes and “8T” means eighth note triplets.</td>
</tr>
<tr>
<td>Swing</td>
<td>The Swing parameter allows you to offset every second position in the grid, creating a swing or shuffle feel. The value is a percentage – the higher you set this, the farther to the right every even grid position is moved.</td>
</tr>
<tr>
<td>Strength</td>
<td>This determines how close the notes should be moved to the quantize grid. When set to 100%, all notes will be forced to the closest grid position; lowering the setting will gradually loosen the timing.</td>
</tr>
<tr>
<td>Delay</td>
<td>This delays (positive values) or advances (negative values) the notes in milliseconds. Unlike the Delay setting in the Track Parameters, this delay can be automated.</td>
</tr>
</tbody>
</table>
Step Designer

The Step Designer is a MIDI pattern sequencer, that sends out MIDI notes and additional controller data according to the pattern you set up. It does not make use of the incoming MIDI, other than automation data (such as recorded pattern changes).

Creating a basic pattern

1. Use the Pattern selector to choose which pattern to create.
   Each Step Designer can hold up to 200 different patterns.

2. Use the Quantize setting to specify the “resolution” of the pattern.
   In other words, this setting determines how long each step is. For example, if Quantize is set to “16th” each step will be a sixteenth note.

3. Specify the number of steps in the pattern with the Length setting.
   As you can see in the note display, the maximum number of steps is 32. For example, setting Quantize to 16 and Length to 32 would create a two bar pattern with sixteenth note steps.

4. Click in the note display to insert notes.
   You can insert notes on any of the 32 steps, but the Step Designer will only play back the number of steps set with the Length parameter.

   • The display spans one octave (as indicated by the pitch list to the left).
   You can scroll the displayed octave up or down by clicking in the pitch list and dragging up or down.
   This way you can insert notes at any pitch. Note though that each step can contain one note only – the Step Designer is monophonic.
Click and drag to view other octaves.

- To remove a note from the pattern, click on it again.

5. Select “Velocity” on the Controllers pop-up menu.
   This pop-up menu determines what is shown in the lower controller display.

6. Adjust the velocity of the notes by dragging the velocity bars in the controller display.

7. To make notes shorter, select “Gate” on the Controllers pop-up menu and lower the bars in the controller display.
   When a bar is set to its maximum value (fully up), the corresponding note will be the full length of the step (as set with the Quantize parameter).

8. To make notes longer, you can tie two notes together. This is done by inserting two notes and clicking the Tie button below the second note.
   When the Tie button is lit for a note, it won’t retrigger – instead the previous note will be lengthened. Also, the tied (second) note will automatically get the same pitch as the first note. You can add more notes and tie them in the same way, creating longer notes.

9. If you now start playback in Cubase SX/SL, the pattern will play as well, sending out MIDI notes on the track’s MIDI output and channel (or, if you have activated the Step Designer as a send effect, on the MIDI output and channel selected for the send in the Inspector).
Adding controller curves

The Controllers pop-up menu holds two more items: two controller types.

- You can select which two controller types (filter cutoff, resonance, volume, etc.) should be available on the pop-up menu by clicking the Setup button and selecting controllers from the lists that appears. This selection is global to all patterns.

- To insert controller information in a pattern, select the desired controller from the pop-up menu and click in the controller display to draw events. The MIDI controller events will be sent out during playback along with the notes.

- If you drag a controller event bar all the way down, no controller value will be sent out on that step.

Other pattern functions

The following functions make it easier to edit, manipulate and manage patterns:

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shift Oct</td>
<td>These buttons allow you to shift the entire pattern up or down in octave steps.</td>
</tr>
<tr>
<td>Shift Time</td>
<td>Moves the pattern one step to the left or right.</td>
</tr>
<tr>
<td>Reverse</td>
<td>Reverses the pattern, so that it plays backwards.</td>
</tr>
<tr>
<td>Copy/Paste</td>
<td>Allows you to copy the current pattern and paste it in another pattern location (in the same Step Designer or another).</td>
</tr>
<tr>
<td>Reset</td>
<td>Clears the pattern, removing all notes and setting controller values to default.</td>
</tr>
<tr>
<td>Random</td>
<td>Generates a completely random pattern – useful for experimenting.</td>
</tr>
<tr>
<td>Swing</td>
<td>The Swing parameter allows you to offset every second step, creating a swing or shuffle feel. The value is a percentage – the higher you set this, the farther to the right every even step is moved.</td>
</tr>
<tr>
<td>Presets</td>
<td>Handling of Presets is described on page 471. Note that a stored Preset contains all 200 patterns in the Step Designer.</td>
</tr>
</tbody>
</table>
Automating pattern changes

You can create up to 200 different patterns in each Step Designer – just select a new pattern and add notes and controllers as described above.

Typically, you want the pattern selection to change during the song. You can accomplish this by automating the Pattern selector, either in real time by activating the Write automation and switching patterns during playback or by drawing in the automation subtrack for the Step Designer’s MIDI track. Note that you can also press a key on your MIDI keyboard to change patterns. Therefore, you have to set up the Step Designer as an insert effect for a record enabled MIDI track. Press C1 to select pattern 1, C#1 to select pattern 2, D1 to select pattern 3, D#1 to select pattern 4 and so on. If you want, you can record these pattern changes as note events on a MIDI track. Proceed as follows:

1. Select the desired MIDI track or create a new one and activate the Step Designer as an insert effect.

2. Set up several patterns as described above.

3. Press the Record button and press the desired keys on your keyboard to select the corresponding patterns. The pattern changes will be recorded on the MIDI track.

4. Stop recording and play back the MIDI track. You will now hear the recorded pattern changes.

- This will only work for the first 92 patterns.
Track Control

The Track Control effect contains three ready-made control panels for adjusting parameters on a GS or XG compatible MIDI device. The Roland GS and Yamaha XG protocols are extension of the General MIDI standard, allowing for more sounds and better control of various instrument settings. If your instrument is compatible with GS or XG, the Track Controls effect allows you to adjust sounds and effects in your instrument from within Cubase SX/SL.

Selecting a control panel

At the top of the Track Controls effect window you will find a pop-up menu. This is where you select which of the available control panels to use:

<table>
<thead>
<tr>
<th>Control panel</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GS Basic Controls</td>
<td>Effect sends and various sound control parameters for use with instruments compatible with the Roland GS standard.</td>
</tr>
<tr>
<td>XG Effect + Sends</td>
<td>Effect Sends and various sound control parameters for use with instruments compatible with the Yamaha XG standard.</td>
</tr>
<tr>
<td>XG Global</td>
<td>Global settings (affecting all channels) for instruments compatible with the Yamaha XG standard.</td>
</tr>
</tbody>
</table>
About the Reset and Off buttons

Regardless of the selected mode, you will find two buttons labelled “Off” and “Reset” at the top of the control panel:

- Clicking the Off button will set all controls to their lowest value, without sending out any MIDI messages.
- Clicking the Reset button will set all parameters to their default values, and send out the corresponding MIDI messages.

For most parameters, the default values will be zero or “no adjustment”, but there are exceptions to this. For example, the default Reverb Send settings are 64.

GS Basic Controls

The following controls are available when the GS Basic Controls mode is selected:

<table>
<thead>
<tr>
<th>Control</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Send 1</td>
<td>Send level for the reverb effect.</td>
</tr>
<tr>
<td>Send 2</td>
<td>Send level for the chorus effect.</td>
</tr>
<tr>
<td>Send 3</td>
<td>Send level for the “variation” effect.</td>
</tr>
<tr>
<td>Attack</td>
<td>Adjusts the attack time of the sound. Lowering the value shortens the attack, while raising it gives a slower attack. Middle position (64) means no adjustment is made.</td>
</tr>
<tr>
<td>Decay</td>
<td>Adjusts the decay time of the sound. Lowering the value shortens the decay, while raising it makes the decay longer.</td>
</tr>
<tr>
<td>Release</td>
<td>Adjusts the release time of the sound. Lowering the value shortens the release, while raising it makes the release time longer.</td>
</tr>
<tr>
<td>Cutoff</td>
<td>Adjusts the filter cutoff frequency.</td>
</tr>
<tr>
<td>Resonance</td>
<td>Adjusts the filter resonance.</td>
</tr>
<tr>
<td>Express</td>
<td>Allows you to send out expression pedal messages on the track’s MIDI channel.</td>
</tr>
<tr>
<td>Press.</td>
<td>Allows you to send out aftertouch (channel pressure) messages on the track’s MIDI channel. This is useful if your keyboard cannot send aftertouch, but you have sound modules that respond to aftertouch. The default value for this parameter is zero.</td>
</tr>
<tr>
<td>Breath</td>
<td>Allows you to send breath control messages on the track’s MIDI channel.</td>
</tr>
<tr>
<td>Modul.</td>
<td>Allows you to send modulation messages on the track’s MIDI channel (just as you normally do with a modulation wheel on a MIDI keyboard).</td>
</tr>
</tbody>
</table>
XG Effects + Sends

The following controls are available when the XG Effects + Sends mode is selected:

<table>
<thead>
<tr>
<th>Control</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Send 1</td>
<td>Send level for the reverb effect.</td>
</tr>
<tr>
<td>Send 2</td>
<td>Send level for the chorus effect.</td>
</tr>
<tr>
<td>Send 3</td>
<td>Send level for the &quot;variation&quot; effect.</td>
</tr>
<tr>
<td>Attack</td>
<td>Adjusts the attack time of the sound. Lowering this value shortens the attack, while raising it gives a slower attack. Middle position means no adjustment is made.</td>
</tr>
<tr>
<td>Release</td>
<td>Adjusts the release time of the sound. Lowering this value shortens the release, while raising it makes the release time longer. Middle position means no adjustment is made.</td>
</tr>
<tr>
<td>Harm.Cont</td>
<td>Adjusts the harmonic content of the sound.</td>
</tr>
<tr>
<td>Bright</td>
<td>Adjusts the brightness of the sound.</td>
</tr>
<tr>
<td>CutOff</td>
<td>Adjusts the filter cutoff frequency.</td>
</tr>
<tr>
<td>Resonance</td>
<td>Adjusts the filter resonance.</td>
</tr>
</tbody>
</table>
XG Global Settings

In this mode, the parameters affect global settings in the instrument(s). Changing one of these settings for a track will in fact affect all MIDI instruments connected to the same MIDI Output, regardless of the MIDI Channel setting of the track. Therefore, to avoid confusion it might be a good idea to create an empty track and use this only for these global settings.

The following controls are available:

<table>
<thead>
<tr>
<th>Control</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Eff. 1</td>
<td>This allows you to select which type of reverb effect should be used: No effect (the reverb turned off), Hall 1-2, Room 1-3, Stage 1-2 or Plate.</td>
</tr>
<tr>
<td>Eff. 2</td>
<td>This allows you to select which type of chorus effect should be used: No effect (the chorus turned off), Chorus 1-3, Celeste 1-3 or Flanger 1-2.</td>
</tr>
<tr>
<td>Eff. 3</td>
<td>This allows you to select one of a large number of “variation” effect types. Selecting “No Effect” is the same as turning off the variation effect.</td>
</tr>
<tr>
<td>Reset</td>
<td>Sends an XG reset message.</td>
</tr>
<tr>
<td>MastVol</td>
<td>This is used to control the Master Volume of an instrument. Normally you should leave this in its highest position and set the volumes individually for each channel (with the volume faders in the Cubase SX/SL mixer or in the Inspector).</td>
</tr>
</tbody>
</table>
Track FX

This plug-in is essentially a duplicate of the Track Parameter section (see page 463). This can be useful if you e.g. need extra Random or Range settings, or if you prefer to have your track parameters in a separate window (to get this, [Alt]/[Option]-click the Edit button for the effect).

The Track FX also includes an additional function that isn’t available among the track parameters:

Scale Transpose

This allows you to transpose each incoming MIDI note, so that it fits within a selected musical scale. The scale is specified by selecting a key (C, C#, D, etc.) and a scale type (major, melodic or harmonic minor, blues, etc.).

• To turn Scale Transpose off, select “No Scale” from the scale type pop-up menu.
Transformer

The Transformer is a real-time version of the Logical Editor. With this you can perform very powerful MIDI processing on the fly, without affecting the actual MIDI events on the track.

The Logical Editor is described on page 607. There you will also find the few differences between the Logical Editor and the Transformer clearly stated.
Managing plug-ins

Selecting Plug-in Information from the Devices menu opens a window in which all loaded plug-ins, audio and MIDI, are listed.

• To view the MIDI effect plug-ins, click the MIDI Plug-ins tab.

• The leftmost column allows you to deactivate plug-ins. This is useful if you have plug-ins installed that you don’t want to use in Cubase SX/SL. Only plug-ins that are activated (ticked checkbox) will appear on the MIDI effect pop-up menus.

• The second column shows how many instances of each plug-in are currently used in the project.

• The remaining columns show various information about each plug-in and cannot be edited.
Merge MIDI in Loop

As mentioned, the parameters and effects described in this chapter do not change the MIDI events themselves, but work rather like “filters”, affecting the music on playback. However, sometimes you may want to make these settings permanent, i.e. convert them to “real” MIDI events on the track. You might for example want to transpose a track and then edit the transposed notes in a MIDI editor. For this, you need to use the Merge MIDI in Loop function on the MIDI menu. This combines all MIDI events on all unmuted tracks, applies track parameters and effects and generates a new MIDI part, containing all the events as you would hear them play back.

1. Make sure only the desired MIDI track(s) are unmuted.
   If you only want to include events from a single track in the Merge operation, you may want to solo the track.

2. Set up the left and right locator around the area you want to merge.
   Only events starting within this cycle area will be included.

3. Select the track on which you want the new part to be created.
   This could be a new track or an existing track. If there are data in the cycle area on the track, you can choose whether this should be kept or overwritten (see below).

4. Select Merge MIDI in Loop from the MIDI menu.
5. Fill in the dialog that appears.
   The options in the dialog are:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Include Inserts</td>
<td>If this is activated, any MIDI insert effects activated for the track(s) will be applied.</td>
</tr>
<tr>
<td>Include Sends</td>
<td>If this is activated, any MIDI send effects activated for the track(s) will be applied.</td>
</tr>
<tr>
<td>Erase Destination</td>
<td>If this is activated, all MIDI data between the left and right locator on the destination track will be deleted.</td>
</tr>
</tbody>
</table>

6. Click OK.
   A new part is created between the locators on the destination track, containing the processed MIDI events.

Applying effects to a single part

Normally, the MIDI track parameters and effects affect a whole MIDI track. This may not always be what you want – you may want to apply some MIDI effects to a single part for example (without having to create a separate track for that part only). The Merge MIDI in Loop function can help:

1. Set up your track parameters and MIDI effects the way you want them for the part.
   This will of course affect the whole track, but focus on the part for now.

2. Set the locators to encompass the part.
   This is easiest done by selecting the part and selecting Locators to Selection from the Transport menu (or using the corresponding key command, by default [P]).

3. Make sure the track holding the part is selected in the Track list.

4. Select Merge MIDI in Loop.

5. In the dialog that appears, activate the desired effect options, make sure that Erase Destination is activated and click OK.
   Now a new part is created on the same track, containing the processed events. The original part is deleted.

6. Turn off or reset all track parameters and effects, so that the track plays back as usual.
MIDI processing and quantizing
Introduction

This chapter describes the various MIDI processing functions available on the MIDI menu. These offer various ways to change MIDI notes and other events, in the Project window or within a MIDI editor.

MIDI functions vs. track parameters

In some cases, the result of a MIDI function can also be obtained by using MIDI track parameters and effects (see page 458). For example, the MIDI functions transpose and quantize are also available as a track parameter and a MIDI effect, respectively. The main difference is that track parameters don’t affect the actual MIDI events on the track in any way, while MIDI functions change the events “permanently” (although recent changes can be undone). Use the following guidelines to decide which path to choose:

• If you want to adjust a few parts or events only, use MIDI functions. The track parameters and effects affect the output of the whole track (although they can be made permanent in a specific area with the Merge MIDI in Loop function).
• If you want to experiment with different settings, track parameters can be the best way to go.
• Track parameter settings are not reflected in the MIDI editors, since the actual MIDI events aren’t affected. This can be potentially confusing; if you’ve e.g. transposed notes using track parameters, the MIDI editors will still show the notes with their original pitch (but they will play back at their transposed pitch). MIDI functions can be a better way in those cases.

Of course, there are also MIDI functions that have no track parameter counterpart, and vice versa.

What is affected by the MIDI functions?

Which events are affected when you use a MIDI function depends on the function, the active window and the current selection:

• A MIDI function may only apply to MIDI events of a certain type.
  For example, quantization affects notes only, while the Delete Controllers function obviously applies to MIDI controller events.
• In the Project window, the MIDI functions apply to all selected parts, affecting all events (of the relevant types) in them.
• In the MIDI editors, the MIDI functions apply to all selected events. If no events are selected, all events in the edited part(s) will be affected.
Quantizing

What is quantizing?

Quantizing in its fundamental form is a function that automatically moves recorded notes, positioning them on exact note values:

For example, if you record a series of eighth notes, some of them may end up slightly beside the exact eighth note positions.

![Quantizing eighth notes](image1)

Quantizing the notes with the quantize grid set to eighth notes will move the “misplaced” notes to exact positions.

![Quantizing notes](image2)

However, quantizing is not only a method of correcting errors, it can also be used creatively in various ways. For example, the "quantize grid" does not have to consist of perfectly straight notes, some notes can automatically be excluded from quantizing, etc.

- **When quantizing MIDI, only notes are affected (not other event types).**
  It is also possible to quantize audio events, which is especially useful when working with Cubase SX/SL’s loop slicing features – see page 398.
Setting Up

At its most basic, setting up quantizing consists of selecting a note value from the Quantize pop-up menu on the toolbar (in the Project window or a MIDI editor).

By default, this allows you to quantize to exact note values (straight, triplet or dotted notes) only. If you want more options, select “Quantize Setup...” from the MIDI menu (or “Setup...” from the Quantize pop-up menu) to open the Quantize Setup dialog.
Any settings you make in the dialog are immediately reflected in the Quantize pop-up menus. However, if you want your settings permanently available on the Quantize pop-up menus, you have to use the presets functions (see page 509).

The dialog contains the following settings:

**Grid display**

The grid display shows one bar (four beats), with blue lines indicating the quantize grid (the positions that notes will be moved to).

**The Grid and Type pop-ups**

These are used to determine the basic note value for the quantizing grid. In other words, these have the same functionality as the Quantize pop-up menu on the toolbar.

Straight eighth note selected as quantizing grid.
Swing

The Swing slider is only available when a straight note value is selected for the grid and Tuplet is off (see below). It lets you offset every second position in the grid, creating a swing or shuffle feel. When you adjust the Swing slider, the result is shown in the grid display below.

Tuplet

Allows you to create more rhythmically complex grids, by dividing the grid into smaller steps.

Magnetic Area

This allows you to specify that only notes within a certain distance from the grid lines should be affected by quantizing.

• When the slider is set to 0%, the Magnetic Area function is deactivated, i.e. all notes are affected by quantizing.

If you move the slider gradually to the right, you will note how the magnetic areas are shown around the blue lines in the grid display.

Only notes within the indicated zones will be affected by quantizing.
Presets

The controls in the lower left corner of the dialog allow you to store the current settings as a preset, available on the Quantize menus in the toolbars. The usual preset procedures apply:

• To store the settings as a preset, click the Store button.
• To “load” a stored preset, showing the stored settings in the dialog, just select it from the pop-up menu. This is useful if you want to modify an existing preset.
• To rename the selected preset, double click on the name and type in a new one.
• To remove a stored preset, select it from the pop-up menu and click Remove.

You can also create presets by extracting existing grooves – see page 510:

Auto and Apply

These functions allow you to apply quantizing directly from the dialog, as described below.

☐ If you don’t want to apply the quantizing you have set up in the dialog, you can close the window by clicking its standard close box. You can also leave the dialog open while you continue working.

The Non Quantize setting

This is an additional setting that affects the result of the quantizing. It allows you to set a “distance” in ticks (120ths of sixteenth notes).

Events that already are within the specified distance from the quantize grid will not be quantized. This allows you to keep slight variations when you quantize, but still correct notes that are too far from the grid.
The Random Quantize setting

This is an additional setting that affects the result of the quantizing. It allows you to set a “distance” in ticks (120ths of sixteenth notes).

Events will be quantized to random positions within the specified “distance” from the quantize grid, thus creating a more “loose” quantizing. Much like the Non Quantize setting, this allows for slight variations, while at the same time keeping notes from ending up too far from the grid.

The Iterative Strength setting

This affects the results of the Iterative Quantize function, as described below.

Extracting a groove

You can extract the groove from an audio event or MIDI part and turn it into a Quantize preset:

- To extract the groove from an audio event, you use Hitpoints and the “Create Groove Quantize” function. See page 413.
- To extract the groove from a MIDI part, you select the part and select “Part to Groove” from the Advanced Quantize submenu on the MIDI menu.

In both cases, the resulting groove appears on the Quantize menus and you apply it as you would any Quantize preset. You can also view and edit the resulting quantize settings in the Quantize Setup dialog.
Applying quantize

There are several ways to apply the quantize:

• The standard method is to select “Over Quantize” from the MIDI menu (or using a key command, by default [Q]).
  This quantizes the selected MIDI parts or notes, according to the current Quantize pop-up menu setting.

• You can also apply quantizing directly from the Quantize Setup dialog, by clicking the “Apply” button.

• If you activate the “Auto” checkbox in the Quantize Setup dialog, any change you make in the dialog is immediately applied to the selected MIDI parts or notes.
  A great way of using this feature is to set up a playback loop, and adjust the settings in the dialog until you get the desired result.

When you apply quantize, the result is based on the original position of the notes. Therefore, you can freely try different quantize settings with no risk of “destroying” anything. See also Undo and Freeze Quantize, page 514.

The Auto Quantize function

If you activate the Auto Q button on the Transport panel, all MIDI recordings you make are automatically quantized according to the settings you have made in the Quantize Setup dialog.
Iterative Quantize

Another way to apply “loose” quantization is to use the Iterative Quantize function on the MIDI menu. It works like this:

Instead of moving a note to the closest quantize grid position, Iterative Quantize moves it only part of the way. You specify how much the notes should be moved towards the grid with the Iterative Strength setting in the Quantize Setup dialog.

Iterative Quantize is also different from “regular” quantization, in that the operation is not based on the notes’ original positions but on their current, quantized position. This makes it possible to repeatedly use Iterative Quantize, gradually moving the notes closer to the quantize grid until you’ve find the desired timing.
Quantize Lengths

This function is only available from within the MIDI editors.

This function (on the Advanced Quantize submenu on the MIDI menu) will quantize the length of the notes, without changing their start positions. At its most basic level, this function will set the length of the notes to the Length Quantize value on the MIDI editors’ toolbar. However, if you have selected the “Quantize Link” option on the Length Quantize pop-up menu, the function will resize the note according to the quantize grid, taking the Swing, Tuplet and Magnetic Area settings into account. An example:

1. Length Quantize set to “Quantize Link”.

2. Some notes, all a 1/16th note of length.

3. Here, the quantize value has been set to straight 1/16th notes with Swing at 100%. Since Snap is activated (see page 605), the quantize grid is reflected in the note display’s grid.

4. Selecting Quantize Lengths will adjust the note lengths according to the grid. If you compare the result to the first figure above, you will find that notes that started within the odd sixteenth note “zones” got the longer grid length, and notes in the even zones got the shorter length.
Quantize Ends

The Quantize Ends function on the Advanced Quantize submenu will only affect the end positions of notes. Apart from that, it works just like regular quantizing, taking the Quantize pop-up menu setting into account.

Undo and Freeze Quantize

As mentioned above, the original position of each quantized note is stored. Therefore, you can make the selected MIDI notes revert to their original, unquantized state at any time, by selecting Undo Quantize from the Advanced Quantize submenu. This is independent from the regular Undo History.

However, there may be situations when you want to make the quantized positions “permanent”. For example, you may want to quantize notes a second time, having the results based on the current quantized positions rather than the original positions. To make this possible, select the notes in question and select “Freeze Quantize” from the Advanced Quantize submenu. This makes the quantized positions permanent.

⚠️ After you have performed a Freeze Quantize for a note, you cannot undo its quantization.
Transpose

The Transpose item on the MIDI menu opens a dialog with settings for transposing the selected notes:

Semitones

This is where you set the amount of transposition.

Scale Correction

Scale Correction transposes the selected notes by forcing them to the closest note of the selected scale type. This can be used for creating interesting key and tonal changes, either by itself or in conjunction with the other settings in the Transpose dialog.

- To activate Scale Correction, click the checkbox.
- Select a root note for the scale from the note drop-down menu. Make sure to select the correct root note if you want to keep the result in the same key as the original notes, or select an entirely different key if you want to experiment.
- Select the desired scale type from the Scale drop-down menu.
Keep Notes in Range

When this checkbox is activated, transposed notes will remain within the Upper and Lower Barrier values.

- If a note ends up outside the barriers after transposition, it will be shifted to another octave, keeping the correct transposed pitch if possible. If this isn't possible (if you have set a very narrow range between the Upper and Lower Barrier), the note will be transposed “as far as possible”, i.e. to the Upper or Lower Barrier note. If you set the Upper and Lower Barriers to the same value, all notes will be transposed to this pitch!

OK and Cancel

Clicking OK performs the transposition. Clicking Cancel closes the dialog without transposing.
Other MIDI menu functions

The following items can be found on the MIDI menu–Functions sub-menu:

**Legato**

Extends each selected note so that it reaches the next note. You can specify the desired gap or overlap with the "Legato Overlap" setting in the Preferences dialog (Editing page).

When using Legato with this setting, each note will be extended to end 5 ticks before the next note.

**Fixed Lengths**

- This function is only available from within the MIDI editors.

This function resizes all selected notes to the length set with the Length Quantize pop-up menu on the MIDI editor toolbar.
Delete Doubles

This function removes double notes, i.e. notes of the same pitch on the exact same position. Double notes can occur when recording in Cycle mode, after Quantizing, etc.

☐ This function always affects whole MIDI parts.

Delete Controllers

This function removes all MIDI controllers from the selected MIDI parts.

☐ This function always affects whole MIDI parts.

Delete Continuous Controllers

This function removes all “continuous” MIDI controller events from the selected MIDI parts. That is, “on/off” events such as sustain pedal events are not removed.

☐ This function always affects whole MIDI parts.

Delete Notes

Allows you to delete very short or weak notes. This is useful for automatically removing unwanted “ghost notes” after recording. Selecting “Delete Notes...” opens a dialog in which you set up the criteria for the function:
The parameters have the following functionality:

**Minimum Length**

When the Minimum Length checkbox is activated, the note length is taken into account, allowing you to remove short notes. You can either specify the minimum length (for notes to be kept) in the value display or by dragging the blue line in the graphical length display below.

- The graphical length display can correspond to 1/4 bar, one bar, two bars or four bars. You change this setting by clicking in the field to the right of the display.

In this case, the whole length display corresponds to one bar, and the Minimum Length is set to 1/32nd notes (60 ticks).

**Minimum Velocity**

When the Minimum Velocity checkbox is activated, the velocity of notes is taken into account, allowing you to remove weak notes. You specify the minimum velocity (for notes to be kept) in the value display.

**Remove when under**

This setting is only available when both Minimum Length and Minimum Velocity is activated. By clicking the value display, you select whether both length and velocity criteria must be met for notes to be deleted, or whether one of the criteria will suffice.

**OK and Cancel**

Clicking OK performs the automatic delete according to the rules set up. Clicking Cancel closes the dialog without deleting notes.
Restrict Polyphony

Selecting this item opens a dialog in which you can specify how many “voices” should be used (for the selected notes or parts). Restricting the polyphony this way is useful when you have an instrument with limited polyphony and want to make sure all notes will be played. The effect is achieved by shortening notes as required, so that they end before the next note starts.

Pedals to Note Length

This function scans for Sustain pedal on/off events, lengthens the affected notes to match the Sustain pedal off position, and then removes the Sustain Controller on/off events.

Delete Overlaps (mono)

This function allows you to make sure that no two notes of the same pitch overlap (i.e. that one starts before the other ends). Overlapping notes of the same pitch can confuse some MIDI instruments (a new Note On is transmitted before the Note Off is transmitted). This command can then be used to automatically rectify the problem.

Delete Overlaps (poly)

This function shortens notes when required, so that no note begins before another ends. This happens regardless of which pitch the notes have.
Velocity

This function opens a dialog that allows you to manipulate the velocity of notes in various ways.

To apply the function, select one of the three processing types from the Type pop-up, adjust the settings and click OK (to close the dialog without applying, click Cancel).

The following types of velocity processing are available:

Add/Subtract

This simply adds a fixed number to the existing velocity values. You set the value (positive or negative) with the Amount parameter.

Compress/Expand

Compresses or expands the “dynamic range” of MIDI notes by scaling the velocity values according to the Ratio setting (0 – 300%). The principle behind this is that multiplying different velocity values with a factor higher than 1 (over 100%) will also make the differences between velocity values greater, while using a factor lower than 1 (under 100%) will make the differences smaller. In short:

- To compress (“even out” velocity differences), use ratio values below 100%.
  After compression, you would probably want to add a velocity amount (with the Add/Subtract function) to maintain the average velocity level.

- To expand (create greater difference in velocity), use ratio values above 100%.
  Before you expand, you may want to adjust the velocity with the Add/Subtract function, so that the average velocity is somewhere in the middle of the range. If the average velocity is high (near 127) or low (near 0), expansion will not work properly, simply because velocity values can only be between 0 and 127!
Limit

This function allows you to make sure that no velocity values fall outside a given range (the Lower and Upper values). Any velocity values outside this range are raised/lowered to exactly the Lower/Upper values.

Fixed Velocity

This function sets the velocity of all selected notes to the Insert Velocity value on the toolbar in the MIDI editors.

Reverse

This function inverts the order of the selected events (or of all events in the selected parts), causing the MIDI music to play backwards. Note though, that the effect is different from reversing an audio recording. With MIDI, the individual notes will still play as usual in the MIDI instrument – it’s only the order of playback that is changed.
Dissolve Part

The Dissolve Part function on the MIDI menu has two separate uses:

- When you work with MIDI parts (on MIDI channel "Any") containing events on different MIDI channels. Dissolve Part separates the events according to MIDI channel.
- When you want to separate MIDI events according to pitch. A typical example would be drum and percussion tracks, where each pitch usually corresponds to a separate drum sound.

Dissolving parts into separate channels

Setting a track to MIDI channel “Any” will cause each MIDI event to play back on its original MIDI channel, rather than a channel set for the whole track. There are two main situations when “Any” channel tracks are useful:

- When you record several MIDI channels at the same time. You may for example have a MIDI keyboard with several keyboard zones, where each zone sends MIDI on a separate channel. Recording on an “Any” channel track allows you to play back the recording with different sounds for each zone (since the different MIDI notes play back on separate MIDI channels).
- When you have imported a MIDI file of Type 0. MIDI files of Type 0 contain only one track, with notes on up to 16 different MIDI channels. If you were to set this track to a specific MIDI channel, all notes in the MIDI file would be played back with the same sound; setting the track to “Any” will cause the imported file to play back as intended.

The Dissolve Part function scans MIDI parts for events on different MIDI channels and distributes the events into new parts on new tracks, one for each MIDI channel found. This allows you to work with each musical part individually. Proceed as follows:

1. Select the part(s) containing MIDI data on different channels.
2. Select “Dissolve Part” from the MIDI menu.
3. In the dialog that appears, select the “Separate Channels” option.
Now, for each MIDI channel used in the selected part(s), a new MIDI track is created and set to the corresponding MIDI channel. Each event is then copied into the part on the track with the corresponding MIDI channel. Finally, the original part(s) are muted.

An example:

Dissolving parts into separate pitches

The Dissolve Part function can also scan MIDI parts for events of different pitch, and distribute the events into new parts on new tracks, one for each pitch. This is useful when the different pitches are not used in a regular melodic context, but rather for separating different sounds (e.g. MIDI drum tracks or sampler sound FX tracks). By dissolving such parts, you can work with each sound individually, on a separate track. Proceed as follows:

1. Select the part(s) containing MIDI data.
2. Select “Dissolve Part” from the MIDI menu.
3. In the dialog that appears, select the “Separate Pitches” option.
   
   A new MIDI track is created for each used pitch in the selected part(s). The events are then copied into the parts on the track for the corresponding pitch. Finally, the original part(s) are muted.
23

The MIDI editors
About editing MIDI

There are several ways to edit MIDI in Cubase SX/SL. You can use the tools and functions in the Project window for large-scale editing, or use the functions on the MIDI menu to process MIDI parts in various ways (see page 504). For hands-on graphical editing of the contents of MIDI parts, you use the MIDI editors:

- **The Key Editor is the default MIDI editor, presenting notes graphically in an intuitive piano roll-style grid.** The Key Editor also allows for detailed editing of non-note events such as MIDI controllers.

- **The Drum Editor is similar to the Key Editor, but takes advantage of the fact that with drum parts, each key corresponds to a separate drum sound.** This is the editor to use when you’re editing drum or percussion parts.

- **The List Editor shows all events in the selected MIDI parts as a list, allowing you to view and edit their properties numerically.**

- **The Score Editor shows MIDI notes as a musical score.** If you are using Cubase SL, the Score Editor offers basic score editing and printing – see page 589 for details. Cubase SX comes with advanced tools and functions for notation, layout and printing, all described in the separate pdf document “Score Layout and Printing”. However, even if your focus is on creating printed scores we recommend that you study this chapter as well, to get a grip on the common MIDI editing procedures.

- **Finally, you can also edit MIDI in the Project Browser.** Like the List Editor, this shows the events in a list and allows you to perform numerical editing. However, you will probably find the List Editor more suited for MIDI editing, since it has various dedicated features and functions for this. The Project Browser is described on page 661.

About this chapter

This chapter describes how to use the Key, Drum and List Editors. Please note that a lot of features are identical in these editors (especially in the Key and Drum Editors) – they are all described in the Key Editor section. The sections about the Drum Editor (see page 560) and the List Editor (see page 577) describe the specific features of these editors only.
Opening a MIDI editor

There are two ways to open a MIDI editor:

- Select one or several parts (or a MIDI track, with no parts selected) and select Open Key Editor, Open Score Editor, Open Drum Editor or Open List Editor from the MIDI menu (or use the corresponding key command). The selected parts (or all parts on the track, if no part was selected) will open in the chosen editor.

- Double click a part. Which editor opens depends on the settings in the Preferences dialog (Event Display–MIDI page):

<table>
<thead>
<tr>
<th>Event Display–MIDI</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Open Key Editor</td>
<td></td>
</tr>
<tr>
<td>Lines</td>
<td></td>
</tr>
<tr>
<td>Show Controllers</td>
<td></td>
</tr>
<tr>
<td>Edit as Drums when Drum Map is assigned</td>
<td></td>
</tr>
<tr>
<td>MIDI</td>
<td></td>
</tr>
</tbody>
</table>

Double clicking will open the editor selected on the Default Edit Action pop-up menu. However, if the option “Edit as Drums when Drum Map is assigned” is activated and a drum map is selected for the edited track (see page 573), the Drum Editor will open. This way you can double click to open the Key Editor (or the Score Editor or List Editor, depending on your preferences) but drum tracks will automatically open in the Drum Editor.

- If the part you open for editing is a shared copy, any editing you perform will affect all shared copies of this part. Shared copies are created by pressing [Alt]/[Option]+[Shift] and dragging, or by using the Repeat function with the “Shared copies” option activated. In the Project window, shared copies are indicated by the part name in italics and an icon in the right corner of the part (see page 122).
Handling several parts

When you open a MIDI editor with several parts (or a MIDI track containing several parts) selected, you might find it somewhat hard to get an overview of the different parts when editing.

If so, the editor toolbar features a few functions to make working with multiple parts easier and more comprehensive:

• The Part List menu lists all parts that were selected when you opened the editor (or all parts on the track, if no parts were selected), and lets you select which part should be active for editing.
  When you select a part from the list, it is automatically made active and centered in the note display.

  ![Part List Menu](image)

• Note that it is also possible to activate a part by using the Arrow tool and clicking on an event in a part.

• The button “Edit Active Part Only” lets you restrict editing operations to the active part only.
  If you for example select “All” from the Select submenu on the Edit menu with this option activated, only events in the active part will be selected. Similarly, if you select notes by dragging with the Arrow tool (making a selection rectangle), only the notes in the active part will be selected.

  ![Edit Active Part Only](image)

• You can zoom in on the active part so that it fills the screen by selecting “Zoom to Event” from the Zoom submenu on the Edit menu.
• The button “Show Part Borders" can be used if you want to see clearly defined borders for the active part. When this is activated, all parts except the active one are grayed out, making the borders easily discernible. In the Key Editor, there are also two "markers" in the ruler with the name of the active part, marking its beginning and end. These can be moved freely to change the size of the part.

“Show Part Borders” activated on the toolbar.

• It is possible to cycle between parts, making them active, with key commands. In the Key Commands dialog – Edit category, there are two functions: “Activate Next Part” and “Activate Previous Part”. If you assign key commands to these, you can use them to cycle between parts in the editors. Please refer to page 805 for instructions on how to set up key commands.
The Key Editor – Overview

The toolbar

As in other windows, the toolbar contains tools and various settings. The user can configure what toolbar items should be shown or hidden and store/recall different toolbar configurations – see page 792.
The info line

The info line shows information about selected MIDI notes. You can edit all values on the info line using regular value editing (see page 545 for details). Length and position values are displayed in the format currently selected for the ruler (see below).

- To hide or show the info line, click the icon in the toolbar.

The ruler

The ruler shows the time line, by default in the display format selected on the Transport panel. You can select a separate format for a MIDI editor ruler by clicking the arrow button to the right of it and selecting an option from the pop-up menu that appears. For a list of the available formats, see page 96.

At the bottom of the pop-up menu there are two additional items:

- If “Time Linear” is selected, the ruler, note display and controller display will be linear in relation to time. This means that if the ruler shows bars and beats, the distance between the bar lines will vary depending on the tempo.
- If “Bars+Beats Linear” is selected, the ruler, note display and controller display will be linear in relation to tempo. I.e. if the ruler shows bars and beats, the distance between beats will be constant. In most cases, you would probably set the display format to “Bars+Beats” in “Bars+Beats Linear” mode when editing MIDI.
The note display

The note display is the main area in the Key Editor. It contains a grid, in which MIDI notes are shown as boxes. The width of a box corresponds to the note length, and the vertical position of a box corresponds to the note number (pitch), with higher notes higher up in the grid. The piano keyboard to the left serves as a guide for finding the right note number.

The chord recognition function

Cubase SX/SL features a handy chord recognition function that helps you identify chords in the key editor note display. To find out which chord some simultaneously played notes make up, place the project cursor over the notes. All MIDI notes currently “touched” by the project cursor are analyzed and the chord recognition display in the toolbar shows you which chord the notes form.

In the picture above, the project cursor touches the notes C, Eb and G. As shown in the chord recognition display, this results in a C minor chord.
The controller display

The area at the bottom of the Key Editor window is the controller display. This consists of one or several controller lanes, each showing one of the following properties or event types:

- Velocity values of the notes.
- Pitch Bend events.
- Aftertouch events.
- Poly Pressure events.
- Program Change events.
- Any type of continuous controller event.

To change the size of the controller display, drag the divider between the controller display and the note display. This will make the controller display larger and the note display smaller, or vice versa.

Velocity values are shown as vertical bars in the controller display, with higher bars corresponding to higher velocity values:

Each velocity bar corresponds to a note in the note display.
Events in the controller display (that is, anything other than velocity values) are shown as “blocks”, the heights of which correspond to the “values” of the events. However, events that have been recorded (or drawn with a low quantize value) may appear more like “filled curves”, simply because they are positioned very closely:

![Controller Display](image)

If you zoom in on the upper “curve”, you will find that it consists of separate events.

- **Unlike notes, events in the controller display have no length. The value of an event in the display is “valid” until the start of the next event:**

  ![Controller Display](image)

  If you delete the second event… …the first event will be “valid” until the start of the third event.

For a description of editing in the controller display, see page 549.
Key Editor operations

Zooming

Zooming in the Key Editor is done according to the standard zoom procedures, using the zoom sliders, the Zoom tool or the Zoom submenu on the Edit menu.

- When you drag a rectangle with the Zoom tool, the result depends on the option “Zoom Tool Standard Mode: Horizontal Zooming Only” in the Preferences dialog (Editing page).
  If this is on, the window will only be zoomed horizontally; if not, the window will be zoomed both horizontally and vertically.

Playing back

You can play back your music as usual when working in a MIDI editor. There are a couple of features making it easier to edit during playback:

Solo button

If you activate the Solo button, only the edited MIDI parts will be heard during regular playback.

Autoscroll

As described on page 143, the Autoscroll function makes the window “follow” the project cursor during playback, so that the current play position is visible at all times. However, when you are working in a MIDI editor, you may want to deactivate Autoscroll – this way, the events you are working with will stay visible.

The Autoscroll button on the toolbar of each MIDI editor is independent for the editor. For example, this means you can have Autoscroll deactivated in the Key Editor and activated in the Project window.
The independent track loop function

The independent track loop is a sort of “mini-cycle”, affecting only the MIDI part being edited. When the loop is activated, the MIDI events within the loop will be repeated continuously and completely independent – other events (on other tracks) will be played back as usual. The only “interaction” between the loop and the “regular playback” is that every time the cycle starts over again, so does the loop.

To set up the independent track loop, proceed as follows:

1. Turn on the loop by clicking on the Loop button on the toolbar.
   If it isn’t visible, you need to right-click (Windows) or [Ctrl]-click (Mac) the toolbar and add the Independent Track Loop Settings section – see page 792.

   ![Image](image1)

   When the loop is activated, the cycle isn’t shown in the editor’s ruler. Now you need to specify the length of the loop:

2. Either [Ctrl]/[Command]-click and [Alt]/[Option]-click in the ruler to set the start and end of the loop, respectively…

3. …or edit the loop start and end positions numerically in the fields next to the Loop button.
   The independent track loop is indicated in dark blue in the ruler.

- The MIDI events will be looped as long as the Loop button is activated and the MIDI editor window is open.

Auditioning

![Image](image2)

If the speaker icon on the toolbar is activated, individual notes will automatically be played back (auditioned) when you move or transpose them, or when you create new notes by drawing. This makes it easier to hear what you’re doing.
Creating and editing notes

To draw new notes in the Key Editor, you use the Pencil tool or the Line tool.

Drawing notes with the Pencil tool

With the Pencil tool, you insert single notes by clicking at the desired time position (horizontal) and pitch position (vertical).

- When you move the pointer in the note display, its bar position is indicated in the toolbar, and its pitch is indicated both in the toolbar and on the piano keyboard to the left. This makes it easy to find the right note and insert position.

- If Snap is activated, this determines the start position of the created note (see page 605).

- If you just click once, the created note will have the length set on the Length Quantize pop-up menu on the toolbar. You can create a longer note by clicking and dragging the pointer with the mouse button pressed. The length of the created note will be a multiple of the Length Quantize value.
Drawing notes with the Line tool

The Line tool can be used for creating series of contiguous notes. To use the Line tool, click and drag to draw a line and then release the mouse button.

- The Line tool has several different modes.
  To select one of the modes, click on the Line tool icon on the toolbar when the tool is already selected. This opens a pop-up menu from which you can select one of the Line modes.

<table>
<thead>
<tr>
<th>Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Line</td>
<td>This is the default mode for the Line tool. When this mode is selected, you click and drag to create a straight line, in any angle. When you release the mouse button a series of notes will be created, aligned with the line. If Snap is activated, the notes will be spaced and sized according to the Quantize value.</td>
</tr>
<tr>
<td>Parabola, Sine, Triangle, Square</td>
<td>These modes insert events along different curve shapes. While they can be used for creating notes, they're probably best suited for controller editing (see page 554).</td>
</tr>
<tr>
<td>Paint</td>
<td>Allows you to insert multiple notes by dragging with the mouse button pressed. If Snap is activated, the notes will be positioned and sized according to the Quantize and Length Quantize values. If you press [Ctrl]/[Command] while painting, movement will be restricted to horizontal only (i.e. the painted notes will have the same pitch).</td>
</tr>
</tbody>
</table>

The tool icon will change appearance according to the selected mode.
Setting velocity values

When you draw notes in the key editor, the notes will get the velocity value set in the insert velocity field on the toolbar.

You can use one of three different methods for determining the velocity:

- Selecting a predefined velocity value from the insert velocity pop-up menu.
  The menu contains five different predefined velocity values. The “Setup...” item opens a dialog that allows you to specify which five velocity values should be available on the pop-up menu (you can also open this dialog by selecting “Insert Velocities...” from the MIDI menu).

- Manually entering the desired velocity value by clicking in the insert velocity field and typing the desired value.

- Using a key command.
  You can assign a key command to each of the five available velocity values in the Key Commands dialog (MIDI category – the items Insert Velocity 1-5). This allows for quick switching between different velocity values when entering notes. See page 805 for instructions on how to set up key commands.

Selecting notes

Selecting notes is done using any of the following methods:

- Use the Arrow tool.
  The standard selection techniques apply.

- Use the Select submenu on the Edit menu or Quick menu.
The Select menu options are:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>All</td>
<td>Selects all notes in the edited part.</td>
</tr>
<tr>
<td>None</td>
<td>Deselects all events.</td>
</tr>
<tr>
<td>In Loop</td>
<td>Selects all notes that are partially or completely inside the boundaries of the left and right locators.</td>
</tr>
<tr>
<td>From Start to Cursor</td>
<td>Selects all notes that begin to the left of the project cursor.</td>
</tr>
<tr>
<td>From Cursor to End</td>
<td>Selects all notes that end to the right of the project cursor.</td>
</tr>
<tr>
<td>Equal Pitch – all Octaves</td>
<td>This function requires that a single note is selected. It selects all following notes that have the same pitch (in any octave) as the currently selected note.</td>
</tr>
<tr>
<td>Equal Pitch – same Octave</td>
<td>As above, but selects notes of the exact same pitch only (same octave).</td>
</tr>
</tbody>
</table>

- You can also use the left and right arrow keys on the computer keyboard to step from one note to the next or previous. If you press [Shift] and use the arrow keys, the current selection will be kept, allowing you to select several notes.

- To select all notes of a certain pitch, press [Ctrl]/[Command] and click on the desired key in the keyboard display to the left.

You can also press [Shift] and double click on a note to select all the following notes of the same pitch – or use the Equal Pitch functions on the Select submenu.

- If the option “Auto Select Events under Cursor” is activated in the Preferences dialog (Editing page), all notes currently “touched” by the project cursor are automatically selected.
Moving and transposing notes

To move notes in the editor, use any of the following methods:

• Click and drag to a new position.
  All selected notes will be moved, maintaining their relative positions. If Snap is activated, this determines to which positions you can move the notes, see page 605.

Note also that you can restrict movement to horizontal or vertical only by holding down [Ctrl]/[Command] while dragging.

• Use the up and down arrow keys on the computer keyboard.
  This method allows you to transpose the selected notes, without risking to move them horizontally. You can also use the Transpose function (see page 515) or the info line (see page 531) for this. Note that pressing [Shift] and using the up and down arrow keys will transpose notes in steps of one octave.

• Use the Move to Cursor function on the Edit menu.
  This moves the selected notes to the project cursor position.

• Select a note and adjust its position or pitch on the info line.
  See page 545.

• Use the Move buttons in the Nudge palette on the toolbar.
  This moves the selected note(s) by the amount set on the Quantize pop-up menu.
  By default, the Nudge palette isn’t shown on the toolbar – see page 792 for more info.

  You can also adjust the position of notes by quantizing (see page 505).

Duplicating and repeating notes

Notes are duplicated much in the same way as events in the Project window:

• Hold down [Alt]/[Option] and drag the note(s) to a new position.
  If Snap is on, this determines to which positions you can copy notes (see page 605).

• Selecting Duplicate from the Edit menu creates a copy of the selected note and places it directly after the original.
  If several notes are selected, all of these are copied “as one unit”, maintaining the relative distance between the notes.

• Selecting Repeat from the Edit menu opens a dialog, allowing you to create a number of copies of the selected note(s).
  This works like the Duplicate function, but you can specify the number of copies.
• You can also perform the Repeat function by dragging: Select the note(s) to repeat, press [Alt]/[Option], click the right edge of the last selected note and drag to the right. The longer to the right you drag, the more copies (as indicated by the tooltip).

Using cut and paste

You can use the Cut, Copy and Paste options on the Edit menu to move or copy material within a part or between different parts. When you paste copied notes, you can either use the regular Paste function or the Paste Time function on the Edit menu’s Range submenu.

• “Paste” inserts the copied notes at the project cursor position, without affecting existing notes.
• “Paste Time” inserts at the project cursor position, but moves (and if necessary, splits) existing notes to make room for the pasted notes.

Selecting “Paste Time” with this data on the clipboard and the project cursor here...

...will give you this:
Resizing notes

To resize a note, use one of the following methods:

- Position the arrow tool at the start or end of the note, so that the pointer takes on the shape of a small double arrow. Click and drag to the left or right to resize the note.
  This method allows you to resize the note from either direction.

- Click with the Pencil tool within the note box and drag to the left or the right (to make the note shorter or longer, respectively).
  With both these methods, the resulting length will be a multiple of the Length Quantize value on the toolbar.

- Use the Trim Start/End buttons on the Nudge palette on the toolbar.
  This resizes the selected note(s) by moving their start or end positions, in steps according to the Length Quantize value on the toolbar. By default, the Nudge palette isn’t shown on the toolbar – see page 792 for more info.

- Select the note and adjust its length on the info line.
  See page 545 for details on info line editing.

Splitting notes

There are three ways to split notes:

- Clicking on a note with the Scissors tool splits the note at the position you pointed (taking the Snap setting into account if activated).
  If several notes are selected, they are all split at the same position if applicable.

- If you select “Split at Cursor”, all notes that are intersected by the project cursor are split at the cursor position.

- If you select “Split Loop”, all notes that are intersected by the left or right locator are split at the locator positions.

Gluing notes

Clicking on a note with the Glue Tube tool will “glue it together” with the next note of the same pitch. The result will be one long note spanning from the start of the first note to the end of the second note, and with the properties (velocity, etc.) of the first note.
Muting notes

Individual notes can be muted in the Key Editor, as opposed to muting an entire MIDI part in the Project window. This allows you to exclude notes from playback, but keep the option to bring them back again at any time. To mute a note, use one of the following methods:

- Click on it with the Mute tool.
- Drag a rectangle with the Mute tool, enclosing all notes you want to mute.
- Select the note(s) and choose Mute from the Edit menu.

The default key command for this is [Shift]+[M].

Muted notes are “dimmed” in the note display.

To unmute a note, either click it or enclose it with the Mute tool, or select it and choose Unmute from the Edit menu. The default key command for this is [Shift]+[U].

Deleting notes

To delete notes, either click on them with the Eraser tool or select them and press [Backspace].
Editing on the info line

The info line shows the values and properties of the selected event(s). If a single event is selected, its values are displayed on the info line. If several events are selected, the info line shows the values of the first of these events, in yellow.

Several events selected.

You can edit the values on the info line using regular value editing. This allows you to move, resize, transpose or change velocity of events in a very precise manner.

- If you have several events selected and change a value, all selected events will be changed relatively.
  In other words, the value will be changed by an equal amount for all selected events.

- If you have several events selected, hold down [Ctrl]/[Command] and change a value, the change will be absolute.
  In other words, the value setting will be the same for all selected events.
Editing Notes via MIDI

You can change the properties of notes via MIDI. For example, this can be a fast way to get the right velocity value, since you will hear the result even as you edit:

1. Select the note you want to edit.
2. Click on the MIDI connector symbol on the toolbar.

   ![MIDI connector symbol](image)

   The symbol should be lit. This enables editing via MIDI.

3. Use the note buttons on the toolbar to decide which properties should be changed by the MIDI input.
   You can enable editing of pitch, note-on and/or note-off velocity.

   ![Note buttons](image)

   With this setting, the edited notes will get the pitch and velocity values of the notes input via MIDI, but the note-off velocities will be kept as they are.

4. Play a note on your MIDI instrument.
   The note selected in the editor will get the pitch, velocity and/or note-off velocity of the played note.

   The next note in the edited part is automatically selected, making it easy to quickly edit a series of notes.

   • If you want another try, select the note again (easiest by pressing the [←] key on the computer keyboard) and again play a note on your MIDI instrument.
Step input

Step input, or step recording, is when you enter notes one at a time (or one chord at a time) without worrying about the exact timing. This is useful e.g. when you know the part you want to record but are not able to play it exactly as you want it.

Proceed as follows:

1. Click the Step Input button on the toolbar to activate Step Input mode.

2. Use the note buttons to the right to decide which properties should be included when you input the notes.
   For example, you may not want to include the velocity and/or note-off velocity of the played notes. It's also possible to turn off the pitch property, in which case all notes will get the pitch C3, no matter what you play.

3. Click anywhere in the note display to set the start position (the desired position of the first note or chord).
   The step input position is shown as a blue line in the note display, and in the lower mouse pointer display in the toolbar.

4. Specify the desired note spacing and length with the Quantize and Length Quantize pop-up menus.
   The notes you input will be positioned according to the Quantize value and have the length set with the Length Quantize value. For instance, if you set Quantize to 1/8 notes and Length Quantize to 1/16 note, the notes will be sixteenth notes, appearing on each eighth note position.
5. Play the first note or chord on your MIDI instrument. The note or chord appears in the editor and the step input position advances one quantize value step.

- If Insert mode is activated, all notes to the right of the step input position will be moved to "make room" for the inserted note or chord.

6. Continue in the same way with the rest of the notes or chords. You can adjust the Quantize or Length Quantize value as you go along, to change the timing or note lengths. You can also move the step input position manually by clicking anywhere in the note display.

- To insert a “rest”, press the right arrow key on the computer keyboard. This advances the step input position one step.

7. When you’re done, click the Step Input button again to deactivate step input.
Editing in the controller display

About controller lanes

By default, the controller display has a single lane, showing one event type at a time. However, you can easily add lanes by right-clicking (Windows) or [Ctrl]-clicking (Mac) in the display and selecting “Create new controller lane” from the Quick menu. This allows you to view and edit different controllers at the same time.

![The controller display with three lanes set up.](image)

- **To remove a lane, right-click it and select “Remove this Lane” from the Quick menu.**
  This hides the lane from view – it doesn’t affect the events in any way.

- **If you remove all lanes, the controller display will be completely hidden.**
  To bring it back again, select “Create new controller lane” from the Quick menu.
Selecting event type

Each controller lane shows one event type at a time. To select which type should be displayed, use the pop-up menu to the left of the lane.

- Selecting “Setup...” opens a dialog in which you can specify which Continuous Controller event types you want available on the pop-up menu.

- Each MIDI track has its own controller lane setup (number of lanes and selected event types).
  When you create new tracks, they get the controller lane setup last used.
Controller Lane presets

Once you have added the required number of controller lanes and selected the event types you need, you can store this combination as a controller lane preset. You could for example have a preset with one velocity lane only, another with a combination of velocity, pitch bend and modulation, and so on. This can make working with controllers much quicker.

• To add the current controller lane setup as a preset, pull down the pop-up menu in the lower left corner of the editor window and select “Add”. Enter a name for the preset in the dialog that appears and click OK.

• To apply a stored preset, select it from the pop-up menu. This immediately brings up the controller lanes and event types in the preset.

• To remove or rename presets, select “Organize” from the pop-up.
**Editing velocity values**

When “Velocity” is selected for viewing, the lane shows the velocity of each note as a vertical bar.

Velocity values are edited with the Pencil tool or the Line tool. The different tools and the different Line tool modes offer the following possibilities:

- You can use the Pencil tool to change the velocity of a single note: click on its velocity bar and drag the bar up or down. While you drag, the current velocity value is shown in the display to the left.

- You can use the Pencil tool or the Line tool’s Paint mode to change the velocity values of several notes by painting a “freehand curve”. When editing velocity, these two methods have the same functionality.
• Use the Line tool’s Line mode for creating linear velocity ramps. Click where you want the ramp to start and drag the cursor to where you want the ramp to end. When you release the mouse button, the velocity values are aligned with the line between the two points.

• Parabola mode works in the same way, but aligns the velocity values with a Parabola curve instead. Use this for smooth, “natural” velocity fades, etc.

• The remaining three Line tool modes (Sine, Triangle and Square) align the velocity values with continuous curve shapes (see below).

Note:

• If there is more than one note on the same position (e.g. a chord), their velocity bars will overlap in the controller lane. If none of the notes are selected, all notes at the same position will be set to the same velocity value when you draw. To edit the velocity of only one of the notes at the same position, first select the note in the note display. Now, editing will only affect the velocity of the selected note.

You can also adjust the velocity of a single note by selecting it and changing its velocity value on the info line.
Adding and editing events in the controller display

When any option other than “Velocity” is selected for viewing in a controller lane, you can create new events or edit the values of existing events using the Pencil tool or the Line tool in its various modes:

- Clicking with the Pencil tool or the Line tool in Paint mode creates a new event.
- To modify the value of an event (without creating a new one), press [Alt]/[Option] and use the Pencil tool or the Line tool’s Paint mode. Note that you can click and drag to change or add multiple events, draw controller curves, etc. You can press or release [Alt]/[Option] while drawing, switching dynamically between “edit mode” and “create mode”.

If you want to enter or adjust a single event, click once with the Pencil tool or the Line tool in Paint mode:

If you want to “paint a curve”, drag the tool (with the mouse button pressed):

- With the Pencil tool and the Line tool in Paint mode, the quantize value determines the “density” of created controller curves (if Snap is activated). For very smooth curves, you should use a small quantize value or turn off Snap. However, please note that this creates a very large number of MIDI events, which can cause MIDI playback to “stutter” in some situations. A medium-low density is often sufficient.
• Clicking and dragging with the Line tool in Line mode shows a line in the controller lane, and creates events with values aligned with this line. This is the best way to draw linear controller ramps. If you press [Alt]/[Option], no new events are created – use this mode for modifying existing controller curves.

Converting a controller curve to a ramp using the Line tool:

• The Parabola mode works in the same way, but aligns the values with a parabola curve instead, giving more “natural” curves and fades. Note that the result depends on from which direction you draw the parabola:

• In Parabola mode you can use modifier keys to determine the shape of the parabola curve. If you press [Ctrl]/[Command] the parabola curve will be reversed, if you press [[Alt]/[Option]+[Ctrl]/[Command] while snap is activated you can change the position of the whole curve (in both cases the snap value for the positioning will be a quarter of the quantize value). If you press [Shift], the exponent will be increased or decreased.
• In Line and Parabola modes, the length quantize value determines the “density” of created controller curves (if Snap is activated).
  For very smooth curves, you should use a small length quantize value or turn off Snap.
  To avoid over-dense controller curves (which may cause MIDI playback to “stutter”),
  use a medium-low density.
• The Sine, Triangle and Square modes create events with values aligned to continuous curves.
  In these modes, the quantize value determines the period of the curve (the length of one curve “cycle”) and the length quantize value determines the density of the events (the lower the length quantize note value, the smoother the curve).
• In Sine, Triangle and Square mode you can also use modifier keys to determine the shape of the curve.
  If you press [Ctrl]/[Command] you can change the phase of the beginning of the curve,
  if you press [Alt]+[Ctrl] (Win)/[Option]+ [Command] (Mac) while snap is activated you
  can change the position of the whole curve (in both cases the snap value for the positioning will be a quarter of the quantize value).

• You can also set the curve period freely by holding down [Shift] when you insert events in Sine, Triangle or Square mode.
  Activate Snap, [Shift]-click and drag to set the length of one period. The period length will be a multiple of the quantize value.
• In Triangle and Square mode you can press [Shift]+[Ctrl]/[Command] to change the maximum position of the triangle curve (to create sawtooth curves) or the pulse of the square curve. As in other modes, you can press [Alt]/[Option] if you want to change the existing events rather than creating new ones.
  Again, the snap value for the positioning will be a quarter of the quantize value.
Moving and copying events

You can move or duplicate events in a controller lane, much like you can with notes:

1. Use the Arrow tool to select the events you want to cut or copy.
   To select more than one event, [Shift]-click or drag a selection rectangle, according to the standard selection procedures.

2. Click and drag the events to move them.
   If Snap is activated, this determines to which positions you can move the events (see page 605).

   • If you hold down [Alt]/[Option] and drag, the events will be copied rather than moved.

   ☑️ If there already is an event of the same type at the exact same position, this will be replaced by the moved event.

   ☑️ Remember that a non-note event doesn't have a length – it's “valid” until the next event (see page 534).

Using cut, copy and paste

You can use the standard Cut, Copy and Paste options on the Edit menu to move or copy events in the controller display:

1. Select the events you want to cut or copy.

2. Select Cut or Copy from the Edit menu.

3. If you want to paste the events into another MIDI part, open that part in another Key Editor window.

4. Position the project cursor where you want to paste the events.

5. Select Paste from the Edit menu.

   The events on the clipboard are added, starting at the project cursor position, maintaining their relative positions. If a pasted event ends up at the same position as an existing event of the same type, the old event is replaced.
Deleting events in the controller display

You delete events by clicking with the Eraser tool or by selecting them and pressing [Backspace]. Please note:

- Deleting a controller event makes the last event before this valid up until the next event. It does not "zero" any controller changes. See page 534.

- You can delete notes by deleting their velocity bars in the controller display.
  Please be aware that if there is more than one note on the same position, there may still only be one velocity bar visible – make sure you delete only the desired notes!

Adding and editing Poly Pressure events

Poly Pressure events are special, in that they “belong to” a specific note number (key). That is, each Poly Pressure event has two editable values: the note number and the amount of pressure. Therefore, when Poly Pressure is selected on the event type pop-up menu, there are two value fields to the left of the controller display, one for the note number and one for the amount:
To add a new Poly Pressure event, proceed as follows:

1. Select Poly Pressure on the event type pop-up menu.

2. Set the note number by clicking on the keyboard display.
   Note that this only works for the topmost lane. If you have selected "Poly Pressure" for several controller lanes, you have to type in the desired note number directly in the lower value field to the left of each lane. The selected note number is displayed in the lower value field to the left of the controller display.

3. Use the Pencil tool to add a new event, just as when adding regular controller events.

To view and edit existing Poly Pressure events, proceed as follows:

1. Select Poly Pressure on the event type pop-up menu.

2. Click on the arrow button next to the note number field to the left of the controller lane.
   A pop-up menu appears, listing all note numbers for which there already are Poly Pressure events.

3. Select a note number from the pop-up menu.
   The Poly Pressure events for the selected note number are shown in the controller lane.

4. Use the Pencil tool to edit the events as usual.
   Press [Alt]/[Option] to edit existing events without adding any new ones.

   • Poly Pressure events can also be added and edited in the List Editor.
The Drum Editor – Overview

The toolbar and info line

These are much the same as the toolbar and info line in the Key Editor, with the following differences:

- The Drum Editor has no Pencil tool – instead there is a Drumstick tool (for inputting and removing notes) and a Line tool with various line and curve modes (for drawing several notes in one go or editing controller events).
- There are no Scissors and Glue Tube tools in the Drum Editor.
- As in the Key Editor, the mouse pointer display in the toolbar shows the pitch and position of the pointer, but the pitch is shown as a drum sound name rather than a note number.
- The Use Global Quantize button allows you to select which value should be used when Snap is on – the global quantize value on the toolbar or the individual quantize values for the drum sounds.
- Instead of a Length Quantize pop-up, there is an Insert Length pop-up menu. It is used in much the same way, as described on the following pages.
The purpose of the Drum Editor is to edit MIDI tracks where each note (pitch) plays a separate sound, as is typically the case with a MIDI drum kit. The drum sound list to the left lists all drum sounds by name (according to the selected drum map or name list – see below), and lets you adjust and manipulate the drum sound setup in various ways.

Note:

- The number of columns in the list depends on whether there’s a drum map selected for the track or not.
  See page 567.
- You can reorder the columns by dragging the column headings, and resize the columns by dragging the dividers between the column headings.

<table>
<thead>
<tr>
<th>Pitch</th>
<th>Instrument</th>
<th>Quantize</th>
<th>M</th>
<th>F Note</th>
<th>D Note</th>
<th>Channel</th>
<th>Output</th>
</tr>
</thead>
<tbody>
<tr>
<td>C</td>
<td>Bass Drum</td>
<td>1 - 16 Note</td>
<td>C</td>
<td>C</td>
<td>E1</td>
<td>10</td>
<td>Default</td>
</tr>
<tr>
<td>D#1</td>
<td>Snare</td>
<td>1 - 16 Note</td>
<td>D#</td>
<td>D#1</td>
<td>E1</td>
<td>10</td>
<td>Default</td>
</tr>
<tr>
<td>D#1</td>
<td>Acoustic Snare</td>
<td>1 - 16 Note</td>
<td>D#</td>
<td>D#1</td>
<td>E1</td>
<td>10</td>
<td>Default</td>
</tr>
<tr>
<td>D</td>
<td>Hand Clap</td>
<td>1 - 16 Note</td>
<td>D</td>
<td>D</td>
<td>E1</td>
<td>10</td>
<td>Default</td>
</tr>
<tr>
<td>E</td>
<td>Electric Snare</td>
<td>1 - 16 Note</td>
<td>E</td>
<td>E</td>
<td>E1</td>
<td>10</td>
<td>Default</td>
</tr>
<tr>
<td>F</td>
<td>Low Floor Tom</td>
<td>1 - 16 Note</td>
<td>F</td>
<td>F</td>
<td>F1</td>
<td>10</td>
<td>Default</td>
</tr>
<tr>
<td>F#1</td>
<td>Closed Hi-Hat</td>
<td>1 - 16 Note</td>
<td>F#1</td>
<td>F#1</td>
<td>F1</td>
<td>10</td>
<td>Default</td>
</tr>
<tr>
<td>G</td>
<td>High Floor Tom</td>
<td>1 - 16 Note</td>
<td>G</td>
<td>G</td>
<td>G1</td>
<td>10</td>
<td>Default</td>
</tr>
<tr>
<td>G#1</td>
<td>Pedal Hi-Hat</td>
<td>1 - 16 Note</td>
<td>G#1</td>
<td>G#1</td>
<td>G1</td>
<td>10</td>
<td>Default</td>
</tr>
<tr>
<td>A</td>
<td>Low Tom</td>
<td>1 - 16 Note</td>
<td>A</td>
<td>A</td>
<td>A1</td>
<td>10</td>
<td>Default</td>
</tr>
<tr>
<td>A#1</td>
<td>Open Hi-Hat</td>
<td>1 - 16 Note</td>
<td>A#1</td>
<td>A#1</td>
<td>A1</td>
<td>10</td>
<td>Default</td>
</tr>
<tr>
<td>B</td>
<td>Crash</td>
<td>1 - 16 Note</td>
<td>B</td>
<td>B</td>
<td>B1</td>
<td>10</td>
<td>Crash</td>
</tr>
<tr>
<td>C#2</td>
<td>High-Middle Tom</td>
<td>1 - 16 Note</td>
<td>C#2</td>
<td>C#2</td>
<td>E1</td>
<td>10</td>
<td>Default</td>
</tr>
</tbody>
</table>
The note display

The Drum Editor’s note display displays notes as diamond symbols. The vertical position of the notes corresponds to the drum sound list to the left, while the horizontal position corresponds to the note’s position in time, just as in the Key Editor. Note however, that the diamond symbols don’t indicate the length of the notes. This makes sense, since drum sounds most often are “one-shot” samples that play to their end regardless of the note lengths.

Drum map and name pop-up menus

Below the drum sound list you will find two pop-up menus, used for selecting a drum map for the edited track or (if no drum map is selected) a list of drum sound names. For an explanation of drum maps, see page 567.

Controller display

The controller display in the Drum Editor is exactly the same as in the Key Editor. You can add or remove controller lanes from the Quick menu, and create and edit events as described on page 549.
Drum Editor operations

The basic handling (zooming, playback, auditioning, etc.) is the same as in the Key Editor (see page 535). The following sections describe the procedures and features that are specific to the Drum Editor.

Creating and editing notes

The standard way of entering notes in the Drum Editor is to click with the Drumstick tool.

When you move the pointer in the note display, its bar position and drum sound is indicated in the toolbar, making it easy to find the right sound and position.

The position of the created note depends on the following factors:

- If Snap is deactivated on the toolbar, the note will appear exactly where you clicked. In this mode, notes can be positioned freely.

- If Snap is activated and Use Global Quantize is deactivated on the toolbar, the note will snap to positions according to the quantize value set for the sound in the drum sound list. You can set up different quantize values for different drum sounds. You may for example want hi-hat notes snap to sixteenth notes, but snare and bass drum snap to eighth notes.

- If both Snap and Use Global Quantize are activated, the note will snap to positions according to the Quantize setting on the toolbar (next to the Use Global Quantize button).

The length of the inserted note is determined by the Insert Length setting on the toolbar. However, if this is set to “Drum-Map Link”, the note will get the length of the quantize value for the drum sound.
• **You can quickly audition the drum sounds by clicking in the leftmost column in the drum sound list.**
  This plays the corresponding note.

• **Clicking with the Drumstick tool on an existing note will remove it.**
  This makes drum pattern editing very quick and intuitive.

### Setting velocity values

The notes you enter will get the insert velocity value set in the insert velocity field on the toolbar – to speed up things you may want to assign key commands to the insert velocity options. See page 539.

### Selecting notes

Selecting notes is done by any of the following methods:

• **Use the Arrow tool.**
  The standard selection techniques apply.

• **Use the Select submenu on the Quick menu (see page 539).**

• **Use the left and right arrow keys on the computer keyboard to step from one note to the next or previous note.**
  If you press [Shift] and use the arrow keys, the current selection will be kept, allowing you to select several notes.

• **You can also press [Shift] and double click on a note to select all the following notes for the same drum sound.**

• **If the option “Auto Select Events under Cursor” is activated in the Preferences dialog (Editing page), all notes currently "touched" by the project cursor are automatically selected.**
Moving, duplicating or repeating notes

To move or copy notes in the editor (to other positions or other drum sounds), you use the same methods as in the Key Editor: click and drag, use the arrow keys or Edit menu functions, etc. – see page 541. There is one thing to note:

When you are moving or copying several selected notes by dragging them and Snap is activated but Use Global Quantize turned off, the notes will snap to positions according to the quantize values for the drum sounds. If the moved/copied notes have different quantize values, the largest value will determine snapping. For example, if you are moving two notes, with the quantize values 1/16 and 1/4 respectively, the notes will snap to quarter notes (1/4).

- You can also adjust the position of notes by quantizing (see page 505). Again, which quantize value is used depends on whether Global Quantize is used.

Muting notes and drum sounds

You can mute individual notes by clicking or enclosing them with the Mute tool or by using the Mute function on the Edit menu (see page 544).

Furthermore, if a drum map is selected (see page 573), the drum sound list will have a Mute column. Click in the Mute column for a drum sound to mute that sound. Finally, clicking the Drum Solo button will mute all drum sounds other than the selected one.

<table>
<thead>
<tr>
<th>Pitch</th>
<th>Instrument</th>
<th>Quantize</th>
<th>M-Note</th>
<th>D-Note</th>
<th>Chair</th>
</tr>
</thead>
<tbody>
<tr>
<td>C1</td>
<td>Bass Drum</td>
<td>1-16 Note</td>
<td>C1</td>
<td>C1</td>
<td>19</td>
</tr>
<tr>
<td>C#1</td>
<td>Side Stick</td>
<td>1-16 Note</td>
<td>C#1</td>
<td>C#1</td>
<td>19</td>
</tr>
<tr>
<td>D1</td>
<td>Acoustic Snare</td>
<td>1-16 Note</td>
<td>D1</td>
<td>D1</td>
<td>19</td>
</tr>
<tr>
<td>D#1</td>
<td>Hand Clap</td>
<td>1-16 Note</td>
<td>D#1</td>
<td>D#1</td>
<td>19</td>
</tr>
<tr>
<td>E1</td>
<td>Electric Snare</td>
<td>1-16 Note</td>
<td>E1</td>
<td>E1</td>
<td>19</td>
</tr>
<tr>
<td>F1</td>
<td>Low Floor Tom</td>
<td>1-16 Note</td>
<td>F1</td>
<td>F1</td>
<td>19</td>
</tr>
<tr>
<td>F#1</td>
<td>Closed Hi Hat</td>
<td>1-16 Note</td>
<td>F#1</td>
<td>F#1</td>
<td>19</td>
</tr>
<tr>
<td>G1</td>
<td>High Floor Tom</td>
<td>1-16 Note</td>
<td>G1</td>
<td>G1</td>
<td>19</td>
</tr>
</tbody>
</table>

Muted drum sounds

- Please note that the mute state for drum sounds is part of the drum map, so any other tracks using the same map will also be affected.
Deleting notes
To delete notes, click on them with the Drumstick tool or Eraser tool or select them and press [Backspace].

Other editing methods
As in the Key Editor, you can edit notes on the info line or via MIDI, and enter notes using step input. Please refer to page 545.
Working with drum maps

Background

As discussed earlier, a drum kit in a MIDI instrument is most often a set of different drum sounds with each sound placed on a separate key (i.e. the different sounds are assigned to different MIDI note numbers). One key plays a bass drum sound, another a snare and so on.

Unfortunately, different MIDI instruments often use different key assignments. This can be troublesome if you have made a drum pattern using one MIDI device, and then want to try it on another. When you switch device, it is very likely that your snare drum becomes a ride cymbal, or your hi-hat becomes a tom, etc. – just because the drum sounds are distributed differently in the two instruments.

To solve this problem, and simplify several aspects of MIDI drum kits (like using drum sounds from different instruments in the same "drum kit"), Cubase SX/SL features so-called drum maps. A drum map is basically a list of drum sounds, with a number of settings for each sound. When you play back a MIDI track for which you have selected a drum map, the MIDI notes are "filtered" through the drum map before being sent to the MIDI instrument. Among other things, the map determines which MIDI note number is sent out for each drum sound, and so which sound is played in the receiving MIDI device.

A solution to the problem above would therefore be to make up drum maps for all your instruments. When you want to try your drum pattern on another instrument, you simply switch to the corresponding drum map and your snare drum sound will remain a snare drum sound.
Drum map settings

A drum map consists of settings for 128 drum sounds (one for each MIDI note number). To get an overview of these settings, open the Drum Editor and use the Map pop-up menu below the drum sound list to select the "GM Map" drum map.

This drum map is set up according to the General MIDI standard. For information on how to load, create and select other drum maps, see page 573.

Now, take a look at the drum sound list (you may have to drag the divider between the list and the note display to the right to see all columns). The columns show the settings of the drum map for each sound.
Here’s a brief description (details follow below):

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pitch</td>
<td>The actual note number of the drum sound. This is what links notes on a MIDI track to drum sounds. For example, with the above drum map, all MIDI notes with the pitch C1 would be mapped to the Bass Drum sound. More on this below.</td>
</tr>
<tr>
<td>Instrument</td>
<td>The name of the drum sound.</td>
</tr>
<tr>
<td>Quantize</td>
<td>This value is used when entering and editing notes as described on page 563 and page 565.</td>
</tr>
<tr>
<td>Mute</td>
<td>Allows you to mute a drum sound, excluding it from playback. See page 565.</td>
</tr>
<tr>
<td>I-note</td>
<td>This is the “input note” for the drum sound. When this MIDI note is sent into Cubase SX/SL, (i.e. played by you), the note will be mapped to the corresponding drum sound (and automatically transposed according to the Pitch setting for the sound). See below.</td>
</tr>
<tr>
<td>O-note</td>
<td>This is the “output note”, i.e. the MIDI note number that is sent out every time the drum sound is played back. See below.</td>
</tr>
<tr>
<td>Channel</td>
<td>The drum sound will be played back on this MIDI channel.</td>
</tr>
<tr>
<td>Output</td>
<td>The drum sound will be played back on this MIDI output. If you set this to “Default”, the MIDI output selected for the track will be used.</td>
</tr>
</tbody>
</table>

- All settings in a drum map (except the Pitch setting) can be changed directly in the drum sound list, or in the Drum Map Setup dialog (see page 574).

Note that the changes you make will affect all tracks that use the drum map.
About Pitch, I-note and O-note

This can be a somewhat confusing area, but once you've grasped how it all works it's not very complicated. Going through the following “theory” will help you make the most out of the drum map concept – especially if you want to create your own drum maps.

As we said earlier, a drum map is a kind of “filter”, transforming notes according to the settings in the map. It does this transformation twice; once when it receives an incoming note (i.e. when you play a note on your MIDI controller) and once when a note is sent from the program to the MIDI sound device.

In the following example, we have modified the drum map, so that the Bass Drum sound has different Pitch, I-note and O-note values.

<table>
<thead>
<tr>
<th>Pitch</th>
<th>Instrument</th>
<th>Quantize</th>
<th>M</th>
<th>I-Note</th>
<th>O-Note</th>
<th>Channel</th>
</tr>
</thead>
<tbody>
<tr>
<td>C1</td>
<td>Bass Drum</td>
<td>1 - 15 Note</td>
<td>C1</td>
<td>E0</td>
<td>10</td>
<td></td>
</tr>
<tr>
<td>C#1</td>
<td>Side Stick</td>
<td>1 - 15 Note</td>
<td>C#1</td>
<td>C#1</td>
<td>10</td>
<td></td>
</tr>
<tr>
<td>D1</td>
<td>Acoustic Snare</td>
<td>1 - 15 Note</td>
<td>D1</td>
<td>D1</td>
<td>10</td>
<td></td>
</tr>
<tr>
<td>D#1</td>
<td>Hard Snare</td>
<td>1 - 15 Note</td>
<td>D#1</td>
<td>D#1</td>
<td>10</td>
<td></td>
</tr>
</tbody>
</table>

I-notes

Let’s look at what happens on input: When you play a note on your MIDI instrument, the program will look for this note number among the I-notes in the drum map. In our case, if you play the note A1, the program will find that this is the I-note of the Bass Drum sound.

This is where the first transformation happens: the note will get a new note number according to the Pitch setting for the drum sound. In our case, the note will be transformed to a C1 note, because that is the pitch of the Bass Drum sound. If you record the note, it will be recorded as a C1 note.
O-notes

The next step is the output. This is what happens when you play back the recorded note, or when the note you play is sent back out to a MIDI instrument in real time (MIDI Thru):

The program checks the drum map and finds the drum sound with the pitch of the note. In our case, this is a C1 note and the drum sound is the Bass Drum. Before the note is sent to the MIDI output, the second transformation takes place: the note number is changed to that of the O-note for the sound. In our example, the note sent to the MIDI instrument will be a B0 note.

Usage

So, what’s the point of all this? Again, the purposes are different for I-notes and O-notes:

• Changing the I-note settings allows you to choose which keys will play which drum sounds, when playing or recording from a MIDI instrument. For example, you may want to place some drum sounds near each other on the keyboard so that they can be easily played together, move sounds so that the most important sounds can be played from a short keyboard, play a sound from a black key instead of a white, and so on. If you never play your drum parts from a MIDI controller (but draw them in the editor) you don’t need to care about the I-note setting.

• The O-note settings let you set things up so that the “Bass Drum” sound really plays a bass drum. If you’re using a MIDI instrument in which the bass drum sound is on the C2 key, you set the O-note for the Bass Drum sound to C2. When you switch to another instrument (in which the bass drum is on C1) you want the Bass Drum O-note set to C1. Once you have set up drum maps for all your MIDI instruments, you don’t have to care about this anymore – you just select another drum map when you want to use another MIDI instrument for drum sounds.
The channel and output settings

You can set separate MIDI channels and/or MIDI outputs for each sound in a drum map. The following rules apply:

- When a drum map is selected for a track, the MIDI channel settings in the drum map override the MIDI channel setting for the track.
  In other words, the MIDI channel setting you make in the Track list or Inspector for the track is normally disregarded. If you want a drum sound to use the channel of the track, set it to channel “Any” in the drum map.

- If the MIDI output is set to “default” for a sound in a drum map, the sound will use the MIDI output selected for the track.
  Selecting any other option allows you to direct the sound to a specific MIDI output.

  By making specific MIDI channel and output settings for all sounds in a drum map, you can direct your drum tracks directly to another MIDI instrument simply by selecting another drum map – you don’t need to make any channel or output changes for the actual track.

- To select the same MIDI channel for all sounds in a drum map, click the Channel column, press [Ctrl]/[Command] and select the desired channel.
  All drum sounds will be set to this MIDI channel. The same procedure can be used for selecting the same MIDI output for all sounds as well.

  It can also be useful to select different channels and/or outputs for different sounds. This allows you to construct drum kits with sounds from several different MIDI devices, etc.
Managing drum maps

Selecting a drum map for a track

To select a drum map for a MIDI track, use the Map pop-up menu in the Inspector or in the Drum Editor:

Selecting “No Drum Map” turns off the drum map functionality in the Drum Editor. Even if you don’t use a drum map, you can still separate sounds by name using a name list (see page 576).

- Initially, the Map pop-up menu will only contain one map: “GM Map”. However, you will find a number of drum maps included on the program CD – how to load these is described below.
The Drum Map Setup dialog

To set up and manage your drum maps, select Drum Map Setup from the Map pop-up menus or the MIDI menu. This opens the following dialog:

This is where you load, create, modify and save drum maps. The list to the left shows the currently loaded drum maps; selecting a drum map in the list displays its sounds and settings to the right.

- The settings for the drum sounds are exactly the same as in the Drum Editor (see page 568).

As in the Drum Editor, you can click the leftmost column to audition a drum sound. Note: if you audition a sound in the Drummap Setup dialog, and the sound is set to MIDI output “Default”, the output selected on the Default pop-up menu in the lower left corner will be used. When auditioning a Default output sound in the Drum Editor, the MIDI output selected for the track will be used, as described on page 572.
Below the drum sound list you will find a number of buttons, with the following functionality:

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>New Map</td>
<td>Click this to add a new drum map to the project. The drum sounds will be named “Sound 1, Sound 2” and so on, and have all parameters set to default values. The map will be named “Empty Map”, but you can rename it by clicking and typing in the list.</td>
</tr>
<tr>
<td>New Copy</td>
<td>Adds a copy of the currently selected drum map. This is probably the quickest way to create a new drum map: select the map that is similar to what you want, create a copy, change the desired drum sound settings and rename the map in the list.</td>
</tr>
<tr>
<td>Remove</td>
<td>Removes the selected drum map from the project.</td>
</tr>
<tr>
<td>Load</td>
<td>Opens a file dialog, allowing you to load drum maps from disk. On the Cubase SX/SL CD you will find a number of drum maps for different MIDI instruments – use this function to load the desired maps into your project.</td>
</tr>
<tr>
<td>Save</td>
<td>Opens a file dialog for saving the drum map selected in the list. If you have created or modified a drum map, you should use this function to save it as a file on disk – this allows you to load it into other projects. Drum map files have the extension “.drm”.</td>
</tr>
<tr>
<td>Assign</td>
<td>Click this button to assign the selected drum map to the current MIDI track (only available if a MIDI track was selected when you opened the Drum Map Setup dialog). This is the same as selecting the drum map from the Map pop-up menu.</td>
</tr>
<tr>
<td>OK</td>
<td>Closes the dialog.</td>
</tr>
</tbody>
</table>

- Drum maps are saved with the project files. If you have created or modified a drum map, you should use the Save function to store it as a separate file, available for loading into other projects.

If you always want to have the same drum map(s) included in your projects, you may want to load these into the default project – see page 762.
O-Note Conversion

This function on the MIDI menu goes through the selected MIDI part(s) and sets the actual pitch of each note according to its O-note setting. This is useful if you want to convert the track to a "regular" MIDI track (with no drum map) and still have the notes play back the correct drum sound. A typical application is if you want to export your MIDI recording as a standard MIDI file (see page 770) – by first performing an O-Note Conversion you make sure that your drum tracks play back as they should when they are exported.

Using drum name lists

Even if no drum map is selected for the edited MIDI track, you can still use the Drum Editor if needed. As previously mentioned, the drum sound list will then only have four columns: Audition, Pitch, Instrument (drum sound names) and Quantize. There will be no I-note and O-note functionality.

In this mode, the names shown in the Instrument column depend on the selection on the Names pop-up menu, just below the Map pop-up in the Drum Editor.

The options on this pop-up menu are the currently loaded drum maps plus a "GM Default" item which is always available. This means you can use the drum sound names in any loaded drum map without using I-notes and O-notes, should you so like.
The List Editor – Overview

The List Editor allows you to view and edit all events in one MIDI part, or in all MIDI parts for a selected instrument or track. It is particularly useful for editing events that are too small or too close together to be edited in the Key Editor. The List Editor contains the following features:

The toolbar

- **The Insert pop-up menu** is used when creating new events. This is where you determine what type of event to add (see page 579).
- **The Mask pop-up menu and Filter view** (Show Filter View button) allow you to hide events from view, based on their type and other properties. See page 582.
- **The Value View button** can be used for hiding and showing the Value display (see below).
- The List Editor has no info line (numerical editing is available in the list instead).

The list

This lists all events in the currently selected MIDI part(s), in the order (from top to bottom) they are played back. You can edit the event properties by using regular value editing, as described on page 580.
The event display

This shows the events graphically. The vertical position of an event in the display corresponds to its entry in the list (i.e. to the playback order), while the horizontal position corresponds to its actual position in the project. This is where you add new parts or events, drag to move them, etc.

The value display

This display shows the “value” of each event, allowing for easy viewing and graphical editing. Typically, the value shown is the “Data 2” or “Value 2” property (amounts for MIDI controller events, velocity for notes, etc.). You can show or hide this display by clicking the “Show List Value View” button on the toolbar.
List Editor operations

Customizing the view

You can click and drag the divider between the list and the event display to make one area wider and the other narrower. Furthermore, the list can be customized in the following ways:

- You can change the order of the columns by dragging the column headings.
- You can resize columns by dragging the dividers between the column headings.

Setting the display format

Just like in the Project window, you set the display format (bars+beats, seconds, etc.) by right-clicking (Windows) or [Ctrl]-clicking (Mac) in the ruler and selecting an option from the pop-up menu. This setting affects both the ruler and all start, end and length values shown in the list.

Zooming

You can change the horizontal magnification in the event display by using the zoom slider below the display or the Magnification Glass tool.

Adding events

To add a new event to the edited part, proceed as follows:

1. Use the Insert pop-up menu on the toolbar to select the event type.

2. Select the Pencil tool and click in the event display, at the desired position (relative to the ruler).
   If you are creating note events, you can click and drag to set the length of the note.

   The new event appears in the list and in the display. Its properties will be set to default values, but can easily be adjusted in the list.

   - Notes you enter will get the insert velocity value set in the insert velocity field on the toolbar. See page 539.
Editing in the list

The list allows you to perform detailed numerical editing of the events' properties. The columns have the following functionality:

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>L</td>
<td>Locate column. An arrow in this column indicates the event that starts closest before the project cursor position. If you click in this column for an event, the project cursor is moved to the start of that event. Double clicking moves the cursor position and starts/stops playback – useful for auditioning when editing in the list.</td>
</tr>
<tr>
<td>Type</td>
<td>The event type. This cannot be changed.</td>
</tr>
<tr>
<td>Start</td>
<td>The start position of the event, shown in the format selected for the ruler. Changing this is the same as moving the event. Note that moving the event past any other event in the list will re-sort the list (the list always shows the events in the order they are played back).</td>
</tr>
<tr>
<td>End</td>
<td>This is only used for note events, allowing you to view and edit the end position of a note (thereby resizing it).</td>
</tr>
<tr>
<td>Length</td>
<td>This is only used for note events. It shows the length of the note – changing this resizes the note and automatically changes the End value as well.</td>
</tr>
<tr>
<td>Data 1</td>
<td>This is the “data 1” or “value 1” property of the event. The content of this depends on the event type – for notes, this is the pitch, for example. Where applicable, the values are shown in the most relevant form. For instance, the Data 1 value for notes is shown as a note number in the format selected in the Preferences dialog (Event Display–MIDI page). See also the table on page 585.</td>
</tr>
<tr>
<td>Data 2</td>
<td>This is the “data 2” or “value 2” property of the event. The content of this depends on the event type – for notes, this is the velocity value, for example. See the table on page 585.</td>
</tr>
<tr>
<td>Channel</td>
<td>The MIDI channel of the event. Note that this setting is normally overridden by the channel setting for the track. To make a MIDI event play back on “its own” channel, set its track to channel “Any” in the Project window.</td>
</tr>
<tr>
<td>Comment</td>
<td>This column is used for some event types only, providing an additional comment about the event.</td>
</tr>
</tbody>
</table>

- You can edit several events at once. If several events are selected and you edit a value for one event, the other selected events’ values will be changed as well. Normally, any initial value differences between the events will be maintained – i.e. the values will change by the same amount. If you press [Ctrl]/[Command] when you edit, however, all events will get the same value.
• For SysEx (system exclusive) events, you can only edit the position (Start) in the list. However, clicking the Comment column opens the MIDI SysEx Editor, in which you can perform detailed editing of system exclusive events – see page 680.

**Editing in the event display**

The event display allows you to edit the events graphically using the tools on the toolbar. You can edit single events as well as several selected events simultaneously.

• To move an event, click and drag it to a new position. Note that moving the event past any other event in the display will re-sort the list (the list always shows the events in the order they are played back). As a result, the vertical position of the event in the display will change as well.

• To make a copy of an event, press [Alt]/[Option] and drag it to a new position.

• To resize a note, select it and drag its end point with the Arrow tool as in the Project window. This only works with notes.

• To mute or unmute an event, click on it with the Mute tool. You can mute or unmute several events in one go by enclosing them in a selection rectangle with the Mute tool.

• You can select a color scheme for the events with the Colors pop-up menu on the toolbar. This affects how all MIDI events are shown in the List, Key and Drum editors – see page 605.

• To delete an event, select it and press [Backspace] or [Delete], or click on it with the Eraser tool in the event display.
Filtering

Clicking the “Show Filter View” button on the toolbar opens an additional filter bar that allows you to hide specific event types from view. For example, it may be hard to find note events if the part contains a lot of controllers. By hiding these the list becomes more manageable.

To hide an event type, tick its checkbox on the filter view. To see one event type only (hide all other event types), press [Ctrl]/[Command] and click its checkbox. If you [Ctrl]/[Command]-click again, all checkboxes are cleared (all events will be visible).

- The event types remain hidden even if you close the filter view.

To make sure you see all events, open the filter view and check that all checkboxes are deactivated.

- The filter view does not remove, mute or in any other way change the events.
Masking

The Mask function is similar to the filter view but allows you to hide events based on other criteria as well. Proceed as follows:

1. Select an event (or several events) of the type you want to view.
2. Pull down the Mask pop-up menu on the toolbar and select one of the options.
   The results are as follows:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Event Types</td>
<td>Only events with the type of the selected event will be shown. This does the same as the filter view but is quicker if you only want to view a single event type.</td>
</tr>
<tr>
<td>Event Types and Data 1</td>
<td>Only events of the same type and with the same “Data 1” value will be shown. For example, if a note event is selected, only notes with the same pitch will be shown. If a controller event is selected, only controllers of the same type will be shown.</td>
</tr>
<tr>
<td>Event Channels</td>
<td>Only events with the same MIDI channel value as the selected event will be shown.</td>
</tr>
</tbody>
</table>

In addition to the above options, the menu also gives you access to the same presets available in the Logical Editor (see page 607). Furthermore, the “Setup...” item on the Mask pop-up menu gives you direct access to the Logical Editor, with the aid of which you can create very complex masking settings.
When you apply any of the presets from the Logical Editor or use the Logical Editor to create masking settings yourself, only the events that meet the criteria specified will be visible.

- To deactivate the Mask function, select “Nothing” from the Mask pop-up menu.

The most typical usage of the Mask function is to view a certain type of controller only (e.g. Modulation, Breath Control, etc.). Since these are all the same event types (controller), this would not be possible using the filter view. With the “Event Types and Data 1” option on the Mask pop-up menu, it is!

**Editing in the value display**

The value display to the right of the event display is a tool for quick viewing and editing of multiple values, e.g. velocities or controller amounts. The values are shown as horizontal bars, with the bar length corresponding to the value.

![Value Display](image)

A velocity ramp in the value display.

You edit the values by clicking and dragging. Note that the pointer automatically takes on the shape of the Pencil tool when you move it into the value display – you don’t have to select the Pencil tool for this.
Exactly which value is shown for an event depends on the event type. The following table shows what is displayed and edited in the Data columns and the value display:

<table>
<thead>
<tr>
<th>Event type</th>
<th>Data 1</th>
<th>Data 2</th>
<th>Value display</th>
</tr>
</thead>
<tbody>
<tr>
<td>Note</td>
<td>Pitch (note number)</td>
<td>Velocity</td>
<td>Velocity</td>
</tr>
<tr>
<td>Controller</td>
<td>Controller type</td>
<td>Controller amount</td>
<td>Controller amount</td>
</tr>
<tr>
<td>Program Change</td>
<td>Program number</td>
<td>Not used</td>
<td>Program number</td>
</tr>
<tr>
<td>Aftertouch</td>
<td>Aftertouch amount</td>
<td>Not used</td>
<td>Aftertouch amount</td>
</tr>
<tr>
<td>Pitch Bend</td>
<td>Bend amount</td>
<td>Not used</td>
<td>Bend amount</td>
</tr>
<tr>
<td>SysEx</td>
<td>Not used</td>
<td>Not used</td>
<td>Not used</td>
</tr>
</tbody>
</table>

- The value display can be hidden from view by clicking the “Show List Value View” button on the toolbar, so that it is not lit.
The Score Editor – Overview (Cubase SL only)

This section describes the Score Editor in Cubase SL. If you are using Cubase SX, please refer to the separate PDF document “Score Layout and Printing” opened from the Start menu (Windows) or the Help menu in the program.

The Score Editor shows the MIDI notes as a musical score. The window contains the following sections and items:

The toolbar

The Score Editor toolbar is similar to the toolbar in the Key Editor, with the following differences:

- The Score Editor toolbar has a button for showing or hiding the extended toolbar (see below).
- There are no active part settings – in the Score Editor, parts on different tracks are shown on different staves.
- There are no local loop settings or chord recognition functions.
The info line

The info line shows information about selected MIDI notes, just like in the Key and Drum Editors. You can edit all values on the info line using regular value editing (see page 545 for details).

- To hide or show the info line, click the “i” icon in the toolbar.

The extended toolbar

The extended toolbar (shown or hidden by clicking the T button on the main toolbar) contains the following items:

Note value buttons

Click one of these to select a note value for input. The “T” and “.” options are for triplet and dotted note values. You can also press [Ctrl]/[Command] and click one of the note value buttons – this will resize all selected notes to the note value you choose.

Enharmonic shift

Allows you to manually select whether a note should be shown with flat or sharp accidentals. See page 601.
The score display

The main area of the Score Editor window shows the notes in the edited parts on one or several staves.

- If you are editing one or several parts on the same track, as much of them as possible is shown on several staves – one above the other – just as with a score on paper.
- If you are editing parts on several tracks, they are put on a grand staff (multiple staves, tied together by bar lines).
- The number of measures across the screen depends on the size of the window and the number of notes in each measure. The maximum number of bars across the page is four.
- The end of the last part is indicated by a double bar line.
- Unlike the other MIDI editors, the Score Editor does not have a ruler. A conventional ruler would not make sense, since there is no exact relationship between a note’s horizontal position in the score and its musical position in the Project.
Score Editor operations (Cubase SL only)

Opening the Score Editor

To open one or several parts in the Score editor you proceed much as with the other editors: select one or several tracks or any number of parts (on the same or different tracks), and select “Open Score Editor” from the Scores submenu on the MIDI menu. The default key command for this is [Ctrl]/[Command]-[R].

- You can also select the Score editor as your default editor, allowing you to open it by double clicking parts. This is done with the Default Edit Action pop-up menu in the Preferences dialog (event Display – MIDI page).

About editing parts on different tracks

If you have selected parts on two or more tracks and open the Score editor, you will get one staff for each track (although you can split a staff in two, e.g. when scoring for piano). The staves are tied together by bar lines and placed in the order of the tracks in the Project window.

- If you need to rearrange the staves: close the editor, go back into the Project window, drag the tracks to the order you want them, and open the Score Editor again.

The Active Staff

Just as in the other editors, all MIDI input (as when recording from your instrument) is directed to one of the tracks, here called the Active staff. The Active staff is indicated by a black rectangle in the left part of the first visible bar.

To change Active staff, click in the staff you want to activate.
Getting the score displayed correctly

When you open the Score Editor for a part recorded in real time, the score may not look as legible as you would first expect. The Score Editor can ignore the minor time variances in performance and make a neater score almost instantly. To achieve this, there are a number of Staff Settings that determine how the program displays the music.

- Note that the time signature follows the time signature(s) on the Tempo track and are common to all tracks/staves in the score.

There are two ways to open the Staff Settings dialog:

- Double click in the white area to the left of the staff.
- Activate a staff by clicking in it, and select “Staff Settings” from the Scores submenu on the MIDI menu. The Staff Settings dialog appears.

The settings you make in this dialog are independent for each staff (track), but common for a piano staff which you have created by choosing the “Split” Staff Mode option (see below).
Staff Mode

This pop-up determines how the staff should be shown:

- When set to “Single”, all notes in the part are shown in the same staff.
- When set to “Split”, the part is split on the screen into a bass and treble clef, as in a piano score.

You use the Splitpoint value field to set the note where you want the split to occur. Notes above and including the split note will appear on the upper staff, and notes below the split note will appear on the lower staff.

Before and after setting a split at C3.

Display Quantize

Notes are not an absolute language, and you must give the program a few hints on how the score should be displayed. This is done using the Display Quantize section of the Staff Settings dialog.
These are only display values used for the graphics in the Score Editor. They do not affect the actual playback in any way.

Here is a description of the functions:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Notes</td>
<td>Determines the smallest note value to be displayed and the “smallest position” to be recognized and properly displayed. Set this to the smallest significant note position used in your music. For example, if you have notes on odd sixteenth note positions, you should set this value to 16. The “T” values are for triplet note values. This setting is partly overridden by Auto Quantize (see below).</td>
</tr>
<tr>
<td>Rests</td>
<td>This value is used as a “recommendation” – the program will not display rests smaller than this value, except where necessary. In effect, this setting also determines how the length of notes should be displayed. Set this value according to the smallest note value (length) you want to be displayed for a single note, positioned on a beat.</td>
</tr>
<tr>
<td>Auto Quantize</td>
<td>Generally, if your music contains mixed triplets and straight notes, try activating this checkbox. Otherwise, make sure it is deactivated. Auto Quantize uses involved methods to make your score look as legible as possible. Auto Quantize allows you to mix straight notes with tuplets (triplets) in a part. But, Auto Quantize also uses the (display) Quantize value. If it can’t find an appropriate note value for a certain note or group of notes, it will use the set Quantize value to display it. If the part is imprecisely played and/or complex, Auto Quantize may have a problem “figuring out” exactly what you “mean”.</td>
</tr>
<tr>
<td>Dev</td>
<td>This option is only available if Auto Quantize is on. When Dev (Deviation) is activated, triplets/straight notes will be detected even if they are not exactly “on the beat”. However, if you know your triplets/straight notes are perfectly recorded (quantized or entered by hand), turn this off.</td>
</tr>
<tr>
<td>Adapt</td>
<td>This option is only available if Auto Quantize is on. When Adapt is activated, the program “guesses” that when one triplet is found, there are probably more triplets surrounding it. Turn this on if not all of your triplets are detected.</td>
</tr>
</tbody>
</table>
Key and Clef

The correct Key and Clef are set using the two scroll bars in the Key & Clef section.

If you activate the “Auto Clef” checkbox, the program attempts to guess the correct clef, judging from the pitch of the music.

- To set the clef and key for the lower staff, activate the “Lower Staff” checkbox in the Key/Clef section.

Display Transpose

Some instruments, for example a lot of brass instruments, are scored transposed. For this purpose, the Staff Settings dialog allows you to specify a separate Display Transpose setting for each staff (track). This transposes the notes in the score (i.e. how they are displayed) without affecting how the notes play back. This allows you to record and play back a multi staff arrangement, and still score each instrument according to its own transposition.

- Use the pop-up menu to select the instrument for which you are scoring.
  You can also manually set a display transpose value with the Semitones box above.
**Flags**

These provide additional options for how the score should be displayed:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clean Lengths</td>
<td>When this is activated, notes that are considered to be chords will be shown with identical lengths. This is done by showing the longer notes as shorter than they are. When Clean Lengths is turned on, notes with very short overlaps are also cut off; a bit as with No Overlap (see below), but with a more subtle effect.</td>
</tr>
<tr>
<td>No Overlap</td>
<td>When this is activated one note will never be shown as overlapping another, lengthwise. This allows long and short notes starting at the same point to be displayed without ties; the long notes are cut off in the display. This will make the music more legible.</td>
</tr>
</tbody>
</table>

An example measure with No Overlap deactivated...

![Example Measure](image1)

...and with No Overlap activated.

![Example Measure](image2)

<table>
<thead>
<tr>
<th>Syncopation</th>
<th>When this function is activated, syncopated notes are shown in a more legible way.</th>
</tr>
</thead>
</table>

This is a dotted quarter at the end of a bar when Syncopation is Off...

![Example Measure](image3)

...and when it is On.

<table>
<thead>
<tr>
<th>Shuffle</th>
<th>Activate this function when you have played a shuffle beat and want it displayed as straight notes (not triplets). This is very common in jazz notation.</th>
</tr>
</thead>
</table>
Applying your settings

After you’ve made your settings, click Apply to apply them to the active staff. You can select another staff in the score and make settings for that, without having to close the Staff Settings dialog first – just remember to click Apply before you change staff, otherwise your changes will be lost.

- As in many other dialogs and property windows in Cubase SX/SL, you can store your settings as presets.
  This is done according to the usual procedures: click Store to store the current settings as a preset, select a preset from the pop-up menu to load it into the dialog or use the Remove button to remove the currently selected preset.
Entering notes with the mouse

To enter notes into a part in the Score Editor, you use the Note tool. However, first you need to set the note value (length) and spacing:

Selecting a note value for input

This can be done in two ways:

• By clicking the note symbols on the extended toolbar. You can select any note value from 1/1 to 1/64th and turn on and off the dotted and triplet options by clicking the two buttons to the right. The selected note value is displayed in the Length value field on the toolbar and in the Note tool cursor shape.
• By selecting an option from the Length Q pop-up on the toolbar.

Selecting a Quantize Value

When you move the mouse pointer over the score, you will see that the position box on the toolbar tracks your movement and shows the current position in bars, beats, sixteenth notes and ticks.

Positioning on screen is controlled by the current Quantize value. If you for example set this to “1/8 Note” you can only insert and move notes to eighth note positions, at quarter notes, at half bars or at bar positions. It is a good strategy to set the Quantize value to the smallest note value in the piece. This doesn’t stop you from inputting notes at “coarser” positions. However, if you set the Quantize value to too small a note value, it is easier to make mistakes.

The Quantize value is set with the Quantize pop-up on the toolbar.

• You can also assign key commands to the different Quantize values. This is done in the Key Commands dialog on the File menu, under the heading “MIDI Quantize”.
• Just like in the other MIDI editors, you can use the Quantize Setup dialog to create other quantize values, irregular grids, etc. However, this is not often used when entering score notes.
**Entering a note**

To add a note to the score, proceed as follows:

1. Make the staff active.
   Notes are always put in on the active staff.

2. Select the type of note by selecting a note value.
   This is described in detail above.

3. If you selected the note value by clicking on a symbol on the extended toolbar, the Note tool was automatically selected – otherwise select the Note tool from the toolbar or Quick menu.

4. Select a Quantize value.
   As described above, the Quantize value will determine the spacing between notes. If you have Quantize set to “1/1 Note” you will only be able to add notes at downbeats. If you set Quantize to “1/8 Note” you will be able to add notes at all eighth note positions etc.

5. Click in the staff and keep the mouse button pressed.
   A note appears under the mouse pointer.

6. Move the mouse horizontally to find the correct position.
   Check the lower mouse position box on the toolbar – the position is “magnetically” attracted to the grid defined by the current Quantize value. This allows you to easily find the correct position.

7. Move the mouse vertically to find the correct pitch.
   The upper mouse position box shows the pitch at the pointer position, making it easy to find the right pitch.

8. Release the mouse button.
   The note appears in the score.

The notes you enter will get the insert velocity value set in the insert velocity field on the toolbar. See page 539.
Selecting notes

There are several ways to select notes in the Score Editor:

By clicking

To select a note, click on its note head with the Arrow tool. The note head gets inverted to indicate that it is selected.

• To select more notes, hold down [Shift] and click on them.
• To deselect notes, hold [Shift] down and click on them again.
• If you hold down [Shift] and double click on a note, this note and all the following notes in the same staff are selected.

Using a selection rectangle

1. Press the mouse button with the Arrow tool in some free (white) space in the score.
2. Drag the mouse pointer.
   A rectangle appears. You can drag to select voices on several voices or staves if you wish.
3. Release the mouse button.
   All notes with their note heads inside the rectangle get selected.
   If you want to deselect one or more of the notes, hold down [Shift] and click as described above.

Using the keyboard

By default, you can step through the notes in the staff using the left and right arrow keys. If you press [Shift], you will select the notes as you step through them.

• If you want to use other keys for selecting notes, you can customize the settings in the Key Commands dialog on the File menu (in the Navigate category).

Deselecting everything

To deselect everything, simply click with the Arrow tool in some “free” (white) space in the score.
Deleting notes

Notes can be deleted in two ways:

Using the Eraser tool
1. Select the Eraser tool from the toolbar or Quick menu.
2. Click on the Note(s) you want to erase, one at a time or drag over them with the mouse button pressed.

Using the keyboard or delete menu item
1. Select the notes you want to delete.
2. Select Delete from the Edit menu, or press [Delete] or [Backspace] on the computer keyboard.

Moving notes

To move or transpose notes, proceed as follows:

1. Set the Quantize value.
   The Quantize value will restrict your movement in time. You can not place the notes on positions smaller than the Quantize value. If Quantize for example is set to “1/8 Note”, you will not be able to move the notes to a sixteenth note position. However, you will be able to put them on any eighth note, quarter note, half note or whole note position.

2. If you want to hear the pitch of the note while moving, activate the speaker icon on the toolbar.
   When it is on, you will hear the current pitch of the “dragged” note.

3. Select the note(s) you plan to move.

4. Click one of the selected notes and drag it to a new position and/or pitch.
   The horizontal movement of the note is “magnetically attracted” to the current Quantize value. The position boxes on the toolbar show what the new position and pitch for the dragged note will be.

5. Release the mouse.
   The notes appear at their new position.

  • If you press [Ctrl]/[Command] and drag, movement is restricted to vertical or horizontal only (depending on in which direction you drag).
You can also move selected notes by using key commands, as assigned in the Nudge category in the Key Commands dialog.

When moving notes to the left or right using key commands, the notes will be moved in steps according to the current Quantize value. The keys assigned for up/down nudging will transpose notes in semitones steps.

**Duplicating notes**

1. Set the Quantize value and select the notes, as for moving.
2. Press [Alt]/[Option] and drag the notes to their new position.

• If you want to restrict movements to one direction only, press [Ctrl]/[Command].
  This works just as for moving, as described above.

• [Alt]/[Option] is the default modifier key for copying/duplicating. If you like, you can change this in the Preferences dialog (Editing–Tool Modifiers page).
  The entry for this is found in the Drag & Drop category (“Copy”).

**Changing the length of notes**

As described earlier in this section (see page 590), the displayed length of a note isn’t necessarily the actual note length, but also depends on the Note and Rest Display Quantize settings in the Staff Settings dialog. This is important to remember when you change the length of a note, since it can give rise to confusing results.

There are several ways to change the length of a note in the Score Editor:

**By using the Note tool**

1. Select a Note value that you wish to apply to the Note.
   This can be done by clicking a note value icon in the extended toolbar or by selecting a new Length value.
2. Select the Note tool if it isn’t already selected.
3. Hold down [Alt]/[Option] and click on the notes you wish to set to this length.
By using the note value icons on the extended toolbar

Using the extended toolbar is another quick way to set a number of notes to the same length:

1. Select the notes you want to change.
2. Hold down [Ctrl]/[Command] and click on one of the note icons on the extended toolbar.
   All the selected notes are now given the length of the clicked note.

By using the info line

You can also edit length values numerically on the info line, just like in the Key and Drum Editors (see page 545).

Splitting and Gluing notes

- If you have two notes strung together by a tie, and click on the “tied” note head with the Scissors tool, the note will be divided into two, with the respective length of the “main” and the tied note.
- Conversely, if you click on a note with the Glue Tube tool it will be joined to the next note with the same pitch.

Enharmonic Shift

The buttons to the right on the extended toolbar allow you to shift the display of selected notes so that for example an F# (F sharp) is instead shown as a Gb (G flat) and vice versa:

1. Select the note(s) you want to affect.
2. Click on one of the buttons to display the selected note(s) a certain way.

| Enharm.Shift | H | k | off | b | # | ∞ |

The "off" button resets the notes to original display. The other five options are double flats, flats, No (no accidentals shown, regardless of pitch), sharps and double sharps.
Flip Stems

Normally the direction of the note stems is automatically selected according to the note pitches, but you can change this manually if you like:

1. Select the notes for which you want to change (flip) the stem direction.
2. Pull down the MIDI menu and select Flip Stems from the Scores submenu.

Working with text

You can use the Text tool to add comments, articulation or instrumentation advice and other text strings anywhere in the score:

Adding a text string

1. Select the Text tool from the toolbar or Quick menu.
2. Click anywhere in the score. A text input line dialog box appears.
3. Enter the text and press [Return].

Editing text

To edit an already added text string, double click it with the Arrow tool. This opens the text for editing, and you can use the arrow keys to move the cursor, delete characters with the [Delete] or [Backspace] keys and type new text as usual. Finish by pressing [Return].

- To delete a text block, select it with the Arrow tool and press [Backspace] or [Delete].
- You can move or duplicate text blocks by dragging (or [Alt]/[Option]-dragging) them, just as with notes.
Changing the text font, size and style

To change the font settings for the text you have added, proceed as follows:

1. Select the text block by clicking it with the Arrow tool.

2. Pull down the MIDI menu and select “Set Font” from the Scores submenu.
   A Font Settings dialog appears, containing the following settings:

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Font</td>
<td>This is where you specify the font for the text. Which fonts are available on the pop-up menu depends on which fonts you have installed on your computer. You probably don’t want to use the “Steinberg” fonts – these are special fonts used by the program (e.g. for score symbols) and not suited for common text.</td>
</tr>
<tr>
<td>Size</td>
<td>Sets the size of the text.</td>
</tr>
<tr>
<td>Frame</td>
<td>Allows you to encase the text in a rectangular (box) or oval frame.</td>
</tr>
<tr>
<td>Text style options</td>
<td>These checkboxes determine whether the text should be bold, italic, and/or underlined.</td>
</tr>
</tbody>
</table>

3. When you’ve made your settings, click Apply.
   If you like, you can leave the Font Settings dialog open, select another text block and adjust the settings for that – just remember to click Apply before you select a new text block.

- If you make settings in the Font Settings dialog with no text block selected, the settings will be used as default for all new text.
  In other words, all text you enter from then on will get the settings you have specified (although you can of course change this manually for each text block as usual).
Printing

To print your score, proceed as follows:

1. Open the parts you want to print in the Score Editor. Printing is only available from within the Score Editor.
2. Select Page Setup from the File menu and make sure all your Printer settings are correct.
3. This includes paper size and margins.
4. Close the Page Setup dialog and select Print from the File menu.
5. The standard Print dialog appears. Fill out the options as desired.
6. Click Print.
Common MIDI editor options and settings

Snap

Snap activated on the toolbar.

The Snap function helps you find exact positions when editing in a MIDI editor. It does this by restricting horizontal movement and positioning to certain positions. Operations affected by snap include moving, duplicating, drawing, sizing, etc.

- When the “Bars+Beats” display format is selected in the ruler, the quantize value on the toolbar determines the snap value. This makes it possible to snap not only to straight note values but also to swing grids set up in the Quantize Setup dialog (see page 505).
- When any time-based display format is selected in the ruler, editing snaps to whole seconds.

Coloring notes and events

By using the Colors pop-up menu on the toolbar, you can select a color scheme for the events in the editor. The following options are available:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Velocity</td>
<td>The notes get different colors depending on their velocity values.</td>
</tr>
<tr>
<td>Pitch</td>
<td>The notes get different colors depending on their pitch.</td>
</tr>
<tr>
<td>Channel</td>
<td>The notes get different colors depending on their individual MIDI channel values.</td>
</tr>
<tr>
<td>Part</td>
<td>The notes get the same color as their respective part in the Project window. Use this option when you are working with two or more tracks in an editor, to see better which notes belong to which track.</td>
</tr>
</tbody>
</table>

When any of the first three options is selected, you can select “Setup” from the Colors pop-up menu. This opens a dialog in which you can specify which colors should be associated with which velocities, pitches or channels, respectively.
The Logical Editor, Transformer and Input Transformer
Introduction

Most of the time you will probably perform your MIDI editing graphically, from one of the main graphic editors. But there are times when you want more of a "search and replace" function on MIDI data, and that’s where the Logical Editor comes in.

The principle for the Logical Editor is this:

• **You set up filter conditions to find certain events.**
  This could be events of a certain type, with certain attributes or values or on certain positions, in any combination. You can combine any number of filter conditions and make composite conditions using AND/OR operators.

• **You select the basic function to be performed.**
  The options include Transform (changing properties of the found events), Delete (removing the events), Insert (adding new events based on the found events’ positions) and more.

• **You set up a list of actions, which specify exactly what should be done.**
  This is not necessary for all functions. For example, the Delete function does not require any additional action specifications – it simply removes all found events. The Transform function on the other hand requires that you specify which properties should be changed and in which way (transpose notes by a certain amount, adjust velocity values, etc.).

By combining filter conditions, functions and the specific actions, you can perform very powerful processing.

To master the Logical Editor you need some knowledge about how MIDI messages are structured. However, the Logical Editor also comes with a rich selection of presets, allowing you to access its processing powers without delving into its more complicated aspects, see page 611.

✓ **Studying the included presets is an excellent way to learn the workings of the Logical Editor! Many of them can also be used as starting points when you set up your own editing operations using the Logical Editor.**
About the Transformer MIDI effect

The Transformer effect is a real-time version of the Logical Editor, allowing you to apply editing to the events played back from a track “on the fly”. The Transformer contains virtually the same settings and functions as the Logical Editor – where there are differences between the two, this is clearly stated on the following pages.

About the Input Transformer

Again, this is very similar to the Logical Editor. Just like the Transformer effect, the Input Transformer works in real time. However, the Input Transformer filters out and transforms MIDI data as it is recorded. In other words, the settings you make in the Input Transformer will affect the actual MIDI events you record.

The Input Transformer is described on page 631. However, we recommend that you make yourself familiar with the Logical Editor first, since they share many features and principles.
Opening the Logical Editor

1. Select the desired parts or events.
   What will be affected by the operation depends on the current selection:
   • In the Project window, edits using the Logical Editor are applied to all selected parts, affecting all events (of the relevant types) in them.
   • In the MIDI editors, edits using the Logical Editor are applied to all selected events. If no events are selected, all events in the edited part(s) will be affected.
   You can change the selection while the Logical Editor window is open.

2. Select “Logical Editor…” from the MIDI menu.
   • For details on how to open the Transformer (and other MIDI effects) see the chapter “MIDI realtime parameters and effects”.

Window overview

This is the filter condition list, specifying which events to look for.

This is where you select a function (Transform, Delete, etc.). The field to the right shows an additional explanation of the selected function.

This is the action list, specifying e.g. how to change the found events.

This is where you load, store and handle presets. See page 630.

The “Do It” button performs the task you have set up (not available in the Transformer).
Selecting a preset

To understand the Logical Editor, it might be a good idea to start with exploring the included presets. These are found on the Presets pop-up menu at the bottom of the window, to the right.

- To load a preset, select it from the Presets pop-up menu. The window will show the settings stored in the preset. As the preset is not applied to the MIDI events yet, you can load different presets just to study them without affecting any events. You can also edit the preset before applying it.

- To apply the loaded preset (i.e. to perform the operations defined in the Logical Editor), click Do It.

- You can also select Logical Editor presets directly from the MIDI menu. This allows you to apply a preset to the selected MIDI part directly, without having to open the Logical Editor.

- It is also possible to select and apply Logical Editor presets directly in the List Editor (from the Mask menu). You can also open the Logical Editor from the List Editor. See page 583 for information about this.

For information on how to create and handle your own presets, see page 630.
Setting up filter conditions

General procedure

The upper list is where you set up the filter conditions, determining which events to find. The list contains one or several conditions, each on a separate line.

- If you want to start from scratch (as opposed to basing your settings on an existing preset) you may want to initialize the settings by selecting the Init option from the Presets pop-up menu.

- To add a new line (condition) click the Add Line button to the right. The new line is added at the bottom of the list. If there are many lines, you may need to use the scrollbar to the right to view them.

- To remove a line, click anywhere on it to select it and click the Delete Line button to the right.
You set up a filter condition line by clicking in the columns and selecting options from the pop-up menus that appear. Here is a brief description of the columns:

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Left bracket</td>
<td>This is used for “bracketing” several lines together when creating conditions with multiple lines and the boolean operators And/Or. See page 620.</td>
</tr>
<tr>
<td>Filter Target</td>
<td>Here you select which property to look for when finding events. Your choice here affects the available options in the other columns as well, see below!</td>
</tr>
<tr>
<td>Condition</td>
<td>This determines how the Logical Editor should compare the property in the Filter Target column to the values in the Parameter columns (Equal, Unequal, Bigger, etc. – see the separate table below). The available options depend on the Filter Target setting.</td>
</tr>
<tr>
<td>Parameter 1</td>
<td>Here you set which value the event properties should be compared to (a numeric value, a position or a choice from a pop-up menu, depending on the Filter Target). For example, if the Filter Target is “Position” and Condition is “Equal”, the Logical Editor will look for all events starting at the position you specify in the Parameter 1 column.</td>
</tr>
<tr>
<td>Parameter 2</td>
<td>This column is only used if you have selected one of the “Range” options in the Condition column. Typically, this allows you to find all events with values inside (or outside) the range between Parameter 1 and Parameter 2.</td>
</tr>
<tr>
<td>Bar Range</td>
<td>This column is only used if the Filter Target is “Position” and one of the “Bar Range” options is selected in the Condition column. In these cases, you use the Bar Range column to specify “zones” within each bar (allowing you to find e.g. all events on or around the first beat of every bar). See page 615.</td>
</tr>
<tr>
<td>Right bracket</td>
<td>This is used for “bracketing” several lines together. See page 620.</td>
</tr>
<tr>
<td>bool</td>
<td>This allows you to insert the boolean operators And/Or, when creating conditions with multiple lines. See page 620.</td>
</tr>
</tbody>
</table>
Conditions

The options in the Condition column have the following meaning (please note that the available Condition options depend on the Filter Target setting):

<table>
<thead>
<tr>
<th>Condition</th>
<th>Events will be found if their Filter Target property…</th>
</tr>
</thead>
<tbody>
<tr>
<td>Equal</td>
<td>…has the exact same value as set up in the Parameter 1 column.</td>
</tr>
<tr>
<td>Unequal</td>
<td>…has any value other than the one set up in the Parameter 1 column.</td>
</tr>
<tr>
<td>Bigger</td>
<td>…has a value higher than the one set up in the Parameter 1 column.</td>
</tr>
<tr>
<td>Bigger or Equal</td>
<td>…has a value that is the same as or higher than the one set up in the Parameter 1 column.</td>
</tr>
<tr>
<td>Less</td>
<td>…has a value lower than the one set up in the Parameter 1 column.</td>
</tr>
<tr>
<td>Less or Equal</td>
<td>…has a value that is the same as or lower than the one set up in the Parameter 1 column.</td>
</tr>
<tr>
<td>Inside Range</td>
<td>…has a value that is between the values set up in the Parameter 1 and Parameter 2 columns. Note that Parameter 1 should be the lower value and Parameter 2 the higher.</td>
</tr>
<tr>
<td>Outside Range</td>
<td>…has a value that is not between the values set up in the Parameter 1 and Parameter 2 columns.</td>
</tr>
<tr>
<td>Inside Bar Range</td>
<td>…is within the “zone” set up in the Bar Range column (Position only), in each bar within the current selection.</td>
</tr>
<tr>
<td>Outside Bar Range</td>
<td>…is outside the “zone” set up in the Bar Range column (Position only), in each bar within the current selection.</td>
</tr>
<tr>
<td>Note is equal to</td>
<td>…is the note specified in the Parameter 1 column, regardless of octave (Pitch only). Lets you find e.g. all C notes, in all octaves.</td>
</tr>
</tbody>
</table>

- The Conditions for the “Property” filter target are different, see page 619.

Below, the different Filter Targets (and their corresponding Condition and Parameter options) are described in more detail.
Searching for events at certain positions

Selecting Position in the Filter Target column lets you find events starting at certain positions, either relative to the start of the song or within each bar.

- If you select any condition other than the Range or Bar Range options, you set up a specific position (in bars, beats, sixteenth notes and ticks) in the Parameter 1 column.

```
<table>
<thead>
<tr>
<th>Filter Target</th>
<th>Condition</th>
<th>Parameter 1</th>
<th>Parameter 2</th>
<th>Bar Range</th>
<th>bool</th>
</tr>
</thead>
<tbody>
<tr>
<td>Position</td>
<td>Equal</td>
<td>5.1.1</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
```

Here, the Logical Editor will find all events at 5.1.1 in the project.

- If you select the Inside or Outside Range option in the Condition column, you set the start position of the range in the Parameter 1 column and the end position in the Parameter 2 column.

The Logical Editor will then find all events inside or outside this position range.

```
<table>
<thead>
<tr>
<th>Filter Target</th>
<th>Condition</th>
<th>Parameter 1</th>
<th>Parameter 2</th>
<th>Bar Range</th>
<th>bool</th>
</tr>
</thead>
<tbody>
<tr>
<td>Position</td>
<td>Inside</td>
<td>436</td>
<td>541</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
```

Here, the Logical Editor will find events starting around the second beat in each bar.
Searching for notes of certain lengths

Only note events have lengths (actually, a note is made up of separate note-on and note-off events but in Cubase SX/SL it’s considered as a single event with a length). Therefore, the “Length” Filter Target is only valid if you’re specifically searching for notes – there has to be another condition line with the Filter Target “Type”, Condition “Equal” and Parameter 1 set to “Note”. See page 620 for more about using multiple filter conditions.

Searching for Value 1 or Value 2

A MIDI event is composed of several values. The meanings of value 1 and 2 depend on the type of event:

<table>
<thead>
<tr>
<th>Event type</th>
<th>Value 1</th>
<th>Value 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Notes</td>
<td>The Note Number/Pitch.</td>
<td>The velocity of the note.</td>
</tr>
<tr>
<td>PolyPressure</td>
<td>The key that was pressed.</td>
<td>The amount of pressure for the key.</td>
</tr>
<tr>
<td>Controller</td>
<td>The type of Controller, displayed as a number.</td>
<td>The amount of Control Change.</td>
</tr>
<tr>
<td>Program Change</td>
<td>The Program Change number.</td>
<td>Not used.</td>
</tr>
<tr>
<td>Aftertouch</td>
<td>The amount of pressure.</td>
<td>Not used.</td>
</tr>
<tr>
<td>Pitchbend</td>
<td>The “fine tune” of the bend. Not always used.</td>
<td></td>
</tr>
</tbody>
</table>

- System Exclusive events are not included in the table above, since they don’t use value 1 and 2.

Since value 1 and 2 have different meanings for different events, searching for e.g. value 2 = 64 would both find notes with the velocity 64 and controllers with the amount 64, etc. If this is not what you want, you can add an additional filter condition line with the Filter Target “Type”, specifying which type of events to find (see below).

This is particularly useful when searching for note pitch or velocity values, as described below.
The general procedures when searching for value 1 or 2 are:

- If you select any Condition other than the Range options, you set up a specific value in the Parameter 1 column.

Here, the Logical Editor will find all events with a value 2 less than 80.

- If you select the Inside or Outside Range option in the Condition column, the range consists of the values between Parameter 1 and Parameter 2. Note that Parameter 1 should have the lower value.

### Searching for note pitch or velocity

If you add another condition line with the Filter Target “Type”, Condition “Equal” and Parameter 1 set to “Note”, the Logical Editor will “know” you are searching for pitch or velocity. This has the following benefits:

- The Filter Targets Value 1 and Value 2 will be displayed as “Pitch” and “Velocity” respectively, making it easier to grasp the function of the filter condition.
- Pitch values in the Parameter columns will be displayed as note names (C3, D#4, etc.). When entering pitch values you can either type a note name or a MIDI note number (0-127).
- When Value 1 (pitch) is selected as Filter Target, an additional option appears in the Condition column: “Note is equal to”. When this is selected, you specify a note name in the Parameter 1 column but without any octave number (C, C#, D, D#, etc.). The Logical Editor can then find all notes of a certain key, in all octaves.

See page 620 for more info on working with multiple filter condition lines.
Searching for controllers

There is similar extended functionality when searching for controllers: If you've added an additional “Type = Controller” condition line, the Logical Editor will “know” you are searching for controllers. The Parameter 1 column will then show the names of the MIDI controllers (Modulation, Volume, etc.) when Value 1 is selected as Filter Target.

Searching for MIDI channels

Each MIDI event contains a MIDI channel setting (1-16). Normally, these settings are not used, since the MIDI event plays back on the MIDI channel set for its track. However, you can come across MIDI parts with events set to different channels in the following scenarios for example:

• If you have recorded MIDI from an instrument sending on several different channels (e.g. a master keyboard with different key zones).
• If you have imported a MIDI file of type 0 (with a single track, containing MIDI events with different channel settings).

Searching for MIDI channel values is straightforward; you select a Condition and enter a MIDI channel (1-16) in the Parameter 1 column (and, if you’ve selected one of the Range Conditions, a higher channel in the Parameter 2 column, creating a value range).

Searching for event types

Selecting Type as the Filter Target allows you to find events of a certain type only.

• The Condition column contains only three options: Equal, Unequal and All Types.
• Clicking the Parameter 1 column displays a pop-up menu, listing the available event types (Note, PolyPressure, Controller, etc.).

The Logical Editor will find all events matching or not matching the selected type (depending on the Condition).

- As mentioned above, selecting Type = Note or Type = Controller adds some additional functionality to the Logical Editor. You should make it a habit to add a Type condition when applicable.
Searching for properties

On the Filter Target pop-up menu you will find an option called Property. This allows you to search for properties that are not part of the MIDI standard but rather event-specific Cubase SX/SL settings.

When the Property option is selected, the Condition column has two options: “Property is set” and “Property is not set”. Which property to look for is selected in the Parameter 1 column. The options are “muted”, “selected” and “locked”. Two examples:

<table>
<thead>
<tr>
<th>Filter Target</th>
<th>Condition</th>
<th>Parameter 1</th>
<th>Parameter 2</th>
<th>Bar Range</th>
<th>Ctrl</th>
</tr>
</thead>
<tbody>
<tr>
<td>Property</td>
<td>Property is set</td>
<td>Event is muted</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Here, the Logical Editor will find all muted events.

<table>
<thead>
<tr>
<th>Filter Target</th>
<th>Condition</th>
<th>Parameter 1</th>
<th>Parameter 2</th>
<th>Bar Range</th>
<th>Ctrl</th>
</tr>
</thead>
<tbody>
<tr>
<td>Property</td>
<td>Property is set</td>
<td>Event is selected</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Property</td>
<td>Property is not set</td>
<td>Event is muted</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Here, the Logical Editor will find all events that are selected but not muted.
Combining multiple condition lines

As described above, you can add condition lines by clicking the Add Line button to the right of the list. The result of combining condition lines depends on the boolean And/Or operators and the brackets.

The bool column

By clicking in the "bool" column to the right in the list, you can select a boolean operator: “And” or “Or”. A boolean operator separates two condition lines and determines the result in the following way:

- If two condition lines are separated by a boolean And, both conditions must be fulfilled for an event to be found.

  The Logical Editor will only find events that are notes and start at the beginning of the third bar.

- If two condition lines are separated by a boolean Or, one of the conditions (or both) must be fulfilled for an event to be found.

  The Logical Editor will find all events that are notes (regardless of their position) and all events starting at the beginning of the third bar (regardless of their type).

- When you add a new condition line, the boolean setting defaults to And. Therefore, if all you want to do is set up two or more conditions that all must be met for an event to be found, you don’t have to think about the boolean column – just add the required lines and make the usual filter settings.
Using brackets

The bracket (parenthesis) columns let you enclose two or more condition lines, dividing the conditional expression into smaller units. This is only relevant when you have three or more condition lines and want to use the boolean Or operator. This is how it works:

- **Without brackets, the conditional expressions are evaluated according to their order in the list.**

<table>
<thead>
<tr>
<th>Field Target</th>
<th>Condition</th>
<th>Parameter 1</th>
<th>Parameter 2</th>
<th>Bar Range</th>
<th>Bool</th>
</tr>
</thead>
<tbody>
<tr>
<td>Types</td>
<td>Equal</td>
<td>Note</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Pitch</td>
<td>Equal</td>
<td>C3</td>
<td></td>
<td>Or</td>
<td></td>
</tr>
<tr>
<td>Channel</td>
<td>Equal</td>
<td>1</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

In this case we have the expression Type = Note AND Pitch = C3 OR Channel = 1, without brackets. This means that the Logical Editor will find all MIDI notes with the pitch C3, as well as all events (regardless of their type) set to MIDI channel 1.

Maybe you wanted to find all notes that either had the pitch C3 or the MIDI channel 1 (but no non-note events)? Then you need to add some brackets:

<table>
<thead>
<tr>
<th>Field Target</th>
<th>Condition</th>
<th>Parameter 1</th>
<th>Parameter 2</th>
<th>Bar Range</th>
<th>Bool</th>
</tr>
</thead>
<tbody>
<tr>
<td>Types</td>
<td>Equal</td>
<td>Note</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Pitch</td>
<td>Equal</td>
<td>C3</td>
<td></td>
<td>Or</td>
<td></td>
</tr>
<tr>
<td>Channel</td>
<td>Equal</td>
<td>1</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Here the expression is Type = Note AND (Pitch = C3 OR Channel = 1), which will find what you want. The rule behind this is:

- **Expressions within brackets are evaluated first.**

If there are several layers of brackets, these are evaluated "from the inside out", starting with the innermost brackets.

You add brackets by clicking in the bracket columns and selecting an option. Up to triple brackets can be selected.
Editing filter conditions as text

The area directly below the filter condition list shows you the current filter conditions as text. It also allows you to enter and edit the filter conditions in textual form. For tips on the syntax, please study the included presets.

- There is no additional functionality involved when editing filter conditions as text; it is simply another way to make settings.

When you enter something in the text field you will see the corresponding settings appear in the filter condition list (provided that you have used the correct syntax).
Selecting a function

The pop-up menu in the top left corner of the Logical Editor is where you select the function – the basic type of editing to be performed. When you select an option from the pop-up menu, the field to the right displays a clarifying text, making it easier to see what the function does.

In the Logical Editor, processing isn’t performed until you click the Do It button. When using the Transformer MIDI effect there is no Do It button – the current settings are automatically applied in real time during playback or live playing.

Below, the available options are listed. Note that some options are available in the Logical Editor only – not in the Transformer effect.

Delete

Deletes all events found by the Logical Editor. In the case of the Transformer, this function will remove (or “mute”) all found events from the “output stream” – the actual events on the track are not affected.

Transform

Changes one or several aspects of the found events. You set up exactly what should be changed in the action list, as described on page 625.

Insert

This will create new events and insert these into the part(s) (Logical Editor) or the output stream (Transformer). The new events will be based on the events found by the Logical Editor’s filter conditions, but with any changes you have set up in the action list applied.

Another way of expressing this is that the Insert function copies the found events, transforms them according to the action list and inserts the transformed copies among the existing events.
Insert Exclusive

This will transform the found events according to the action list. Then, all events that were not found (that didn’t meet the filter conditions) are deleted (Logical Editor) or removed from the output stream (Transformer).

Copy (not available in the Transformer)

This will copy all found events, transform them according to the action list and paste them into a new part on a new MIDI track. The original events are not affected.

Extract (not available in the Transformer)

This works like Copy, but will cut the found events instead. Or in other words, Extract will transform all found events and move them to a new part on a new MIDI track.

Select (not available in the Transformer)

This will simply select all found events, highlighting them for further work in the regular MIDI editors.
Specifying actions

The lower list in the Logical Editor window is the action list. This is where you specify any changes that should be made to the found events (relevant for all function types except Delete and Select).

The handling of the action list is similar to the filter condition list, but without the brackets and booleans. You simply add lines by clicking the Add Line button to the right, and fill out the columns as required. To remove a superfluous action line, select it and click the Delete Line button.

Below, the four list columns are described:

**Action Target**

This is where you select the property that should be changed in the events:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Position</td>
<td>Adjusting this value will move the events.</td>
</tr>
<tr>
<td>Length</td>
<td>Lets you resize the events (notes only).</td>
</tr>
<tr>
<td>Value 1</td>
<td>This adjusts value 1 in the events. As described on page 616, the meaning of value 1 depends on the event type. For notes, value 1 is the pitch.</td>
</tr>
<tr>
<td>Value 2</td>
<td>This adjusts value 2 in the events. As described on page 616, the meaning of value 2 depends on the event type. For notes, value 2 is the velocity value.</td>
</tr>
<tr>
<td>Channel</td>
<td>Allows you to change the MIDI channel setting. See page 618.</td>
</tr>
<tr>
<td>Type</td>
<td>Allows you to change an event from one type to another, e.g. transform aftertouch events to modulation events.</td>
</tr>
<tr>
<td>Value 3</td>
<td>This adjusts value 3 in the events. At the time of this writing, this option is only implemented for notes and corresponds to the note off value.</td>
</tr>
</tbody>
</table>
Operation

This setting determines what to do with the Action Target. The options on this pop-up menu are different depending on the selected Action Target. Below, all available operations are listed:

Add

Adds the value specified in the Parameter 1 column to the Action Target.

Subtract

Subtracts the value specified in the Parameter 1 column from the Action Target.

Multiply by

Multiplies the Action Target value with the value specified in the Parameter 1 column.

Divide by

Divides the Action Target value with the value specified in the Parameter 1 column.

Round by

This “rounds” the Action Target value with the value specified in the Parameter 1 column. In other words, the Action Target value is changed to the closest value that can be divided by the Parameter 1 value.

For example, if the Action Target value is 17 and Parameter 1 is 5, the result of rounding will be 15 (the closest value that can be divided by 5). Another word for this type of operation would be “quantizing”, and it’s actually possible to use it for this, by setting the Action Target to “Position” and specifying a quantize value with Parameter 1 (in ticks, with 480 ticks per quarter note).

Set Random Values between

This will set the Action Target value to a random value within the range specified with Parameter 1 and 2.
Set Relative Random Values between

This will add a random value to the current Action Target value. The added random value will be within the range specified with Parameter 1 and 2. Note that these can be set to negative values.

For example, if you set Parameter 1 to -20 and Parameter 2 to +20, the original Action Target value will get a random variation, never exceeding ±20.

Set to fixed value

This sets the Action Target to the value specified in the Parameter 1 column.

Add Length

This is only available when Action Target is set to Position. Furthermore, it is only valid if the found events are notes (and thus have a length). When Add Length is selected, the length of each note event will be added to the Position value. This can be used for creating new events (using the Insert function) positioned relative to the end positions of the original notes.

Transpose to Scale

This is only available when Action Target is set to Value 1, and when the filter conditions are specifically set up to find notes (a “Type = Note” filter condition line has been added). When “Transpose to Scale” is selected, you can specify a musical scale using the Parameter 1 and 2 columns. Parameter 1 is the key (C, C#, D, etc.) while Parameter 2 is the type of scale (major, melodic or harmonic minor, etc.).

Each note will be transposed to the closest note in the selected scale.
**Use Value 2**

This is only available when Action Target is set to Value 1. If this option is selected, the Value 2 setting in each event will be copied to the Value 1 setting.

For example, this would be useful if you are transforming all Modulation controllers to Aftertouch events (since controllers use Value 2 for their amount, while Aftertouch uses Value 1 – see the table on page 616).

**Use Value 1**

This is only available when Action Target is set to Value 2. If this option is selected, the Value 1 setting in each event will be copied to the Value 2 setting.

**Mirror**

This is only available when Action Target is set to Value 1 or Value 2. When this option is selected, the values will be “mirrored” or “flipped” around the value set in the Parameter 1 column.

In the case of notes, this will invert the scale, with the key set in the Parameter 1 column as “center point”.

**Linear Change in Loop Range**

This will affect events within the loop range (between the left and right locators) only. It will create a linear “ramp” of values (replacing the original values) starting at the value in the Parameter 1 column and ending at the Parameter 2 value.

This can be used for creating linear controller sweeps, velocity ramps, etc.
Relative Change in Loop Range

As with the previous option, this will create a ramp of values, affecting events in the cycle loop range only. However, here the changes are “relative”, meaning that values will be added to the existing values.

In other words, you set up a value ramp starting at Parameter 1 and ending at Parameter 2 (note that the Parameter values can be negative). The resulting value ramp is then added to the existing values for the events within the cycle loop range.

For example, if you apply this to note velocities with Parameter 1 set to 0 and Parameter 2 set to -100, you create a velocity fade-out, keeping the original velocity relations:

Applying the defined actions

Once you have set up filter conditions, selected a function and set the required actions (or loaded a preset), you apply the actions defined with the Logical Editor by clicking the Do It button.

Logical Editor operations can be undone just like any other editing.

- Again, when using the Transformer MIDI effect there is no Do It button. The processing is applied to the events played back from the track (or played live “thru” the track) as soon as you set it up. Since no existing events on the track are affected by the Transformer setting, there is no need for undo.
Working with presets

The Presets section in the bottom right section of the window allows you to load, store and manage Logical Editor presets. A preset contains all settings in the window, which means you can simply load a preset and click Do It.

• To load a preset, select it from the Presets menu.

Storing your own settings as a preset

If you have made Logical Editor settings that you want to use again, you can store them as a preset:

1. You can enter some explanatory text in the Comment field. An extra description of the preset can be useful, especially if the settings are complex.

2. Click the Store button in the Presets section. A dialog for specifying a name for the new preset is displayed.

3. Enter a name for the preset and click OK. The preset is stored.

• To remove a preset, load it and click the Remove button.

Organizing and sharing presets

The Logical Editor presets are stored as individual files within the Cubase SX/SL program folder, in the presets\Logical Edit subfolder. While these files cannot be edited “manually”, you can reorganize them (e.g. putting them in subfolders) like any files.

This also makes it easy to share presets with other Cubase SX/SL users, by transferring the individual preset files.

• The list of presets is read each time the Logical Editor is opened.
The Input Transformer

This function allows you to selectively filter out and change MIDI data coming to a MIDI track before it is recorded. The Input Transformer is very similar to the Transformer MIDI effect, but contains four independent “modules”, for which you can set up different filtering and actions if you like. You can activate any or all of these four modules.

Here are some of the things the Input Transformer allows you to do:

- Set up split keyboard combinations for recording left and right hands separately.
- Turn a controller like a foot pedal into MIDI notes (for playing bass drum the right way).
- Filter out one specific type of MIDI data on one MIDI channel only.
- Turn aftertouch into any controller (and vice versa).
- Invert velocity or pitch.

And again: four of these things can be done at the same time.

Opening the Input Transformer

To open the Input Transformer for a MIDI track, select the track and click the Input Transformer button in the Inspector to open the pop-up menu:

- Select Global to make Input Transformer settings that affect all MIDI inputs (and thereby all MIDI tracks).
- Select Local to make Input Transformer settings for this track only.
In both cases, the button lights up and the Input Transformer window opens.

Handling the four modules

The Input Transformer is really four separate transformers, or modules.

• You select which module to view and make settings for by clicking its button in the Selected Module section.

Module 2 selected for viewing and editing.

• The checkboxes in the Active Module section determine which module(s) are active.

Here, modules 1, 2 and 4 are active.
The two modes

The Mode pop-up menu contains two options: Filter and Transform.

• In Filter mode, only the filter conditions (the upper list) are taken into account. All events matching the conditions set up will be filtered out (excluded from the recording).

• In Transform mode, events matching the filter conditions will be transformed according to the settings in the action list (the lower list).

Setting up filtering and actions

This is done just like in the Logical Editor. Here is a brief rundown:

• Click the Add Line buttons to add lines to the filter condition list or action list.
  To remove a line, click it to select it and click the Delete Line button to the right.

• Clicking the columns in the filter condition list opens pop-up menus allowing you to specify the conditions to match.

• Clicking the columns in the action list opens pop-up menus allowing you to specify what should be done to the found events (when Transform mode is selected).

  For detailed descriptions of the filter conditions and action columns, see page 612.

• Selecting the Init option from the Presets pop-up menu will reset the selected module, removing all filter condition and target list lines.

• The Input Transformer has no “Do It” button – the settings are active as soon as you activate an Active Module checkbox.
  The settings made in the activated modules will affect all MIDI data recorded on the track.
• Closing the Input Transformer window does *not* turn it off – you need to deactivate all Active Module checkboxes for this!
  A lit Input Transformer button indicates that one or more modules are active.
Working with the Tempo track
Background

For each audio or MIDI track in Cubase SX/SL, you can specify whether it should be time based or tempo based (see page 113). For tempo based tracks, the tempo can either be fixed through the whole project (this is called “Fixed tempo mode”) or follow the Tempo track (this is called “Tempo track mode”), which may contain tempo changes.

- To switch between Fixed tempo mode and Tempo track mode, use the Tempo button on the Transport panel:

  ![Transport panel with Tempo button](image)

  When the Tempo button is lit (and the text “Track” is shown), the tempo follows the Tempo track, when it is deactivated (and the text “Fixed” is shown), the Fixed tempo is used (see page 644). You can also switch tempo mode in the Tempo Track Editor (see below).

The Tempo track also contains time signature events. These are always active, regardless of whether Fixed tempo mode or Tempo track mode is selected.

A note about tempo based audio tracks

For tempo based tracks, the start time position of audio events depends on the current tempo setting. However, it is important to realize that the actual audio (“within” the events) will play back as recorded, regardless of any tempo changes you make. Therefore, it’s good practice to make the proper tempo and time signature settings before you start recording tempo based audio.

- To make an already recorded audio track follow the tempo changes, you can use the Hitpoints and Slicing features, as described on page 398. How well this works depends on the character of the audio recordings, since the Hitpoint detection feature works best with fairly rhythmical material.

- To adapt the tempo track to time based material, you can use the Time Warp tool, as described on page 650. This allows you to adjust the tempo track so that tempo-based material (e.g. positions in music) coincides with time-based material (e.g. positions in narration, video, etc.).
The Tempo Track Editor – overview

To make changes to the actual Tempo track you need to open the Tempo Track Editor, by selecting “Tempo Track” on the Project menu.

The toolbar

The toolbar contains various tools and settings. The tempo and time signature displays to the right allow you to view and edit the value of the selected tempo curve point or time signature event, much like the info line in other editors.
The ruler

The ruler in the Tempo Track Editor shows the timeline. As in other windows, you can select a display format by clicking on the arrow button to the right of the ruler, and selecting an option from the pop-up menu that appears.

The two additional items at the bottom of the menu have the following functionality:

- If “Time Linear” is selected, the ruler, time signature area and tempo curve display will be linear in relation to the timeline. This means that if the ruler shows bars and beats, the distance between the bar lines will vary depending on the tempo.

- If “Bars+Beats Linear” is selected, the ruler, time signature area and tempo curve display will be linear in relation to beats. If the ruler shows bars and beats, the distance between beats will be constant.
The time signature area

The area below the ruler contains time signature events.

The tempo curve display

The main display shows the tempo curve (or, if Fixed tempo mode is selected, the Fixed tempo – see page 644). To the left of the display is a tempo scale to help you quickly locate the desired tempo.

• Note that the vertical “grid lines” correspond to the display format selected for the ruler.
Operations

Zooming

Changing the magnification is done using any of the following methods:

• By using the zoom sliders in the lower right corner of the window.

• By using the Magnifying Glass tool.
  This works according to the standard procedures.

• By using the Zoom submenu on the Edit menu.
  The options on the menu work as in other windows.

Editing the tempo curve

This section assumes that you are working in Tempo track mode, i.e. the Tempo button is lit on the Transport panel.

Adding tempo curve points

1. Use the “insert curve” pop-up menu in the toolbar to select whether you want the tempo to change gradually from the previous curve point to the new one (“Ramp”) or change instantly to the new value (“Jump”).

2. Select the Pencil tool.

3. Click at the desired time position in the tempo curve display, and keep the mouse button pressed.
   If Snap is activated on the toolbar, this determines at which time positions you can insert tempo curve points, see page 646.

When you click, the tempo display in the toolbar shows the tempo value.
4. Drag the curve point to the desired tempo value (indicated in the tempo display), and release the mouse button.
   The tempo curve point is inserted. The result depends on whether you selected “Ramp” or “Jump” in step 1 above:
   
   Insert curve set to “Ramp”:
   
   ![Ramp Curve Example]
   
   Insert curve set to “Jump”:
   
   ![Jump Curve Example]

   • You can also just click and draw a tempo curve with the Pencil tool, having curve points automatically inserted as you draw.
   You would probably want to select the “Ramp” Insert Curve mode when doing this.

   • Instead of using the Pencil tool, you can press [Alt]/[Option] and use the Arrow tool.
   This will only insert a single point (i.e. you cannot draw a curve with the Arrow tool).

   ❑ You can also have tempo values automatically inserted by the Beat Calculator, see page 647.

Selecting tempo curve points

Selecting curve points is done using any of the following methods:

• Use the Arrow tool.
   The standard selection techniques apply.

• Use the Select submenu on the Edit menu.
   The options are:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>All</td>
<td>Selects all curve points on the Tempo track.</td>
</tr>
<tr>
<td>None</td>
<td>Deselects all curve points.</td>
</tr>
<tr>
<td>In Loop</td>
<td>Selects all curve points between the left and right locator.</td>
</tr>
<tr>
<td>From Start to Cursor</td>
<td>Selects all points to the left of the project cursor.</td>
</tr>
<tr>
<td>From Cursor to End</td>
<td>Selects all points to the right of the project cursor.</td>
</tr>
</tbody>
</table>
You can also use the left and right arrow keys on the computer keyboard, to go from one curve point to the next. If you press [Shift] and use the arrow keys, the current selection will be kept, allowing you to select several points.

**Editing tempo curve points**

Curve points can be edited in the following ways:

- By clicking and dragging horizontally and/or vertically. If several points are selected, all of them are moved. If Snap is activated on the toolbar, this determines to which time positions you can move curve points, see page 646.
- By adjusting the tempo value in the tempo display on the toolbar. For this to work, a single tempo curve point must be selected.

Dragging tempo curve points with a time based display format (any other format than “Bars+Beats”) may give confusing results. This is because moving a point will change the relationship between tempo and time. Specifically, let's say you move a tempo point to the right and drop it on a certain time position. When you release the mouse button, the mapping between tempo and time will be adjusted (since you have changed the tempo curve). As a result, the moved point will appear at another position. For this reason, we recommend that you use the Bars+Beats display format when editing tempo curves.
**Adjusting the curve type**

You can change the curve type of a tempo curve segment at any time, using the following method:

1. Select all curve points within the segment you want to edit.

![Curve Type Selection](image)

2. Pull down the Curve pop-up menu on the toolbar and select “Jump” or “Ramp”.

   The curve sections between the selected points are adjusted.

![Curve Type Options](image)

**Removing tempo curve points**

To remove a curve point, either click on it with the Eraser tool or select it and press [Backspace]. The first tempo curve point cannot be removed.

**Recording tempo changes**

The tempo record slider on the toolbar allows you to record tempo changes “on the fly”: simply start playback and use the slider to raise or lower the tempo at the desired positions. Useful for creating natural sounding ritardandos, etc.
Setting the Fixed tempo

When the Tempo track button is deactivated, the Tempo track curve is greyed out (but still visible). Since the Fixed tempo is constant throughout the whole project, there are no tempo curve points. Instead, the Fixed tempo is displayed as a horizontal black line in the tempo curve display.

There are two ways to set the tempo in Fixed mode:

- Drag the tempo line up or down with the Arrow tool.
- Adjust the value numerically in the tempo display on the toolbar.
Adding and editing time signature events

- To add a time signature event, click in the time signature area with the Pencil tool. This adds a default 4/4 time signature event at the closest bar position. You can also do this by pressing [Alt]/[Option] and clicking with the Arrow tool.

- To edit the value of a time signature event, select it and adjust the value in the signature display on the toolbar. Note that there are two thumbwheel controls for the signature display; the left adjusts the numerator and the right adjusts the denominator.

- You can move a time signature event by clicking and dragging it with the Arrow tool. Again, note that time signature events can only be positioned at the start of bars.

- To remove a time signature, either click on it with the Eraser tool or select it and press [Backspace]. The first time signature event cannot be removed.

Exporting and importing Tempo tracks

You can export the current tempo track for use in other projects by selecting “Tempo Track” from the “Export” submenu on the File menu. This allows you to save the tempo track information (including time signature events) as a special xml file (file extension “.smt”).

To import a saved tempo track, select “Tempo Track” from the “Import” submenu on the File menu. Note that this replaces all tempo track data in the current project (although the operation can be undone if needed).
Options and settings

Snap

You activate or deactivate Snap by clicking the Snap icon on the tool-
bar. The behavior of the function depends on the display format se-
lected for the ruler:

• If “Bars+Beats” is selected, tempo curve points will snap to the start
  of bars.

• If any other display format is selected, tempo curve points will snap to
  the vertical grid lines in the tempo curve display.
  The spacing of the grid lines depends on the horizontal magnification.

• Time signature events can only be positioned at the start of bars, re-
  gardless of whether Snap is activated or not.

Autoscroll

When this option is activated, the tempo curve display will scroll dur-
ing playback, keeping the project cursor visible.
The Beat Calculator

The Beat Calculator is a tool for calculating the tempo of freely recorded audio or MIDI material. It also allows you to set the tempo by tapping.

Calculating the tempo of a recording

1. In the Project window, make a selection that covers an exact number of beats of the recording.


3. Enter the number of beats that the selection encompasses in the Beats field. The corresponding tempo is calculated and displayed in the BPM field.

   - If you need to adjust the selection, you can just go back to the Project window, leaving the Beat Calculator open. To re-calculate the tempo after adjusting the selection, click Refresh.

4. If you like, you can insert the calculated tempo into the Tempo track, by clicking one of the buttons in the lower left corner of the Beat Calculator window.
   Clicking “At Tempo Track Start” will adjust the first tempo curve point, while “At Selection Start” will add a new tempo curve point at the selection’s start position, using the “Jump” curve type (see page 640).

   - If Fixed tempo mode is selected when you insert the calculated tempo, the Fixed tempo will be adjusted, regardless of which button you click.
Using Tap Tempo

The Tap Tempo function allows you to specify a tempo by tapping:

1. Open the Beat Calculator.

2. If you want to tap the tempo to some recorded material, activate playback.

3. Click the Tap Tempo button.
   The Tap Tempo window appears.

4. Tap the tempo on the computer keyboard's space bar or with the mouse button.
   The tempo display will update the calculated tempo between each tap.

5. When you stop tapping, the program calculates the average timing of the taps and displays it.

6. Click OK to close the Tap Tempo window.
   The tapped tempo is now shown in the Beat Calculator's BPM display. If you like, you can insert it into the Tempo track as described on the previous page.
Merge Tempo From Tapping

This function allows you to create a complete tempo track based on your tapping. Typically, you would use this if you have an audio file with no tempo mapping, and want to be able to add sequenced material afterwards, etc.

1. Create an empty time-based MIDI track and, while playing back your audio material, tap the new tempo on your MIDI keyboard and record the created notes onto the new MIDI track.
   Note that you must create note events – pedal events cannot be used for this function.

2. Play back the audio and check that the timing of the MIDI notes corresponds to that of the audio.
   If necessary edit the MIDI notes in an editor.

3. Select the part (or the individual notes, in an editor) that you want to use for the calculation.

4. Select "Merge Tempo From Tapping" from the Functions submenu on the MIDI menu.
   A dialog opens.

5. In the dialog, specify what type of note (1/2, 1/4 etc.) you tapped during the recording.
   If you activate the "Begin at Bar Start" option, the first note will automatically start at the beginning of a bar when calculating the new tempo curve.

6. Click OK.
   The project’s tempo is adjusted to the tapped notes.

7. Open the Project menu and select "Tempo Track" to check that the new tempo information is reflected in the tempo curve.

   • Another way of creating a tempo map for freely recorded audio would be to use the Time Warp tool – see page 650.
The Time Warp tool

The Time Warp tool lets you adjust the Tempo track so that “musical time based” material (positions related to the tempo) matches “linear time based” material (positions in time). Some typical applications:

• When you have recorded music (audio or MIDI) without tempo reference or metronome click – the Time Warp tool can be used for creating a tempo map that fits the recording (allowing you to rearrange or add sequenced material).

• When you are creating music for a movie and want to match certain positions in the video with certain positions in the music.

The Time Warp tool makes use of the fact that tracks can be based on time positions (linear time base) or positions related to tempo (musical time base) – see page 113 for a description of these modes.

Basic procedure

You use the Time Warp tool to drag a musical position (a position in bars+beats format) to a certain position in time. This can be done in the Project window or in editor windows, as described below. Here is the general procedure:

1. Make sure Tempo track mode is selected.
   You cannot use the Time Warp tool in Fixed tempo mode.

2. Select the Time Warp tool.

   Bars+Beats format is automatically selected for the ruler in the active window and the ruler is shown in dark red.

3. Click in the window at a musical position and drag it so that it matches a position in the material you are editing – e.g. the start of an event, a certain “hit” within an audio event, a frame in a video clip, etc.
   When you click with the Time Warp tool it snaps to the grid in the window.
Dragging the start of bar 9 to the start of the audio event.

While you are dragging, the track(s) you are editing are temporarily switched to linear time base – this means that the contents of the tracks remain at the same time positions regardless of the tempo (there is an exception to this in the Project window – see below).

4. When you release the mouse button the musical position you clicked on matches the time position you dragged it to. This is because the Time Warp tool changed the last tempo event on the Tempo track (and/or added new ones, depending on window and usage), thereby scaling the tempo track to fit.

Rules

• When you use the Time Warp tool, the tempo value of the last tempo event (before the click position) is adjusted.

• If later tempo events exist, a new tempo event will be created at the click position. This way, the later tempo event(s) will not be moved.

• If you press [Shift] and use the Time Warp tool, a new tempo event is created at the click position. [Shift] is the default modifier for this – you can adjust this in the Preferences dialog (Editing-Tool Modifiers page, under the Warp Tool category).

• If you use the Time Warp tool in an editor, a tempo event will be created at the start of the edited part or event. Only the track being edited will be affected – but note that events after the edited events or parts (on the edited track) will be affected as well.

• If you have made a selection range (in the Project window, Audio Part Editor or Sample Editor) and use the Time Warp tool within that range, the tempo changes will be confined to that range. This means tempo events will be inserted at the start and end of the selection range, if needed – useful if you need to adjust the tempo within a certain area but want all material outside that range to stay in place.

• When you click with the Time Warp tool, it snaps to the tempo grid in the window.
• When you drag the tempo grid to a new position, it can be magnetic to events in the window.
  In the Project window, this requires that Snap is activated and “Events” is selected on the Snap pop-up menu – the grid will then snap to the start and end of events or parts, and to markers. In the Sample Editor, this requires that Snap to Zero Crossings is activated – the grid will then snap to hitpoints (if any). In the MIDI editors, this requires that Snap is activated – the grid will then snap to the start and end of notes.
• The function will create tempo values up to 300 bpm.

**Viewing and adjusting tempo events**

When you select the Time Warp tool, the ruler of the active window is shown in dark red. Existing tempo events are shown in the ruler as “flags” with the tempo values displayed.

This helps you see what’s going on, but you can also use this for editing the tempo track:

• If you press the create/erase modifier key (by default [Shift]) and click on a tempo event in the ruler, it is deleted.

• You can click on a tempo event in the ruler and drag to move it. This automatically edits the tempo value in the event so that elements to the right keep their positions.

• If you press [Alt]/[Option] and move (or delete) a tempo event in the ruler, the tempo value is not adjusted – this means elements to the right will be moved.
  This is the default modifier key for this – you can adjust this in the Preferences dialog (Editing-Tool Modifiers page, under the Warp Tool category).
Using the Time Warp tool in the Project window

In the Project window there are two modes for the Time Warp tool:

- In the default mode, all tracks are temporarily switched to linear time base when you use the tool. This means that all tracks will keep their absolute time positions when you adjust the tempo track.
- In the “musical events follow” mode, no tracks are switched to linear time base. This means that all tracks (that are not set to linear time base) will follow the changes you make to the tempo track.

You select the Time Warp mode by selecting the tool, clicking on the tool icon and selecting from the pop-up menu that appears.

Matching a musical score to video

Here’s an example of how to use the Time Warp tool in “musical events follow” mode. Let’s say you are creating the music for a film. You have a video track, an audio track with a commentary and some audio and/or MIDI tracks with your music. Now you want to match the position of a musical cue to a position in a video film. The musical cue happens in bar 33. There are no tempo changes in the project (yet).

1. Make sure tempo track mode is selected in the Transport panel.

2. Now you need to locate the position in the video. If you don’t need very high precision, you can simply locate it looking at the thumbnails on the video track – otherwise you can pinpoint the exact position and add a marker to the Marker track (that you can snap to later on). If you are using Cubase SX, you could also make a note of the exact position and add an extra ruler track set to show time code.
3. Make sure the correct tracks are set to linear time base or musical time base, respectively.
   In our example we want the video track and the audio track with a commentary voiceover to be linear time based (as well as the marker track, if you are using one). All other tracks should be set to musical time base. You change this by clicking the time base button in the Track list or Inspector.

4. Set up the Grid Type pop-up menu as desired.
   When you click with the Time Warp tool, it snaps to the selected grid. In this case, the musical cue happens at the start of bar 33, so we can set the grid to “Bar”.
   - Note that this affects the snapping to the ruler (tempo grid) when you click! In addition, the tool can be “magnetic” to events in the Project window when you drag – for this you need to activate Snap and select “Events” on the Snap pop-up menu.
   In our example, this would be useful if you created a marker at the desired position in the video – when you drag the grid (see below), it will snap to the marker.

5. Select the Time Warp tool and select the “musical events follow” mode.
6. Click in the event display at the start of bar 33 and drag to the desired position in the video. As mentioned above, this can mean dragging to a position indicated by the thumbnails on the video track, to a marker on the Marker track or to a time position on an additional ruler track (Cubase SX only).

When you drag, you will see the ruler being scaled – and the music tracks will follow.

7. Release the mouse button.
If you look in the ruler at the beginning of the project, you will see that the first (and only) tempo event has been adjusted.

8. Try playing back.
The musical cue should now happen at the correct position in the video.

OK, let’s say you need to match another cue to another position later on in the video. If you simply repeat this procedure, you will find that the first cue gets out of sync – since you are still changing the first (and only) tempo event on the Tempo track!
You need to create a “lock point” – a tempo event at the first cue position:

9. Press [Shift] and click with the Time Warp tool in the event display at the cue position.
   In our case this is bar 33.

As you can see, a tempo event (with the same value as the first one) is added at that position.

10. Now match the next musical cue to the next video position, by dragging the musical position to the desired time position as before.
    The new tempo event is edited – the first tempo event is unaffected and the original cue is still matched.

• If you know you are going to match several cues this way, you should make it a habit to press [Shift] each time you use the Time Warp tool to match positions.
    This adds a new tempo event – that way you don’t have to add tempo events afterwards as in step 9 above.

About snapping

If Snap is activated in the Project window and “Events” is selected on the Snap pop-up menu, the Time Warp tool will be magnetic to events when you drag the tempo grid. This makes it easier to snap a tempo position to a marker, the start or end of an audio event, etc.
Using the Time Warp tool in an audio editor

Using the Time Warp tool in the Sample Editor or Audio Part Editor is different from using it in the Project window, in the following ways:

- When you use the Time Warp tool, a tempo event is automatically inserted at the beginning of the edited event or part – this tempo event will be adjusted when you warp the tempo grid with the tool. This means that material before the edited events won’t be affected.
- There is only one mode for the Time Warp tool in the audio editors: When you use the tool, the edited track is temporarily switched to linear time base.

Making a tempo map for a “free” recording

The following example shows how to use the Time Warp tool in the Sample Editor to create a tempo map matching freely recorded music. Let’s say you have recorded a drummer, playing without a metronome – this typically means the tempo varies ever so slightly. To be able to add sequenced material and easily rearrange the recorded audio, you want the tempo in Cubase SX/SL to match the recorded drum track:

1. If necessary, move the recorded event to its desired start position.
   Move it so that the first downbeat ("one") happens on the start of the desired bar – zoom in if needed.

2. Open the drum recording in the Sample Editor and make sure Hitpoint mode isn’t selected.
   The Time Warp tool cannot be used in Hitpoint mode – however, if you have calculated hitpoints already these will be visible when the Time Warp tool is selected (see below).

3. Set the zoom so that you can see the individual drum hits clearly.
   To achieve this type of “visual” beat matching, it’s important to have a fairly clean recording, such as the drum track in this example.

4. Select the Time Warp tool.
   You have already matched the first downbeat with the start of a bar. However, if the recording starts before the first downbeat (with a fill, some silence, etc.) you want to “lock” the first downbeat so that it stays in position:
5. Press [Shift] and click in the event at the position of the first downbeat (the start of the bar).
When you press [Shift], the pointer turns into a pencil. Clicking adds a tempo event at the first downbeat – when you later adjust the tempo with the Time Warp tool, the first downbeat will stay in place. Note: if the event started exactly on the first downbeat (no audio before the "one") you wouldn’t need to do this. This is because a tempo event is automatically added at the start of the edited event.

6. Now, locate the start of the next bar in the ruler.

7. Click at that position in the event display and drag the position to the downbeat of the second bar in the recording.
When you click, the pointer will snap to the ruler grid.

You mustn’t necessarily match the downbeats (“ones”) – in this figure beat “2” in the second bar is matched to the “two” in the recording’s second bar (simply because the snare drum hits on the upbeats are easier to spot in the waveform image).

When you dragged the grid you changed the tempo value in the tempo event at the first downbeat. If the drummer held a fairly consistent tempo, the following bars should now match pretty well too.

8. Check the following bars and locate the first position where the audio drifts from the tempo.
Now, if you simply adjusted that beat in the tempo grid to match the beat in the recording, the tempo event at the first downbeat would be changed – this would ruin the match in the previous bars! We need to lock these by inserting a new tempo event.

9. Locate the last beat that's in sync.
   This would be the beat just before the position where the audio and tempo drift apart.

10. Press [Shift] and click at that position to insert a tempo event there.
    This locks this matched position – the material to the left will not be affected when you make adjustments further along.

11. Now match the tempo grid to the next (unmatched) beat by clicking and dragging with the Time Warp tool.
    The tempo event you inserted in step 10 will be adjusted.

12. Work your way through the recording this way – when you find that the recording drifts from the tempo, repeat steps 9 to 11 above.
    Now the Tempo track follows the recording and you can add sequenced material, rearrange the recording etc.

Matching to hitpoints

If you have calculated hitpoints for the audio event you are editing, these will be shown when the Time Warp tool is selected.

- The number of hitpoints shown depends on the Hitpoint Sensitivity slider setting you've made in Hitpoint mode.
- If you activate the Snap to Zero Crossing button on the toolbar, the Time Warp tool will snap to hitpoints when you drag the tempo grid.
- If you use the Create Markers function on the Audio-Advanced submenu, markers will be created at the hitpoint positions. This can be useful when using the Time Warp tool in the Project window, as the tool will be magnetic to markers (if Snap to Events is activated on the toolbar).
Using the Time Warp tool in a MIDI editor

This is very similar to using the tool in an audio editor:

• When you use the Time Warp tool, a tempo event is automatically inserted at the beginning of the edited part – this tempo event will be adjusted when you warp the tempo grid with the tool. This means that material before the edited part won’t be affected.

• There is only one mode for the Time Warp tool in the MIDI editors: When you use the tool, the edited MIDI track is temporarily switched to linear time base.

• The rulers in the MIDI editors can be set to “Time Linear” or “Bars+Beats Linear” mode (see page 531) – the Time Warp tool requires Time Linear mode. If necessary, the ruler mode will be switched when you select the Time Warp tool.

• If Snap is activated on the toolbar in the MIDI editor, the tool will snap to the start and end of MIDI notes when you drag the tempo grid.

Typically, you would use the Time Warp tool in a MIDI editor to match the Cubase SX/SL tempo to freely recorded MIDI material (much like the audio example above).
The Project Browser
Background

While the Project window and the editors display events and other data graphically, the Project Browser window provides a list based representation of the project. This allows you to view and edit all events on all tracks by using regular value editing in a list.

Opening the Project Browser

You open the Project Browser by selecting “Browser” from the Project menu. The Browser window can be open while you are working in other windows; any changes made in the Project window or an editor are immediately reflected in the Project Browser and vice versa.

Window Overview

The time Format (display format) pop-up menu. The Add pop-up menu and Add button, for creating new parts, events and regions. The Filter pop-up menu, used when editing MIDI.

The Project Structure list. This is where you navigate through the project. The event display. This is where you view and edit parts, events and Regions.
Navigating in the Browser

You use the Project Browser much like you use the Mac OS X Finder and Windows Explorer for browsing folders on your hard disk:

• Click on an item in the Project Structure list to select it for viewing. The contents of the item are shown in the event display.

In this figure, the parts on a MIDI track are displayed.

• Items with hierarchical substructures can be folded out by clicking the plus symbols or the "closed folder" symbols in the Project Structure list. When the substructure of an item is revealed, a minus symbol or an "open folder" symbol is shown instead – click this to hide the substructure.

• To reveal or hide all substructures in the Project Structure list, use the buttons "(+) All" and "(–) All" above the list.

• The actual editing is done in the event display, using regular value editing techniques. There is one exception: You can rename items in the Project Structure list by clicking on their names and typing.
Customizing the View

You can drag the divider between the Project Structure list and the event display to make one of them wider and the other narrower. Furthermore, the event display can be customized in the following ways:

• You can change the order of the columns by dragging the column headings to the left or right.

• You can resize columns by dragging the dividers between the column headings.

• To select a display format for all position and length values, use the Time Format pop-up menu.

• You can sort events in the display by columns, by clicking the column heading. If you for example want to sort events by their start positions, click that column heading. An arrow appears in the column heading, indicating that events are sorted by that column. The direction of the arrow indicates whether the events are sorted in ascending or descending order. To change the direction, click the column heading again.

About the Sync Selection option

If the “Sync Selection” checkbox is activated (in the upper right corner of the Project Browser), selecting an event in the Project window automatically selects it in the Project Browser, and vice versa. This makes it easy to locate events in the two windows.

• This function is only available when a single event or part is selected.
Editing audio tracks

Audio tracks can have two "subitems": Track Data and Automation.

- The Automation item corresponds to the Automation subtrack in the Project window, and contains the track’s automation events (see page 671).
- The Track Data item corresponds to the actual audio track in the Project window. It contains audio events and/or audio parts, which in turn can contain audio events.

Note, that if you have not performed any automation or opened an automation subtrack, the Browser will only contain the audio data.

The following parameters are available for the different items:
The list columns for audio parts:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the part. Double clicking on the part symbol beside it opens the Audio Part Editor for the part.</td>
</tr>
<tr>
<td>Start</td>
<td>The start position of the part. Editing this value is the same as moving the part in the Project window.</td>
</tr>
<tr>
<td>End</td>
<td>The end position of the part. Editing this value is the same as resizing the part in the Project window.</td>
</tr>
<tr>
<td>Length</td>
<td>The length of the part. Editing this value is the same as resizing the part in the Project window.</td>
</tr>
<tr>
<td>Offset</td>
<td>This adjusts the start position of the events within the part. Adjusting this value is the same as sliding the contents of the part in the Project window (see page 128): setting a positive Offset value is the same as sliding the contents to the left, while a negative Offset corresponds to sliding the contents to the right.</td>
</tr>
<tr>
<td>Mute</td>
<td>Click in this column to mute or unmute the part.</td>
</tr>
</tbody>
</table>
The list columns for audio events:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Allows you to enter a descriptive comment for the event. Double clicking on the waveform image beside it opens the Sample Editor for the event.</td>
</tr>
<tr>
<td>File</td>
<td>The name of the audio file referred by the event’s audio clip.</td>
</tr>
<tr>
<td>Start</td>
<td>The start position of the event. If the event belongs to an audio part, you cannot move it outside the part.</td>
</tr>
<tr>
<td>End</td>
<td>The end position of the event.</td>
</tr>
<tr>
<td>Snap</td>
<td>The absolute position of the event’s snap point. Note that adjusting this value will not change the position of the snap point within the event – instead it is another way of moving the event!</td>
</tr>
<tr>
<td>Length</td>
<td>The length of the event.</td>
</tr>
<tr>
<td>Offset</td>
<td>This determines “where in the audio clip” the event starts. Adjusting this value is the same as sliding the contents of the event in the Project window (see page 128). You can only specify positive Offset values, since the event cannot start before the start of the clip. Likewise, it cannot end after the end of the clip. If the event already plays the whole clip, the Offset cannot be adjusted at all.</td>
</tr>
<tr>
<td>Volume</td>
<td>The volume of the event, as set with the Volume handle or on the info line in the Project Window.</td>
</tr>
<tr>
<td>Fade In</td>
<td>The length of the fade-in and fade-out areas respectively. If you use these settings to add a fade (where there previously was none), a linear fade will be created. If you adjust the length of an existing fade, the previous fade shape will be maintained.</td>
</tr>
<tr>
<td>Fade Out</td>
<td>Click in this column to mute or unmute the event.</td>
</tr>
<tr>
<td>Image</td>
<td>Displays a waveform image of the event inside a grey box corresponding to the clip. The image is scaled according to the width of the column.</td>
</tr>
</tbody>
</table>

Creating audio parts

When the “Audio” item of an audio track is selected in the Project Structure list, you can create empty audio parts on the track by clicking the Add button on the toolbar. This will insert a part between the left and right locator.
Editing MIDI tracks

Just like audio tracks, MIDI tracks can have two “subitems”: Track Data and Automation.

- The Track Data item corresponds to the actual MIDI track in the Project window and can contain MIDI parts (which in turn can contain MIDI events).
- The Automation item corresponds to the automation subtrack in the Project window, and contains the track’s automation events (see page 671).

Note, that if you have not performed any automation or opened an automation subtrack, the Browser will only contain the MIDI data.

When editing the Track Data, the following parameters are available:

The list columns for MIDI parts:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the part.</td>
</tr>
<tr>
<td>Start</td>
<td>The start position of the part. Editing this value is the same as moving the part.</td>
</tr>
<tr>
<td>End</td>
<td>The end position of the part. Changing this is the same as resizing the part (and will automatically affect the Length value as well).</td>
</tr>
<tr>
<td>Length</td>
<td>The length of the part. Changing this resizes the part and automatically changes the End value.</td>
</tr>
<tr>
<td>Offset</td>
<td>This adjusts the start position of the events within the part. Adjusting this value is the same as sliding the contents of the part in the Project window (see page 128): setting a positive Offset value is the same as sliding the contents to the left, while a negative Offset corresponds to sliding the contents to the right.</td>
</tr>
<tr>
<td>Mute</td>
<td>Click in this column to mute or unmute the part.</td>
</tr>
</tbody>
</table>
The list columns for MIDI events:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Type</strong></td>
<td>The type of MIDI event. This cannot be changed.</td>
</tr>
<tr>
<td><strong>Start</strong></td>
<td>The position of the event. Editing this value is the same as moving the event.</td>
</tr>
<tr>
<td><strong>End</strong></td>
<td>This is only used for note events, allowing you to view and edit the end position of a note (thereby resizing it).</td>
</tr>
<tr>
<td><strong>Length</strong></td>
<td>This is only used for note events. It shows the length of the note – changing this resizes the note and automatically changes the End value as well.</td>
</tr>
<tr>
<td><strong>Data 1</strong></td>
<td>The property of this value depends on the type of MIDI event: For notes, this is the note number (pitch). This is displayed and edited as a note name and an octave number, with the values ranging between C-2 and G8. For Controller events, this is the type of Controller, displayed in words. Note that you can edit this by entering a number – the corresponding Controller type is automatically displayed. For Pitch Bend events, this is the fine adjustment of the bend amount. For Poly Pressure events, this is the note number (pitch). For other event types, this is the value of the event.</td>
</tr>
<tr>
<td><strong>Data 2</strong></td>
<td>The property of this value depends on the type of MIDI event: For notes, this is the note-on velocity. For Controller events, this is the value of the event. For Pitch Bend events, this is the coarse bend amount. For Poly Pressure events, this is the amount of pressure. For other event types, this is not used.</td>
</tr>
<tr>
<td><strong>Channel</strong></td>
<td>The event’s MIDI Channel. See page 73.</td>
</tr>
<tr>
<td><strong>Comment</strong></td>
<td>This column is used for some event types only, providing an additional comment about the event.</td>
</tr>
</tbody>
</table>

- For SysEx (system exclusive) events, you can only edit the position (Start) in the list.

However, clicking the Comment column opens the SysEx Editor, in which you can perform detailed editing of system exclusive events. This and other aspects of working with system exclusive messages are described in the chapter “Working with System Exclusive messages”.

The Project Browser 26 – 669
Filtering MIDI events

When you are editing MIDI in the Project Browser, the large number of different MIDI events displayed can make it hard to find your way. To remedy this, the Filter pop-up menu allows you to select a single event type for display.

When this option is selected, only Program Change events will be shown in the event display. To reveal all event types, select the top item (“---”) from the menu.

Creating MIDI parts

When a MIDI track is selected in the Project Structure list, you can create empty MIDI parts on the track by clicking the Add button. This will insert a part between the left and right locator.

Creating MIDI events

You can use the Project Browser to create new MIDI events:

1. Select a MIDI part in the Project Structure list.
2. Move the project cursor to the desired position for the new event.
3. Use the Add pop-up above the event display to select which type of MIDI event to add.
4. Click the Add button.
   An event of the selected type is added to the part, at the project cursor position. If the cursor is outside the selected part, the event is added at the beginning of the part.
Editing Automation tracks

All kinds of Cubase SX/SL automation (the automation subtracks for MIDI, audio, group and FX channel tracks or the individual automation tracks for VST Instruments, ReWire channels or Input/Output busses) are handled in the same way in the Project Browser. Each Automation item in the Project Structure list will have a number of subentries, one for each automated parameter. Selecting one of these parameters in the Project Structure list shows its automation events in the list:

You can use the two columns in the list to edit the position of the events and their values.

Editing the Video track

When the Video track is selected in the Project Structure list, the event display lists the video events on the track, with the following parameters:

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the video clip that the event refers to.</td>
</tr>
<tr>
<td>Start</td>
<td>The start position of the event. Editing this value is the same as moving the event.</td>
</tr>
<tr>
<td>End</td>
<td>The end position of the event. Editing this value is the same as resizing the event, and will automatically change the Length value as well.</td>
</tr>
<tr>
<td>Length</td>
<td>The length of the event. Editing this value is the same as resizing the event, and will automatically change the End value as well.</td>
</tr>
<tr>
<td>Offset</td>
<td>This determines “where in the video clip” the event starts. Note that the event cannot start before the start of the clip, or end after the end of the clip. Thus, if the event already plays the whole video clip, the Offset cannot be adjusted at all.</td>
</tr>
</tbody>
</table>
## Editing the Marker track

Marker events have the following parameters:

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the marker. This can be edited for all markers except the left and right locator.</td>
</tr>
<tr>
<td>Start</td>
<td>The position of “regular” markers or the start position of cycle markers.</td>
</tr>
<tr>
<td>End</td>
<td>The end positions of cycle markers. Editing this value is the same as resizing the cycle marker, and will automatically change the Length value as well.</td>
</tr>
<tr>
<td>Length</td>
<td>The length of cycle markers. Editing this value is the same as resizing the marker, and will automatically change the End value as well.</td>
</tr>
<tr>
<td>ID</td>
<td>The number of the marker. For regular (non-cycle) markers, this corresponds to the key commands used for navigating to the markers. For example, if a marker has ID 3, pressing [3] on the computer keyboard will move the song position to that marker. By editing these values, you can assign the most important markers to key commands. Note that you cannot edit the “L” and “R” marker IDs (Left and Right locator) or assign IDs 1 and 2 to markers (since these are reserved for the locators).</td>
</tr>
</tbody>
</table>

When the Marker track is selected, you can insert markers selecting “Marker” or “Cycle Marker” from the Add pop-up menu and clicking the Add button. Regular markers will be added at the current project cursor position while cycle markers will be added between the current left and right locator positions.
Editing the Tempo track

When Tempo track is selected in the Project Structure list, the event display shows the events on the Tempo track, with the following parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Position</td>
<td>The position of the Tempo event. You cannot move the first event on the Tempo track.</td>
</tr>
<tr>
<td>Tempo</td>
<td>The tempo value of the event.</td>
</tr>
<tr>
<td>Type</td>
<td>This indicates whether the tempo should jump to the value of the event (&quot;Jump&quot; type) or whether it should change gradually from the previous Tempo event, creating a ramp (&quot;Ramp&quot; type). See page 640.</td>
</tr>
</tbody>
</table>

You can add new Tempo events by clicking the Add button. This creates a Jump-type event with the value 120 bpm, at the project cursor position. Make sure that there is no other tempo event at the current cursor position.

Editing Time Signatures

When "Signature track" is selected in the Project Structure list, the event display shows the Time Signature events in the project:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Position</td>
<td>The position of the event. Note that you cannot move the first Time Signature event.</td>
</tr>
<tr>
<td>Signature</td>
<td>The value (time signature) of the event.</td>
</tr>
</tbody>
</table>

You can add new Time Signature events by clicking the Add button. This creates a 4/4 event, at the beginning of the bar closest to the project cursor position. Make sure that there is no other time signature event at the current cursor position.
Deleting Events

The procedure for deleting Events is the same for all different Track types:

1. Click on an Event (or a Part) in the Event display to select it.
2. Select Delete from the Edit menu or press [Delete] or [Backspace].

Note that you cannot delete the first Tempo Event or the first Time Signature Event.
Working with System Exclusive messages
Introduction

System Exclusive (SysEx) is a special type of MIDI message used to send things that only make sense to a unit of a certain make and type. Every major MIDI manufacturer has its own SysEx identity code. System Exclusive messages are typically used for transmitting patch data, i.e. the numbers that make up the settings of one or more sounds in a MIDI instrument.

Cubase SX/SL allows you to record and manipulate System Exclusive data in various ways. This chapter points to various features that help you manage and create System Exclusive data.

Bulk dumps

Recording a bulk dump in Cubase SX/SL

In any programmable device, all settings are stored as numbers in computer memory. Change those numbers, and you will change the settings.

Normally, MIDI devices allow you to dump (transmit) all or some settings in the device’s memory, in the form of MIDI System Exclusive messages. Return these messages, and you get the settings back. This is (among other things) a way of making backup copies of the settings of any instrument.

If your instrument allows the dumping of a few or all of its settings via MIDI by activating some function on the front panel, this dump will most probably be recordable in Cubase SX/SL.

1. Open the Preferences dialog from the File menu (on the Mac, this is located on the Cubase SX/SL menu) and select the MIDI–Filter page. As described on page ??, this allows you to govern which MIDI event types should be recorded and/or thru-put.
2. Deactivate the Sysex checkbox in the Record section, but make sure the Sysex checkbox in the Thru section is activated.
With this setting (shown in the figure above) SysEx messages will be recorded but not echoed back out to the instrument (which could lead to strange results).

3. Activate recording on a MIDI track and initiate the dump from the front panel of the instrument.

4. When done recording, select the new part and open the List Editor from the MIDI menu.
This allows you to check that the System Exclusive dump was recorded – there should be one or several SysEx events in the part/event list.

If your MIDI instrument doesn’t offer a way to initiate a dump “by itself”, you have to send a Dump Request message from Cubase SX/SL to start the dump. You will then have to use the MIDI SysEx Editor (see page 680) to insert the specific Dump Request message (see the instrument’s documentation) at the beginning of a MIDI track. When you activate recording, the Dump Request message will be played back (sent to the instrument), the dump will start and be recorded as above.
Transmitting a bulk dump back to a device

1. Make sure the MIDI track with the System Exclusive data is routed to the device.
   You may want to check your device’s documentation to find details about which MIDI channel should be used, etc.

2. Solo the track.
   This might not be necessary, but it is a good safety measure.

3. Make sure the device is set up to receive System Exclusive data (often, the reception of SysEx is turned off by default).

4. If necessary, put the device in “Standby to Receive System Exclusive” mode.

5. Play back the data.

Some advice

- Don’t transmit more data than you need. If all you want is a single program, don’t send them all, it will only make it harder to find the one you want. Usually, you can specify exactly what you want to send.
- If you want the sequencer to dump the pertinent sounds to your instrument each time you load a project, put the SysEx data in a silent “count-in” before the project itself starts.
- If the dump is very short (for instance, a single sound) you can put it in the middle of the project to re-program a device on the fly. However, if you can achieve the same effect by using Program Change. This is definitely preferable, since less MIDI data is sent and recorded. Some devices may be set up to dump the settings for a sound as soon as you select it on the front panel.
- If you create parts with useful “SysEx dumps”, you can put these on a special muted track. When you want to use one of them, drag it to an empty unmuted track and play it back from there.
- Do not transmit several SysEx dumps to several instruments at the same time.
- Make a note of the current device ID setting of the instrument. If you change this, the instrument may refuse to load the dump later.
Recording System Exclusive parameter changes

Often you can use System Exclusive to remotely change individual settings in a device, open up a filter, select a waveform, change the decay of the reverb etc. Many devices are also capable of transmitting changes made on the front panel as System Exclusive messages. These can be recorded in Cubase SX/SL, and thus incorporated into a regular MIDI recording.

Here's how it works: let's say you open up a filter while playing some notes. In that case, you will record both the notes and the System Exclusive messages generated by your opening of the filter. When you play it back, the sound changes exactly like it did when you recorded it.

1. Open the Preferences dialog from the File menu (on the Mac, this is located on the Cubase SX/SL menu), select the MIDI–Filter page and make sure that System Exclusive is recorded.

2. Make sure the instrument is actually set to transmit front panel control movements as System Exclusive data.

3. Record normally.
   When you're done, you can check that the events were recorded properly in the List Editor.
Editing System Exclusive messages

While System Exclusive events are shown in the List Editor/Project Browser, their entire content is not (only the beginning of the message is displayed in the Comment column for the event). Furthermore, you cannot edit the event (other than moving it) as you can with other event types in the List Editor.

Instead, you use the MIDI SysEx Editor for this.

• To open the MIDI SysEx Editor for an event, click in the Comments column for the event in the List Editor/Project Browser.

The display shows the entire message on one or several lines. All System Exclusive messages always begin with F0 and end with F7 with a number of arbitrary bytes in between. If the message contains more bytes than fit on one line, it continues on the next. The Address indication to the left helps you find out on which position in the message a certain value resides.
Selecting and viewing values

To select a value, either click on it or use the cursor keys. The selected byte is indicated in various formats:

- In the main display, values are shown in hexadecimal format.
- To the right of this, values are shown in ASCII format.
- At the bottom of the dialog, the selected value is shown in binary and decimal formats.

Editing a value

The selected value can be edited directly in the main display or in the decimal and binary displays. Just click on it and type in the desired value as usual.

Adding and deleting bytes

Using the Insert and Delete buttons, or their corresponding computer keyboard keys, you can add and delete bytes from the message. Inserted data will appear before the selection.

Importing and exporting data

The Import and Export buttons allow you to get SysEx data from disk and to export the edited data to a file. The file format used is called “MIDI SysEx” (.SYX), in which data is saved exactly as is, in a binary file. Only the first dump in a .SYX file will be loaded.

This format should not be confused with MIDI files.
Export Audio Mixdown
Introduction

The Export Audio Mixdown function in Cubase SX/SL allows you to mix down audio from the program to a file on your hard disk, in a number of formats. You can choose to mix down one of the following:

• An output bus.
For example, if you have set up a stereo mix with tracks routed to a stereo output bus, mixing down that output bus would give you a mixdown file containing the whole mix. Similarly, you can mix down a complete surround bus, either to a single multi-channel file (interleaved) or to one file per surround channel (split).

• The channel for an audio track (Cubase SX only).
This will mix down the channel for the track, complete with insert effects, EQ, etc. This can be useful for turning a number of events into a single file, or if you are using CPU-intensive insert effects – by exporting the track and re-importing it into the project you can turn off the insert effect, saving processor power.

• Any kind of audio channel in the mixer (Cubase SX only).
This includes VST Instrument channels, effect return channels (FX Channel tracks), Group channels and ReWire channels. There are many uses for this – for example, you can mix down an effect return track or turn individual ReWire channels into audio files.

Notes

• The Export Audio Mixdown function mixes down the area between the left and right locator.

• When you mix down, you get what you hear – mutes, mixer settings and insert effects are taken into account. Note though that you will only include the sound of the bus or channel you select for mixdown.

• MIDI tracks are not included in the mixdown!
To make a complete mixdown containing both MIDI and audio, you first need to record all your MIDI music to audio tracks (by connecting the outputs of your MIDI instruments to your audio inputs and recording, as with any other sound source).

• With Cubase SX, you can also export selected tracks – this is a different function that doesn’t create an audio mixdown. Rather, this is a way to transfer complete tracks (including clips and events) from one project to another. See page 767.
Mixing down to an audio file

1. Set up the left and right locator to encompass the area that you want to mix down.

2. Set up your tracks, so that they play back the way you want. This includes muting unwanted tracks or parts, making manual mixer settings and/or activating the R (Read) automation buttons for some or all mixer channels.


   ![Image of Export Audio Mixdown dialog]

   The upper half of this dialog is a standard file dialog, while the lower half contains file format options and settings for the mixdown function. Note that the available settings and options differ depending on the selected file format (see page 688).

4. Select the bus or channel you want to mix down with the Outputs pop-up menu (with Cubase SL you can only export busses, not channels). This lists all output busses and channels in the active project.
5. Select the channel configuration for the mixdown file with the Channels pop-up menu. Typically you would select the same channel configuration as the bus or channel you’re mixing down, but it’s also possible to e.g. mix down a stereo bus to a mono file. In this case a warning will appear, asking if that’s what you want to do. Here you will also find the “N. Chan. Split” and “N. Chan. Interleaved” options – these allow you to create a surround mixdown file, either as one mono file per surround channel – split – or as a single multi-channel file – interleaved (Cubase SX only).

- The Channels pop-up and the “N. Chan” options are only available when an uncompressed file format is selected (AIFF, uncompressed Wave, Wave64 or Broadcast Wave). For the other formats you can select stereo or mono using controls that are specific to each format. When mixing down to 5.1 Surround, you also have the option to mix down to Windows Media Audio Pro (Windows and Cubase SX only) – see page 701.

6. Select a file format with the File type pop-up menu.

7. Make additional settings for the file to be created. This includes selecting sample rate, resolution, quality, etc. The available options depend on the selected file format – see page 688.

8. If you want to automatically import the resulting audio file back into Cubase SX/SL, activate the “Import to” checkboxes. If you activate the “Pool” checkbox, a clip referring to the file will appear in the Pool. Activating the “Audio Track” checkbox as well will create an audio event that plays the clip, and place it on a new audio track, starting at the left locator.

- The Import options are only available if you have selected an uncompressed file format (AIFF, uncompressed Wave, Wave64 or Broadcast Wave files).

9. If you activate Real-Time Export, the export will happen in real time, i.e. the process will take the same time as regular playback. Some VST plug-ins require this to have time to update correctly during the mixdown – consult the plug-in manufacturers if uncertain.

10. If you activate Update Display, the meters will be updated during the export process. This allows you to check for clipping, for example.

11. Select a folder and a name for the audio file to be created.
With some file formats you can create split stereo files (see page 689). This will create two files (one for each side) with the same name, but with the letter “L” appended for the left channel file and “R” for the right channel file. In the same way, split multi-channel (surround) files (Cubase SX only) will have the same name followed by a number indicating the surround channel.

12. Click Save.

• Depending on the file format, an additional dialog may appear. For example, when exporting to MP3 format a dialog appears where you can add info about the song title, artist, etc. Make the desired settings and click OK to proceed.

A dialog with a progress bar is displayed while the audio file is created. If you change your mind during the file creation, you can click the Abort button to abort the operation.

• If you have activated any of the “Import to” options, the file will be imported back into the project. When playing back the re-imported file in Cubase SX/SL, remember to mute the original tracks so that you really hear the true result.
File format specifics

The following pages describe the different export file formats, and their options and settings.

- AIFF files (see page 689).
- Sound Designer II files (Mac OS X and Cubase SX only, see page 691).
- Wave files (see page 692).
- Wave 64 files (Cubase SX only, see page 694).
- Broadcast Wave files (see page 695).
- MP3 and MP3Pro files (SX only – upgrade needed for SL users, see page 696).
- Ogg Vorbis files (see page 698).
- Real Audio G2 files (Windows only, see page 699).
- Windows Media Audio files (Windows only, see page 700).
- Windows Media Audio Pro files (Windows and Cubase SX only, see page 701).
AIFF files

AIFF stands for Audio Interchange File Format, a standard defined by Apple Computer Inc. AIFF files have the extension ".aif" and are used on most computer platforms. The following settings are available for the AIFF export file format:

Channels

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mono</td>
<td>The audio is mixed down to mono.</td>
</tr>
<tr>
<td>Stereo Split</td>
<td>Two mono files are created, one for each side of the stereo mix. The files will have the name you specify in the dialog, but with &quot;L&quot; and &quot;R&quot; added, respectively. Select this format if you plan to use the resulting file in another application that doesn't support stereo interleaved files. If you plan to re-import the file into Cubase SX/SL, we recommend that you use the Stereo Interleaved option instead, since Cubase SX/SL doesn't automatically handle stereo split files as one entity.</td>
</tr>
<tr>
<td>Stereo Interleaved</td>
<td>A stereo audio file is created. This is the recommended stereo option if you want to re-import the file into Cubase SX/SL.</td>
</tr>
<tr>
<td>N. Chan. Split (Cubase SX only)</td>
<td>This is used when you want to export surround channels or mixes (busses). Exporting with this option will create a set of mono files, with each file containing the audio of one of the surround channels. The number and configuration of the channels depends on the format of the output bus (or channel) you have selected on the Outputs pop-up menu. For example, if you have selected a 5.1 output bus this will result in six mono audio files. They will have the name specified in the File name field above, followed by a number (1-6).</td>
</tr>
<tr>
<td>N. Chan. Interleaved (Cubase SX only)</td>
<td>This is used when you want to export surround channels or mixes (busses). Exporting with this option will create a single audio file containing all surround channels. The number and configuration of channels in the interleaved file depends on the format of the output bus (or channel) you have selected on the Outputs pop-up menu. For example, if you have selected a 5.1 output bus this will result in a 5.1 audio file (containing six channels).</td>
</tr>
</tbody>
</table>
Resolution

Allows you to select 8, 16, 24 bit or 32 bit (float) files.

• If the file is an “intermediate mixdown” that you plan to re-import and continue working on in Cubase SX/SL, we recommend that you select the 32 bit (float) option.
  32 bit (float) is a very high resolution (the same resolution as used internally for audio processing in Cubase SX/SL), and the audio files will be twice the size of 16 bit files.

• If you are making a mixdown for CD burning, you should use the 16 bit option, as CD audio is always 16 bit.
  In this case, we recommend that you activate the UV-22HR dithering plug-in (see page 241). This reduces the effects of quantization noise and artifacts from being introduced when converting the audio down to 16 bit.

• 8 bit resolution should only be used if required, since it will result in limited audio quality.
  8 bit audio may be suitable in some multimedia applications, etc.

Sample Rate

This is the sample rate of the exported file. In most cases, you should select the sample rate set for the project, since a lower sample rate will degrade the audio quality (mainly reducing the high frequency content) and a higher sample rate will only increase the file size, without adding to audio quality. Also consider the future usage of the file – if you e.g. plan to import the file into another application, you should select a sample rate supported by that application.

• If you are making a mixdown for CD burning, you should select 44.100 kHz, since this is the sample rate used on audio CDs.
Broadcast options (embedded information)

AIFF files exported from Cubase SX/SL can have some additional information embedded: date and time of creation, a timecode position (allowing you to insert exported audio at the correct position in other projects, etc.) along with author, description and reference text strings.

- If the option “Include Broadcast Options in created AIFF Files” is activated in the Preferences (Record-Broadcast Wave page), the exported AIFF file will contain embedded information.
  Some applications may not be able to handle AIFF files with embedded info – if you get problems using the file in another application, turn off the option and re-export.

- If the option “Show Broadcast Options for AIFF Export” is activated on the same page, a dialog will appear when you click Save to export the file – use this to enter the desired embedded information.
  You can enter default text strings for author, description and reference on the same Preferences page – these will automatically appear in the Broadcast Options dialog when it appears.

Sound Designer II files (Mac OS X and Cubase SX only)

The SD II format was developed by Digidesign. It is one of the most popular audio file formats on the Macintosh, especially for professional audio work. The following export settings are available:

Channels

Allow you to select mono or stereo files, with the same options as for AIFF files (see page 689).

Resolution

The bit resolution of the file, with the same options as for AIFF files (see page 690), except that 32-bit (float) files are not supported.

Sample Rate

The options are the same as for AIFF files. See page 690.
Wave files

Wave files have the extension ".wav" and are the most common file format on the PC platform. Wave files can be uncompressed or compressed, as described below. For uncompressed Wave files (the most common choice), the following settings are available:

Channels

Allows you to select mono, stereo or multi-channel files with the same options as for AIFF files (see page 689).

Resolution

The bit resolution of the file, with the same options as for AIFF files (see page 690).

Sample Rate

The options are the same as for AIFF files. See page 690.

Coding (Windows only)

The Coding pop-up menu allows you to select a compression scheme for the Wave file, creating smaller files (with a loss of audio quality).

- Which options are available depends on the installed and activated codecs in the ACM (Audio Compression Manager) under Windows. See the operating system documentation for details.

- When a compression option is selected, not all Channels, Resolution and Sample Rate options may be available (depending on the selected compression scheme). The Attributes pop-up menu displays the currently selected properties for the file.

- For regular, uncompressed Wave files, select "PCM / uncompressed Waves".

Wave files exported by Cubase SX/SL for Mac OS X are always uncompressed.
**Broadcast options (embedded information)**

Wave files exported from Cubase SX/SL can have some additional information embedded: date and time of creation, a timecode position (allowing you to insert exported audio at the correct position in other projects, etc.) along with author, description and reference text strings.

- If the option “Include Broadcast Options in created WAVE Files” is activated in the Preferences (Record-Broadcast Wave page), the exported Wave file will contain embedded information. Some applications may not be able to handle Wave files with embedded info – if you get problems using the file in another application, turn off the option and re-export.

- If the option “Show Broadcast Options for WAVE Export” is activated on the same page, a dialog will appear when you click Save to export the file – use this to enter the desired embedded information. You can enter default text strings for author, description and reference on the same Preferences page – these will automatically appear in the Broadcast Options dialog when it appears.
Wave64 files (Cubase SX only)

Wave64 is a proprietary format developed by Sonic Foundry Inc. In terms of audio quality, Wave64 files are identical to standard wave files, but there is one major difference:

- In the file headers, Wave64 files use 64-bit values for addressing where wave files use 32-bit values. The consequence of this is that wave64 files can be considerably larger than standard wave files. Wave64 is therefore a good file format choice for really long recordings (file sizes over 2GB), e.g. live surround recordings.

Wave64 files have the same options as regular wave files (see page 692) and have the extension ".w64".

- If the option “Show Broadcast Options for WAV64 Export” is activated in the Preferences (Record-Broadcast Wave page) a dialog will appear when you click Save to export the file. This allows you to enter information (date and time, description strings etc.) to be embedded in the file. Note that you can enter default text strings for author, description and reference on the same Preferences page – these will automatically appear in the Broadcast Options dialog when it appears.
Broadcast Wave files

Audio-wise, Broadcast Wave files are the same as regular Wave files. They have the same options as Wave files, but there are no Coding (compression) options for Broadcast Wave files.

If the option “Show Broadcast Options for Broadcast WAVE Export” is activated in the Preferences (Record-Broadcast Wave page) a dialog will appear when you click Save to export the file. This allows you to enter information to be embedded in the file: date and time of creation, a timecode position (allowing you to insert exported audio at the correct position in other projects, etc.) and author, description and reference text strings.

- You can enter default text strings for author, description and reference in the Preferences dialog (Record–Broadcast Wave page). These will automatically appear in the Broadcast Options dialog when it appears.

- If you don’t want to add embedded information, you can deactivate “Show Broadcast Options” in the Preferences.
MPEG Layer 3 files (Cubase SX only)

- Cubase SL users can export to MP3 20 times as a “trial” feature (fully functional), after which the function is disabled.
  
  When the MP3 format is selected, a text at the bottom of the Export Audio Mixdown dialog shows you how many remaining encodings you have left.
  
  You can upgrade your Cubase SL copy to include unlimited MP3 encoding by clicking the “Order now” link in the lower right corner of the dialog (this takes you to Steinberg’s online store on the web – a working internet connection is required).
  
  MPEG Layer 3 files have the extension “.mp3”. By use of advanced audio compression algorithms, mp3 files can be made very small, maintaining good audio quality.
  
  The following options are available for MPEG Layer 3 files:

Channels

Use the radio buttons to select mono or stereo files. This setting affects which options are available on the Attributes pop-up menu (see below).

Sample Rate

Determines the frequency range of the audio – the lower the sample rate, the lower the highest audible frequency in the audio. This setting will also affect which options are available on the Attributes pop-up menu, as described below.

Attributes

This pop-up menu allows you to select a bit rate for the mp3 file. As a rule, the higher the bit rate, the better the audio quality and the larger the file. For stereo audio, 128 kBit/s is often considered to result in “good” audio quality.

- Note that the available options on this pop-up menu depend on the Channels and Sample Rate settings.
  
  This is because for mono audio and/or low sample rates, there is no point in using the highest bit rates – they would simply create larger files without adding to audio quality.
Quality

These options determine the “depth” of the encoding algorithm and thus the quality of the resulting file. In the “Highest” mode, the encoding will take the longest time, while in the “Fast” mode, the audio quality may be lower. The file size is not affected by these options.

MP3Pro (Cubase SX only)

When this checkbox is activated, Cubase SX will export to MP3Pro format. MP3Pro (MP3’s successor format) allows for smaller files compared to the MP3 format, but retains the sonic quality.

Options

When you click the Save button, an Options dialog opens in which you can enter information about the file. This additional information (called the ID3 tag) will be embedded as text strings in the file, and can be displayed by some mp3 playback applications.

- For the information to be included in the file, you need to activate the “Insert Options” checkbox in the dialog.
Ogg Vorbis files

Ogg Vorbis is an open, patent-free audio encoding and streaming technology, offering compressed audio files (extension ".ogg") of small size but with comparatively high audio quality.

The following options are available for Ogg Vorbis files:

Channels

Use the radio buttons to select mono or stereo files.

Sample Rate

Determines the frequency range of the audio – the lower the sample rate, the lower the highest audible frequency in the audio.

Quality

The Ogg Vorbis encoder uses variable bit rate encoding, and the Quality setting determines between which limits the bit rate will vary. Generally speaking the higher the Quality setting, the higher the sound quality but also the larger the files.

Options

When you click the Save button, an Options dialog opens in which you can enter information about the file, as when creating mp3 files.

- For the information to be included in the file, you need to activate the “Insert Options” checkbox in the dialog.
Real Audio G2 files (Windows only)

Real Audio files (extension “.rm”) allow very high compression rates and can therefore be made very small. This makes the format especially useful for downloading and streaming multimedia from the internet.

The following options are available for Real Audio files:

Coding and Content

This is where you specify the desired audio quality for the file. In the Real Audio G2 format, this information is divided in two pop-up menus: Coding (determining the bit rate) and Content (specifying the typical audio content – voice, music, etc.).

When you select a Coding/Content, a descriptive text appears in the field below the pop-up menu, describing the suitable use of the selected format.

• Note that the choice of mono or stereo is included in the Coding/Content options.

Options

When you click the Save button, an Options dialog opens in which you can select one or more modes (each explained in the dialog) for the file. You can also enter information about the file. These text strings will be embedded in the file and can be displayed by some Real Audio playback applications.
Windows Media Audio files (Windows only)

Windows Media Audio is an audio format developed by Microsoft Inc. Due to advanced audio compression algorithms, Windows Media Audio files can be made very small, maintaining good audio quality. The files have the extension ".wma".

The following options are available for Windows Media Audio files:

Attributes

This pop-up menu allows you to select a bit rate for the WMA file. As a rule, the higher the bit rate, the better the audio quality and the larger the file. For stereo audio, 96 kBit/s is often considered to give "good" audio quality.

Options

When you click the Save button, an Options dialog opens in which you can enter information about the title and author of the file, as well as copyright information and a description. These text strings will be embedded in the file and can be displayed by some Windows Media Audio playback applications.
Windows Media Audio Pro files (Windows and Cubase SX only)

This is a continuation of the Windows Media Audio format (described above) developed by Microsoft Inc. Due to the advanced audio codecs and lossless compression used, WMA Pro files can be decreased in size with no loss of audio quality. Furthermore, WMA Pro features the possibility of mixing down to 5.1 surround sound. The files have the extension ".wma".

- Click the Options button to open a dialog in which you can make settings for the Windows Media Audio files. When you have made the desired settings, click OK to encode the file.

The following options are available:

**Input Stream**

Here you set the sample rate (44.1, 48 or 96 khz) and the bit resolution (16 bit or 24 bit) of the encoded file. These should be set to match the sample rate and bit resolution of the source material. If no value matches that of your source material, use the closest highest available value. E.g. if you’re using 20 bit source material, set the bit resolution to 24 bit rather than 16 bit.
Encoding Scheme

These settings are used for defining the desired output from the encoder, e.g. whether it should be a stereo file or a 5.1 surround file. Make settings appropriate for the intended use of the file. If the file will be downloaded or streamed on the Internet, you might not want too high bit rates for example. See below for descriptions of the options.

- **Mode**
  The WMA Pro encoder can use either a constant bit rate or a variable bit rate for encoding to 5.1 surround, or it can use lossless encoding for encoding to stereo. The options on this menu are as follows:

<table>
<thead>
<tr>
<th>Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Constant Bitrate (CBR)</td>
<td>This will encode to a 5.1 surround file with a constant bit rate (set in the Bit Rate/Channels menu, see below). Constant bit rate is preferably used if you want to limit the size of the final file. The size of a file encoded with constant bit rate is always the bit rate times the duration of the file.</td>
</tr>
<tr>
<td>Variable Bitrate with Quality</td>
<td>Encodes to a 5.1 surround file with a variable bit rate, according to a quality scale (the desired quality is set in the Bit Rate/Channels menu, see below). When you encode with variable bit rates, the bit rate fluctuates depending on the character and intricacy of the material being encoded. The more complex passages in the source material, the higher the bit rate – and the larger the final file – will be.</td>
</tr>
<tr>
<td>Unconstrained VBR (Average)</td>
<td>Encodes to a 5.1 surround file with an unconstrained variable bit rate. Unconstrained means that there will be no limitation to the bit rate used for encoding certain complex passages in the source material. You can however set a recommended average bit rate to somewhat help constrain the size of the final file in the Bit Rate/Channels menu.</td>
</tr>
<tr>
<td>Constrained VBR (Maximum)</td>
<td>Encodes to a 5.1 surround file with a constrained variable bit rate. This means that even though the bit rate fluctuates, it will never be allowed to exceed the maximum value you set in the Bit Rate/Channels menu.</td>
</tr>
<tr>
<td>Lossless</td>
<td>Encodes to a stereo file with lossless compression.</td>
</tr>
</tbody>
</table>

- Note that if you encode to a surround file, it can only be played as intended on computers using Windows XP, since no other Windows version supports WMA surround. With other operating systems than XP, the surround file will instead be reproduced as a stereo file.
• **Bit Rate/Channels**
  This menu allows you to set the desired bit rate – from 128 kbps to 768 kbps, depending on the selected Mode (see above). If the Mode “Variable Bitrate with Quality” is used (see above), the menu allows you to select from six levels of desired quality, with 10 being the lowest and 100 the highest. Generally, the higher the bitrate or quality you select, the larger the final file will be. The menu also shows the channel format (5.1 or stereo).

• **Method**
  Lets you choose between “One Pass” and “Two Pass”.

• One pass means that the source material is passed through the encoder just once, and analyzed as well as encoded during the process.

• Two pass, on the other hand, means that the source material is passed through the encoder twice. During the first pass, the material is analyzed, and the actual encoding is applied during the second pass.

  Two pass encoding can result in a file of better quality, but the process takes longer.

**Dynamic Range Control**

These controls allow you to define the dynamic range of the encoded file. The dynamic range is the difference in dB between the average loudness and the peak audio level (the loudest sounds) of the audio. These settings affect how the audio is reproduced if the file is played on a Windows XP computer with a player in the Windows Media 9 series, and the user activates the special “Quiet Mode” feature of the player to control the dynamic range.

The dynamic range is automatically calculated during the encoding process, but you can specify it manually as well.

If you want to manually specify the dynamic range, first put a checkmark in the box to the left by clicking in it and then enter the desired dB values in the Peak and Average fields. You can enter any value between 0 and -90 dB. Note however that it is usually not recommended to change the Average value, since it affects the overall volume level of the audio and therefore can affect the audio quality adversely.
The Quiet Mode in a Windows Media 9 player can be set to one of three settings. Below, these settings are listed together with an explanation of how the Dynamic Range settings affect them:

- **Off**: If Quiet Mode is off, the dynamic range settings that were automatically calculated during the encoding will be used.
- **Little Difference**: If this is selected and you have not manually changed the dynamic range settings, the peak level will be limited to 6 dB above the average level during playback. If you have manually specified the dynamic range, the peak level will be limited to the mean value between the peak- and average values you specified.
- **Medium Difference**: If this is selected and you have not manually changed the dynamic range settings, the peak level will be limited to 12 dB above the average level. If you have changed the dynamic range, the peak level will be limited to the peak value you specified.

**Surround Reduction Coefficients**

Here you can specify which amount of volume reduction, if any, should be applied to the different channels in a surround encoding. These settings affect how the audio is reproduced on a system incapable of playing back the file in surround, in which case the surround channels of the file will be combined into two channels and played back in stereo instead.

The default values will normally produce satisfactory results, but you can change the values manually if you wish. You can enter any value between 0 and -144 dB for the surround channels, the center channel, the left and right channels and the LFE channel respectively.

**Output Media Description**

In these fields you can enter a number of text strings with information about the file – title, author, copyright information and a description of its contents. This information will then be embedded in the file header and can be displayed by some Windows Media Audio playback applications.

- **For more information about surround sound and encoding, please refer to the chapter “Surround sound (Cubase SX only)”**.
29

Synchronization
Background

What is synchronization?

Synchronization is said to exist when you make two pieces of equipment agree on time or tempo. You can establish synchronization between Cubase SX/SL and a number of other types of devices, including tape recorders and video decks, but also MIDI devices that “play back”, such as other sequencers, drum machines, “workstation sequencers” etc.

When you set up a synchronization system you must decide which unit is the master. All other devices are then slaved to this unit, which means they will adjust their playback speed to the master’s.

Cubase SX/SL as a slave

When a synchronization signal is coming in to Cubase SX/SL, from another device (such as a tape recorder, video recorder etc.), this device is the master and Cubase SX/SL is the slave. Cubase SX/SL will adjust its playback to the other device.

Cubase SX/SL as a master

When you set up Cubase SX/SL to transmit synchronization information to other devices, Cubase SX/SL is the master and the other devices are the slaves; they will adjust their playback to Cubase SX/SL.

Cubase SX/SL – both master and slave

Cubase SX/SL is a very capable synchronization device. It can operate as both a master and a slave at the same time. For example, Cubase SX/SL might be slaved to a tape recorder transmitting timecode, while at the same time transmitting MIDI Clock to a drum machine, acting as a master for that.

The VST System Link feature (with which you can synchronize separate computers running Cubase SX/SL or Nuendo for example) is described in a separate chapter. See page 723.
Timecode, MIDI clock and word clock

Basically there are three types of synchronization signals for audio, timecode, MIDI clock and word clock:

Timecode (SMPTE, EBU, MTC, VITC etc.)

Timecode appears in a number of guises. No matter which “format” it has, it always supplies a “clock on the wall” type of synchronization, that is, a synchronization related to hours, minutes, seconds and two smaller units called “frames” and “subframes”.

- LTC (SMPTE, EBU) is the audio version of timecode. This means that it can be recorded on the audio track of an audio or video recorder.
- VITC is the video format timecode, that is it is stored in the actual video image.
- MTC is the MIDI version of timecode, transmitted in MIDI cables.
- ADAT sync (Alesis) is only used with the ASIO Positioning Protocol, see page 711.

For the ASIO Positioning Protocol, other high precision timecode formats may also be supported.

Format recommendations for timecode – without ASIO Positioning Protocol

- When synchronizing your system to external timecode, via a synchronizer, the most common timecode format is MTC. Contrary to some reports you might have heard, MTC delivers good precision for external sync. This is due to the fact that the operating system can “time stamp” incoming MIDI messages, which increases precision.

Format recommendations for timecode – with ASIO Positioning Protocol

- LTC and VITC are the formats with the highest precision and are recommended when available.
- MTC is the next best option and probably the most common choice, since few audio hardware solutions have built in LTC or VITC readers. However, LTC and VITC offer even higher precision when available.
**MIDI Clock**

MIDI Clock is a tempo based type of synchronization signal, that is it is related to the number of “beats per minute”. MIDI Clock signals are suitable for synchronizing two devices that agree on tempo, such as for example Cubase SX/SL and a drum machine.

MIDI Clock is not suitable as a master sync source for an application like Cubase SX/SL. Therefore Cubase SX/SL will transmit MIDI Clock signals to other devices, but it will not receive MIDI Clock.

**Word Clock**

Word clock is basically a replacement for the sample rate clock in for example an audio card. Word clock hence runs at the same rate as the sample rate in the audio, 44.1kHz, 48kHz etc.

Word clock does not contain any position information, it is only a “simple” signal for clocking the audio at its sample rate.

Word clock comes in many formats, analog on coaxial cable, digital as part of an S/PDIF, AES/EBU or ADAT audio signal, etc.
Synchronizing the transport vs. synchronizing audio

How timing is handled in a non-synchronized system

Let’s first look at the situation where Cubase SX/SL is not synchronized to any external source.

Any digital playback system has an internal clock that ultimately affects the playback speed and stability, and PC audio hardware is no exception. This clock is extremely stable.

When Cubase SX/SL is playing back with no external synchronization, all playback is internally synchronized to the internal digital audio clock, to ensure synchronization between digital audio and MIDI.

Synchronizing Cubase SX/SL’s playback

Let’s assume now that we use external timecode synchronization, with Cubase SX/SL. For example, we might synchronize playback to a tape recorder.

Timecode coming from an analog tape recorder will always vary slightly in speed. Different timecode generators and different tape recorders will also supply timecode with slight differences in speed. In addition, the shuttling of tape mechanisms due to overdubs and re-recordings can cause the physical tape to wear and stretch, which affects the speed of the timecode.

If you set up Cubase SX/SL to sync to incoming timecode, it will vary its overall playback speed to compensate for such fluctuations in the speed of the timecode – that’s the whole purpose of synchronization.

What happens with the digital audio?

The fact that Cubase SX/SL’s playback is synchronized to the timecode does not affect the playback of the digital audio. It still relies on the perfectly stable, built-in clock in the audio hardware.

As you may understand by now, problems will appear when the perfectly stable digital audio gets related to the slightly varying speed of a system synchronized to timecode.

The playback timing of each event will not be in total accordance with the tape or the MIDI playback, since the playback speed of the audio is determined by the digital audio hardware’s built-in clock.
Resolving to word clock

The solution to this problem is to use one external clock for all components in the system. One master clock is used to derive whatever type of clock signal each component in the system needs. For example, something called a house clock can be used to generate sample rate clocks for the digital audio hardware and timecode for Cubase SX/SL. This ensures all components in the system use the same reference source for their timing.

Synchronizing digital audio to external clocks running at sample rate is often called "resolving" or "synchronizing to word clock".

If you aim to perform synchronization to external signals, we strongly recommend that you obtain proper synchronization equipment. This encompasses:

• An audio card that can be slaved to external word clock.
• A synchronizer that can read timecode (and possibly house clock) and generate the required sync signals from that, such as the Steinberg TimeLock Pro.
  or...
• An audio system with complete built-in synchronization possibilities, preferably supporting the ASIO Positioning Protocol.

Using timecode without word clock

Of course, it is possible to set up a synchronization system where you lock Cubase SX/SL to timecode without using word clock. However, please note that the timing of audio vs. MIDI cannot be guaranteed and that fluctuations in speed in the incoming timecode will not affect the playback of audio events. This means that synchronizing to timecode may work in the following situations:

• When the timecode was originally generated by the audio card itself.
• When the source providing the timecode is extremely stable (such as a digital video system, a digital tape recorder or another computer).
• When you remain synchronized to that same stable source throughout the entire process, both while recording and playing back audio.
About the ASIO Positioning Protocol (APP)

- The ASIO Positioning Protocol is a technology that expands on the type of sync described above and makes sample accurate positioning possible.

When transferring audio digitally between devices, it is important that synchronization using word clock and timecode is completely correlated. If not, the audio will not be recorded at the exact intended (sample accurate) position, which can cause various types of problems, such as inaccurately positioned audio material, clicks and pops etc.

A typical situation is when transferring material from a digital multi-track tape recorder to Cubase SX/SL (for editing) and then back again. If you do not have sample accurate synchronization set up, you cannot be sure that the material will appear in its exact original position, when transferred back to the tape recorder.

In order to take advantage of the ASIO Positioning Protocol, your audio hardware must be suitably equipped and the functionality must be included in the ASIO driver for the hardware.

An example of a system for doing sample accurate transfers, would be transferring audio tracks from an Alesis ADAT to Cubase SX/SL. Here the ADAT will be the sync master (though it doesn’t necessarily have to be). It provides both the digital audio (with an inherent word clock) and positional information (timecode) via its ADAT sync protocol. The master clock is generated by the ADAT itself.

Hardware and software requirements for APP

- Your computer audio hardware (in our example above this would be an ADAT card in your computer) must support all the functionality required for the ASIO Positioning Protocol. That is, it must be able to read the digital audio and the corresponding positional information from the external device.
- There must be an ASIO 2.0 driver for the audio hardware.
- For resolving to external timecode, the audio hardware must have a timecode reader/writer on-board.
• For information about which audio hardware models currently support APP, see the Steinberg web site (www.steinberg.net).

☐ The ASIO Positioning Protocol exploits the specific advantage of having an audio card that has a built-in timecode reader. With such a card and the ASIO Positioning Protocol, you can achieve constant sample accurate synchronization between the audio source and Cubase SX/SL.

Machine control

Cubase SX/SL can control external tape transports and similar devices via MIDI Machine Control. This allows you to operate an external tape transport from Cubase SX/SL’s Transport panel. That is, Cubase SX/SL can make the tape recorder locate to a certain position, start, stop, rewind etc.

About sync and machine control

Controlling tape transports is a two-way process:

• Cubase SX/SL sends out machine control commands to the tape recorder, asking it to locate to a certain position and activate playback etc.
• The tape recorder locates to the requested position, starts and delivers time-code back to Cubase SX/SL, to which Cubase SX/SL is synchronized.

Even though it appears as if Cubase SX/SL is controlling the tape recorder completely, it is important to remember that in this setup, Cubase SX/SL is still being synchronized to the external tape transport, not vice versa.

Also note that the two processes of sync and machine control are completely separated, in terms of protocols used. You can for example synchronize to MTC while sending out transport commands via MMC.

MIDI Machine Control (MMC)

This is a standard MIDI protocol for controlling tape transports. There are a number of tape recorders and hard disk recording systems on the market that support this protocol. Cubase SX/SL implements three MMC commands: Start, Stop and Locate.
Window Overview

The Synchronization Setup dialog

This dialog box is used for setting up everything that has to do with Cubase SX/SL’s synchronization to other units. You reach it from the Transport menu.
Operations

Making connections and basic settings

The descriptions below are for a basic setup with a separate synchronizer and audio card. Depending on your exact situation and requirements for communication with external devices, there are endless variations on this theme. Please consult your dealer for more detailed recommendations.

The following connections are required for external sync via a synchronizer, including resolving of the audio card. For details on audio card and synchronizer settings and connections, see the included manuals.

• Route the master clock signal (LTC, VITC, etc.) to an input on the synchronizer.
• Connect the word clock output on the synchronizer to an input on the audio card.
• Connect the MIDI Timecode (MTC) output on the synchronizer to the corresponding input on the computer.
• Set up the synchronizer and make sure the frame rate settings are in accordance with the master clock.

For more information on frame rates, see page 721.

A typical synchronization setup.
Setting up the audio card for external synchronization

1. Open the Device Setup dialog from the Devices menu and select the item VST Multitrack from the list to the left.

2. Click the Control Panel button to open the card’s proprietary setup dialog.
   If this card is accessed via a special ASIO driver (as opposed to MME or Direct X), this dialog is provided by the card, not by Cubase SX/SL. Hence the settings vary with the card brand and model.

3. Adjust the settings as recommended by the card manufacturer, then close the dialog.
   The dialog may also contain various diagnostic tools that allow you to verify for example whether word clock is arriving correctly.

4. From the Clock Source pop-up, select the input to which you routed the word clock signal.
   This pop-up may not be used if you selected an input in the Control Panel dialog instead.

Setting up Cubase SX/SL for external sync to timecode

1. In the Synchronization dialog, set Timecode Source to MIDI Timecode or ASIO Positioning Protocol (only if your hardware is ASIO Positioning Protocol compatible).

2. For MIDI Timecode, use the “MIDI Timecode Settings – MIDI Input” pop-up menu to select an input for the timecode.
   If you are using the ASIO Positioning Protocol this is not required, since the timecode is then coming in directly via your audio hardware.

3. Close the Synchronization Setup dialog and instead open the Project Setup dialog from the Project menu.
4. Use the Start value to set which frame on the external device (e.g. a video tape) should correspond to the beginning of the project.

![Project Setup](image)

Set this to the timecode position where you want the project to start.

- You can also set this with the function “Set Timecode at Cursor” on the Project menu.
  This is useful if you know that a certain position in your project would coincide with a certain timecode position in the external device. Move the project cursor to the desired position, select “Set Timecode at Cursor” and specify the corresponding timecode position in the dialog that appears – the Start value is adjusted accordingly.

5. Close the Project Setup dialog.

6. On the Transport panel, activate the Sync button (or select Sync Online from the Transport menu).

7. Start the tape (or video, or...) that contains the timecode. Cubase SX/SL starts playing when it receives timecode with a position “higher” than, or equal to, the project Start frame.

   You can wind the device that sends the timecode to any position and start from there.

- When the device with the timecode is stopped, you can use the Cubase SX/SL transport controls as you normally do, when it is not synchronized.

You should also look into the Sync Options, see page 722.

The Sync indicator

On the Transport panel you can check the status of incoming timecode by observing the sync indicator. It switches between “Offline” (not waiting for sync), “Idle” (ready for sync but no signal is coming in), and “Lock xx” (where xx is indicating the frame rate of the incoming signal).
Synchronizing other Equipment to Cubase SX/SL

You may have other MIDI devices that you want to synchronize to Cubase SX/SL. There are two types of synchronization that Cubase SX/SL can transmit: MIDI Clock and MIDI Timecode.

Transmitting MIDI Clock

If you transmit MIDI Clock to a device supporting this type of synchronization signal, the other device will follow Cubase SX/SL’s tempo. The tempo setting in the other device is of no relevance. Instead it plays at the same tempo as Cubase SX/SL. If the device also reacts to Song Position Pointers (which Cubase SX/SL transmits) it will follow when you wind, rewind and locate using the Cubase SX/SL Transport panel.

- MIDI Clock transport commands include “Start”, “Stop” and “Continue”. However, some MIDI equipment (e.g. some drum machines) do not recognize the “Continue” command. If this is the case with your equipment, activate the option “Always Use MIDI Clock Start” in the Preferences (Transport page).
  When this is activated, only the Start command is used.

Transmitting MIDI Timecode

If you transmit MIDI Timecode to a device supporting this type of synchronization signal, the device will synchronize time-wise to Cubase SX/SL, that is, the time displays on Cubase SX/SL’s Transport panel and on the other device will agree. When you wind and locate Cubase SX/SL and then activate playback, the other device will follow from the same position (if it has this capability and is set up for it).
### Setting Up

1. Connect the desired MIDI Outputs from Cubase SX/SL to the device(s) that you plan to synchronize.

2. Open the Synchronization Setup dialog from the Transport menu.

3. Activate the sync outputs by using the corresponding checkboxes in the lower right part of the dialog.
   - You can output any combination of MIDI Timecode and MIDI Clock to any combination of outputs (however, you probably don’t want to send MTC and MIDI Clock to the same output).

   - **Some MIDI Interfaces will automatically send MIDI Clock to all MIDI outputs, regardless of the MIDI Clock Port selection you make in Cubase SX/SL. If this is the case, you should only select one MIDI Clock Port (consult the documentation of the MIDI Interface if in doubt).**

<table>
<thead>
<tr>
<th>Send MIDI Timecode</th>
<th>Send MIDI Clock</th>
</tr>
</thead>
<tbody>
<tr>
<td>Port</td>
<td>Port</td>
</tr>
<tr>
<td>MIDI Out 1</td>
<td>MIDI Out 1</td>
</tr>
<tr>
<td>MIDI Out 2</td>
<td>MIDI Out 2</td>
</tr>
<tr>
<td>MIDI Out 3</td>
<td>MIDI Out 3</td>
</tr>
</tbody>
</table>

   - MIDI Timecode transmitted to Outputs 1 and 2.
   - MIDI Clock transmitted to Output 3.

4. Set the other device(s) to their "external synchronization" mode (or some other mode with a similar name) and activate playback on them if necessary.

5. Activate playback in Cubase SX/SL, and the other device(s) will follow.
MIDI Machine Control

Machine Control commands can be sent using MIDI Machine Control (MMC):

1. Set up and test basic timecode synchronization, as described earlier in this chapter.

2. Connect a MIDI Out on your MIDI interface to MIDI In on the tape recorder (or similar device).
   If you have not already done so (when setting up for MIDI Timecode), also connect a MIDI cable from the MIDI Output on the tape recorder to a MIDI In on the computer.

3. Make sure you have timecode recorded on the tape recorder, and that it is set up to utilize MMC.

4. Open the Synchronization Setup dialog on the Transport menu in Cubase SX/SL.

5. Select MIDI Machine Control from the Machine Control section of the dialog.

6. Select the correct MIDI In- and Outputs from the MIDI Machine Control Settings pop-ups.

7. Open the Preferences dialog from the File menu (on the Mac, this is located on the Cubase SX/SL menu), select the MIDI Filter section and make sure Sysex is activated in the Thru section.
   This is necessary since MMC uses two-way communication (the tape recorder “replies” to the MMC messages it receives from Cubase SX/SL). By filtering out Sysex Thru, you ensure that these MMC System Exclusive replies are not echoed back to the tape recorder.
8. Close the Preferences and open the Project Setup dialog from the Project menu.

9. As when synchronizing without using transport control, use the Start value to specify which frame on the tape should correspond to the beginning of the project.

10. Close the Project Setup dialog.

11. On the Transport panel, activate the Sync button.

12. Press play on the external tape transport and let the tape roll for a few seconds, so that Cubase SX/SL can “learn” about the timecode positions on the tape. Stop the tape transport.

13. Now activate play from Cubase SX/SL.

   The external tape transport should wind the tape to a position just before the project cursor in Cubase SX/SL and go into Play. After a short while, Cubase SX/SL should start, in sync.

   Try to Stop, Fast Forward and Rewind from Cubase SX/SL and activate Play from different positions in the project. The tape transport should follow.

   ❐ Each time you start up your external tape transport, you may have to activate play from its front panel for a couple of seconds. If you don’t, Cubase SX/SL has no chance of “knowing” where to wind the first time, since it doesn’t know what timecode is recorded on the tape.

Whenever you want to turn off the synchronization between the tape recorder and Cubase SX/SL, simply deactivate Sync on the Transport panel.
Options

Making Project Settings

About Frame Rates

The frame rate is the number of frames per second in a film or on a video tape. Just as there is always sixty seconds to a minute, there is always a certain number of frames to each second. However, the frame rate used varies with the type of media (film or video), which country the video tape has been produced in, and other circumstances.

In the Project Setup dialog are two settings for frame rates:

• The Frame Rate pop-up is automatically adjusted to the frame rate of the incoming timecode. There is an exception to this when you are synchronizing Cubase SX/SL to MIDI Timecode: If you have selected 29.97 fps or 30 dfps as Frame Rate in Cubase SX/SL, this selection will be kept, since these frame rates are not included in the MTC format.

The Project Setup dialog contains six frame rates to choose from:

<table>
<thead>
<tr>
<th>Frame Rate</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>24 fps</td>
<td>The traditional frame rate of 35mm film.</td>
</tr>
<tr>
<td>25 fps</td>
<td>The frame rate used for all video and audio in Europe (EBU).</td>
</tr>
<tr>
<td>29.97 fps</td>
<td>Straight 29.97 frames per second.</td>
</tr>
<tr>
<td>30 fps</td>
<td>Straight 30 frames per second. This is often used in the United States for audio only work.</td>
</tr>
<tr>
<td>29.97 dfps</td>
<td>“Drop frame” code running at 29.97 frames per second, most often used in the United States of America for work with color video.</td>
</tr>
<tr>
<td>30 dfps</td>
<td>Very rarely used.</td>
</tr>
</tbody>
</table>

• The Display Format pop-up contains a number of formats that when selected work as the “master” setting for the display format used in the various windows’ rulers and position displays. The item “60 fps (user)” on this menu represents a user definable frame rate. To make editing with frame accuracy correspond to the actual frame rate in an external sync source, you need to set this frame rate to the same value as the Frame Rate pop-up.
Proceed as follows:

1. Open the Preferences dialog (accessed from the File menu under Windows or the Cubase SX/SL menu on the Mac) and select the Transport page.

2. Enter the desired frame rate under "User Definable Framerate". Either type the desired value directly or use the arrow buttons to increase/decrease the value. You can enter any value between 2-200.

3. When you're done, click OK to close the dialog and save the settings.

The Frame Rate you specified will now be the one used when you select "60 fps (user)" in the Display Format pop-up.

Sync Options

The following options are available in the Synchronization Setup dialog:

Drop Out Time

On an analog tape with timecode, dropouts may occur. If a drop-out is very long, Cubase SX/SL may (temporarily) stop. In the Dropout Time field you can set how long a drop-out (in frames) should be tolerated until Cubase SX/SL decides that the tape isn't good enough to synchronize to. If you have a very stable timecode source, you may lower this number to make Cubase SX/SL stop more swiftly after the tape recorder has been stopped.

Lock Time

Using this field you can set how many frames of "correct" timecode Cubase SX/SL should receive before attempting to "lock" (synchronize) to incoming timecode. If you have an external tape transport with a very short start-up time, you could try lowering this number to make lock-up even faster than it already is.
Introduction

VST System Link is a network system for digital audio that allows you to have several computers working together in one large system. Unlike conventional networks it does not require Ethernet cards, hubs, or CAT-5 cables; instead it uses the kind of digital audio hardware and cables you probably already possess in your studio.

VST System Link has been designed to be simple to set up and operate, yet give enormous flexibility and performance gains in use. It is capable of linking computers in a “ring” network (the System Link signal is passed from one machine to the next, and eventually returns to the first machine). VST System Link can send its networking signal over any type of digital audio cable, including S/PDIF, ADAT, TDIF, or AES, as long as each computer in the system is equipped with a suitable ASIO compatible audio interface.

So, why would you want to link up two or more computers? Well, the added computer power gives you vast possibilities:

- Dedicate one computer to running VST instruments while recording audio tracks on another.
- If you need lots of audio tracks, you may simply add tracks on another computer.
- You could have one computer serve as a “virtual effect rack”, running CPU-intensive send effect plug-ins only.
- Since you can use VST System Link to connect different VST System Link applications on different platforms, you can take advantage of effect plug-ins and VST instruments that are specific to certain programs or platforms.

This chapter describes how to set up and use VST System Link in Cubase SX/SL.
Preparations

Requirements

The following equipment is required for VST System Link operation:

- Two or more computers. These can be of the same type or use different operating systems – it doesn’t matter. For example, you can link an Intel-based PC to an Apple Macintosh without problems.
- Each computer must have audio hardware with specific ASIO drivers, installed and working.
- The audio hardware must have digital inputs and outputs. Of course, to be able to connect the computers the digital connections must be compatible (i.e. the same digital formats and connection types must be available).
- At least one digital audio cable for each computer in the network.
- A VST System Link host application installed on each computer. As of this writing, VST System Link is implemented for Cubase SX/SL (version 1.6 or later), Nuendo and Cubase 5.2s (System Link version). Any VST System Link applications can connect to each other.

Additionally, we recommend that you use a KVM switchbox:

Using a KVM switchbox

If you want to set up a multi-computer network, or even a small network in a limited space, it's a good idea to invest in a KVM (Keyboard, Video, Mouse) switchbox. With one of these switchers you can use the same keyboard, monitor, and mouse to control each computer in the system, and switch between computers very rapidly. KVM switchers are not too expensive, and very easy to setup and operate. It you decide not to go this route, the network will function just the same, but you may end up doing a lot of jumping from one machine to the other while setting up!
Making connections

Below, we will assume that you are connecting two computers. Should you have more than two computers, it’s still best to start with two and add the others one by one once the system is working – this makes troubleshooting easier if you run into problems. For two computers, you will need two digital audio cables, one in each direction:

1. Connect a digital audio cable from the digital output of Computer 1 to the digital input of Computer 2.
2. Connect the other cable from the digital output of Computer 2 into the digital input of Computer 1.

• If a card has more than one set of inputs and outputs, choose whichever one that suits you – for simplicity usually the first set is best.

Setting up clock sync

Before you proceed you need to make sure that the clock signals on your ASIO cards are synchronized correctly. This is essential when cabling any kind of digital audio system, not just VST System Link.

All digital audio cables by definition always carry a clock signal as well as audio signals, so you don’t need to use a special Word Clock input and output for this (although you may find that you get a slightly more stable audio system if you do, especially when using multiple computers).

The Clock Mode or Sync Mode is set up in the audio hardware’s ASIO control panel. In Cubase SX/SL, you proceed as follows:

1. Pull down the Devices menu and open the Device Setup dialog.
2. Select the VST Multitrack device and make sure the Setup tab is selected to the right.
3. Click the Control Panel button. The ASIO control panel appears.
4. Open the ASIO control panel on the other computer as well. If you are using another VST System Link host application on that computer, check its documentation for details on how to open the ASIO control panel.
5. Now, you need to make sure that one audio card (and only one!) is set to be the Clock Master, and all the other cards must be set to listen for the clock signal coming from the Clock Master i.e. they must be Clock Slaves.

The naming and procedure for this differs depending on the audio hardware – consult its documentation if required. If you are using Steinberg Nuendo ASIO hardware, all cards default to the “AutoSync” setting – in this case you must set one of the cards (and only one) to “Master” in the Clock Mode section of the control panel.

- Typically, the ASIO control panel for an audio card contains some indication of whether the card receives a proper sync signal or not, and the sample rate of that signal.
  This is a good indication that you have connected the cards and set up clock sync properly. Check your audio hardware’s documentation for details.

- It’s very important that one and only one card is the clock master, otherwise the network cannot function correctly. Once you have set this up, all the other cards in the network will take their clock signal from this card automatically.

The only exception to this procedure is if you are using an external clock – which could be from a digital mixing desk or special Word Clock synchronizer for example. If so, you must then leave all your ASIO cards in Clock Slave or AutoSync mode, and make sure that each of them is listening for the signal coming from the synchronizer, usually passed through your ADAT cables or Word Clock connectors in a daisy chain fashion.
Minimizing the latency

The general definition of latency is the amount of time it takes any system to respond to whatever messages are sent to it. For example, if your system’s latency is high and you play VST instruments in real time, you will get a noticeable delay between when you press a key and when you hear the sound of the VST instrument. Nowadays, most ASIO-compatible audio cards are capable of operating with very low latencies. Also, all VST applications are designed to compensate for latency during playback, making the playback timing tight.

However, the latency time of a VST System Link network is the total latency of all the ASIO cards in the system added together. Therefore it’s extra important to minimize the latency times for each computer in the network.

- The latency does not affect the synchronization – it’s always perfectly in time. But, it can affect the time it takes to send and receive MIDI and audio signals, or make the system seem sluggish.

To adjust the latency of a system, you typically adjust the size of the buffers in the ASIO control panel – the lower the buffer size, the lower the latency. Generally speaking it’s best to keep to fairly low latencies (buffer sizes) if your system can handle it – about 12 ms or less is usually a good idea.
Setting up your software

Now it’s time to set up your programs. The procedures below describe how to set things up in Cubase SX/SL; if you are using another program on the other computer, please refer to its documentation.

Setting the sample rate

The projects in both programs must be set to use the same sample rate. Select “Project Setup…” from the Project menu and make sure the sample rate is the same in both systems.

Streaming digital audio between applications

1. Create input and output busses in both applications and route these to the digital inputs and outputs.
   The number and configuration of the busses depends on your audio hardware and on your needs. If you have a system with eight digital i/o channels (such as an ADAT connection), you could create several stereo or mono busses or a surround bus together with a stereo bus, or any combination you need. The important thing is that you should have the same configuration in both applications – if you have four stereo output busses on Computer 1, you want four stereo input busses on Computer 2, etc.

2. Set things up so that Computer 1 plays back some audio.
   You could for example import an audio file and play this back in Cycle mode.

3. In the Inspector or mixer (Cubase SX only), make sure the playing audio channel is routed to one of the digital output busses you have set up.

4. In Computer 2, open the mixer and locate the corresponding digital input bus.
   The audio being played back should now “appear” in the program running on Computer 2. You should see the input bus level meters moving.

5. Reverse this procedure so that Computer 2 plays back and Computer 1 “listens”.
   Now you have verified that the digital connection works as it should.

- From this point on in this chapter, we refer to the busses connected to the digital inputs and outputs as “VST System Link busses”.

Settings for the audio hardware

When you send VST System Link data between computers, it is important that the digital information isn’t changed in any way between the programs. Therefore, you should open the control panel (or additional application) for your audio hardware and make sure that the following conditions are met:

- If there are additional “format settings” for the digital ports that you use for VST System Link data, make sure these are turned off. For example, if you are using an S/P DIF connection for VST System Link, make sure that “Professional format”, Emphasis and Dithering are turned off.

- If your audio hardware has a mixer application allowing you to adjust the levels of digital inputs and outputs, make sure that this mixer is disabled or that the levels for the VST System Link channels are set to (± 0dB).

- Similarly, make sure no other forms of DSP (pan, effects, etc.) are applied to the VST System Link signal.

Notes for Hammerfall DSP users

If you are using RME Audio Hammerfall DSP audio hardware, the Totalmix function allows for extremely complex signal routing and mixing in the audio hardware. This can in some situations lead to “signal loops” in which case the VST System Link won’t work. If you want to make absolutely sure this won’t cause any problems, make sure the default or “plain” preset is selected for the Totalmix function.
Activating VST System Link

After setting up the inputs and outputs, you now need to define which input/output should carry the actual VST System Link information.

The System Link networking signal is carried on only one bit of one channel. This means that if you have an ADAT based system which normally carries eight channels of 24-bit audio, once you activate VST System Link you will have seven channels of 24-bit audio and one channel of 23-bit audio (the least significant bit of this last channel is what we will use for networking). In practice this makes no discernible difference to the audio quality, since you will still have around 138dB headroom on this channel.

To set things up we need to open the VST System Link panel:

1. Open the Device Setup dialog on the Devices menu.
2. Select the VST System Link device and make sure the Setup tab is selected to the right.
3. Use the ASIO Input and ASIO Output pop-up menus to define which channel should be the networking channel (and thus become a 23-bit audio channel, in our example).
   Quite often you will be able to just leave these pop-ups the way they are.

4. Click the Active checkbox at the top of the panel.

5. Repeat the steps above for every computer on the network.
   As the computers are made active, you should see the small T (Transmit) and R (Receive) lights flashing on each active computer, and the name of each computer should appear in the list at the bottom of the pane. Each computer is assigned a random number – don’t worry about this, it’s just so the network knows internally which one is which.

   • You can double click on the name in bold (which is the name of the computer you’re currently working on) and set it to whatever other name you wish.
     This name will appear in the System Link window of every computer on the network.

   • If you don’t see the name of each computer appearing once you have made it active, you may have to check your settings.
     Go through the procedure above again and make sure that all ASIO cards are listening to the digital clock signals correctly, and that each computer has the correct inputs and outputs assigned to the System Link network.

**Putting the network online**

After each computer’s name you will see whether it is online or not. When a computer is online, it will receive transport and timecode signals, and its sequencer application can be started and stopped by remote control. If it is off-line it can only be started from its own keyboard – it is effectively an independent machine, although it is still on the network.

   • Note that any computer can control any and all of the others – VST System Link is a peer to peer network and there is no absolute “master” computer.
     However, most users do like to think of one machine as the master (in a one person/two computer network, this would be the machine you actually sit behind most of the time).
For now, let’s put all computers online:

1. Activate the Online checkbox in the VST System Link panel for all computers.

![VST System Link panel](image)

2. Check that the system is working by pressing Play on one computer – all computers should start almost instantly and play perfectly in time, with sample accurate precision.

   - The Offset setting to the right allows you to adjust whether one machine will play back slightly ahead or behind the rest. This is normally not needed, but occasionally with some hardware you may find that the lock is a few samples out. In that case you can adjust the lock with the Offset value. For now, leave it set to 0 – it will most likely be what you want.

   VST System Link sends and understands all transport commands, so you can play, stop, fast forward, rewind etc. the entire network from one computer without a problem – try it! If you jump to a locator point on one machine, all other machines will also instantly jump to that locator point.

   ❯ Don’t forget to make sure that all computers have their tempos set to the same value, otherwise your synchronization will be seriously skewed.
Using MIDI

As well as supplying transport and sync control, VST System Link also supplies up to 16 MIDI ports, each with 16 channels. You set this up as follows:

1. Use the MIDI Ins and Outs value boxes to specify the number of MIDI ports you need.
   The default value is 0 MIDI In and 0 MIDI Out ports.

2. Create a MIDI track in the Project window and open the Inspector (top section).

3. If you now pull down the “in” or “out” pop-ups, you will find the specified System Link ports added to the list of MIDI Inputs and Outputs.

This allows you to route MIDI tracks to VST instruments running on another computer, as described in the application examples (see page 738).
The “Active ASIO Ports for Data only” setting

If you are sending huge amounts of MIDI data at once, there is a small possibility that you might run out of bandwidth on your VST System Link network. This will manifest itself by notes “choking” or timing becoming erratic.

If this happens, you can devote more bandwidth to MIDI by selecting Active ASIO Ports for Data only in the VST System Link Setup panel. When this is active, the VST System Link information will be sent on the entire channel instead of just one bit, more than enough for all the MIDI you could ever hope to use. The downside is that you can no longer use this ASIO channel for audio transfer (do not connect it to a speaker!), thus leaving you only 7 channels of audio in our ADAT cable example. Depending on how you work this might be a reasonable compromise.

Hearing the network audio

If you are using an external mixing desk, hearing your audio really isn't an issue – just plug the outputs of each computer into the desired channels on the external mixing desk, press Play on one of the computers, and you're good to go.

However, many people prefer to mix internally inside the computer and just use a desk for monitoring (or maybe not use any external mixer at all). In this case you'll need to select one computer to be your “main mix computer” and send the audio from your other computers into this.

In the following example, we assume you are using two computers, with Computer 1 as your main mix computer and Computer 2 running two additional stereo audio tracks, an FX channel track with a reverb plug-in and a VST instrument plug-in with stereo outputs.

1. First you want to set things up so that you can listen to the audio playback from Computer 1.
   In other words, you need an unused set of outputs, e.g. an analog stereo output, connected to your monitoring equipment.

2. Go to Computer 2 and route each of the two audio tracks to a separate output bus.
   These should be busses connected to the digital outputs – let's call them Bus 1 and 2.

3. Route the FX channel track to another VST System Link bus (Bus 3).
4. Route the VST instrument channel to yet another bus (Bus 4).

5. Go back to Computer 1 and check the corresponding four VST System Link input busses.
   If you start playback on Computer 2, the audio should “appear” on the input busses on Computer 1. However, to mix these audio sources you need actual mixer channels:

6. Add four new stereo audio tracks on Computer 1 and route these to the output bus you use for listening, e.g. to the analog stereo outputs.

7. For each of the audio tracks, select one of the four input busses.
   Now, each Computer 2 bus is routed to a separate audio channel on Computer 1.

8. Activate monitoring for the four tracks.
   If you now start playback, the audio from Computer 2 will be sent “live” to the new tracks on Computer 1, allowing you to hear them together with any tracks you play back on Computer 1.

Adding more tracks

OK, but if you have more audio tracks than you have VST System Link busses (physical outputs)? Then you just use the Computer 2 mixer as a submixer: Route several audio channels to the same output bus and adjust the output bus level if needed.

Note also that if your audio cards have multiple sets of input and output connections you can link up e.g. multiple ADAT cables and send audio via any of the busses on any of the cables.

Internal mixing and latency

One problem with mixing inside the computer is the latency issue we mentioned earlier. The VST engine always compensates for record latencies, but if you are monitoring through Computer 1 you will hear a processing delay while you listen to signals coming from your other computers (not on your recording!). If your audio card in Computer 1 supports ASIO Direct Monitoring you should definitely turn this on – you’ll find the setting in the VST Multitrack Device Setup panel (see page 52). Most modern ASIO cards support this function. If yours doesn’t you may want to change the Offset value in the VST System Link Setup panel to compensate for any latency issues.
**Setting up a larger network**

This is not much more difficult than a two computer network. The main thing to remember is that VST System Link is a daisy chain system. In other words, the output of Computer 1 goes to the input of Computer 2, the output of Computer 2 goes to the input of Computer 3, and so on around the chain. The output of the last computer in the chain must always go back into the input of Computer 1, to complete the ring.

Once you’ve done this, the transmission of all the transport, sync, and MIDI information to the whole network is handled pretty much automatically. However, where you may run into confusion in a large network is in the transmission of audio signals back to a central mix computer.

If you have lots of hardware inputs and outputs on your ASIO cards you don’t need to send audio via the chain at all, but can transmit it directly to the master mix computer via one or more of its other hardware Inputs. For example, if you have a Nuendo Digiset interface or 9652 card on Computer 1 you could use ADAT cable 1 for networking, ADAT cable 2 as a direct audio input from Computer 2, and ADAT cable 3 as a direct audio input from Computer 3.

You can also transmit audio via the ring system if you don’t have enough hardware I/Os for direct audio transmission. For example, in a four computer scenario you could send audio from Computer 2 into a channel in the mixer in Computer 3, and from there to a channel in the mixer in Computer 4, and from there back to the master mixer in Computer 1. This can certainly be tricky to set up, so generally it is recommended that if you want to set up a complex network, you should make sure to use ASIO cards with at least three separate digital I/Os.
Application examples

Using one computer for VST instruments

In this example, you are using one computer as your main record and playback machine, and want to use another computer as a virtual synth rack.

1. Record a MIDI track into Computer 1.

2. Once you have finished recording, route the MIDI output of that track to System Link MIDI port 1.

3. Now go to Computer 2, open up the VST Instrument rack and assign an instrument to the first slot in the rack.

4. Route the VST Instrument channel to the desired output bus. If you are using Computer 1 as your main mixing computer, this would be one of the VST System Link output busses, connected to Computer 1.

5. Create a new MIDI track in the Project window of Computer 2, and assign the MIDI output of the track to the VST Instrument you created.

6. Assign the MIDI input of the track to be VST System Link port 1. Now, the MIDI track on Computer 1 is routed to the MIDI track on Computer 2, which in turn is routed to the VST Instrument.

7. Now activate monitoring for the MIDI track on Computer 2, so that it will listen and respond to any MIDI commands coming in. In Cubase SX/SL, you would click the monitor button in the Track list or Inspector.

8. Press play on Computer 1. It will now send the MIDI information on the track to the VST Instrument loaded on Computer 2.

Even with a slow computer you should be able to stack a whole bunch of extra VST Instruments this way, expanding your sound palette considerably. Don’t forget that VST System Link MIDI is also sample accurate, and thus has much tighter timing than any hardware MIDI interface ever invented!
Creating a virtual effect rack

The effect sends for an audio channel in Cubase SX/SL can either be routed to an FX channel track or to any activated Group or output bus. This allows you to use a separate computer as a “virtual effect rack”, by setting things up in the following way:

1. Go to Computer 2 (the machine you will use as effect rack) and add a new stereo audio track.
   You cannot use an FX channel track in this case, since the track must have an audio input.

2. Add the desired effect as an insert effect for the track.
   Let’s say you add a high-quality reverb plug-in.

3. In the Inspector, select one of the VST System Link busses as input for the audio track.
   You want to use a separate System Link bus, which will only be used for this purpose.

4. Route the channel to the desired output bus.
   If you are using Computer 1 as your main mixing computer, this would be one of the VST System Link output busses, connected to Computer 1.

5. Activate monitoring for the track.

6. Now, go back to Computer 1 and select a track to which you want to add some reverb.

7. Bring up the effect sends for the track, in the Inspector or the mixer.

8. Pull down the send routing pop-up menu for one of the sends, and select the VST System Link bus assigned to the reverb in step 3.

9. Use the send slider to adjust the amount of effect as usual.
   The signal will be sent to the track on Computer 2 and processed through its insert effect, without using any processor power on Computer 1.

   You can repeat the steps above to add more effects to the “virtual effect rack”. The number of effects available this way is only limited by the number of ports used in the VST System Link connection (and of course by the performance of Computer 2, but given that it won’t have to handle any recording or playback, you should be able to use quite a lot of effects).
Getting extra audio tracks

All computers on a VST System Link network are locked with sample accuracy. Therefore, if you find that the hard drive on one computer isn’t fast enough to run as many audio tracks as you need, you could record new tracks on one of the other computers instead. This would create a “virtual RAID system”, with several disks all operating together. All tracks will remain locked together just as tightly as if they were all running on the same machine. This means that you effectively have an unlimited track count! Need another 100 tracks? Just add another computer.
Video
Background

Video support in Cubase SX/SL

Cubase SX/SL plays back video films in a number of formats.

Under Windows, video playback can be done using one of three playback engines: Video for Windows, DirectShow or Quicktime. This ensures compatibility with as wide a range of video files as possible. The following file formats are supported: AVI, Windows Media Video, Quicktime or MPEG formats (in Cubase SX you can also import files in Windows Media Video Pro format).

Under Mac OS X, Quicktime is always used as playback engine. QuickTime supports the following video file formats: AVI, MPEG, QuickTime and DV.

Generally there are two ways to play back video:

• Without any special hardware at all, using the computer CPU. In this case, the “codec” is in software. While this will be fine in many situations it does put a limit on the size of the video window as well as the quality of the image.

• Using video hardware that for example connects to an external monitor. Mac OS X: Using a FireWire port, you can play back video on an external monitor using a DV-to-analog converter or a DV camera. This is valid for DV video and QuickTime is used for playback.

Hardware solutions for playing back a video on an external monitor and further information can be found on www.steinberg.net.
Operations

About the video playback engine

In Cubase SX/SL for Windows, you select a playback engine in the Device Setup dialog, under the “Setup” tab for the Video Player device:

What playback engine to select depends largely on which type of video system you are using, as well as on the file format and codec of the video files you want to work with. Below is a brief guide to which formats you may be able to use with the different playback engines. However, this also depends on the video hardware – please consult the hardware documentation for detailed information.

<table>
<thead>
<tr>
<th>Playback engine</th>
<th>Video file formats</th>
<th>Codecs</th>
</tr>
</thead>
<tbody>
<tr>
<td>DirectShow</td>
<td>AVI, MPEG</td>
<td>Cinepak, DV, Indeo, MJPEG, MPEG</td>
</tr>
<tr>
<td>QuickTime</td>
<td>QuickTime, AVI, MPEG</td>
<td>Cinepak, DV, Indeo, MJPEG, MPEG</td>
</tr>
<tr>
<td>Video for Windows</td>
<td>AVI</td>
<td>Cinepak, Indeo, MJPEG (with some video cards)</td>
</tr>
</tbody>
</table>

- Make sure to read the section “Before you start” on page 748.
- Generally, you can expect most Windows hardware to work with DirectShow.

On a Windows system, the DirectShow and Video for Windows players are provided by the operating system, you don’t have to install any additional software.
• For the Quicktime playback method to be available, you must have QuickTime installed on your computer.

There is a freeware version (a QuickTime installer is included on the Cubase SX/SL CD if required, or you can download it from www.quicktime.com) and a “pro” version, which offers additional video cutting options. The player engine is the same in both versions, so for mere playback in Cubase SX/SL there is no need to purchase the “pro” version.

Under Mac OS X, there is only one standard player option. The Quicktime playback engine is always used, supporting the formats AVI, MPEG, QuickTime and DV. If your system has a FireWire port, there is also a FireWire option – see below.

Importing a video file

Video files are imported in the same manner as audio files, see page 114.

• By using the File menu (Import Video File).
• By using drag and drop.
• By importing to the Pool first and then dragging to the Project window (see the Pool chapter for details).

Note:

• To be able to play back the video, you must add a video track (by using the Add Track submenu on the Project menu or Quick menu). You can only have one video track in each project.
• All video files on the track must be of the same size and compression format.
• The Import dialog has an option for extracting the audio from a video file – see page 746.
Playing back a video file

Video files are displayed as events/clips on the video track, with thumbnails representing the frames in the film.

A video event on a video track.

To view the video on the computer screen (as opposed to on an external monitor, see below), proceed as follows:

• If you’re running MacOS X, first open the Device Setup dialog from the Devices menu, click Video Player in the list and make sure “Onscreen Window” is selected in the Video Output section of the dialog.

• Pull down the Devices menu and select Video (or use a key command – by default [F8]).
A video window appears. In Stop mode, this displays the video frame at the project cursor position.
Playback is done together with all other material, using the Transport panel.

Setting the Window size

If you are playing back video in a window on your computer screen, you may want to adjust the size:

• Open Device Setup dialog from the Devices menu, click Video Player in the list and use the Video Window buttons to select a size.

Playing back video in full screen mode

When viewing video on the computer screen you can choose to let the video occupy the whole screen, during playback or in Stop mode:

• Right-click (Win) or [Ctrl]-click (Mac) in the video window to switch to full screen. Click again to exit full screen.
Playing back a video file on external equipment (Mac OS X only)

For Apple computers equipped with a FireWire port, you can easily connect external video hardware via this, as OS X has built-in video support for the most common formats (NTSC/PAL/DVCPRO). FireWire is capable of high data-transfer speed and is the most common standard for communicating with video-related peripheral equipment.

- To play back a video file via hardware connected to the FireWire port, select “FireWire” in the Outputs pop-up of the Device Setup–Video Player dialog. When FireWire is selected as output, a number of format options appear on the Format pop-up, allowing you to select between various video formats and resolutions.

Extracting audio from a video file

If a video file contains audio, it can be extracted. Regardless of the audio format in the actual file, the resulting audio file will always be in the format (Sample Rate and Record Format) that is specified for the Project in the Project Setup dialog.

There are three ways to extract audio from a video file:

- By checking the Extract audio option in the Import Video dialog. This will add the audio to the currently active audio track. The new audio event will start at the same time as the video event, so that they are in sync with each other.

- By using Import Audio from Video File from the File menu. This is just as above, but no video clip is created, only an audio event (starting at the project cursor position on the selected track).

- By using Extract Audio from Video File on the Pool menu. This creates an audio clip in the Pool, but doesn’t add any events to the Project window.

- These functions are not available for mpeg video files.
Replacing the audio in a video file (Cubase SX only)

Cubase SX has a special function for replacing the audio in a video file:

1. Pull down the File menu and select Replace Audio in Video File.

2. In the file dialog that appears, locate and select the video file on your hard disk, and click Open.
   A new file dialog appears.

3. Locate and select the audio file that you want to insert into the video file, and click Open.
   The audio is added to the video file, replacing its current audio track (if any).

   • By combining the functions Extract Audio, Export Audio Mixdown and Replace Audio in Video File, you can create a complete audio track for a video file.

Project window and Browser editing operations

Video clips are played back by events just as audio clips are. You can use all the basic editing operation on video events, just as with audio events (see page 119). The following operations are not possible on the video track:

• Drawing, Gluing, Muting and Scrubbing.

• The video track has no editor and does not make use of parts.

Pool operations

For more about operations on video clips in the Pool, see page 424.
Before you start

When working on a project involving a video file, there are several points to bear in mind:

Have you selected the right player?

The player is used not only for playback of the video file, but also to provide file information in the Pool and in the Import Video dialog. Therefore, to make sure that you have chosen the right player for a particular type of video file, check the file information displayed in the Import Video dialog or the Pool prior to trying to import or playing back the file.

When this information reads “0x0 pixel”, “0.000 s” and “0 Frames”, the video file is either corrupt, or the format is not supported by the codecs available to the selected video player. You will either have to change the video player, or install the required codec.

- Trying to import or play back a file not supported by the selected video player leads to unpredictable results – if no information on the number of frames, the length and the pixel resolution is available in the Import Video dialog or the Pool, you cannot import/play this file properly with this particular video player.

- You can change the video player in the Device Setup dialog. After having done so, make sure to remove any previously imported video file from the Pool first, and re-import it.

Editing a video file

Cubase SX/SL allows you to cut, copy, paste and trim video events, i.e. your video track may contain more than one video event. However, when using the DirectShow video player on a Windows system, you may find that only the first event on the video track is played back correctly. In such a case make sure that the video track contains no more than one video event.

When working with a Windows operating system, you may find that you are unable to edit a video file copied from a CD. This is because files copied from CD are write protected by default. Right-click the file, and uncheck the “Read-Only” option in the File Properties dialog.
When you have a video file in a format not supported by Cubase SX/SL, use an external application to convert the file to a format that Cubase SX/SL can import.

**Graphics cards**

There are some graphics cards that provide more than one output. You can use such cards for display of the video on an extra TV or computer monitor in full screen mode. Check the card’s documentation for information on how it handles video output and how to set it up for multi-monitor display.

Dedicated video cards are currently not supported by Cubase SX/SL.

**Options**

In the Preferences dialog (Event Display–Video page), there are two options for video playback:

- **Show Video Thumbnails.**
  When this is activated, thumbnail frames of the video contents are shown in the track.

- **Video Cache Size.**
  This determines how much memory is available for video thumbnails. If you have long video clips and/or work with a large zoom factor (so that a lot of frames are shown in the thumbnails), you may have to raise this value.
Introduction

ReWire and ReWire2 are special protocols for streaming audio between two computer applications. Developed by Propellerhead Software and Steinberg, ReWire provides the following possibilities and features:

• Real-time streaming of up to 64 separate audio channels (256 with ReWire2), at full bandwidth, from the “synthesizer application” into the “mixer application”. In this case, the “mixer application” is of course Cubase SX/SL. An example of a “synthesizer application” is Propellerhead Software’s Reason.

• Automatic, sample accurate synchronization between the audio in the two programs.

• The possibility to have the two programs share one sound card and take advantage of multiple outputs on that card.

• Linked transport controls that allow you to play, rewind etc, either from Cubase SX/SL or from the synthesizer application (provided it has some kind of transport functionality).

• Automatic audio mixing functions of separate channels as required. In the case of Reason for example, this allows you to have separate mixer channels for the different devices.

• Additionally, ReWire2 offers the possibility to route MIDI tracks in Cubase SX/SL to the other application, for full MIDI control. For each ReWire2 compatible device, a number of extra MIDI outputs will be made available in Cubase SX/SL. In the case of Reason, this allows you to route different MIDI tracks in Cubase SX/SL to different devices in Reason, having Cubase SX/SL serve as main MIDI sequencer.

• Less total system requirements than when using the programs together in the conventional way.
Launching and quitting

When using ReWire, the order in which you launch and quit the two programs is very important:

Launching for normal use with ReWire

1. First launch Cubase SX/SL.

2. Enable one or several ReWire channels in the ReWire Device dialog for the other application.
   This is described in detail on page 754.

3. Launch the other application.
   It may take slightly longer for the application to start when you are using ReWire.

Quitting a ReWire session

When you are finished, you also need to quit the applications in a special order:

1. First quit the synthesizer application.

2. Then quit Cubase SX/SL.

Launching both programs without using ReWire

We don’t know exactly why you would want to run Cubase SX/SL and the synthesizer application at the same time on the same computer, without using ReWire, but you can:

1. First launch the synthesizer application.

2. Then launch Cubase SX/SL.

Please also note that the two programs now compete for system resources such as audio cards, just as when running either with other, non-ReWire audio applications.
Activating ReWire channels

ReWire supports streaming of up to 64 separate audio channels, while ReWire2 supports 256 channels. The exact number of available ReWire channels depends on the synthesizer application. Using the ReWire Device panels in Cubase SX/SL, you can specify which of the available channels you want to use:

1. Pull down the Devices menu and select the menu item with the name of the ReWire application. All recognized ReWire compatible applications will be available on the menu. The ReWire panel appears. This consists of a number of rows, one for each available ReWire channel.

2. Click on the power buttons to the left to activate/deactivate the desired channels. The buttons light up to indicate activated channels. Please note that the more ReWire channels you activate, the more processing power is required.

   • For information about exactly what signal is carried on each channel, see the documentation of the synthesizer application.

3. If desired, double click on the labels in the right column, and type in another name. These labels will be used in the Cubase SX/SL mixer to identify the ReWire channels.
Using the transport and tempo controls

- This is only relevant if the synthesizer application has some sort of built-in sequencer or similar.

Basic transport controls

When you run ReWire, the transports in the two programs are completely linked. It doesn’t matter in which program you Play, Stop, Fast Forward or Rewind. However, recording (if applicable) is still completely separate in the two applications.

Loop settings

If there is a loop or cycle facility in the synthesizer application, that loop will be completely linked to the Cycle in Cubase SX/SL. This means that you can move the start and end point for the loop or turn the loop on or off in either program, and this will be reflected in the other.

Tempo settings

As far as tempo goes, Cubase SX/SL is always the Master. This means that both programs will run in the tempo set in Cubase SX/SL.

However, if you are not using the Tempo track in Cubase SX/SL, you can adjust the tempo in either program, and this will immediately be reflected in the other.

- If you are using the Tempo track in Cubase SX/SL (if the Tempo button is activated on the Transport panel), you should not adjust the tempo in the synthesizer application, since a tempo request from ReWire will automatically deactivate the Tempo switch in Cubase SX/SL.
How the ReWire channels are handled in Cubase SX/SL

When you activate ReWire channels in the ReWire Device panels, they will become available as channel strips in the mixer. The ReWire channel strips have the following properties:

- ReWire channels appear to the right of the other audio and MIDI channel strips in the mixer. ReWire channel strips are denoted by a yellow label in the mixer.

- ReWire channels may be any combination of mono and stereo, depending on the synthesizer application.

- ReWire channels have the same functionality as regular audio channels. This means you can set volume and pan, add EQ, insert effects and sends and route the channel outputs to groups or busses (done in the Inspector · or in the mixer if you are using Cubase SX). However, ReWire channels have no monitor buttons.

- All ReWire channel settings can be automated using the Read/Write buttons. When you write automation, channel automation tracks will automatically appear in the Project Window. This allows you to view and edit the automation graphically, just as with VST Instrument channels, etc.

- You can mix down the audio from ReWire channels to a file on your hard disk with the Export Audio Mixdown function (see page 685). In Cubase SX/SL, you can export the output bus to which you have routed the ReWire channels. In Cubase SX, you can also export individual ReWire channels directly – “rendering” each ReWire channel to a separate audio file.
Routing MIDI via ReWire2

This feature is only available with ReWire2-compatible applications.

When using Cubase SX/SL with a ReWire2-compatible application, additional MIDI outputs will automatically appear on the MIDI Output pop-up menus for MIDI tracks. This allows you to play the synthesizer application via MIDI from Cubase SX/SL, using it as one or several separate MIDI sound sources.

The MIDI outputs for a Reason song. Here, each output goes directly to a device in the Reason rack.

- The number and configuration of MIDI Outputs depends on the synthesizer application.
Considerations and limitations

Sample rates

Synthesizer applications may be limited to audio playback in certain sample rates. If Cubase SX/SL is set to a sample rate other than those, the synthesizer application will play back at the wrong pitch. Consult the documentation of the synthesizer application for details.

ASIO drivers

ReWire works well with ASIO drivers. By using the Cubase SX/SL bussing system you can route sounds from the synthesizer application to various outputs on an ASIO compatible audio card.
33

File handling
File Operations

New Project

The New Project command on the File menu allows you to create a new project, either empty or based on a template:

1. Select New Project from the File menu.
   A list of templates is displayed. When you install Cubase SX/SL, templates for various purposes are included, but you can also create your own (see page 763).

2. Select a template from the list, or select “Empty”.
   A file dialog appears, allowing you to specify a folder for the new project.

3. Select an existing project folder or create a new one by typing its name in the dialog.
   A new, untitled project is created.

Open

The Open command on the File menu is used for opening saved project files. Both Cubase SX/SL project files (extension “.cpr”) and project files created in Steinberg’s Nuendo (extension “.npr”) can be opened (although Nuendo-specific settings will be ignored).

- Several projects can be open at the same time.
  The active project is indicated by the blue Activate button in the upper left corner of the Project window. To make another project active, click its Activate button.

- You can also open project files by selecting a shortcut from the “Recent Projects” submenu on the File menu.
  This submenu lists the projects you have recently worked with, with the most recent one at the top of the list.

- Projects can also automatically be opened when you launch Cubase SX/SL (see page 783).
About the “Pending Connections” dialogs

If you open a Cubase SX/SL project created on another setup (other audio hardware), the program tries to find matching audio inputs and outputs for the i/o busses (this is one of the reasons why you should use descriptive, generic names for your input and output ports – see page 16).

If the program cannot resolve all audio inputs and outputs used in the project, a Pending Connections dialog will appear. This will allow you to manually re-route any ports specified in the project to ports available in your system.

Similarly, a Pending Connections dialog will appear if you open a project with MIDI ports that don’t match the current MIDI setup. Again, use the dialog to re-route ports.

Close

The Close command on the File menu closes the active window. If a Project window is active, selecting Close will close the corresponding project.

• If the project contains unsaved changes, you will be asked whether you want to save the project before closing it. If you select “Don’t Save”, and have recorded or created new audio files since saving, you get the choice to delete or keep these.
Save and Save As

The commands Save and Save As allow you to save the active project as a project file (file extension ".cpr"). The Save command stores the project under its current name and location, while Save As allows you to rename and/or relocate the file. If you haven’t yet saved the project, or if it hasn’t been changed since it was last saved, only Save As will be available.

- Generally, we recommend that you save project files in their project folders, to keep the projects as manageable as possible.

A word about file extensions

Under Windows, file types are indicated by three letter file name extensions (such as *.cpr for Cubase SX/SL project files). Under Mac OS X, it is not necessary to use file name extensions, since the file types are stored internally in the files. However, if you want your Cubase SX/SL projects to be compatible with both platforms, you should make sure the option “Use File Extension in File Dialog” is activated in the Preferences dialog – this is the default setting. When this is activated, the proper file name extension is automatically added when you save a file.

Saving a Default project

If you always want the same default project to open when you launch Cubase SX/SL, you can save a default project:

1. Set up a project the way you want it.
2. Select “Save As” from the File menu and save the project with the name “default.cpr”. The location depends on the operating system:
   - Mac OS X: the folder “Library/Preferences/Cubase SX/SL/” in your “home” directory. The full path would be: Users/<user name>/Library/Preferences/Cubase SX/SL.
   - Windows: Among the User Settings for Cubase SX/SL. The full path is: Documents and Settings/<user name>/Application Data\Steinberg\Cubase SX/SL

- This is the one case when the file name extension is crucial under Mac OS X as well!

3. Open the Preferences dialog and select the General page.
4. Open the “On Startup” pop-up and select “Open Default Project”. The next time you launch Cubase SX/SL, the default project is automatically opened. For details on the other Startup options, see page 783.
Save New Version

This function is only available as a key command, by default [Ctrl]+[Alt]+S (Windows) or [Command]+[Option]+S (Mac). When you use this function, a new version of the project is saved (or in other words, the project is saved under a new name). The new file will have the same name as the original project but with an incremental number attached. For example, if your project is called “My Project” you will get new versions called “My Project-01”, “My Project-02”, and so on.

Save New Version is useful if you are experimenting with edits and arrangements and want to be able to go back to a previous version at any time. The most recent new versions you have created will be listed on the Recent Projects submenu on the File menu, for instant access.

Save as Template

This function allows you to save the current project as a template. Templates are always stored in the Templates folder (within the Cubase SX/SL program folder). When you create a new project, the available templates will be listed, allowing you to base the new project on a template.

- Templates can contain clips and events, just like regular projects.
  If this is not what you want, make sure to remove all clips from the Pool before you save the project as a template.
Save Project to New Folder

This function is very useful if you want to move or archive your project. If you select this item, you will first be asked where to store the saved project. Then a dialog will appear, with the following options:

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project Name</td>
<td>By default, this will be the current name of the project you're saving, but you can change it if you like.</td>
</tr>
<tr>
<td>Minimize Audiofiles</td>
<td>If this is activated, only the audio file portions that are actually used in the project will be included. This can significantly reduce the size of the project folder (if you are using small sections of large files), but it will also mean you cannot make use of the remaining audio file portions if you continue working with the project in its new folder.</td>
</tr>
<tr>
<td>Freeze Edits</td>
<td>This will perform a Freeze Edits operation, making all processing and applied effects permanent to each clip in the Pool. See page 357.</td>
</tr>
<tr>
<td>Remove Unused Files</td>
<td>When this is activated, only files in the Pool that are actually used in the project will be stored in the new folder.</td>
</tr>
</tbody>
</table>

When you've made your settings, click OK to save the project in the new folder. The original project isn’t removed or affected.

Revert

If you select Revert from the File menu, you will be asked whether you really want to revert to the last saved version of the project. If you click “Revert”, all changes you have made since saving will be discarded.

- If you have recorded or created new audio files since saving, you will be asked whether you want to delete or keep these.
Working with Libraries (Cubase SX only)

A Library is a stand-alone Pool, that is not associated with a project file. You can use Libraries to store sound effects, loops, Video Clips, etc., and transfer media from a Library into a project by using drag and drop. The following library functions are available on the File menu:

**New Library**

Creates a new library. Just as when creating new projects, you will be asked to specify a project folder for the new library (in which media files will be stored). The Library will appear as a separate Pool window in Cubase SX.

**Open Library**

Opens a file dialog for opening a saved library file.

**Save Library**

Opens a file dialog for saving the library file (file extension ".npl").
The Cleanup function

The Cleanup function on the File menu helps you to save hard disk space by locating, and if you like, deleting unused audio files in the project folders on your disk.

1. Select “Cleanup…” from the File menu.
   If there are any open projects, an alert will appear, allowing you to close these. Clicking “Close” closes all open projects and brings up the Cleanup dialog.

2. If you want to restrict the Cleanup function to a certain folder only, click the “Search Folder” button and select the folder.
   You should only select a specific folder if you are certain it doesn’t contain audio files used in other projects (outside the folder)! See the note below.
   If you want the Cleanup function to be applied to all folders on all hard disks, you don’t need to make any special settings, as this is the default mode. After selecting a folder you can reset the function to search all folders by opening the “Search Folder” dialog again and clicking “Cancel”.

3. Click the Start button.
   Cubase SX/SL will now scan the selected folder (or all hard disks) for Cubase SX/SL project folders and check for audio and image files (in the Audio, Edits and Images subfolders) that are not used by any project. The found files are listed in the dialog.

4. When the scan is complete, you can select files by clicking in the list.
   Use [Ctrl]/[Command]-click to select several files, and [Shift]-click to select a range of files. You can also click the Select All button to select all files in the list.

• There are situations when the Cleanup function will list files that are not unused!
  - If you have moved or renamed files or folders (without updating the project files to use the new paths), there is no way for Cubase SX/SL to know that these files are used in a project.
  - If you perform the Cleanup function on a folder in which there are audio files belonging to other projects (outside the folder), these files will be considered “unused”.
  - Also, make sure you don’t delete any files used in other applications, or files that you generally want to keep!

   However, you can safely delete Image files since these can be reconstructed by the program if necessary.

5. Delete any files you don’t want to keep, by selecting them and clicking Delete.

6. Close the dialog by clicking its close button.
Exporting and importing tracks (Cubase SX only)

You can export Cubase SX tracks (of any type) for later import into other Cubase SX projects (or Nuendo projects). Everything associated with the tracks will be exported (mixer channel settings, automation sub-tracks, parts and events etc.) and a separate "media" folder will be created, containing copies of all referenced audio files.

Project specific settings such as tempo are not part of the exported track files.

Exporting tracks
1. Select the tracks that you wish to export.
2. Pull down the File menu and open the Export submenu.
3. On the submenu, select “Selected Tracks...”.
   A file dialog appears allowing you to select or create (and name) an empty destination folder for the exported tracks.
4. Click OK.
   The tracks will be saved in the specified folder, and will contain two items; a XML file named after the enclosing folder and a subfolder named “Media” which will contain any associated audio or video files.

Importing tracks

The Import Track Archive function lets you import track exported from another Cubase SX (or Nuendo) project.

• Note that the sample rate used in the project you import tracks to has to match the sample rate in the original project! If not, audio files will play back at the wrong speed.

1. Pull down the File menu and open the Import submenu.
2. On the submenu, select “Track Archive...”.
3. In the file dialog that appears, locate the XML file, select it and click Open.
   The “Copy files to Project Folder?” dialog appears just like when importing audio files.
4. Click Yes to copy the files into your current project or No to leave them in their current location.
   The tracks are imported, complete with all contents and settings.
Exporting and importing OMF files (Cubase SX only)

Open Media Framework Interchange (OMFI) is a platform independent file format intended for transfer of digital media between different applications. Cubase SX can import and export OMF files (file extension ".omf"), allowing you to use Cubase SX in conjunction with other audio and video applications.

**Exporting OMF files**

1. Pull down the File menu and open the Export submenu.

2. On the submenu, select “OMF...”.
   The OMF Export Setup dialog appears.

3. Select “1.0 File” or “2.0 File” depending on which OMFI version is supported by the application in which you plan to import the file.

4. Select whether you want to include all audio data in the OMF file (“Export All to One File”) or use references only (“Export Media File References”).
   If you choose “Export All to One File”, the OMF file will be totally “self-contained”, but possibly very large. If you choose “Export Media File References”, the file will be small, but the referenced audio files must be available for the receiving application.

5. If you selected the “2.0 File” option above you can choose whether to include the fades and volume settings for the events (as set up with the event fade and volume handles) – to include these in the OMF file, activate “Export Clip Based Volume” or “Use Fade Curves” respectively.

6. Specify a sample size (resolution) and sample rate for the exported files (or use the current project settings).

7. Click OK, and specify a name and location in the file dialog that appears.

The exported OMF file will contain (or make reference to) all audio files that are played in the project (including fade and edit files). It will not include unused audio files referenced in the Pool, or any MIDI data. Video files are not included, but Cubase SX stores the start positions of Video Events in the OMF file, allowing you to manually import video files in the other OMF application (see below).
Importing OMF files

1. Pull down the File menu and open the Import submenu.

2. On the submenu, select “OMF...”.

3. In the file dialog that appears, locate the OMF file and click Open. A project file dialog appears, allowing you to specify a folder for the new project.

4. Select an existing project folder or create a new one by typing its name in the dialog.

5. If the OMF file contains Video Event information, you are asked whether you want to create Markers at the start position of the Video Events. This allows you to manually import the video files, using the Markers as position references.

   A new, untitled project is created, containing the Audio Events of the imported OMF file.
Exporting and importing MIDI files

Cubase SX/SL can import and export Standard MIDI Files, which makes it possible to transfer MIDI material to and from virtually any MIDI application, on any platform. When you import and export MIDI files, you can also specify whether certain settings associated with the tracks should be included in the files (automation subtracks, volume and pan settings etc.).

Exporting MIDI Files

To export your MIDI tracks as a Standard MIDI File, pull down the File menu and select “MIDI File...” from the Export submenu. A regular file dialog appears, allowing you to specify a location and name for the file.

When you have specified a location and a name for the file, click “Save”. At this point, the Export Options dialog appears, allowing you to specify a number of options for the file – what should be included in the file, its type and its resolution (see below for descriptions of the options).

The Export Options dialog.

You will also find these settings in the Preferences dialog (MIDI-MIDI File page). If you set these up once and for all in the Preferences, you only need to click OK in the Export Options dialog to proceed. The dialog contains the following options:
The MIDI File will include the Tempo track.

Inspector settings (other than patch, volume, pan and effects – see above) are not included in the MIDI file!

To include these, you need to convert the settings to “real” MIDI events and properties by using the Merge MIDI in Loop function for each track, see page 500.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Export Inspector Patch</td>
<td>If this is checked, the MIDI patch settings in the Inspector – Bank Select and Program Select (used for selecting sounds in the connected MIDI instrument) are included as MIDI Bank Select and Program Change events in the MIDI file.</td>
</tr>
<tr>
<td>Export Inspector Volume/Pan</td>
<td>If this is checked, Volume and Pan settings made in the Inspector are included as MIDI Volume and Pan events in the MIDI file.</td>
</tr>
<tr>
<td>Export Automation</td>
<td>If this is checked, recorded automation (see page 205) is converted to MIDI controller events and included in the MIDI file. This also includes automation recorded with the MIDI Control plug-in (see page 483).</td>
</tr>
<tr>
<td>Export Inserts</td>
<td>If this is checked and you are using any MIDI plug-ins as insert effects, the modifications to the original MIDI notes that occur as a result of the effect(s) will be included in the MIDI file. A MIDI delay, for example, will produce a number of repeats to a MIDI note by actually adding additional, “echoing” notes at rhythmic intervals – these notes will be included in the MIDI file if the option is activated.</td>
</tr>
<tr>
<td>Export Sends</td>
<td>If this is checked and you are using any MIDI plug-ins as send effects, the modifications to the original MIDI notes that occur as a result of the effect(s) will be included in the MIDI file.</td>
</tr>
<tr>
<td>Export Marker</td>
<td>If this is checked, any markers you have added (see page 153) will be included in the MIDI file as Standard MIDI File Marker events.</td>
</tr>
<tr>
<td>Export as Type 0</td>
<td>If this is checked, the MIDI file will be of Type 0 (all data on a single track, but on different MIDI channels). If you don’t check this option, the MIDI file will be of Type 1 (data on separate tracks). Which type to choose depends on what you want to do with the MIDI file (in which application or sequencer it should be used, etc.).</td>
</tr>
<tr>
<td>Export Resolution</td>
<td>You can specify a MIDI resolution between 24 – 960 for the MIDI file. The resolution is the number of pulses, or ticks, per quarter note (PPQ) and determines the precision with which you will be able to view and edit the MIDI data. The higher the resolution, the higher the precision. The resolution should be chosen depending on the application or sequencer with which the MIDI file should be used though, since certain applications and sequencers may not be able to handle certain resolutions.</td>
</tr>
</tbody>
</table>
Importing MIDI Files

To import a MIDI file from disk, proceed as follows:

1. Select “MIDI File...” from the Import submenu on the File menu.

2. In the dialog that appears, select whether a new project should be created for the file or not.
   If you select “No”, the MIDI file will be imported into the current project.

3. Locate and select the MIDI file in the file dialog that appears, and click Open.

4. If you chose to have a new project created, you are asked to specify a project folder for the new project.
   Select an existing project folder or create a new one by selecting a location for it and typing its name in the dialog.

The MIDI file is imported. The result depends on the contents of the MIDI file and the Import Options settings in the Preferences dialog – MIDI-MIDI File page:

The Import Options are as follows:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Extract First Patch</td>
<td>If this is checked, the first Program Change and Bank Select events for each track are converted to Inspector settings for the track.</td>
</tr>
<tr>
<td>Extract First Volume/Pan</td>
<td>If this is checked, the first MIDI Volume and Pan events for each track are converted to Inspector settings for the track.</td>
</tr>
<tr>
<td>Import Volume/Pan as</td>
<td>If this is checked, all MIDI Volume and Pan events in the MIDI file will be converted to automation data for the MIDI tracks.</td>
</tr>
<tr>
<td>Automationtrack</td>
<td></td>
</tr>
<tr>
<td>Import to Left Locator</td>
<td>If this is checked, the imported MIDI file will be placed so that it starts at the position of the left locator – otherwise it will start at the beginning of the project. Note that if you choose to have a new project created automatically, the MIDI file will always start at the beginning of the project.</td>
</tr>
</tbody>
</table>
As mentioned on page 771, the result also depends on what type of MIDI file it is – Type 0 or Type 1:

- If the MIDI file is of Type 0 (all data on a single track), only one MIDI track will be created. This track will be set to MIDI Channel “Any”, allowing all MIDI events to play back on their original channels. You can use the Dissolve Part function on the MIDI menu to distribute the events onto different tracks with different MIDI Channels (see page 523).

- If the MIDI file is of Type 1 (data on several tracks) a number of new MIDI tracks and parts will be created.

In both cases, the Tempo track is adjusted according to the Tempo track in the MIDI file.

- It is also possible to import a MIDI file from disk by dragging and dropping it from the Windows Explorer or the Mac OS Finder into the Cubase SX/SL Project window. The Import Options apply if you use this method as well.
**Importing Cubase VST files**

As described on page 760, the regular Open function can open projects made in Cubase SX/SL or Nuendo. It is also possible to import files created in older versions of Cubase. There are three options for this on the File – Import submenu:

**Import Cubase Song**

This will open a Song file (Windows file extension "*.all") created in Cubase 5.0 or later and convert it to a Cubase SX/SL project. When importing a Song, you will be asked to specify a folder for the new project, as usual.

- **Cubase Songs can contain more than one Arrangement (containing independent part and event data).** If this is the case, you will be asked which one of these Arrangements to import.

To import all Arrangements in a Cubase Song, simply repeat this for all Arrangements, and save each as a separate project.

The conversion has the following limitations:

<table>
<thead>
<tr>
<th>Data</th>
<th>Conversion result</th>
</tr>
</thead>
<tbody>
<tr>
<td>MIDI output setting for MIDI tracks</td>
<td>If the output information stored in the original Song doesn’t match the current outputs, a “Pending Connections” dialog will appear, allowing you to remap each MIDI output in the Song to a new output.</td>
</tr>
<tr>
<td>MIDI track play parameters (Inspector settings)</td>
<td>Only the volume and transpose settings are included; the other parameters (velocity, compression, length and pan) are ignored.</td>
</tr>
<tr>
<td>MIDI part play parameters (Inspector settings)</td>
<td>All settings are included, except transpose.</td>
</tr>
<tr>
<td>Group tracks</td>
<td>Removed.</td>
</tr>
<tr>
<td>Style tracks</td>
<td>Removed.</td>
</tr>
<tr>
<td>Chord tracks</td>
<td>Removed.</td>
</tr>
<tr>
<td>Drum tracks</td>
<td>Converted to MIDI tracks with drum maps. MIDI output settings for individual drum sounds will be ignored.</td>
</tr>
<tr>
<td>Solo/Mute status of tracks</td>
<td>Ignored.</td>
</tr>
<tr>
<td>MIDI “effect” devices, such as the arpeggiator and IPS</td>
<td>Removed.</td>
</tr>
</tbody>
</table>
It's also possible to import Songs created in version 3.7x of Cubase for Windows.
However, this will only include the basic audio and MIDI data, ignoring most of the settings.

**Import Cubase Arrangement**

As mentioned above, a Song in previous versions of Cubase could contain one or several Arrangements. These contained all the part and event data along with file references, but without mixer settings and similar, which were global to all Arrangements in the Song. Arrangements could be saved as separate files, with the extension ".arr".

When you import a Cubase Arrangement into Cubase SX/SL, it will be converted to a project, just as when importing a Song. The same limitations apply.

<table>
<thead>
<tr>
<th>Data</th>
<th>Conversion result</th>
</tr>
</thead>
<tbody>
<tr>
<td>Window layouts</td>
<td>Ignored.</td>
</tr>
<tr>
<td>Key command settings</td>
<td>Ignored.</td>
</tr>
<tr>
<td>Grooves</td>
<td>Ignored.</td>
</tr>
<tr>
<td>MIDI Mixermaps</td>
<td>Removed.</td>
</tr>
<tr>
<td>Dynamic events in audio parts (including M-points)</td>
<td>Ignored.</td>
</tr>
<tr>
<td>Automation</td>
<td>The VST channel automation is included, but limited to volume, pan and EQ data. Plug-in automation and automation for DSP Factory settings are ignored.</td>
</tr>
<tr>
<td>Left/right locator positions and cycle status</td>
<td>Ignored.</td>
</tr>
<tr>
<td>Sync settings and status</td>
<td>Ignored.</td>
</tr>
<tr>
<td>Master track hitpoints</td>
<td>Removed.</td>
</tr>
<tr>
<td>VST Group channels</td>
<td>Removed.</td>
</tr>
<tr>
<td>Multiple audio tracks routed to the same audio channel</td>
<td>Will be replaced by separate audio tracks (with separate channels in the mixer). This is because in Cubase SX/SL there is always one channel per track.</td>
</tr>
<tr>
<td>Solo/Mute status of VST channels</td>
<td>Ignored.</td>
</tr>
</tbody>
</table>

CUBASE SX/SL
File handling  33 – 775
Import Cubase Part

Just as in Cubase SX/SL, previous Cubase versions used parts as containers for MIDI or audio events. These could be saved as separate files with the extension "*.prt". When you import a part file, the following happens:

- A new track is created, with the name of the part. That is, the name of the part when it was saved in Cubase, not (necessarily) the file name.
- The part appears as a Cubase SX/SL part, at the left locator position.
- If the imported part was an audio part, the necessary clips and file references are added to the Pool.

Note that none of these file formats contain any actual audio data. Just as with Cubase SX/SL projects, the files only contain references to audio files. This means that you need access to the referenced audio files as well, to properly import Songs, Arrangements or Parts with audio.
**Importing audio CD tracks**

You can import audio from audio CDs, for use in Cubase SX/SL projects. This is done by selecting “Import Audio CD” from the Pool menu (or by selecting the “Audio CD...” option from the Import submenu on the File menu).

- If the project window is active, the imported audio CD track(s) will be inserted on the selected audio track, at the project cursor position. It is also possible to import audio CD tracks into the Pool, which may be the preferred method if you want to import several CD tracks in one go.

Selecting one of the Import Audio CD menu items brings up the following dialog:

- If you have more than one CD drive, you use the Drives pop-up menu to select the one holding the audio CD.

- The Speeds pop-up menu (Windows version only) lists all possible data transfer speeds for the selected CD drive. While you normally want to use the fastest possible speed, you may have to select a slower speed for flawless audio extraction.
• The main display in the dialog lists all audio tracks on the CD. The columns have the following functionality:

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Grab</td>
<td>Activate the checkbox in this column for the track you want to grab (import). To activate more than one checkbox (import more than one track), click and drag over the checkboxes (or press [Ctrl]/[Command] or [Shift] and click).</td>
</tr>
<tr>
<td>Track</td>
<td>When you import an audio CD track, the file will be named according to the name in this column. You can rename a track by clicking in the Track column and typing a new name. You can also apply a name to all audio CD tracks (e.g. the name of the album, see below).</td>
</tr>
<tr>
<td>Length</td>
<td>The length of the whole audio CD track, in minutes and seconds.</td>
</tr>
<tr>
<td>Size</td>
<td>The file size of the whole audio CD track, in MegaBytes.</td>
</tr>
<tr>
<td>Grab Start</td>
<td>You can grab a section of a track if you like. This indicates the start of the section to be grabbed in the track. By default, this is set to the start of the track (0.000) but you can adjust this on the grab selection ruler (see below).</td>
</tr>
<tr>
<td>Grab End</td>
<td>Indicates the end of the section to be grabbed in the track. By default, this is set to the end of the track but you can adjust this on the grab selection ruler (see below).</td>
</tr>
</tbody>
</table>

• You can audition the selected audio CD track by clicking the Play button. The track will be played back from the grab selection start (see below) to the track end (or until you click the button again). During playback, the button is labeled “Stop”.

• The arrow buttons next to the Play button allow you to audition the start and end of the grab selection only. The left button will play a short snippet beginning at the start of the grab selection (see below), while the right button will play a snippet starting just before the end of the grab selection.

• If you want to import a section of an audio CD track only, you select the track in the list and specify the start and end of the grab selection by dragging the handles in the grab selection ruler. Use the start and end audition buttons to fine tune the selection boundaries.
Note that you can import sections of several audio CD tracks by selecting them in turn and adjusting the grab selection. The grab start and end settings for each track will appear in the list.

- If you wish, you can change the generic audio file name in the File Name field.
  By default, the imported audio files will get this name with a track number added (typically Track 01, Track 02, and so on). However, if you have adjusted the track name for a specific audio CD track in the list, the corresponding audio file will use that name instead.

- By default, imported audio CD tracks will be stored as Wave files (Windows) or AIFF files (Mac) in the Audio folder of the current project.
  You can select another folder by clicking the Change Folder button.

- Clicking the Grab button will convert the selected audio CD tracks (the tracks for which the Grab checkbox is ticked) to audio files. The grabbed files will be listed at the bottom of the dialog – click OK to actually import the files into the project and close the dialog, or click Cancel to discard the grabbed files.

**Importing Audio from Video files**

While you can automatically extract the audio when importing a video file (see page 746), it is also possible to import the audio from a video file without importing the video itself:

1. Pull down the File menu and select “Audio from Videofile” from the Import submenu.

2. In the file dialog that appears, locate and select the video file and click Open.
   The audio in the selected video file is extracted and converted to a Wave file in the project’s Audio folder.

- A new Clip is created and added to the Pool. If the Project Window is active, an Event will be inserted on the selected Track at the project Cursor position.
  This works just like when importing regular audio files.
Importing ReCycle files

ReCycle, developed by Propellerhead Software, is a program designed especially for working with sampled loops. By “slicing” a loop and making separate samples of each beat, ReCycle makes it possible to match the tempo of a loop and edit the loop as if it was built up of individual sounds. Cubase SX/SL can import two file types created by ReCycle:

- REX files (export file format of the first versions of ReCycle, extension ".rex").
- REX 2 files (file format of ReCycle 2.0 and later, extension ".rx2").

Proceed as follows:

1. Select an audio track and move the project cursor to where you want the imported file to start.
   You probably want to import REX files to tempo based audio tracks, since this will allow you to change the tempo later on (having the imported REX file automatically adjust).

2. Select “Audio File…” from the Import submenu on the File menu.

3. Select REX files or REX 2 files with the file type pop-up menu in the file dialog.

4. Locate and select the file and click Open.
   The file is imported, and automatically adjusted to the current Cubase SX/SL tempo.
   Unlike a regular audio file, the imported REX file will consist of several events, one for each “slice” in the loop. The events will automatically be placed in an audio part on the selected track, and positioned so that the original internal timing of the loop is preserved.

5. If you now open the part in the Audio Part Editor, you can edit each slice separately by muting, moving and resizing events, adding effects and processing, etc.
   You can also adjust the tempo and have the REX file automatically follow (provided that its track is tempo based).

- **You can also achieve similar results by using Cubase SX/SL’s own loop slicing features.**
  See page 398.
Importing compressed audio files

During the last years, various audio compression formats have become very common. The major advantage of using such file formats is that the file size is significantly reduced, with very little degradation of sound quality. This allows for quick download, mass storage and easy transport.

Cubase SX/SL can import (and export, see page 685) several common audio compression formats. The procedure is the same as when importing any non-compressed audio file, with one important thing to note:

- If you import a compressed audio file, Cubase SX/SL will create a copy of the file and convert this to Wave format (Windows) or AIFF format (Mac OS X) before importing it (the original compressed file will not be used in the project). The Wave/AIFF file will be placed in the designated project Audio folder. Please be aware that the converted Wave/AIFF file will be several times larger than the original compressed file!

The following file types are supported:

MPEG audio files

MPEG, which stands for Moving Picture Experts Group, is the name of family of standards used for coding audio-visual information (e.g. movies, video, music) in a digital compressed format.

Cubase SX can read three types of audio MPEG files: MPEG Layer 1 (file extension *.mpeg), MPEG Layer 2 (*.mp2) and MPEG Layer 3 (*.mp3). Cubase SL can read mp3 only. Currently, mp3 is the most common of these formats, while the mp2 format is mostly used in broadcast applications.

- Note that the file extension ".mpeg" can also be used by MPEG video files. If you select an MPEG video file in the Import Audio dialog you will not be able to import it.

Ogg Vorbis files

Ogg Vorbis is a relatively new format that is open and patent-free and offers very small audio files maintaining comparatively high audio quality. Ogg Vorbis files have the extension ".ogg".
Windows Media Audio files (Windows only)

Windows Media Audio is an audio format developed by Microsoft Inc. Due to advanced audio compression algorithms, Windows Media Audio files can be made very small, maintaining good audio quality. The files have the extension “.wma”.

Options and Settings

Auto Save

If you activate the Auto Save checkbox in the Preferences dialog (General page), Cubase SX/SL will automatically save backup copies of all open projects with unsaved changes.

• You specify how often a backup copy should be created with the Auto Save Interval setting.

• Backup copies are named “Name.bak”, where “Name” is the name of the project. The files are saved in the project folder.

• Unsaved projects are also backed up in the same way. Backup copies of unsaved projects will be named “#UntitledX.bak” where “X” is an incremental number, to allow multiple backup copies in the same project folder.
## Startup Options

The “On Startup” pop-up menu in the Preferences dialog (General page) allows you to specify what should happen each time you launch Cubase SX/SL. The following options are available:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Do Nothing</td>
<td>Cubase SX/SL launches without opening a project.</td>
</tr>
<tr>
<td>Open Last Project</td>
<td>The last saved project is opened on launch.</td>
</tr>
<tr>
<td>Open Default Project</td>
<td>The default project is opened (see page 762).</td>
</tr>
<tr>
<td>Show Open Dialog</td>
<td>The Open dialog appears on launch, allowing you to manually locate and open the desired project.</td>
</tr>
<tr>
<td>Show Template Dialog</td>
<td>The Template dialog appears on launch, allowing you to create a new project from one of the templates.</td>
</tr>
<tr>
<td>Show Open Options Dialog</td>
<td>The Open Document Options dialog appears on launch, see below. It allows you to make a different choice each time you launch Cubase SX/SL.</td>
</tr>
</tbody>
</table>
Cubase SX/SL Open Document Options Dialog

The Cubase SX/SL projects you have used recently are displayed in the list. To open one of them, select it and click the “Open Selection” button. To open another project not listed there, click the “Open Other...” button. A file dialog appears that allows you to look for the desired file on your disk. Click the "New Project" button to create a new project using a template or not.

If you hold down [Ctrl]/[Command] while launching Cubase SX/SL this dialog will always be displayed, regardless of the startup option selected in the Preferences dialog (General page).
Customizing
Background

The user can customize the appearance and functionality of Cubase SX/SL in various ways.

User configurable items described in this chapter are:

• Window layouts
  By storing different window combinations as window layouts, you can quickly switch between different working modes – see page 787.

• Transport panel
  The user can configure which Transport panel items are to be shown or hidden, and where they should be located – see page 790.

• Toolbars
  In the project window and all editor windows, the user can configure which toolbar items are to be shown or hidden, and where they should be located – see page 792.

• Track list
  The controls shown in the Track list can be set for each track type – see page 794.

• Preferences presets (Cubase SX only)
  You can save and recall preference settings as preference presets – see page 799.

• Appearance
  The general look of the program can be adjusted – see page 801.

This chapter also contains a section describing where your preferences and settings are stored (see page 801), to help you transfer your customized settings to another computer.
Working with window layouts

A configuration of windows for the active project is called a “window layout”. By storing different window combinations as window layouts, you can quickly switch between different working modes. You may for example want as large a Project window as possible when you are editing, whereas you may want the mixer and effect windows open during mixdown. Window layouts are listed and managed on the Window Layouts submenu on the Windows menu.

Editing the active window layout

There is always one layout active, even if you haven’t saved any. To make changes to the active window layout, proceed as follows:

- Make the desired changes to the window configuration. This may include opening, closing, moving and sizing windows, and adjusting zoom and track height.

  The changes are automatically stored for the active layout.

Creating a new window layout

1. Set up the windows you want to include in the window layout. This may include opening, moving and sizing windows, and adjusting zoom and track height.

2. Pull down the Window menu and open the Window Layouts submenu.

3. Select “New...”.
4. In the dialog that appears, enter a name for the window layout.

![New Window Layout dialog]

5. Click OK.
The window layout is stored and will appear on the Window Layouts submenu. It will now be the active layout.

Activating a window layout
1. Pull down the Window menu and open the Window Layouts submenu.
2. Select the window layout from the list on the submenu.
The windows are closed, opened, moved and/or resized according to the stored window layout.

- You can also activate any of the first nine window layouts using key commands.
  By default, this is done by pressing [Alt]/[Option] and the corresponding key on the numeric keypad ([Alt]/[Option]-[1] selects layout 1, and so on).

Recapture layout
This allows you to change a stored layout:
1. First select a stored layout so that it is active.
2. Change the setup of the windows the way you want them and select Recapture.
3. In the dialog that appears, click OK to save the changes to the layout.
   If you wish, you can also rename the layout in the dialog.
Organizing window layouts

If you select "Organize..." from the Window Layouts submenu, a dialog opens, listing all available window layouts.

- To rename a window layout, double click its name in the list and type in a new name.

- To create a new window layout based on the current window configuration, click the New button. The new layout appears in the list allowing you to adjust its name and properties.

- To activate a layout, either select it and click the Activate button, or double click in the number column to the left. The layout is activated and the dialog is closed (unless the "Keep Window Open" checkbox is ticked).

- To remove a window layout, select it in the list and click the Remove button. The layout is removed from the list.

- To close the dialog, click the OK button. Note that you can continue working in other windows with the Organize Layouts dialog open.
Customizing the Transport panel

You can customize the appearance of the Transport panel by deciding which parts of it you wish to be visible, and where the parts should be located on the panel.

Setting which items are shown/hidden

If you right-click (Win) or [Ctrl]-click (Mac) anywhere within the Transport panel area, a pop-up menu will appear. On this menu, you can directly check or uncheck elements of the Transport panel as desired.

You can also select different preset configurations from the lower half of the menu. To make all hidden items visible again, select “Show All”.

<table>
<thead>
<tr>
<th>Performance</th>
<th>Record Mode</th>
<th>Location</th>
<th>Jog/Zoom</th>
<th>Mute/Transport</th>
<th>Meter + Sync</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Setup...
The Transport Setup dialog

If you right-click (Win) or [Ctrl]-click (Mac) anywhere within the Transport panel area and select “Setup…” from the pop-up menu, a dialog appears. In this dialog you can also configure where the separate parts should be placed on the panel as well as saving/recalling different configurations of the Transport panel.

The dialog is divided into two columns. The left column displays the currently visible items on the Transport panel, and the right column displays the currently hidden items.

- You can change the current show/hide status by selecting items in one column and then use the arrow buttons in the middle of the dialog to move them to the opposite column. Changes are applied directly.

- By selecting items in the “Visible Items” column and using the Move Up and Move Down buttons you can change the position of the selected item(s) on the Transport panel. Changes are applied directly. To undo all changes and revert back to the standard Transport panel layout, you can select “Default” from the pop-up menu accessed by right-clicking/[Ctrl]-clicking the Transport panel.

A “customized” Transport panel
• If you click the Save button (disk icon) in the Presets section, you can name the current configuration and to save it as a preset. The saved setting appears in the Presets field.

• To remove a preset, select it and click the trash icon.

• Saved configurations are available for selection from the Presets popup in the dialog, or directly from the pop-up menu brought up by right-clicking or [Ctrl]-clicking the Transport panel.

Customizing the toolbars

You can customize the appearance of the toolbars in the Project window and editor windows by deciding which sections should be visible, and where the sections should be located on the panel. The screenshots below illustrate customizing the Project window toolbar but you can use the same procedures for the toolbars in the Sample Editor, the MIDI editors and the Tempo Track Editor.

Setting which items are shown/hidden

If you right-click (Win) or [Ctrl]-click (Mac) anywhere within the toolbar area, a pop-up menu will appear. On this menu, you can directly check or uncheck elements of the toolbar as desired.

You can also select “Show All” (makes all hidden items visible) or “Default” (makes all hidden items visible – except those that are hidden by default – and moves them back to their standard locations).
The Toolbar Setup dialog

If you select “Setup...” from the pop-up menu, a dialog appears. In this dialog you can decide which items should be visible, where the separate items should be placed on the toolbar and save/recall different configurations of the toolbar.

The dialog is divided into two columns. The left column displays the currently visible items on the toolbar, and the right column displays the currently hidden items.

- You can change the current show/hide status by selecting items in one column and then use the arrow buttons in the middle of the dialog to move them to the opposite column. Changes are applied directly.

- By selecting items in the “Visible Items” column and using the Move Up and Move Down buttons you can change the position of the selected item(s) on the toolbar. Changes are applied directly.

A “customized” toolbar

- If you click the Save button (disk icon) in the Presets section, a text field appears, allowing you to name the current configuration and to save it as a preset. The saved setting appears in the Presets field.
• To remove a preset, select it and click the trash icon.

• Saved configurations are available for selection from the Presets pop-up in the dialog, or directly from the pop-up menu brought up by right-clicking or [Ctrl]-clicking the toolbar.

Customizing track controls

You can configure (separately for each track type) what track controls should be shown in the Track list. You can also specify the location of controls and group controls so that they are always shown adjacent to each other. All this is done using the Track Controls Settings dialog.

Opening the Track Controls Settings dialog

There are two ways to open the dialog:

• By right-clicking (Win) or [Ctrl]-clicking (Mac) a track in the Track list, and selecting “Track Controls Settings” from the menu that appears.

or

• By clicking the arrow in the top left corner of the Track list and selecting “Track Controls Settings”.

The dialog mainly consists of two lists, the left showing “Used Controls” and the right “Available Controls”.

• The items in the Used Controls list are the controls currently shown in the Track list for the selected track type.

• The items in the Available Controls list (if any) are controls currently hidden in the Track list for the selected track type.
Setting the track type

The settings made in the Track Controls Settings dialog apply to the selected track type (Audio, MIDI, Group/FX Channel, Folder, Video). If you right-clicked (Win) or [Ctrl]-clicked (Mac) an audio track to open the dialog for example, the settings for audio tracks are automatically displayed. The selected track type is shown in the menu display in the top left corner of the dialog.

- To change the selected track type, click the arrow to the right in the menu display and select a track type from the pop-up menu that appears.
  All settings made in the dialog will apply to all tracks (current and subsequent) of the selected type.

The track type pop-up
Removing track controls

To remove track controls in the Track list, proceed as follows:

1. Make sure you have selected the desired track type (see above).
2. Select the control(s) you wish to hide in the Used Controls list. You can use standard multiple selection methods (i.e. [Shift] and [Ctrl]/[Command].
3. Click the “Remove” button. The control(s) are moved to the Available Controls list.
4. Click OK to remove the controls from the Track list.
   • All controls can be removed except the Mute and Solo buttons.

Adding available track controls

To add available track controls to the Track list, proceed as follows:

1. Make sure you have selected the desired track type (see above).
2. Select the control(s) you wish to add in the Available Controls list and click the “Add” button.
3. Click OK to add the controls to the Track list.

Moving track controls

You can change the position or order of the track controls if you like:

1. Make sure you have selected the desired track type (see above).
2. Select the control(s) you wish to move in the Used Controls list.
3. Use the “Move Up” and “Move Down” buttons to reposition the selected controls up or down in the Track list.
4. Click OK. The controls are moved.
Grouping track controls

If you resize the Track list, the position of the controls will change dynamically to accommodate as many controls as possible in the available space (given that Wrap Controls is activated – see below). By grouping several track controls you can ensure that they will always be positioned side by side in the Track list. To group controls, proceed as follows:

1. Make sure you have selected the desired track type (see above).
2. Select at least two controls you wish to group in the Used Controls list.
   • You can only group controls that are adjacent to each other in the Used Controls list. To group controls that are currently not adjacent in the list, use the Move Up/Down buttons first.
3. Click Group.
   A number is displayed in the Group column for the grouped controls. The first group created will have the number 1, the second 2 and so on.
4. Click OK.
   The controls are now grouped.

About Wrap Controls

This is by default activated (checked). Wrap Controls is the function that allows the controls to be dynamically repositioned when resizing the Track list. That is, as many controls as can fit in any given space will be displayed depending on how you resize the Track list.

If you deactivate Wrap Controls, the positions of the controls will be fixed, regardless of the size of the Track list. In this mode, you may have to resize the tracks vertically (by dragging the dividers between them) to display all the controls.

About the Length column

The Length column in the Used Controls list allows you to set the maximum number of characters allowed in certain text fields (Name, Output). To change the setting, click on the number in the Length column and type in a new value.
About Reset

There are two Reset buttons in the dialog:

- Clicking Reset will restore all default track controls settings for the selected track type.
- Clicking Reset All will restore all default track controls settings for all track types.

Saving presets

You can save track control settings as presets for later recall:

1. Click on the Save icon beside the Presets name field. A dialog appears allowing you to type in a name for the preset.
2. Click OK to save the settings as a preset. Saved presets are available for selection from the Presets pop-up and from the pop-up at the top left corner of the Track list.
3. To remove a preset, select it in the Track Controls Settings dialog, and click the Delete icon beside the Presets name field.

- Cubase SX/SL comes with a number of track control settings presets available.
About preference presets (Cubase SX only)

It is possible to save complete or partial preferences settings as presets. This lets you recall settings quickly and easily.

Saving a preference preset

When you have made your preferences settings, proceed as follows to save all settings as a preset:

1. If the dialog is not already open, select Preferences from the File menu (Win)/Cubase SX menu (Mac).

2. Make sure that the “Store marked preferences only” box is not checked. This is because this option is used for saving partial settings (see below), as opposed to complete settings.

3. Click the Store button in the lower left section of the Preferences dialog. A dialog appears, allowing you to type in a name for the preset.

4. Click OK to save. Your saved settings will now be available from the Preference Presets pop-up for your future projects.

Loading a preference preset

To load a saved preference preset, proceed as follows:

1. Select Preferences from the File menu (Win)/Cubase SX menu (Mac).

2. Select the saved preset from the Preference Presets pop-up.

3. Click OK to exit the Preferences dialog and apply the saved preset settings.
Saving partial preferences settings

It is also possible to save partial preferences settings. This is useful when you have made settings that perhaps only relate to a specific project or settings that you wish to apply only in certain situations for example. When you apply a saved partial preference preset you only change the specific saved settings, and all other Preferences dialog settings will be left unchanged.

When you have made your specific preferences settings, proceed as follows to save the partial settings as a preset:

1. Open the Preferences dialog.

2. Activate the “Store marked preferences only” checkbox. When this is on, a new “Store” column appears in the Preferences page list.

3. Click in the Store column for the Preferences items you wish to save. Note that if you check a Preferences page that contains subpages these will automatically also be checked. If this is not what you want, simply uncheck the subpages.

4. Click the Store button in the lower left section of the Preferences. A dialog appears, allowing you to type in a name for the preset. It is a good idea to choose a descriptive name for a partial preference preset, preferably relating to the saved settings (for example “Configuration” or “Editing-Controls” etc.).

5. Click OK to save. Your saved settings will now be available from the Preference Presets pop-up for your future projects.
Appearance

In the Preferences dialog you will find a page called Appearance. Here you can adjust the look of the program, with the following settings:

- Basic Appearance Scheme.
  By selecting an option from this pop-up menu you can adjust the general look of the program. After selecting an Appearance Scheme and clicking Apply or OK, you need to restart the program for the changes to take effect.

- Brightness/Intensity sliders.
  These sliders allow you to fine-tune the brightness and contrast in various areas in the program. Changes take effect when you click Apply or OK.

Where are the settings stored?

As you have seen, there are a large number of ways in which you can customize Cubase SX/SL. While some of the settings you make are stored in each project, others are stored in separate preference files.

If you need to transfer your projects to another computer (e.g. in another studio), you can bring all your settings along by copying the desired preference files and installing them on the other computer.

- It’s a good idea to make a backup copy of your preference files once you have set things up the way you want!
  This way, if another Cubase SX/SL user wants to use his or her personal settings when working on your computer, you can restore your own preferences afterwards.

The table below shows the location and name of each preference file.

- Under Windows, these are stored in the folder "\Documents and Settings\<user name>\Application Data\Steinberg\Cubase SX/SL".
  On the Start menu you will find a shortcut to this folder, for easy access.

- Under Mac OS X, they are stored in the folder "Library/Preferences/Cubase SX/SL/" under your “home” directory.
  The full path would be: “/Users/<user name>/Library/Preferences/Cubase SX/SL/".
Any exceptions to the above are stated in the table.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Stored in</th>
</tr>
</thead>
<tbody>
<tr>
<td>Current edit modifier keys</td>
<td>Edit Modifiers.xml</td>
</tr>
<tr>
<td>Current key commands</td>
<td>Key Commands.xml</td>
</tr>
<tr>
<td>Current preferences</td>
<td>Cubase SX/SL Defaults – Mac OS X only; under Windows, preferences are stored in the Registry: HKEY_CURRENT_USER\Software\Steinberg\Cubase SX/SL\Defaults(2)</td>
</tr>
<tr>
<td>Color setup</td>
<td>saved in project</td>
</tr>
<tr>
<td>Crossfade presets</td>
<td>Presets\RAMPresets.xml</td>
</tr>
<tr>
<td>Drum maps</td>
<td>saved in Project/Export as *.drm file</td>
</tr>
<tr>
<td>EQ presets</td>
<td>Presets\RAMPresets.xml</td>
</tr>
<tr>
<td>Installed MIDI devices</td>
<td>Midi Devices.bin</td>
</tr>
<tr>
<td>Key commands presets</td>
<td>Presets\KeyCommands&lt;Preset Name&gt;.xml</td>
</tr>
<tr>
<td>Logical Editor presets</td>
<td>Presets\Logical Edit&lt;Preset Name&gt;.xml</td>
</tr>
<tr>
<td>MIDI FX presets</td>
<td>Presets&lt;Plugin Name&gt;&lt;Plugin Name&gt;.xml</td>
</tr>
<tr>
<td>Mixer view preset</td>
<td>saved in project</td>
</tr>
<tr>
<td>Preferences configurations</td>
<td>Configuration.xml</td>
</tr>
<tr>
<td>Preferences presets</td>
<td>Presets\Configurations&lt;Preset Name&gt;.xml</td>
</tr>
<tr>
<td>Quantize presets</td>
<td>Presets\RAMPresets.xml</td>
</tr>
<tr>
<td>User templates</td>
<td>templates&lt;Template Name&gt;.cpr</td>
</tr>
<tr>
<td>Toolbar presets</td>
<td>Presets\RAMPresets.xml</td>
</tr>
<tr>
<td>Track controls presets</td>
<td>Presets\RAMPresets.xml</td>
</tr>
<tr>
<td>Transport panel presets</td>
<td>Presets\RAMPresets.xml</td>
</tr>
<tr>
<td>Usage profile log</td>
<td>Usage Profile.xml</td>
</tr>
<tr>
<td>VST connections presets</td>
<td>Presets\RAMPresets.xml</td>
</tr>
<tr>
<td>Window layouts</td>
<td>Window Layouts.xml</td>
</tr>
<tr>
<td>Zoom presets</td>
<td>Presets\RAMPresets.xml</td>
</tr>
<tr>
<td>Audio plugin presets</td>
<td>Presets\RAMPresets.xml</td>
</tr>
</tbody>
</table>
35

Key commands
Background

Introduction

Most of the main menus in Cubase SX/SL have key command shortcuts for certain items on the menus. In addition, there are numerous other Cubase SX/SL functions that can be performed via key commands. These are all default settings. If you want, you can customize existing key commands to your liking, and also add commands for menu items and functions currently not assigned any.

- You can also assign tool modifier keys, i.e. keys that change the behavior of various tools when pressed. This is done in the Preferences dialog – see page 813.

How are key commands settings saved?

Every time you edit or add any key command assignment, this is stored as a global Cubase SX/SL preference – not as part of a project. Hence, if you edit or add a key command assignment, any subsequent projects that you create or open will use these modified settings. However, the default settings can at any time be restored by selecting "Reset All" in the Key Commands dialog.

In addition, you can save key commands settings as a "key commands file", which is stored separately and can be imported into any project. This way you can quickly and easily recall customized settings, when moving projects between different computers, for example. The settings are saved in a file on disk with the windows extension ".xml".

See later in this chapter for details on how to save key commands settings.
Setting up Key Commands

The following is a description of how you set up key commands and save them as presets for easy access.

Key commands settings are accessed and edited mainly in the Key Commands dialog, but there are also some settings that can be made in the Preferences dialog, and these are also addressed in this chapter.

Adding or modifying a key command

In the Key Commands dialog you will find all main menu items and a large number of other functions, arranged in a hierarchical way similar to that of the Windows Explorer and Mac OS Finder. The categories are represented by a number of folders, each containing various menu items and functions. When you open a category folder by clicking the plus-sign beside it, the items and functions it contains are displayed with the currently assigned key commands.
To add a key command, proceed as follows:

1. Pull down the File menu and select “Key Commands…”. The Key Commands dialog appears.

2. Use the list in the Commands column to navigate to the desired category.

3. Click the plus-sign to open the category folder and display the items contained in it. Note that you can also click the “global” plus- and minus-signs in the top left corner to open and close all category folders at once.

4. In the list, select the item to which you wish to assign a key command. Already assigned key commands are shown in the Keys column as well as in the Keys section in the top right corner.

5. Alternatively, you can use the search function in the dialog to find the desired item. For a description of how to use the search function, see page 808.

6. When you have found and selected the desired item, click in the “Type in Key” field and enter a new key command. You can choose between any single key or a combination of one or several keys (Command, Option (Mac), Ctrl, Alt (Win), Shift) plus any key. Just press the keys you want to use.
7. If the key command you entered is already assigned to another item or function, this is displayed below the “Type in Key” field.

In the case that a key command already is assigned to another function, you can either ignore this and proceed to assign the key command to the new function instead, or you can select another key command.

8. Click the Assign button above the field.
The new key command appears in the Keys List.

⚠️ If the key command you enter is already assigned to another function, you will get a prompt asking if you want to reassign the command to the new function instead, or cancel the operation.

Note that you can have several different key commands for the same function. So adding a key command to a function that already has another key command will not replace the key command previously defined for the function. If you wish to remove an assigned key command, please see page 808.

9. Click OK to exit the dialog.
Searching for key commands

If you want to know which key command is assigned to a certain function in the program, you can use the Search function in the Key Commands dialog:

1. Click in the search text field at the top left of the dialog and type in the function for which you want to know the key command. This is a standard word search function, so you should type the command as it is spelled in the program. Partial words are OK; to search for e.g. all quantize related commands you could type “Quantize”, “Quant”, etc.

2. Click the Search button (the magnifying glass icon). The search is conducted and the first matching command is selected and displayed in the commands list below. The keys column and the keys list show the assigned key commands, if any.

3. To search for more commands containing the word(s) you entered, just press the Search button again.

4. When you’re done, click OK to close the dialog.

Removing a key command

To remove a key command, proceed as follows:

1. If the key commands dialog isn’t already open, pull down the File menu and select “Key Commands…”.

2. Use the list of categories and commands to select the item or function for which you wish to remove a key command. The key command for the item is shown in the Keys list and the Keys column.

3. Select the key command in the Keys list and click the Remove button (the trash icon). You will get a prompt asking if you want to remove the key command or cancel the operation.

4. Click OK to close the dialog.
Setting up macros

A macro is a combination of several functions or commands, to be performed in one go. For example, you could select all events on the selected audio track, remove DC offset, normalize the events and duplicate them, all with a single command.

Macros are set up in the Key Commands dialog as follows:

1. Click the Show Macros button.
   The macro settings are shown in the lower part of the dialog. To hide these from view, click the button (now renamed to Hide Macros) again.

2. Click New Macro.
   A new, unnamed macro appears in the Macros list. Name it by typing the desired name. You can rename a macro at any time by clicking it in the list and typing a new name.

3. Make sure the macro is selected, and then use the Categories and Commands in the upper half of the dialog to select the first command you want to include in the macro.

4. Click Add Command.
   The selected command appears in the list of Commands in the Macros section.

5. Repeat the procedure to add more commands to the macro.
   Note that commands are added after the currently selected command in the list. This allows you to insert commands "in the middle" of an existing macro.

- To remove a command from the macro, select it in the Macros list and click Delete.
Similarly, to remove an entire macro, select it in the Macros list and click Delete.

After you’ve closed the Key Commands dialog, all macros you have created appear at the bottom of the Edit menu, available for instant selection.

You can also assign key commands to macros. All macros you have created appear in the upper section of the Key Commands dialog under the Macros category – just select a macro and assign a key command as with any other function.

Saving key commands settings

As previously mentioned, any changes made to the key commands (and macros) are automatically stored as a Cubase SX/SL preference. It is however also possible to store key commands settings separately. In this way, you can store any number of different key command settings as presets for instant recall.

Proceed as follows:

1. Set up the key commands and macros to your liking.
   When setting up key commands, remember to click “Assign” to make the changes.

2. Click the Save button (the disk icon) by the Presets pop-up menu.
   A dialog appears, allowing you to type in a name for the preset.

3. Click OK to save the preset.
   Your saved key commands settings will now be available in the Preset pop-up menu for your future projects.
Loading saved key command settings

To load saved key command settings, proceed as follows:

- **Note that this operation may replace existing key commands!**
  The key command settings you load will replace the current key command settings for the same functions (if any). If you have macros of the same name as those stored in the preset you load, these will be replaced too.
  If you want to be able to revert to your current settings again, make sure to save them first, as described above!

  1. Open the Key Commands dialog from the File menu.
  2. Select the saved key commands preset you wish to open from the Presets pop-up.
  3. Click OK to exit the Key Commands dialog and apply the saved preset settings.
     The loaded key commands settings now replace the current key command settings.

Loading saved key commands settings from earlier versions of Cubase SX/SL

If you have used a previous version of Cubase SX/SL, you may have saved key commands settings from it that you’d like to use in Cubase SX/SL 2.0. This is possible by using the Import function, which lets you load and apply either saved key commands or macros:

  1. Open the Key Commands dialog from the File menu.
  2. Click the “Import” button (the folder icon) to the right of the Presets pop-up menu.
     A standard browser dialog opens.
3. In the browser dialog, use the “Files of type:” pop-up to specify if you want to import a Key Commands File (Windows file extension “.key”) or a Macro Commands File (extension “.mac”).
In Cubase SX/SL 2.0, Key Commands files include any macro settings and use the Windows extension “.xml”. So after you have imported an older file, you might want to save it as a preset (as described on page 810) to be able to access it from the Presets pop-up menu in the future.

4. Navigate to the file you want to import and click “Open”.
The file is imported.

5. Click OK to exit the Key Commands dialog and apply the imported settings.
The settings in the loaded key commands- or macros file now replace the current settings.

About the “Reset” and “Reset All” functions
These two buttons in the Key Commands dialog will both restore the default settings. The following rules apply:
- “Reset” restores the default key command setting for the function selected in the Commands list.
- “Reset All” will restore the default key commands for all commands.

Note that the “Reset All” operation will cause any changes made to the default key commands to be lost! If you want to be able to revert to these settings again, make sure to save them first!

About the default key commands
As mentioned before, there are numerous default key commands. For an overview of these, please refer to the Getting Started book where they are listed for your convenience.
Setting up tool modifier keys

A tool modifier key is a key you can press to get an alternate function when using a tool. For example, clicking and dragging and event with the Arrow tool normally moves it – holding down a modifier key (by default [Alt]/[Option]) will copy it instead.

The default tool modifier keys are listed in the Getting Started book, but you can customize them if needed. This is done in the Preferences dialog:

1. Open the Preferences dialog from the File menu (on the Mac, this is located on the Cubase SX/SL menu) and select the Editing – Tool Modifiers page.

2. Select an option in the Categories list, and then locate the action for which you want to edit the modifier key.
   For example, the “Copy” action mentioned above resides in the category “Drag & Drop”.

3. Select the action in the Action list.

4. Hold down the desired modifier key(s) and click the Assign button.
   The current modifier key(s) for the action is replaced. If the modifier key(s) you pressed are already assigned to another tool, you will be asked whether you want to overwrite them. If you do, this will leave the other tool without any modifier key(s) assigned.

5. When you’re done, click OK to apply the changes and close the dialog.
Index
### CUBASE SX/SL

**Index**

### A

Activate Next/Previous Part 529  
Activate project button 760  
Active ASIO Ports for  
  Data only 735  
Active Part 528  
Active Staff 589  
Add Bus 18  
Add Child Bus 19  
Add Track 109  
Adjust Fades to Range 167  
Adjust Loop (Hitpoints) 400  
Aftertouch  
  Deleting 558  
  Editing 554  
  Recording 73  
AIFF files 689  
Always use MIDI Clock Start 717  
Angle Mode 288  
Any (MIDI channel setting) 69  
Apogee UV22/UV22 HR 242  
APP  
  Introduction to 711  
  Setting up 715  
Appearance 801  
Applying effects 352  
Archiving 440  
Arpache 5 473  
Arpeggiator 473  
ASIO 2.0 52  
ASIO Device Ports  
  Selecting for busses 18  
  Setting up 16  
ASIO Direct Monitoring 52  
ASIO Positioning Protocol  
  Introduction to 711  
  Setting up 715  
Attenuate (Surround Panner) 293  

### Audio channels

  - Copying settings 219  
  - Linking 226  
  - Making settings for 212  
  - Mixing down to file 684  
  - Saving settings 228  

### Audio clips

  - About 332  
  - Creating new versions 424  
  - Deleting 426  
  - Locating events 427  
  - Managing in Pool 424  
  - Opening in the  
    Sample Editor 433  

### Audio effects

  - About 232  
  - Applying 352  
  - Automating 311  
  - Editing 256  
  - For output busses  
    (Master inserts) 241  
  - In surround configurations 294  
  - Inserts 234  
  - Loading 257  
  - Naming 257  
  - Organizing in subfolders 259  
  - Post-fader inserts 234  
  - Pre/Post fader sends 249  
  - Presets 255  
  - Recording with 61  
  - Saving 257  
  - Sends 248  
  - Tempo sync 233  
  - Using VST System Link 739  

### Audio events

  - Blue handles 166  
  - Editing in Browser 667  
  - Editing in Sample Editor 366  
  - Fade handles 166
Making selections in 375
Slicing 412
Volume handles 168

Audio files
Converting 441
Deleting permanently 426
Exporting 684
Format for recording 43
Formats 434
Import options 115
Importing into Pool 434
Importing into
Project window 114
Locating missing 430
Reconstructing missing 431
Removing missing 431

Audio parts
About 85
Creating by gluing events 124
Creating from events 116
Drawing 116
Editing in Audio Part
Editor 386
Editing in Project Browser 666
Sliding contents 128

Automation
About 296
Editing in Project Browser 671
Modes 308
Opening automation
subtracks 299
Reduction Preference 320
Showing and hiding 299
Trimming/offsetting
curves 309
Write/Read buttons 306

Automation events
About 313
Editing 314
Editing in Project Browser 318
Removing 317
Selecting 316
Automation follows Events 305
Automation Reduction Level 320
Automation subtracks
Assigning parameters to 301
Hiding and showing 304
Muting 305
AutoPan (MIDI effect) 475
Autoscroll 143, 535

B
Backup (.bak) files 782
Bank Select 446
Bars+Beats Linear
MIDI editors 531
Tempo Track Editor 638
Basic Appearance Scheme 801
Beat Calculator 647
Bounce (Export Audio) 684
Bounce Selection
Pool 436
Project window 131
Sample Editor 378
Brightness 801
Broadcast Wave files
Exporting 695
Recording 43
Browser 662
Busses
About 14
Adding 18
Mixing down to file 684
Routing to and from 21
Viewing in the mixer 22
Bypass
Effect sends 250
Insert effects 236

C
Calculate (Hitpoints) 405
Channel (MIDI) 66
Channel Overview
EQ 218
Insert effects 237
Channel Settings
Audio tracks 212
Copying 219
MIDI tracks 225
Channel view sets 195
Chase 36
Child Bus 19
Chn setting 68
Chord Recognition 532
Chorder 477
Clean Lengths 594
Cleanup 766
Clef 593
Click 80
Clips, see “Audio clips”
Close 761
Close Gaps 416
Color pop-up menu
MIDI editors 605
Project window 110

Colorize Event Background 106
Compress (MIDI effect) 481
Conform Files 442
Constrain Delay Compensation 270
Controller display
About 533
Adding and removing lanes 549
Controller lane presets 551
Editing events 554
Editing velocity 552
Selecting event type 550
Controllers
Deleting 558
Editing 554
Recording 73
Convert Files 441
Convert to Real Copy 122
Count-in 80
Cpr files 760
Create Audio Images During Record 53
Create Events (Cycle Rec Mode) 56
Create Groove Quantize 413
Create new controller lane 549
Create Regions (Cycle Rec Mode) 57
Create slices 412
Crop 139
Crossfades
Creating 173
Editing in dialog 176
Presets 178
Removing 175
Csh files 440
Cubase VST files 774
Cursor, see “Project cursor”
Cut Time 138
Cycle
  About 32
  About recording 42
  Recording audio 55
  Recording MIDI 71
Cycle markers
  About 154
  Adding in Marker window 155
  Drawing 159
  Editing 161
  Making selections with 162
  Navigating to 161
  On Marker track 158
Cycle Record modes 71

D
DC Offset 346
Deactivate Punch In on Stop 78
Default Edit Action 527
Default project 762
Delay compensation
  About 233
  Constraining 270
Delete
  Audio files from disk 426
  Events in Project window 131
  MIDI controllers 518, 558
  MIDI drum notes 566
  MIDI notes 544
Delete Continuous Controllers 518
Delete Controllers function 518
Delete Doubles function 518
Delete Notes function 518
Delete Overlaps
  Audio 60
  Mono (MIDI) 520
  Poly (MIDI) 520
Delete Overlaps (audio) 133
Delete Time 138
Density (MIDI Effect) 482
Detect Silence 358
DirectShow 743
DirectX plug-ins 260
Disable Hitpoints 408
Disable inserts 236
Disable sends 250
Disable Track 34
Display format 96
Display Quantize 591
Display Transpose 593
Dissolve Part
  Audio 116
  MIDI 523
Dithering 241
Divide audio events 414
Dividing the Track list 111
Drag Delay 120
Draw
  Automation events 314
  Hitpoints 410
  In Sample Editor 382
  Markers 159
  MIDI controllers 554
  MIDI notes 537
  Parts 116
Drop Out Time 722
Drum Editor
  Creating and editing notes 563
  Muting drum sounds 565
  Selecting drum maps 573
Drum maps
  About 567
  Making settings 568
  MIDI channel and output 572
  O-Note Conversion 576
  Selecting 573
  Setup dialog 574
Drum mode (Time Stretch) 351
Drum name lists 576
Drum Sound Solo 565
Drumstick tool 563
Duplicate
  Events and parts 122
  MIDI notes 541
Duplicate track 110

E
Edit Active Part Only 528
Edit as Drums when Drum Map is assigned 527
Edit button
  Audio channel strips 212
  Audio track Inspector 89
  MIDI channel strips 225
  MIDI track Inspector 460
Editing via MIDI 546
Edits folder 332
Effect Return channels 253
Effects, see “Audio effects” or “MIDI effects” 546
Elements (Sample Editor) 367
Enable Record on Selected Track 39
Enable Solo on Selected Track 130
Enable Track 34
Enharmonic Shift 601
Envelope 335
EQ
  Bypassing 217
  Presets 217
  Setting 214
Equal Pitch (Selection) 540
Eraser tool 131
Event as Region 139
Events
  Duplicating 122
  Grouping 128
  Locking 129
  Moving 120
  Muting 130
  Overlapping in audio part 389
  Overlapping in Project window 121
  Removing 131
  Renaming 123
  Renaming all on track 110
  Resizing 125
  Resizing with time stretch 127
  Selecting 119
  Sliding contents 128
  Splitting 124
Events (Snap mode) 141
Events from Regions 139
Events to Part 116
Events, see also “Audio events” 116
Exclusive Solo 206
Export
  OMF 768
Export Audio Mixdown 684
Export MIDI files 770
Export Options (MIDI files) 770
Export selected tracks 767
Export Tempo track 645
Extract Audio from Video 779

F
Fade handles 166
Fade In/Out functions 169
Faders 202
Fades
  Auto Fades 179
  Creating 166
  Editing in dialog 170
  Presets 171
  Processing 169
  Removing 168
Fill Loop 123
Filter (MIDI) 77
Filter (Project Browser) 670
Filter bar 582
Find missing files 430
Find Selected in Pool 428
FireWire 746
Fixed Lengths 517
Fixed tempo 636
Fixed Velocity 522
Flip Stems 602
Folder parts 149
Folder tracks
  About 146
  Moving tracks into 147
  Muting and soloing 148
Frame rates 721
Freeze Edits 357
Freeze Quantize 514
Freeze VST Instruments 273
FX channel tracks
  About 244
  Adding effects for 246
  Mixing down to file 684
  Routing sends to 248
  Setting up 245
  Soloing 254

Group
Gain 336
Generic Remote Device 326
Global (Input Transformer) 631
Glue Tube tool
  MIDI editors 543
  Project window 124
  Score Editor 601
Grid (Snap mode) 141
Groove Quantize
  From audio 413
  From MIDI 510
Group 128

Group channel tracks
  About 84
  Routing audio to 222
  Using effects 243
GS Control Panel 493

H
Hitpoint Edit tool 408
Hitpoint Sensitivity 407
Hitpoints
  Auditioning 406
  Background 398
  Calculating 405
  Disabling 408
  Editing manually 410
  Locking 409
Horizontal Zooming Only 101

I
Import
  Audio CD Tracks 777
  Audio files 114
  Audio from Video file 779
  Cubase Arrangement 775
  Cubase Part 776
  Cubase Song 774
  Medium in Pool 434
  MIDI files 770
  MPEG files 781
  Ogg Vorbis files 781
  OMF 768
  REX 780
  Video files 114
  WMA files 782
Import Audio CD 436
Import Tempo track 645
Import Track Archive 767
Independent track loop
  Audio Part Editor 391
  MIDI editors 536
Info line
  Drum Editor 560
  Key Editor 531
  Pool 421
  Project window 94
  Sample Editor 370
  Score Editor (Cubase SL) 587
Initialize Channel 220
I-Note 570
Input (MIDI) 66
Input busses
  About 14
  Adding 18
  Routing to channels 21
  Viewing in the mixer 22
Input channels 201
Input Gain
  About 204
  Setting record level 48
Input levels 47
Input Phase switch 205
Input Transformer 631
Input VU meters 47
Input/Output routing panel
  (Mixer) 188
Inputs (Audio) 16
Insert effects (Audio) 234
Insert into Project 428
Insert pop-up menu 579
Insert Silence
  Project window 139
  Sample Editor 377
Insert velocity (MIDI Editors) 539
Inspector
  Audio tracks 90
  Folder tracks 91
General controls 89
Handling 88
MIDI tracks 459
Instrument Freeze 273
Intensity (Appearance) 801
Interpolate Audio Images 371
Iterative Quantize 512
J
Jog wheel 33
Jump tempo curve mode 641
K
Keep Last
  Audio cycle recording 55
  MIDI cycle recording 71
Key (Scores) 593
Key commands
  About 804
  Default 812
  Importing 811
  Loading 811
  Modifying 805
  Removing 808
  Resetting to default 812
  Saving 810
  Searching for 808
L
Lanes
  Audio Part Editor 388
  Stacked Audio Recording 59
  Stacked MIDI Recording 72
Latency
  Monitoring 50
  VST System Link 728
Left locator 32
Legato 517
Length Adjustment 76
Length Compression 465
Length Quantize 537
Level faders 202
Level meters
  Input VU mode 47
  Post-Fader VU mode 48
  Settings 221
LFE amount (Surround) 291
Libraries 765
Line mode
  Automation 315
  MIDI controllers 555
  MIDI velocity 553
Linear Record Mode
  Audio 54
  MIDI 70
Linear time base 113
List Editor
  Adding events 579
  Editing in the list 580
  Editing in the value display 584
  Filtering events 582
  Masking events 583
Local (Input Transformer) 631
Locate when clicked in empty space 30
Locators 32
Lock 129
Lock Event Attributes 129
Lock Hitpoints 409
Lock Time 722
Logical Editor
  About 608
  Actions 625
  Filter conditions 612
  Functions 623
  Opening 610
  Presets 611, 630
Loop
  Audio Part Editor 391
  MIDI editors 536
  Loop icon
    Audio Part Editor 390
    Pool 432
    Sample Editor 372
M
  M button 130
  Machine control
    Introduction to 712
    Setting up 719
  Macros 809
  Magnetic Cursor (Snap mode) 142
  Magnifying Glass tool 101
Markers
  About 154
  Adding in Marker window 155
  Drawing on Marker track 159
  Editing in Project Browser 672
  Editing on Marker track 159
  ID-numbers 157
  Key commands for 163
  Marker track 158
  Marker window 154
  Moving 156
  Removing 155
  Snapping to 141
Mask function 583
Merge Clipboard 337
Merge MIDI in Loop 500
Merge Record Mode
  Audio 54
  MIDI 70
Merge Tempo From Tapping 649
Meter characteristics 221
Metric Bias 407
Metronome
  Activating 80
  Precount 80
  Settings 81
Micro Tuner (MIDI Effect) 482
MIDI channel
  "Any" 69
  In drum maps 572
  Selecting for tracks 68
  Send effects 470
MIDI Channel Settings 225
MIDI Clock
  About 708
  Always use “Start” 717
  Transmitting 717
MIDI connector button 546
MIDI Device Manager 447
MIDI devices
  Defining new 452
  Editing patches for 451
  Installing 448
  Selecting patches for 450
MIDI Echo 484
MIDI effects
  About 468
  Deactivating 499
  Inserts 469
  Presets 471
  Sends 470
MIDI files 770
MIDI Filter 77
MIDI input (Editing via) 546
MIDI Input Transformer 631
MIDI inputs
  Renaming 66
  Selecting for tracks 66
MIDI notes
  Deleting 544
  Drawing 537
  Editing velocity 552
  Moving 541
  Muting 544
  Muting in Drum Editor 565
  Quantizing 505
  Resizing 543
  Selecting 539
  Splitting and gluing 543
  Transposing (Function) 515
  Transposing (in editor) 541
MIDI outputs
  In drum maps 572
  Renaming 66
  Selecting for tracks 68
  Send effects 470
MIDI parts
  About 85
  Drawing 116
  Editing 527
  Editing in Project Browser 668
  Sliding contents 128
MIDI Record Catch Range 76
MIDI reset 74
MIDI Step Sequencer 489
MIDI Thru 65
MIDI tracks
  Channel Settings window 225
  Settings 460
  Track Parameters 463
MIDIControl (MIDI Effect) 483
Minimize Files 439
Mix (Cycle Record mode) 71
Mixer

Common panel 200
Extended channel strips 188
Group channels 222
Hiding channel types 194
Input and output busses 201
Input/Output settings 188
Link/Unlink channels 226
Loading settings 229
Multiple mixer windows 185
Pan 207
Saving settings 228
Solo and Mute 206
View options 190
Volume 202

Mixer Selection Follows

Project 213
Mixing down to an audio file 684
MMC

Introduction to 712
Setting up 719
Modifier keys 813
Monitor button

Audio tracks 51
MIDI tracks 65
Monitoring modes 50
Move Hitpoints 410
Move to Back/Front 121
Move to Cursor 121
Move to Origin 121
MP3 files

Exporting 696
Importing 781
MP3Pro 697
MPEG files

Audio 781
Video 743

MPEX

Pitch Shift 342
Time Stretch 351
Multiple audio tracks 109
Musical time base 113
Mute

Events in Project window 130
MIDI notes 544
Mixer 206
Tracks 130
Mute Pre-Send when Mute 250
Mute tool 130

N

N. Chan. Split/Interleaved
(Export) 689
New Project 99
No Overlap 594
Noise Gate 338
Non Quantize setting 509
Normal Record Mode

Audio 54
MIDI 70
Normal Sizing 125
Normalize

Audio process 339
Surround Panner 293
Notes to CC 487
Notes, see “MIDI notes”
Npl files

Libraries 765
Pool files 440
Nudge buttons

MIDI editor toolbar 541
Project window toolbar 121
Nudge position buttons 34
Numeric keypad 29
Offline Process History 355
Ogg Vorbis files
  Exporting 698
  Importing 781
OMF files 768
On Import Audio Files 115
On Processing Shared Clips 333
On Startup setting 783
Online (VST System Link) 732
O-Note 570
O-Note Conversion 576
Open 760
Open Document
  Options dialog 784
Original Tempo (Hitpoints) 404
Output (MIDI) 66
Output busses
  About 14
  Adding 18
  Mixing down to file 684
  Routing channels to 21
  Surround configurations 283
  Viewing in the mixer 22
Output channels 201
Outputs (Audio) 16
Over Quantize 511
Overlapping events
  Audio Part Editor 389
  Project window 121
Overview 108
Overwrite
  (Cycle Record mode) 71
  Overwrite mode (Automation) 309
Padlock symbol 129
Pan Law 209
Pan modes 208
Parabola mode
  Automation 316
  MIDI controllers 555
  MIDI velocity 553
Part Data mode 107
Part to Groove 510
Parts, see “Audio parts” or “MIDI parts”
Paste at Origin 123
Paste Time
  MIDI editing 542
    Selection ranges 138
Patch Banks 449
Patch Editor (Surround) 294
Pattern Sequencer 489
Peak Hold Time 221
Pedals to Note Length 520
Pencil tool 116
Pending Connections 761
Performance meter 230
Phase Reverse 340
Pitch Bend
  Deleting 558
  Editing 554
    Recording 73
Pitch Shift 340
Play icon
  Audio Part Editor 390
    Pool 432
    Sample Editor 372
Play tool
  Audio Part Editor 390
    Project window 117
Plug-in delay compensation 233
Plug-in Information window
  MIDI plug-ins 499
  VST plug-ins 261
Plug-ins
   Applying 352
   Automating 311
   Getting info 261
   In surround configurations 294
   Installing 258
   Organizing 259
Poly Pressure events 558
Polyphony (Restricting) 520
Pool
   About 418
   Auditioning 432
   Convert Files 441
   Finding clips in 427
   Handling audio clips 424
   Import Medium 434
   Importing Pool files 440
   Locate missing files 430
   Record folder 437
   Status column icons 423
Position Mode 288
Post-Fader VU meters 48
Postroll 79
Pre fader sends 249
Pre/Post crossfade 334
Precount 80
Preferences
   Presets 799
   Transferring 801
Prepare Archive 440
Preroll 79
Prg field 450
Printing Scores 604
Processing
   About 333
   Plug-ins 352
   Settings and functions 334
   Undoing 355
   Program Change 446
Project
   Activating 760
   Creating 99
   Default 762
   Opening 760
   Saving 762
   Saving templates 763
Project Browser 662
Project cursor
   Autoscroll 143
   Moving 30
   Selecting events with 120
   Snapping to 142
Project overview line 108
Project scrubbing 33
Project Setup dialog 99
Punch In
   Automatic 41
   Manual 40
Punch Out 41
Q
Quantize
   About 505
   Applying 511
   Automatic during recording 70
   Creating grooves from audio 413
   Creating grooves from MIDI 510
   Ends 514
   Freezing 514
   Lengths 513
   Setting on toolbar 506
   Setup dialog 506
   Undoing 514
Quantizer 488
Quick Zoom 102
Quicktime 743
R

R button 306
Ramp tempo curve mode 641
Random (Track parameter) 466
Random Quantize setting 510
Range (Track parameter) 467
Range Selection tool 135
Read button 306
Real Audio files 699
Real-Time Export 686
Reconstruct 431
Record Catch Range 76
Record enable 39
Record file type 43
Record folder 46
Record format 44
Record Mode (Linear)
  Audio 54
  MIDI 70
Recording in MIDI editors 76
Recording tempo changes 643
ReCycle files 780
Redo Zoom 105
Regions
  Creating 379
  Creating from events 139
  Creating with Detect
    Silence 360
  Editing 380
  Exporting as audio files 436
  Removing 381
Remote control
  Key commands 325
  Setting up 322
  Writing automation 324
Remove DC Offset 346
Remove Empty Tracks 110
Remove missing files 431
Remove Parameter 317
Removing crossfades 175
Removing fades 168
Repeat
  Events and parts 122
  MIDI notes 541
Replace Audio in Video File 747
Replace Record Mode
  Audio 54
  MIDI 70
Reset 74
Reset Mixer 220
Resolution 44
Resolving 710
Restrict Polyphony 520
Retrospective Record 75
Return To Start Position on
  Stop 34
Reverse 347
Reverse (MIDI function) 522
Revert 764
ReWire
  About 752
  Activating 754
  Channels 756
  Routing MIDI 757
REX files 780
Right locator 32
Roland GS Control Panel 493
Routing
  Audio to and from busses 21
  Effect sends 248
  Effect sends (Panning) 251
  Inputs/outputs in effects 238
Ruler
  About 96
  Adding additional time scales 97
Ruler tracks 97
S

S button 130
Sample rate 100
Sample size 44
Save 762
Save New Version 763
Save Project to new folder 764
Scissors tool
  MIDI editors 543
  Project window 124
  Score Editor 601
Score
  Displaying 590
  Printing 604
Scrubbing
  Events in Project window 118
  Events in Sample Editor 373
  Project 33
  Resizing events by 126
  While setting snap point 374
Search key commands 808
Selecting
  Events in Project window 119
  MIDI notes 539
  Mixer channels 213
Send effects (Audio) 244
Sensitivity slider 407
Set Audio Event from Loop 415
Set Pool Record Folder 437
Set Record Folder 46
Set Tempo from Event 415
Set Timecode at Cursor 716
Shared copy 122
Shared VST plug-ins folder 259
Show Controllers 107
Show Data on Small Track Heights 106
Show Event Names 106
Show Event Volume Curves
  Always 166
Show Filter View 582
Show Part Borders 529
Show Used Automation 312
Show Video Thumbnails 749
Shuffle 594
Shuffle (Snap mode) 142
Shuttle speed 33
Signal levels 47
Silence 347
Sine mode
  Automation 316
  MIDI editing 556
Sizing Applies Time Stretch 127
Sizing Moves Contents 125
Slices
  Auditioning 406
  Creating 412
  Disabling 408
  Locking 409
Snap
  MIDI editors 605
  Project window 140
Snap point
  Setting for clips in Pool 433
  Setting in Project window 140
  Setting in Sample Editor 374
Snap Record Parts to Bars 76
Snap to Zero Crossing
  Preference setting 143
  Sample Editor 384
Snap Track Heights 103
Solo
  Audio Part Editor 391
  Folder tracks 148
  MIDI editors 535
  Mixer 206
  On Selected Track 130
  Tracks 130
Solo Defeat 206, 254
Solo Record in MIDI Editors 76
Sound Designer II files 691
Speaker icon (MIDI editors) 536
Speaker tool
  Audio Part Editor 390
  Project window 117
Speakers (SurroundPanner) 289
Spectrum Analyzer 361
Split
  Events 124
  Range 139
Split (Piano) Staff 591
Split at Cursor
  MIDI editors 543
  Project window 124
Split Loop
  MIDI editors 543
  Project window 124
Split MIDI Events 124
Square mode
  Automation 316
  MIDI editing 556
Stacked Cycle Recording
  Audio 59
  MIDI 72
Staff Mode 591
Staff Settings 590
Standard Mode 288
Start Record at Left Locator 40
Startup options 783
Static Value Line (Automation) 313
Stationary cursor 143
Statistics 364
Step Bar 30
Step Designer 489
Step input 547
Step Input button 547
Stereo Flip 348
Stereo Pan Law 209
Stereo pan modes 208
Stereo Split 689
Stop after Automatic Punch Out 78
Stretch to Project Tempo 416
Strip Silence 360
Surround
  About 278
  Applying plug-ins 294
  Exporting to file 293
  Positioning sounds 287
  Routing to surround channels 286
  Setting up 283
  Surround Panner 287
SurroundDither 242
Swing 508
Sync indicator 716
Sync Selection 664
Synchronization
  About 706
  Audio card settings 715
  Connections for 714
  Formats 707
  Frame rates 721
  Indicator (Transport panel) 716
  Machine control 719
  Options 722
  Recording in Sync mode 40
  Synchronization Setup dialog 713
  Syncing equipment to Cubase 717
  To timecode 715
Syncopation 594
System Exclusive
About 676
Bulk Dumps 676
Editing 680
Recording parameter changes 679

T
T button (Scores) 587
Tap Tempo 648
Templates 763
Tempo
About 636
Calculating 647
Editing 640
Editing in Project Browser 673
Importing and exporting 645
Recording 643
Setting from event 415
Setting in Fixed mode 644
Tapping 648
Tempo based tracks 113
Tempo record slider 643
Time based tracks 113
Time display 31
Time format 96
Time Linear
MIDI editors 531
Tempo Track Editor 638
Time Scales 97
Time signature 645
Time Stretch 349
Time Warp tool 650
Timecode
About 707
Frame rates 721
Synchronizing to 715
Toggle Track List 112
Tool modifier keys 813

Toolbar
Audio Part Editor 387
Customizing 792
Drum Editor 560
Key Editor 530
List Editor 577
Pool 420
Project window 93
Sample Editor 368
Score Editor (Cubase SL) 586

Touch Fader mode 308
Track Archive (importing) 767
Track Control Settings 794
Track Controls (MIDI Effect) 493
Track FX (MIDI Effect) 497
Track list
About 87
Customizing 794
Dividing 111
Track Parameters 463
Track types 84
Tracks
Adding 109
Audio channel configuration 44
Changing height of 103
Disabling/Enabling 34
Importing and exporting 767
Locking 129
Musical/Linear time base 113
Removing 110
Renaming 110
Routing MIDI to VST Instruments 267
Selecting 110
Transfer projects and settings 801
Transfer tracks between projects 767
Transformer (MIDI effect) 609
Transparent events 106
Transport menu
  Functions 27
  Playback options 35
Transport panel
  Customizing 790
  Display format 31
  Hiding and showing 27
  Key commands 29
  Overview 26
Transpose
  Info line 95
  MIDI function 515
  Track parameter 464
Triangle mode
  Automation 316
  MIDI editing 556
Trim buttons 126
Trim mode 309

U
Undo
  Processing 355
  Recording 53
  Zoom 105
Undo Quantize 514
Ungroup 128
Unlock 129
Update Display 686
Update Origin 422
Use File Extension in File
  Dialog 762
Use level scan (Hitpoints) 400
Use pop-up menu (Hitpoints) 407
UV22/UV22 HR 242

V
Velocity
  Editing 552
  Editing via MIDI 546
  Info line 95
  MIDI function 521
Velocity Compression 465
Velocity Shift
  Track parameter 464
Video
  Extracting audio from 746
  Importing files 744
  Playing back 745
  Playing back via FireWire 746
  Preparations 748
  Replacing audio 747
  Setting up 743
Video Cache Size 749
Video for Windows 743
Video playback engine 743
Video track
  About 744
    Editing in Project Browser 671
    Showing thumbnails 749
Volume (Info line) 202
Volume handle 168
VST Channel Settings 212
VST Connections 17
VST Instruments
  Activating 267
  Automating 272
  Channels 268
  Freezing 273
  Routing tracks to 267
  Selecting patches 271
  Using VST System Link 738
VST Performance window 230
VST plug-ins
  Getting info 261
  Installing 258
VST Ports 16
VST System Link
  About 724
  Activating 731
  Connections 726
  Latency 728
  MIDI 734
  Putting computers online 732
  Requirements 725
  Setting up sync 726
  Settings 729
VU meters
  Input VU mode 47
  Post-Fader VU mode 48
  Settings 221
VU-Meter Peak’s Hold Time 221

W
  W button 306
  Wave files 692
  Wave Image Style 107
  Wave64 files 694
  Waveform zooming 102
  Window layouts 787
  Windows Media Audio files
    Exporting 700
    Importing 782
    Surround format (Pro) 701
WMA files
  Exporting 700
  Importing 782
WMA Pro files 701
Word Clock
  About 708
  Selecting for sync 715
  Setting up 714
Wrap Controls (Track list) 103

Write button 306

X
  XG Control Panel 493
  X-Over mode 308

Y
  Yamaha XG Control Panel 493

Z
  Zero Crossings 143
  Zoom
    About 101
    History 105
    Presets 104
    Sample Editor 371
    Track height 103
    Waveforms 102
  Zoom N Tracks 103
  Zoom Tool Standard Mode 101
  Zoom while Locating in
    Time Scale 102